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Preface 
The Oracle|Agile documentation set includes Adobe® Acrobat™ PDF files. The Oracle Technology 
Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html) contains the 
latest versions of the Oracle|Agile PLM PDF files. You can view or download these manuals from 
the Web site, or you can ask your Agile administrator if there is an Oracle|Agile Documentation 
folder available on your network from which you can access the Oracle|Agile documentation (PDF) 
files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader™ version 7.0 or later. 
This program can be downloaded from the Adobe Web site (http://www.adobe.com). 

The Oracle Technology Network (OTN) Web site 
(http://www.oracle.com/technology/documentation/agile.html) can be accessed through Help > 
Manuals in both the Agile Web Client and the Agile Java Client. If you need additional assistance or 
information, please contact support (http://www.oracle.com/agile/support.html) 
(http://www.oracle.com/agile/support.html) for assistance. 

Note Before calling Agile Support about a problem with an Oracle|Agile PLM manual, please 
have ready the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Documentation Accessibility  

Our goal is to make Oracle products, services, and supporting documentation accessible, with good 
usability, to the disabled community. To that end, our documentation includes features that make 
information available to users of assistive technology. This documentation is available in HTML 
format, and contains markup to facilitate access by the disabled community. Accessibility standards 
will continue to evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be accessible to 
all of our customers. For more information, visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/ http://www.oracle.com/accessibility/.  

Readme 

Any last-minute information about Oracle|Agile PLM can be found in the Readme file on the Oracle 
Technology Network (OTN) Web site (http://www.oracle.com/technology/documentation/agile.html). 

Agile Training Aids 

Go to the Oracle University Web page 
(http://www.oracle.com/education/chooser/selectcountry_new.html) for more information on Agile 
Training offerings. 

http://www.oracle.com/technology/documentation/agile.html
http://www.adobe.com/
http://www.oracle.com/technology/documentation/agile.html
http://www.oracle.com/agile/support.html
http://www.oracle.com/agile/support.html
http://www.oracle.com/accessibility/
http://www.oracle.com/accessibility/
http://www.oracle.com/technology/documentation/agile.html
http://www.oracle.com/education/chooser/selectcountry_new.html


 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  
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Chapter 1 

Introduction 
This chapter includes the following: 

� What’s in this Manual........................................................................................................................................... 1 
� Overview of the Agile PLM Suite ......................................................................................................................... 2 
� What’s New for the User Experience in Agile PLM 9.2.2..................................................................................... 3 

 
 

What’s in this Manual 
This manual is an introduction to Agile Product Lifecycle Management (PLM) and its main features 
across the user solutions of the Agile PLM suite. Agile PLM is a comprehensive suite of enterprise 
business applications, and the information in this guide is both a starting point for learning Agile as 
well as a “return-to” reference manual. 

This Agile Manual Precedes the Solution Manuals 
Chapters 2–5 provide information about the two primary client applications and introduce basic 
terms, concepts, and features that are used in Agile PLM. Chapters 6–10 cover features and 
functionality in Agile PLM 9.2.2 that all users will work with sooner or later. 

Agile PLM Basics 

Every new Agile user needs to have a good grasp of the material in either Chapters 2, 4, and 5, if 
primarily using Java Client, or Chapters 3, 4, and 5, if primarily using Web Client. Some solutions 
are accessed only through Web Client. Your Agile administrator has likely set up your Agile account 
with a “preferred client.” 

à Chapter 2, Navigating in Agile Java Client (on page 5) — Java Client user interface is fully 
described 

à Chapter 3, Navigating in Agile Web Client (on page 23) — Web Client user interface is fully 
described 

à Chapter 4, Concepts and Terms in Agile PLM Solutions (on page 61) — the basics in Agile 
PLM are surveyed 

à Chapter 5, Working with Business Objects (on page 81) — creating objects, printing, sending, 
relationships, subscriptions 

You can change many of your user settings to help you manage your Agile user experience. A 
complete list of the settings in your user object is found in User Properties Defined (on page 56). 

Cross-Solution Utilities in Agile PLM 

The material in Chapters 6–10, within each chapter, tends to run from elementary to advanced. You 
will likely need to learn some things about reports, searches, workflows, and attachments in Agile 

Agile Product Lifecycle Management Page - 1 

 

 



Getting Started with Agile PLM User Guide  
 
 
 

early on; however, not everything in these chapters has to be – or can be – mastered at once. For 
example, you could learn how to work with attachments (ch.9) but find that you do not have to work 
with file folders (ch.10). 

à Chapter 6, Working with Agile Reports (on page 117) — using and customizing the many out-
of-box reports in Agile PLM 

à Chapter 7, Finding Agile Data with Searches (on page 135) — locating data and information in 
the Agile database 

à Chapter 8, Routing Objects with Workflows (on page 197) — routing business objects for 
approval and to gather other kinds of information 

à Chapter 9, Working with Attachments (on page 241) — Agile business objects can “carry” 
additional data as attachments 

à Chapter 10, Working with File Folders (on page 284) — more advanced capabilities with the 
Agile objects that hold attachment files and URLs 

The Agile end-user guides all assume that you have learned the basic information presented in this 
guide. For instance, although each PLM solution may have its own default workflows, saved 
searches, and predefined reports, the basic information in this manual is preliminary to the more 
specific information in the various user guides. 

Overview of the Agile PLM Suite 
The Agile PL covers five primary areas of product lifecycle management: M suite of solutions 

à Agile Product Collaboration (PC) — Management and collaboration of product record information 
throughout the product lifecycle, across internal organizations and the extended supply chain. 

Client. Accessed through Java Client and Web 

Agile Product Governance & Compliance (PG&C) — Management and tracking of all substan
and materials contained by any item or manufacturer part, allowing companies to meet 
substance restrictions and reporting requirements, design recyclable products, minimize 
complia

à ces 

nce costs, and eliminate noncompliance on future products. Accessed through Web 

à m 
ss the product lifecycle and 

à n 
 with a closed-loop corrective action 

à 
 and synchronization of product cost data and processes. Accessed through Web 

ile 

ces 

Client. 

Agile Product Portfolio Management (PPM, formerly Program Execution) — Integration of progra
and product information, streamlining business processes acro
across a portfolio of programs. Accessed through Web Client. 

Agile Product Quality Management (PQM, formerly Product Service & Improvement) — Integratio
of customer, product, quality, and regulatory information
system. Accessed through Java Client and Web Client. 

Agile Product Cost Management (PCM) — Management of product costs across the product 
lifecycle
Client. 

Agile administrators use Agile Java Client to set up and maintain settings for these solutions. 

The Agile Application Server, the foundation of the Agile suite, manages data stored in the Ag
database. All Agile data is contained or organized in business objects that are set up by the 
administrator, and specified and used by the enterprise’s Agile users. For instance, the 
administrator configures the Parts class of objects, and users create and deploy specific instan
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of the kinds of Parts made available to them. “Business objects” is a general term that implies 

nctional components, the primary 

objects created from the classes available to the enterprise, but other entities in Agile are also 
objects, such as workflows, searches, reports, and so forth. 

The following figure shows relationships between the Agile fu
client applications used to manipulate the data (Agile Java Client and Web Client), and the Agile 
Application Server (the database where the data is stored). 

Agile Java Client
(Java client)

Agile Web Client
(HTML client)

Application & 
Database  
Servers
(hold the Agile 
database)

Administrative 
settings

Product 
Collaboration

Product Quality 
Management

Product Cost 
Management

Product Portfolio 
Management

AGILE PLM FUNCTION

CLIENT APPLICATION 
USED TO WORK WITH 
DATA

DATA STORAGE

Product 
Governance & 
Compliance

 

 for the User Experience in Agile 

n Agile PLM 9.2.2. 

 

What’s New
PLM 9.2.2 
This section lists new elements of the user experience that are found i

Java Client and Web Client User Interfaces 
The user interfaces of the primary Agile clients are described in Navigating in Agile Java Client (on 
page 5), and Navigating in Agile Web Client (on page 23). 

à Bookmarks – you can create nested organizational bookmark folders in which to sort and
bookmarks. You can rename bookmarks in order to give them names that are meaningful to you.

Parametric Search – Agile 9.2.2 includes easy-to-u

 save your 
 

à se parametric searches. The Agile 

à s. A grey dot 

administrator configures the parametric searches to present the most commonly used search 
attributes. Parametric searches can be saved. 

à New Rational Search Operators – New search operators include: Contains All, Between, Not Between. 
Updated search operators are In, Not In, Contains Any, and Contains None. 

Tab content indicator – In Web Client, a simplified content indicator is used on all tab
indicates there is content on the tab. A red dot alerts users to problematic content on the tab. 
For more information, see Web Client Tab Content Indicator Icons (on page 27). 
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à 
 objects (except Reports and Action Items) have Relationships 

à 
shboard Extensions (DX) allow the Agile system to access internal or external 

 and 
n Agile 

à 
s: Notifications, Workflow Routings, and My Assignments. The My 

 
ns and tasks can be performed on the My 

Assignments tab. 

à User-defined Web Client Home Page Quick Links – Each user can define his own list of ten most 
commonly used Links, Bookmarks, and Searches. 

 

Relationships tab – the Relationships tab and Reference tab have been merged into one tab called 
the Relationships tab. All Agile
tabs. Relationships may have an optional rule to define how the two objects affect one another. 
The Web Client Relationships tab includes a preview pane that allows you to view details about 
the selected related object. 

Dashboard Management Extensions – This feature introduced in this release is similar to Process 
Extensions. Da
content and configure the display format (tabular or charts) for authorized users to view
manipulate the outputs in Agile Web Client. Dashboard tabs and formats are defined i
Administrator. 

Web Client Home Page – The inbox display has been simplified. The Web Client inbox is 
organized into three tab
Assignments tab can be sorted by pre-defined views and by using the filter to sort the table by
multiple criteria. Many assignment management actio
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Navigating in Agile Java Client 
This chapter includes the following: 

� Logging In and Out of Java Client ....................................................................................................................... 5 
� Java Client Windows, Menus, and Toolbars........................................................................................................ 7 
� Java Client Tables ............................................................................................................................................... 10 
� Using the Inbox.................................................................................................................................................... 11 
� Using Bookmarks and the Recently Visited List .................................................................................................. 12 
� Changing Your User Settings .............................................................................................................................. 14 
� Address Book in Java Client................................................................................................................................ 18 
� User Groups ........................................................................................................................................................ 20 
� Creating Supplier Groups .................................................................................................................................... 22 

Agile Java Client is distributed using only a browser and Java Web Start. The Product Collaboration 
and Product Quality Management (PQM) solutions can be accessed with Java Client. While you 
may prefer to work in Java Client on a regular basis, some utilities on the Tools menu (Agile Import, 
Export, FileLoad) and Reports open only in Web Client. 
 

Logging In and Out of Java Client 
Agile PLM 9.2.2 has been installed on your company’s system, and the administrator has sent you 
a URL to connect to Java Client. There may already be a shortcut icon on your desktop, or there is 
an application path on your Start menu. If you do not have access to Java Client, see your 
administrator. 

Complete details for installing Java Client are in the appropriate Agile Installation Guide. 

To log in to Java Client: 

1. Start the Web browser and type the following, per information from your administrator: 

http://<webserver_hostname>/JavaClient/start.html 
2. You will receive a message about accessing the computer when you install and run Java 

Client. Click Launch. The Login window appears. 

3. Enter your username. Your username is not case-sensitive. 

Your username is assigned by your Agile administrator and can be an abbreviation of your full 
name. For example, the name Michael Jones may be abbreviated to MICHAELJ or MJONES. 
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4. Enter your password. Your password is case-sensitive. 

 
Your password is initially assigned by your Agile administrator. If you have the appropriate 
privileges, you can change your password at any time. The administrator may require you to do 
so within a set number of sessions. (See Changing Your Password (on page 36)). 

5. Click OK. 

The login process is complete. The Java Client window opens, as shown in the figure below. 

The next time you start Java Client, you are prompted to create shortcuts on the desktop and in 
the Start menu. It is recommended that you choose Yes for either or both shortcut types. 

You can also start Java Client using the Java Web Start icon on your desktop. double-click the 
icon and you will see an option for Agile PLM. 

Note If you are having difficulty logging in to Java Client, check with your administrator, who 
can see if any users are logged in multiple times, or if any users have been inactive for 
awhile and their session can be terminated by the administrator. Another problem could 
be that your Java Web Start cache is too full. To clear the cache, open Java Web Start, 
choose File > Preferences, click the Advanced tab, and click Clear Folder. Then try launching 
Java Client.   

You can search for Agile data using the Simple Search field and Run Search button. To create a 
Quick Search, use the Search Option drop-down list to select a specific object type. Or, use the 
Advanced Search  button. You can choose an activity from the menu bar, main toolbar, or tab 
toolbar. For detailed instructions about searching, see, Finding Agile Data with Searches (on page 
135). 
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To close Java Client, click the Exit  button.    

Java Client Windows, Menus, and Toolbars 
This section discusses some of the key user interface elements of Java Client. 

Java Client Menus 
Depending on your assigned roles and privileges, you can use the following menus to perform 
various tasks: 

à File — Perform actions on Agile business objects, including New (Create), Open, Close, Save, 
Save As, Send, Scan Files, Batch Print, and Exit Java Client. Some Agile objects are items (parts 
and documents), changes (such as engineering change orders and price change orders), file 
folders (attachment objects), users, and suppliers. For more information about classes of Agile 
objects, see Introducing Agile Objects (on page 61). 

Note The Scan utility (File > Scan Files) is available in Java Client only. See Agile 
Scan Utility (on page 7). 

à Edit — Cut, Copy, and Paste data. Delete and Undelete an object. Create a Quick Search or an 
Advanced Search and Organize Searches (delete). Add and organize (that is, delete) Bookmarks. 

à View — View Notifications, Workflow Routings, and toggle the Windows Bar on or off: the Windows 
Bar shows all current open windows in Java Client. 

à Tools — Work with the Address Book; generate Reports and Analytics; access Agile Import, Export, 
and FileLoad (these are documented in Import & Export Guide). Process Extensions appear on a 
drop-down menu, which depends on a developer at your company (or an Oracle Consulting – 
Agile Practice consultant) having created process extensions. 

à Settings — Transfer Authority for other users or user groups to sign off your workflows; create and 
modify Personal Groups, Personal Supplier Groups, and Personal Criteria; view Deleted Personal 
Groups; view and modify your Current User settings; Change Password. 

Note Color Scheme and Options offer some standard Windows-based options. 

à Window — This is a standard menu that lets you switch to the Previous Window or the Next 
Window, and to arrange your open windows in Cascade or Tile schemes. There are some 

a se those. keybo rd equivalents if you prefer to u

Help — Manuals gives access to About Agileà Agile documentation.  displays information about the 
current release of Java Client. 

e system as an attached file to a file folder object. Scan is 
described in Scan Utility

 

Agile Scan Utility 
From Java Client only, Agile’s Scan  utility runs a Windows utility that scans documents using a 
TWAIN interface. The user specifies valid file types. Scanned images are designated as one of 
those file types, and they are added to th

 (on page 280). 

There are toolbars in the main Java Client window, in object windows, and in some object tabs. 

Java Client Toolbars 
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Depending on your assigned roles and privileges, you can use the toolbar buttons on the main 
toolbar to perform the tasks described in the following table. Toolbars in object windows contain 
buttons that pertain to the object. 

These are the buttons that appear on Java Client’s main toolbar.   

Button  Name Descr ipt ion For  more in format ion,  
see . . .  

 Inbox Displays Notifications or Workflow 
Routings. You can change this by clicking 
the View/Edit Current User button; see 
below. 

Using the Inbox (on page 11) 

 New Object Opens the New window, where you select 
which type of object you want to create, and 
assign a number to the object. 

Agile Object Types (on page 
63) 

 Open 
Selected 
Objects 

Displays the tabbed window for the selected 
object(s). 

— 

 Cut Removes selected information and places it 
on the Clipboard. 

— 

 Copy Places a copy of the selected information on 
the Clipboard. 

— 

 Paste Places a copy of the Clipboard contents into 
editable fields and tables. 

— 

 

 

Show 
Search 
Options, 
Hide Search 
Options, & 
Search 
Attachment 
Contents 

Show Search Options opens a drop-down 
list to select a base class of objects that will 
limit the search (this is now default layout). 
Hide Search Options toggles back to the 
basic search icons. There is also a checkbox 
that lets you Search Attachment Contents 
when checked. 

Base classes and other object 
types are presented in Installed 
Agile Classes, Base 
Classes, and Subclasses 
(on page 64). 
Full Text Search for 
Content in Attachment 
Files (on page 145)  

 Run Search Searches for objects that match the criteria 
in the Simple Search text box. 

Quick Searches and 
Wildcard Characters (on 
page 143) 

 Advanced 
Search 

Looks for objects with fields that match 
(multiple) conditions of the search that you 
set up. A Where Used search finds 
assemblies that contain parts that meet your 
search criteria; a Relationship search finds 
objects related to the objects that match your 
search criteria. 

Advanced Searches (on page 
155)  

 Last Search 
Results 

Displays results of the most recent search 
you performed. 

— 

 Address 
Book 

Opens the Address Book window, where you 
can view, create, and modify user groups. 

Address Book in Java 
Client (on page 18) 
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Button  Name Descr ipt ion For  more in format ion,  
see . . .  

 Process 
Extensions 

Lets you run/access custom actions that 
were defined by someone else. 

Agile SDK Developer Guide — 
how to use Process Extensions 
framework to develop and deploy 
custom actions 

 View/Edit 
Current User 

Lets you modify your Agile user profile. Changing Your User 
Settings (on page 33) 

 Exit Lets you log out of Java Client. — 

 
 

Windows Bar 
Below the main toolbar is an optional windows bar. 

 

The windows bar contains a button for each open Java Client window. Each button includes the title 
of the window and an icon reflecting the window’s contents. The button representing the current 
window is recessed, that is, it appears concave. To move to a different window, click its button in 
the windows bar. 

To close a window using the windows bar: 

Right-click the button representing the window you want to close, and choose Close. 

You can also use Shift-click and Ctrl-click to select multiple windows, right-click (over one of the 
selected windows), and choose Close. 

Finally, there is also a Close All option when you right-click over any window. 

You can hide or show the windows bar, and you can move it to the top or bottom of the Java Client 
desktop. 

To hide the windows bar: 

Right-click the window bar and choose Hide Windows Bar, or choose View > Windows Bar. 

To show the windows bar: 

Choose View > Windows Bar. 

To move the windows bar: 

Right-click the windows bar and choose Move. 

Hiding and Showing the Navigation Pane 
At times you may want to view the main window only (hide the navigation pane), then show the 
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navigation pane again when you need to use it. 

To hide or show the navigation pane: 

1. On the boundary between the navigation and content panes, click the small arrows that point 
left (to hide) and right (to show) the navigation pane. 

To adjust the width of the navigation pane: 

1. Hold the pointer on the boundary between the navigation and content panes. The pointer 
changes to a double-sided arrow. 

2. Drag until the pane is the desired width: it is limited to a maximum of about one-fourth the total 
screen width. 

 

Java Client Tables 
Java Client displays many types of information in tables. For example, search results, BOMs, and 
AML information appear in tables. 

Sort Order in Tables 
You can change the sort order of some Agile tables, such as the Affected Items table. To sort a 
table, click the column header of the column by which you want to sort. For example, to sort the 
Affected Items table by item description, click the Item Description column header. You can change the 
width of the columns, too. 

Selecting Rows in Tables 
There are a number of tables in Java Client on which you can perform certain actions. For example, 
on the Affected Items table, you can remove items. From the search results table, you can open an 
object and modify it or export it; you select the items on which you want to perform the action, then 
click the action to perform it. 

Tables on object tabs have a “handle” column at the left, as shown in the following figure. You can 
select rows by using any of the following methods: 

à You can select all the rows with the top handle, or you can use Windows commands (Shift–
click and Ctrl–click) on the row handles to select the rows on which you want to perform the 
action. 

à You can select a row by clicking in the row or you can use Windows commands (Shift–click and 
Ctrl–click) in the rows you want. 

à You can drag-select (mouse-down or mouse-up as you drag across multiple rows). 
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When you have selected the rows you want, the available actions are buttons in the menu bar 
above the table. 

 

For editable tables, select the rows you want and click the Edit button, and the Edit mode popup 
appears. In this mode, make any changes or updates and click OK. The table refreshes to reflect the 
changes. 

In Edit mode, Java Client displays the object ID and object Description, which identifies the data in 
the row that has the focus. 

To open and view objects in a table, use one of these methods: 

à To open one object, double-click the object’s row in the table. 

à To open an object with a specific tab on top: 
a. Select the object’s row in the table. 
b. Right-click. 
c. In the displayed menu, choose Open and the tab you want. 

à To open multiple objects: 
a. Select multiple rows in the table. 
b. Either press Enter on the keyboard, or right-click the mouse and choose Open. 

 

Using the Inbox 
As information passes through the Agile system, users receive news of status changes, requests, 
and notifications. When you first start Java Client, it is a good idea to view your Inbox. 

To view your Inbox in Java Client: 

1. Click the arrow to the right of the  Inbox icon on the main menu bar. 

2. Click the Inbox section that you want to view, Workflow Routings or Notifications. 
 

Notifications 
The Notifications section of the Inbox lists program notifications. Notifications inform you of some 
action or process that has taken place, such as subscriptions, RFQs, and project invitations. You 
also receive a notification when a program-related request is sent to your My Assignments tab. The 
Accept function does not apply to notifications. 

You can view or delete a notification. To view a notification, double-click it. To delete a notification, 
select it and click Delete. 
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Workflow Routings 
The Workflow Routings section of the Inbox lists routable objects that require your review or action. 
For example, your Inbox may contain changes for which you are an approver. The out-of-box 
workflow routings are a combination of base classes and actions that define the kind of review, as in 
the table below. 

Base c lass . . .  . . . includes routab le  objects 
f rom these c lasses. . .  

. . .combined wi th  these 
act ions of  rev iew 

Change Change Orders, Change Requests, Site 
Change Orders, Price Change Orders, 
Deviations, and Stop Ships 

... That Require My Approval 

... That I Am An Observer Of 

... That Were Returned To Me 

... Transferred to Me 

... Escalated to Me 

 

Quality Change Request 
(QCR) 

Corrective and Preventive Actions and 
Audits 

 

Problem Service Request 
(PSR) 

Non-Conformance Requests and 
Problem Reports 

 

Package Packages  

Program Activities and Gates  

Transfer Order Content Transfer Orders and 
Automated Transfer Orders 

 

Declarations Substance Declarations, Part 
Declarations, JGPSSI Declarations, 
Homogeneous Material Declarations, 
Supplier Declarations of Conformance, 
IPC 1752-1 Declarations, and IPC 
1752-2 Declarations 

 

 

To open a workflow routing in the table, double-click its number. 

To export objects to a text or PDX file (if you have privileges), select the row and choose Tools > 
Export. 

The Print button prints the entire Inbox table. 

Using Bookmarks and the Recently Visited List 
If there are objects that you need to return to frequently, you can use Bookmarks and the Recently 
Visited list for quick access. 
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Bookmarking 
Bookmarking lets you keep a list of objects that you return to frequently. You can click an object 
bookmark to quickly display that object. 

To bookmark an object in Java Client:     

1. Open the object. 

2. Choose Edit > Add Bookmark, or click the Add Bookmark button  in the object’s toolbar. 

The Add Bookmark dialog displays. 

3. Enter a name for the bookmark in the Name field. 

4. Select a folder in which to store it. 

You can always save a bookmark in the My Bookmarks folder. 

5. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

6. Click OK in the Add Bookmark dialog to save the bookmark. 

The object’s number is saved in the My Bookmarks list on the Searches tab in the navigation 
pane. 

To open a bookmarked object in Java Client:     

Double-click the object’s number in the My Bookmarks list on the Searches tab in the navigation 
pane. The object opens. 

Organizing Bookmarks 

You can arrange your bookmarks in folders using the Organize Bookmarks window (Edit > Organize 
Bookmarks). 

To organize bookmarks in Java Client: 

1. Choose Edit  > Organize Bookmarks. The Organize Bookmarks window opens. 
 

The Organize Bookmarks Window 

Use the features in the Organize Bookmarks window to create or remove folders and rename or 
remove bookmarks. 

Button  Descr ipt ion 

Remove Removes the selected bookmark or folder. 

Rename Renames the selected bookmark or folder. 

New Adds a new bookmarks folder within the current folder. See Bookmarking (on page 48) for 
more information. 

Save Saves the changes you made in the Organize Bookmarks window. 

Cancel Discards the changes you made in the Organize Bookmarks window and closes the window. 
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Removing Bookmarks 
To remove a bookmark: 

1. In the Organize Bookmarks window, select the bookmark or folder you want to remove. 

2. Click the Remove button. 

3. Click Yes to remove the bookmark or folder. 

Note Removing a folder will also remove all of its children. 

4. When you are finished, click Save. 
 

Renaming Bookmarks 
To rename a bookmark: 

1. In the Organize Bookmarks window, select the bookmark or folder you want to rename. 

2. Click the Rename button. 

3. Edit the name of the bookmark in the Enter Name field. 

4. Click OK. 

5. When you are finished, click Save. 
 

Recently Visited List 
When you view an object during a work session, it is added to the Recently Visited list. The 
Recently Visited list includes the last 10 objects viewed (or 25, 50, or 100, depending on your 
administrator’s setting of a Preference). 

To open a recently visited object in Java Client: 

1. double-click the Recently Visited icon under the Searches tab in the navigation pane. 

2. double-click the object’s number in the list. The object opens. 
 

Changing Your User Settings 
This section includes information about creating or changing your User Profile, password, personal 
criteria, and escalations. 

Note Keep in mind that the Agile administrator may have set values in Agile PLM that impact 
what you are able to modify. Most changes made by the administrator are automatically 
implemented systemwide; however, if the administrator makes changes in your role 
assignment, or to the roles and privilege masks themselves, these take effect for a user 
only after the user has logged out and logged back in to Web or Java Client. 

 

Changing Your User Profile 
Your user profile contains a variety of information about how to contact you, your Windows date and 
time preferences, and several Java Client onscreen display preferences. Your Agile administrator 
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determines whether you can edit your user profile. 

To edit or add information to your user profile:  

1. Open your user profile by choosing Settings > Current User on the computer from which you are 
logged in to Java Client, or click the View/Edit Current User button . 

2. Click the tab on which you want to make changes. 

3. To make changes to the General Info tab, simply edit any field that is available. Use the lists, 
browse buttons, and text boxes to enter the requested information. 

You can also make changes to the Escalations and Attachments tabs. For information about 
escalations, see Working with Escalations (on page 16). For information about working with the 
Attachments tab, see Working with Attachments (on page 241). 

Note If you will be working primarily in Java Client, check the System Preferences under the 
Preferences tab: Preferred Client should be set to Java Client and Receive Email 
Notifications should be set to Yes. This will ensure that you will receive email notifications 
in the same client you are working in. If there is a discrepancy and you are not able to 
change these properties, see your Agile administrator. 

 

Changing Your Password 
These instructions describe how to change your login password, which you can do at any time. The 
Change Approval Password option is enabled only when your Use Login Password for Approval user 
property is set to No. 

To change your login password: 

1. Choose Settings > Change Password. The Change Password dialog box appears. 

2. Type your old login password in the Old Password field. 

3. Type your new login password in the New Password and Retype New Password fields. (Passwords 
are case-sensitive.) 

If you want to change your approval password (and the Change Password dialog displays the 
Change Approval Password fields), fill in the fields as described above. 

4. Click OK. 

If you have not followed the rules defined on your Agile system for selecting passwords, you are 
prompted to correct your password. 

Persisted User Interface Settings 

For some user interface settings, the most recently used settings are persisted across sessions for 
each user. 

Examples include: 

à Add method – (Search, Type in Known Number(s), Create) 

à Edit Rows After Adding. 
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Working with Escalations 
If your administrator has granted you the necessary privileges, you can set up escalations for 
yourself. Escalations allow changes to be forwarded automatically to a designated user if you do not 
respond within a set amount of time. You can also create escalations for your personal user groups. 

Your Agile administrator can add escalations to your user profile, and can edit existing escalations. 

To manage escalations for yourself: 

1. Choose Settings > Current User on the computer from which you are logged in to Java Client. 

Or, click the View/Edit Current User  button on the main toolbar. 

2. Click the Escalations tab. 

3. To set up a new escalation, click the Add button, then select an escalation criteria and one or 
more users to be notified for that criteria. You can select a different person for each criteria, if 
you want. 

4. To edit an escalation, select it on the Escalations tab and click the Edit button . Add users to, 
or remove them from, the Notify Users list. 

5. To delete an escalation, select it and click the Delete button . 

To manage escalations for a personal user group: 

1. Choose Settings > Personal Groups. 

2. Double-click the group. 

3. When the user group window appears, click the Escalations tab. 

4. Follow steps 3–5 in the preceding procedure, “To manage escalations for yourself.” 

5. To set up a new escalation, click the Add button, then select an escalation criteria and one or 
more users to be notified for that criteria. You can select a different person for each criteria, if 
you want. 

6. To edit an escalation, select it on the Escalations tab and click the Edit button . Add users to, 
or remove them from, the Notify Users list. 

7. To delete an escalation, select it and click the Delete button . 
 

Creating Personal Criteria 
A saved “personal criteria” is a reusable database query very similar to an advanced search, in that 
the attributes used to create personal criteria are similar to the attributes used to create advanced 
searches. (For more information, see Advanced Searches (on page 155).) They may also be 
thought of as “filters” or “qualifying descriptions” of objects that you are interested in tracking. 

Personal criteria are used to define signoff authority transfers. If you have the appropriate 
privileges, you can temporarily transfer your signoff authority for routable objects to one or more 
Agile users. For more information about signoff authority transfers, see Transferring Signoff 
Authority (on page 224) and Defining Personal Criteria for Authority Transfers (on page 227). 

Any criteria in Agile—personal or reusable—applies to one Agile class (and its children) or a 
particular subclass; therefore, you must create a separate criteria to apply to the objects of another 
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class or another subclass. 

To create a personal criteria:  

1. Choose Settings > Personal Criteria. The Personal Criteria window appears. 

2. Click the Create button. The Create Criteria dialog box appears. 

3. Fill in the Name and Description fields, and select the object type that your personal criteria will 
apply to. This list includes all the Agile classes and user-defined subclasses. 

Note The personal criteria name must be unique. If you specify a personal criteria 
name that is already used, you get a duplicate name error message. 

4. Select the attribute you want from the Attribute drop-down list. The values that are available 
change according to the Agile class or subclass you selected in the previous step. Click OK in 
the small dialog box. 

5. The Match If field specifies the search operator. The values that appear depend on what you 
selected from the Attribute list. Select from the listed operators, which will be a subset of the 
following: 

Contains, Does Not Contain 
Equal To, Not Equal To 
Greater Than, Greater Than Or Equal To 
Less Than, Less Than Or Equal To 
Is Null, Is Not Null 
Starts With, Does Not Start With 
Like, Not Like 

6. In the Value field, select a value for the field you selected from the Attribute list. Click OK in the 
small dialog box. 

7. If you are going to add additional conditions, select AND or OR in the And/Or field. 

8. Repeat step 4 through step 7 until your personal criteria is complete. 

9. When the criteria is complete, click OK. 

Note Changing the criteria in the Object Type field resets the entire personal criteria. A 
personal criteria applies to one class or subclass. You must create a separate 
global criteria to apply to another class or subclass. 

If you want your criteria to be case-sensitive, select the Case Sensitive checkbox. This can 
simplify how you define personal criteria: 
y If you enter text in the Value field, the criteria will look for text that is an exact match, 

depending on the restraints of the Match If field’s value. 
y If you define a numerical value, checking Case Sensitive allows the Agile system to make 

use of internal database settings to find objects more quickly. 

Using case-sensitive searches improves performance of the system and is recommended 
when possible. 

The Add( ) button places parentheses around the specified condition or conditions, which changes 
the order in which the search conditions are evaluated. The Add( ) button functions like a formula 
within parentheses in an algebraic equation, following the standard algebraic order of operations. 
The grouped criteria within parentheses are resolved before any others. If you do not use 
parentheses when defining your personal criteria search, the search is processed row by row 
without any precedence of And/Or values. The first line is combined with the second based on the 
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first line’s And/Or value. The result of the first two lines is then combined with the third line based on 

g a 
etailed 

Finding Agile Data with Searches

the second line’s And/Or value, and so on. 

Editing Personal Criteria 
Use this dialog box to edit the conditions in your personal criteria object. Defining or modifyin
personal criteria object is similar to defining or modifying an advanced search. For d
information about searches, see  (on page 135). 

à , and Delete to add more Search Condition rows as 

à 

elect 
tch If search operator (for 

is relevant 

à t. Use And if both conditions must be met. 

à ws in parentheses, which determines precedence in 

d with 
 then 

à se Sensitive if you want to perform a case-sensitive search where text capitalization 
matters. 

Address Book in Java Client 
r groups for various 

e the address book can include: 

à When you share, or grant, one or more of your roles to another user or user group for specific 

ok. 

You can perform the following modifications to your personal criteria object: 

In the search condition table, use Add, Insert
needed, or to delete rows you do not want. 

Click a cell in the Search Condition table to display the search criteria selection list. 

Working from left to right in the search condition row, click the drop-down list buttons to s
the target Attribute (for example, CoverPage.Originator), the Ma
example, Equal To), and the Value (for example, John Smith). 

Depending on the selection in the Attribute list, the Value field may contain a list that 
to the selection, a calendar button, or a field where you can enter text or numbers. 

Click the And/Or field to select And or Or from the lis
Use Or if either or both conditions can be met. 

Use the (  ) button to enclose selected ro
the way the search is performed. 

If you do not use parentheses when defining your personal criteria search, the search is 
processed row by row without any precedence of And/Or values. The first line is combine
the second based on the first line’s And/Or value. The result of the first two lines is
combined with the third line based on the second line’s And/Or value, and so on. 

Select Ca

 
 

The address book is a multi-list window that lets you select users and use
functions. The situations in which you us

à When you send email notifications 

à When you select people or groups to sign off a workflow 

objects 

You can also create user groups in the address bo

Overview of the Address Book 
You can access the address book by clicking the  button on the main toolbar, or by choosing 
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Tools > Address Book, or when you are performing actions that involve sending an object or a 
notification (for example, routing a change). You can select individual users or user groups. The 

Note The Agile administrator can use Discovery privileges to limit the users you see in the 

address book lists all the individuals and user groups that use Java Client and Web Client. 

address book. 

 
 

Selecting Users and User Groups from the Address Book 
You can select recipients individually or in groups. When you select a group, all the members of the 

e or First Name by clicking one group receive the email message. You can sort users by Last Nam
of the radio buttons. 

To select users or user groups from the address book:  

1. To display a list of names on the Users tab, click the Check Names  button, whic
of all users. 

h returns a list 

2. Select a person on the Users tab, or select a user group on the User Groups tab. 
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To see more information about a user or user group, select it and click the View button. 

To add names directly to the Recipients st, type a known value (e.g., last name) in the Find 
Name field, then click the Check Names

3. 
 

 li
 button or the keyboard shortcut Ctrl+K; the system 

moves that name over to Recipients. 

Once you click the Check Names  button or Ctrl+K, the e tire list on the left disappears: dele
the name(s) in the Find Name fi

n te 
eld, click the Check Names  button or Ctrl+K again, the list of 

4. ct a name, then click the Add 

users or user groups returns. 

You can also sele  button to move your selection into the 

 name or multiple names, select using the same techniques and click the Remove 

Recipients list. 

To select multiple names or user groups, use the Shift-click or Ctrl-click, then the Add button. 

remove aTo 

 button. 

On the User Groups tab, if you ect a user group, and you want only the group name to ap

in the Recipients list, use the 

5. pear  sel

 button. If you do this when selecting approvers, only the 
group as a whole becomes an approver, and any single member of the group can approve. 

If you select a user group, and you wan see every name in that group in the Recipients list, use

the Add all the users in the selected group 

t to  

 button (this button only appears on the User Groups 
tab). If you do this when selecting approvers for a routable object, each individual becomes an 

7. 
u included in the new group. 

8. Click Save

Note  

approver. 

6. Continue selecting names and using the arrows until the Recipients list is correct. 

Click Save As to create a new user group that includes every individual’s name on the 
assembled list. This includes the individuals of any user group yo

 to save the list. Click Close to close the address book. 

When you add a user group to a group, and save it, then open the modified
user group, all the names of the added user group are there; the modified 
group does not “track” user groups that were added. 

 

User Groups 
roups, as well as modifying and This section details how to create both personal and global user g

deleting them. See also Creating Supplier Groups (on page 22). 

Your User Profile User Group tab lists the Global Groups of which you are a member. YourNote  
membership in the personal groups of individual users is not displayed on the User Group 
tab. See also Changing Your User Profile (on page 14). 

 

Creating User Groups 
You can create personal user groups; with the appropriate privileges, you can create global user 
groups. 

Page - 20 Agile Product Lifecycle Management 

 

 



 Chapter 2  
 
 

To create a perso l user group in Java Client: na

1. Choose Settings > Personal Groups. The Personal User Groups window appears. 

Click the New 2.  button. The Create User Group dialog box opens. 

3. Using the Subclass drop-down list, select a sub
be the only subclass available if your adminis

class of the User Groups class. User Groups will 
trator has not created another one in the User 

4. ame field. 

Groups class. 

Fill in a name for the group in the N

5. Click  next to the Users field, and move users (from the Users list) or other user groups (from 

6. le fields populated. 

cept values from the drop-down lists. Enter a description 

. 

To c roup from the address book: 

the Groups list) to the Recipient list. 

Click OK. The new user group object appears, with applicab

7. On the General Info tab, select or ac
and the maximum number of named users, if appropriate. 

8. When you are finished, click Save. 

9. Continue to select, enter, or accept valu  for properties under the Users and Escalations tabs

reate a user g

es

1. Open the address book by clicking the  button on the main toolbar, or by choosing Tools > 
Address Book. 

2. Select and move users (from the Users list) or other user groups (from the User Groups list) to 

3. 

up from the Existing Group field; the 

5. Groups. 

s 

r Personal Groups folder. 

use

onal Groups, or 

the Recipients list. 

Click Save As Group. The Save Group dialog box appears. 

4. Enter a name in the New Group field. Or you can select a gro
new version of the existing group will overwrite the original one. 

In the Save In area, select Personal Groups or Global 
6. The Subclass field contains only User Group. It will list other subclasses if the administrator ha

created new subclasses of the User Groups class. 

7. Click OK. The new user group is saved in the Global o
 

Completing or Editing User Groups 
To complete additional information about your user group, or to edit an existing personal 

r group: 

1. If the address book is still open, click Refresh. Otherwise, choose Settings > Pers
open the address book , and display the Groups tab. 

2. Navigate to the group you created by expanding the appropriate group folder. 

4. o tab, specify general information about the user group. 

3. Select the group and click View. The group opens in a tabbed window. 

On the Genera nfl I
5. You can click the Users tab to delete users. On the Users tab, select the name, and click the 

Delete button . 

6. To add or modify escalations for the user group, click the Escalations tab. For information about 
escalations, see Working with Escalations (on page 16). 
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7. Add or remove any attachment references for the user group on the Attachments tab. 

g with AttachmentsFor information about attachments, see Workin  (on page 241). 

s 
8. Click Close to close the user group window. 
 

Deleting Personal User Group
To delete a personal user group: 

1. Choose Settings > Personal Groups. 

2. Select the group and click . The selected group is deleted. 

 book: To delete a personal user group from the address

1. Open the address book  and display the Groups tab. 

2. Select the group you want to delete. Click View. 

3. Click . The selected group is deleted. 
 

Creating Supplier Groups 
You c create personal supplier groups; you cannot create a global supplier group in Java Client.

 are other companies who are using Agile PLM to work with your company. 
an  

Suppliers

ted by the Agile administrator, as noted in step 4 below. Note Global supplier groups are crea
For more information about creating global supplier groups see Agile Administrator Guide. 

To create a perso l supplier group: na

1. Choose Settings > Personal Supplier Groups. The Personal Supplier Groups window appears. 

2. Click the New  button. The Create New Supplier Group dialog opens. 

Fill in the Name and Description fields, and select Yes or No in the Enabled field. 

The Type field is grayed, with the

3. 

4.  value of Personal entered. (Supplier groups that are created 
ier 
s, 

ministrator Guide.) 

OK, you are returned to the original dialog. Click OK again, the new supplier group object 
appears, with applicable fields populated. 

 

from the Admin > User Settings > Supplier Groups node are “global.” You can create global suppl
groups only if you have sufficient privileges. For more information about global supplier group
see Agile Ad

5. For the Suppliers field, click the down-arrow, and move suppliers from the Choices list to the 
Selected list. 

6. Click 
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Navigating in Agile Web Client 
This chapter includes the following: 

� Introducing Web Client ........................................................................................................................................ 23 
� Main Toolbar........................................................................................................................................................ 29 
� Navigation Pane Toolbar ..................................................................................................................................... 31 
� Changing Your User Settings .............................................................................................................................. 33 
� Exploring the Home Page.................................................................................................................................... 37 
� Using and Organizing Bookmarks ....................................................................................................................... 48 
� Using the Recently Visited List ............................................................................................................................ 52 
� User Groups and the Address Book in Web Client.............................................................................................. 52 
� User Properties Defined ...................................................................................................................................... 56 

 
 

Introducing Web Client 
Agile Web Client is opened using only a browser. Web Client is the only client that supports these 
Agile solutions: 

à Program Portfolio Management, 

à Product Governance & Compliance, and 

à Product Cost Management. 

Both Web and Java clients support these Agile solutions: 

à Product Collaboration and 

à Product Quality Management. 

Agile Reports (Analytics and Reports) and some utilities—Agile Import, Export, FileLoad—can be 
accessed from either client but, when selected, open in Web Client. For example, in Java Client, 
choosing Tools > Import opens the Import utility in Web Client; Java Client remains open. 

Logging In to Web Client 
Agile PLM 9.2.2 has been installed on your company’s system, and you are ready to work in Web 
Client. There may be a bookmark already on your browser, or perhaps your Agile administrator has 
given you a starting URL, along with username (User ID) and password. 

Important If a URL is specified in the documentation or release notes, copy the upper- and lower-
case characters exactly, including the full domain name specified. 

Also, if a popup blocker is installed on your machine, the login may halt. You would disable the 
popup blocker, then click the Retry button, which will display the application in a new window. 
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To start Web Client: 

1. Start your browser. 

2. Click the Web Client bookmark, if one exists, or type a URL that follows this pattern: 

http://Web Server.<domainname>.com/Agile/PLMServlet 
The Login page appears. 

3. Enter your username. Your username is not case-sensitive. 

Your username is assigned by your Agile administrator and can be an abbreviation of your full 
name. For example, the name Michael Jones may be abbreviated to MICHAELJ or MJONES. 

4. Enter your password. Your password is case-sensitive. 

Your password is initially assigned by your Agile administrator. If you have the appropriate 
privileges, you can change your password at any time. The administrator may require you to do 
so within a set number of sessions. (See Changing Your Password (on page 36)). 

5. Click the Login button. If you make a mistake, click Clear and retype your username and 
password. 

The login process is complete, and the user Home page appears (“Welcome, <Your Name>”). 

You can choose an activity from the user Home page, the navigation bar on the left, or the main 
toolbar at the top. For more information, see Main Toolbar (on page 29) or Navigation Pane Toolbar 
(on page 31). 

You can select a preferred start page; see Choosing Your Preferred Start Page (on page 24). 

Choosing Your Preferred Start Page 
At any time you can change the start page that opens when you log in to Web Client. However, your 
administrator may restrict what properties you are able to change in your user object. 

To set or change your preferred start page: 

1. Click the Tools icon , and on the drop-down menu, click My Settings. 

2. On the Settings Home page, click User Profile. Your “user object” appears, that is, the Agile 
database object that your administrator created to represent you. 

3. Click the Preferences tab. 

4. Click the Edit button. The properties on the page become editable. 

5. Under Display Preferences, click the drop-down arrow for Preferred Start Page. Select the page 
you want. 

The Preferred Start Page list includes the Home page and all the dashboard tabs for which you 
have view privileges. 

If you are not able to view any dashboard tabs, the only selection is Home. 

6. Now click the drop-down arrow for Preferred Inbox View. 

In Web Client, if you have selected Home as your start page, this setting determines which tab 
is displayed when you view the Home page by clicking the  Home button in the main menu. 
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Choose My Assignments, Notifications, or Workflow Routings. 

Note If you chose a Dashboard page in step 5, that Dashboard page will be 
displayed when you click the  Home button in the main menu. However, you 

can use the  Home button drop-down list to display the Home page with the 
selected tab displayed: My Assignments, Notifications, or Workflow Routings. 

For more information about the Home page and these settings, see Exploring the Home Page 
(on page 37). 

7. When you have finished, click Save (at the top of the page). Your preferences have been saved 
and you will see your chosen start page the next time you log in to Web Client. 

For more information about changing properties in your user object, see Changing Your User Profile 
(on page 14). 

For more information about the other links in the list of My Settings, see Changing Your User 
Settings (on page 33). 

Logging Out of Web Client 
To log out of Web Client: 

1. From the menu bar, click the  Logout button. 

2. You are returned to the Login page. To exit, close the browser from the upper-right corner. 
 

Bookmarking Web Client in Your Browser 
When the Web Client Login page opens in your browser, you can bookmark it to create a startup 
shortcut. Create a shortcut on your desktop, then click it the next time you want to open the Web 
Client. 

Web Client Tables 
Web Client displays many types of information in tables. For example, search results, BOMs, and 
RFQ information appear in tables. Often a table is what you see when you click a tab in an object, 
so as BOM tab displays the BOM table. 

To open and view objects in a table: 

à Click the Number link of the object. 

Web Client displays a tooltip (in both Read and Edit modes) that displays the object ID and object 
Description, which identifies the data in the row that has the focus. 

Sort Order in Tables 

You can change the sort order of some Agile tables, such as the Affected Items table. To sort a table, 
click the column header of the column by which you want to sort. For example, to sort the Affected 
Items table by item description, click the Item Description column header. On a returned-search table, 
all columns are “live,” that is, clicking them sorts the table one way, clicking again sorts the other 
way (ascending or descending order). 
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Selecting Rows in Tables 

There are a number of Agile tables on which you can perform certain actions in Web Client. For 
example, on the Affected Items table, you can delete items. These tables have a “handle” column at 
the left, as shown in the following figure. You can select rows by using any of the following methods: 

à You can select all the rows with the top handle, or you can use Windows commands (Shift–
click and Ctrl–click) on the row handles to select the rows on which you want to perform the 
action. 

à You can select a row by clicking in the row or you can use Windows commands (Shift–click and 
Ctrl–click) in the rows you want. 

à You can drag-select (mouse-down or mouse-up as you drag across multiple rows). 

When you have selected the rows you want, the available actions are buttons in the menu bar 
above the table. 

 

If a table is more than one page long, you can select rows on multiple pages to perform actions. 

For example, to remove items from the Affected Items table that spans two pages: 

1. Go to the first page and select all the items you want to delete. 

2. Go to the next page and select all the items you want to delete. 

3. Click Remove. 
 

Using Copy/Paste in Tables 

Copy/paste functionality in Web Client is applicable to changes (to edit Affected Items tab) and 
supplier responses. 

To use copy/paste in tables: 

1. Select rows to edit, then click Edit to display the table page in edit mode. 

2. If not already done, fill in the values that you will copy. 

3. Select the columns to copy by checking the Paste Column checkbox for each column. 

4. Select the row you want to copy by highlighting the row. 

5. Click the Copy button. 
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6. Select which columns to paste by checking or unchecking the Paste Column checkbox for each 
column. 

7. Select which row(s) to paste to. 

8. Click the Paste button. 

Note For information about using Web Client affected item table Fill Up and Fill Down buttons, 
see the chapter about the affected items of changes in Product Collaboration Guide. 

 

Web Client Tab Content Indicator Icons 
In Web Client, a grey dot icon  appears on the tab, next to the tab name, to indicate: 

à The tab has contents. For example, content icon on a BOM tab indicates that the item has child 
items added to the BOM tab. 

à The tab has active contents. For example, a content icon appears on the Changes tab of an item 
only when the item has pending changes (active changes). 

A red dot icon  appears on a tab to alert you that the tab has problematic content. 

à A red dot icon is displayed on the Compliance tab if an item or manufacturer part that has a 
specification that is non-compliant or is missing information. 

à A red dot icon is displayed on the item Changes tab if the item has a released Deviation or Stop 
Ship. 

 

Tab Web Cl ient  Tab Indicator  Found in  these c lasses of  
business objects  

Attachments (and Files)  = Object has attachments All objects except file folders 
(which contain attachment 
content) and reports. 

Changes  = Item has pending changes 

 = (Red icon) Item has released 
Deviation or Stop Ship 

Items and published prices. 

BOM  = Item has BOM items Items. 

Manufacturer  = Item has manufacturer parts Items & Sourcing Projects. 

Affected Items  
(in PCOs: Affected Prices) 

 = Change has affected items Changes, PSRs, QCRs. 

Sites  = Item has sites assigned Items. 

Prices  = Object has prices Items & Manufacturer Parts. 

Suppliers  = Object has suppliers Items & Manufacturer Parts. 

Quality  = Item has active PSR or QCR Items. 
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Tab Web Cl ient  Tab Indicator  Found in  these c lasses of  
business objects  

Compliance  = Object has specifications 

 = (Red icon) Object has non-compliant 
or incomplete specifications 

Items & Manufacturer Parts. 

Content  = Program has object content 
(relationships) 

the 
 with 

bles. 

Agile PPM Program objects 

For Program classes, 
relationships are included on 
Content tab and relationships
rules are named delivera

Discussions  = Program has discussions Agile PPM Program objects. 

Related PSR  = PSR has related PSRs Agile PQM Product Service 
Request (PSR) objects. 

PSRs  = Customer has active PSRs Customers 

First object tab “Page One” 

In Web Client, optional tabs: 

Page Two and Page Three 

Not applicable 

Tab indicator icons are not used on these 
tabs. f Page Two and 

Page Three sections are enabled, 
they appear on the first object tab. 
Your Agile administrator may 
rename them. 

for example: 

Cover Page 

Title Block 

General Information 

General Info 

All objects have a “Page One” that 
uses one of the names to the left. 

In Web Client, i

Relationships  

 the 
ve an 

ator icon.) 

All classes (except Actions Items 
and Reports) 

(For Programs classes, 
relationships are included on
Content tab, which does ha
indic

Where Used  Items, Manufacturer Parts
Discussions, File Folders. 

, 

History  All. 

Workflow (routable objects 
rs, 

s 
only) 

 Changes, PSRs, QCRs, 
Packages, Transfer Orde
Program

Escalations  Users and User Groups 

Shares  Users and User Groups 

Subscriptions  Users 
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Using Online Help 

The Help menu  provides access to online Agile documentation set and online help tools: 

à Manuals – Opens the Agile|Agile Documentation web page, with access to online manuals for 
M. The documentation set contains detailed information about 
ations, concepts, procedures, and reference information. 

lbars in the main Web Client w ct windows, and in so bs. 

Depending on your assigned roles and privileges, you can use the toolbar 
 to p  the tasks  ob  windows contain 

buttons that pertain to the o

Web Client and Agile PL
Oracle|Agile PLM applic

à About Agile – Displays technical information about the current release of Web Client. 
 

Main Toolbar 
There are too indow, in obje me object ta

buttons on the main 
toolbar erform  described in the following table. Toolbars in

bject.    
ject

Button  Name Descr ipt ion For  more 
in format ion,  see. . .  

 
Back r 

ver, undo any changes 
— Takes you to the previous page you viewed in you

browser. (It does not, howe
you entered in Agile.) 

 
Forward 

 to view the page 
— Takes you to the next page forward. It is disabled if 

you did not use the Back button
currently in your browser. 

 
Refresh 

ge 
tton. 

 
on 
 

— You can refresh  (update) objects, the Recently 
Visited list, Bookmark list, and Search Results pa
by clicking the Refresh bu

There is a Validate button on the Cover Page of
change objects in Edit mode. The Validate butt
saves the changes, validates the workflow, and
reloads the workflow list. 

 Home ient as 
 user 

h has been selected by your 

ts, Workflow Routings, or 
Notifications. 

osing YouBrings you to your home page in Web Cl
defined by Preferred Inbox View in your
properties, whic
administrator and can be changed by you. So, 
based on that setting, when you click the Home 
button, the main area displays your My 
Assignmen

Above the main area, the standard Home page has 
the live links that you have defined as your Quick 
Links list. 

Cho r 
Preferred Start 
Page (on page 24) 
Exploring the 
Home Page (on
37) 

Quick L

 page 

inks (on page 

Management User 
Guide 

37) 

Product Portfolio 

 
Create Lets you create objects in all the base classes and 

classes that your company has purchased and to 
which you have privileges. 

Introducing Agile 
Objects (on page 61) 
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Button  Name Descr ipt ion For  more 
in format ion,  see. . .  

 
Search 
Attachment 
Contents 

In the quick search interface, this checkbox lets you 
Search Attachment Contents when checked. 

Base classes and other 
object types are 
presented in Installed 
Agile Classes, Base 
Classes, and 
Subclasses (on page 
64). 
Web Client Quick 
Search (on page 142)  
Full Text Search 
for Content in 
Attachment Files 
(on page 145) 

 Run Simple 
Search 

Searches for objects that match the criteria in the 
Simple Search text box. 

Quick Searches (on 
page 140) 

 
Advanced 
Search 

Looks for objects with fields that match (multiple) 
conditions of the search that you set up. A Where 
Used search finds assemblies that contain parts that 
meet your search criteria; a Relationship search 
finds objects related to the objects that match your 
search criteria. 

Advanced 
Searches (on page 
155) 

 
 Pre-configured parametric search drop-down list. 

Select a base class from the list to display the 
parametric search window. In the parametric search 
window, select an object type to display the object 
search criteria your Agile administrator has pre-
configured for you. 

Web Client 
Parametric Search 
Window (on page 
150) 

 
Last Search 
Results 

Displays results of the most recent search you 
performed. 

— 
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Button  Name Descr ipt ion For  more 
in format ion,  see. . .  

 
Tools Drop-down menu with links to Address Book and 

My Settings. 

It also links to these Agile client utilities: Analytics 
and Reports, Import, Export, and FileLoad. 

If Product Portfolio Management is installed, further 
down the menu are: Microsoft Project 
Synchronization Setup and Microsoft Project 
Publish. 

Administration is visible only if you have been 
assigned the Administrator privilege (or 
Administrator role); it lets you access settings for the 
following Administrator nodes: Users, User Groups, 
and Supplier Groups. 

User Groups and 
the Address Book 
in Web Client (on 
page 52)  
Changing Your 
User Settings (on 
page 33)  Working 
with Agile Reports 
(on page 117) 

Agile Import, Export, 
FileLoad, and Microsoft 
Project links are 
documented in Agile 
PLM Import & Export 
Guide 

Analytics are 
documented in Portfolio 
Analytics User Guide 

Administration nodes 
are documented in 
Administrator Guide 

 
Help The Help > Manuals command you access to 

Agile 9 documentation. The Help > About Agile 
command displays version information. 

Using Online Help 
(on page 29) 

 LogOut Lets you exit Web Client. — 

 
 

Web Client Session Timeouts 
Web Client sessions are set to time out, or disconnect, after a session is idle for a specified period 
of time. If you are interrupted while you are in the middle of a wizard operation (such as creating a 
change), and the session is idle and times out, your information will be lost. If you try to perform a 
Web Client action after the session has timed out, the login page appears. 

Occasionally, if you try to perform an action in Web Client after a timeout, you may see a second, 
smaller Web Client page. If this happens, simply close all dialog boxes and pages and log in again. 

For more information about extending the timeout (idle time) value for Web Client, see your 
administrator or the appropriate Agile Installation Guide. 

Navigation Pane Toolbar 
The left pane, called the navigation pane, provides access to searches—via Search Folders 
containing out-of-box solution-oriented searches, Bookmarks, and Recently Visited—and Analytics and 
Reports. As you perform certain actions in Web Client, such as stepping through wizards or 
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configuring user settings, the navigation pane provides tools for navigating the process. 

 
 

Showing and Hiding the Navigation Pane 
At times you may want to show the navigation pane or view the main window only (hide the 
navigation pane). 

To show or hide the navigation pane: 

à Click the Expand Left Navigation button (which points right), or the Collapse Left Navigation button 
(which points left). 

or: 

à When the navigation pane is collapsed, you can click the Search Folders or Reports and Analytics 
buttons to expand the navigation pane and display that menu of navigation folders or links. 
y Clicking the same button (Search Folders or Reports and Analytics) a second time hides the 

navigation pane; then clicking any of the buttons restores the navigation pane. 

To adjust the width of the navigation pane: 

1. Hold the pointer on the boundary between the navigation and content panes. The pointer 
changes to a double-pointed arrow. 

2. Drag until the pane is the desired width: it is limited to a maximum of about one-fourth the total 
screen width. 

Note Adjusting the width of the navigation pane is possible only in Internet Explorer. 
 

Search Folders 
The Search Folders section of the navigation pane contains saved searches you can use whenever 
needed. It includes predefined system searches and searches you have created, stored in folders; 
click one to view the search results. For more information about saved searches, see Saved 
Searches (on page 138). 

Shortcuts 
Beneath the search folders are two “shortcuts” areas: 

à My Bookmarks—Objects you have bookmarked for quick display later. To bookmark an object, 
choose Actions > Bookmark on an object’s page. For more information about bookmarking, see 
Using and Organizing Bookmarks (on page 48). 

à Recently Visited—The last 10 objects you have viewed (or 25, 50, or 100, depending on your 
Agile administrator’s setting of a System Preference); click one to display it. For more 
information about the Recently Visited list, see Using the Recently Visited List (on page 52). 
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Analytics and Reports Folders 
The Analytics and Reports Folders section of the navigation pane gives you access to the types of 
reports for which you have privileges—and include Analytics folders if that is part of your Agile 
installation. You can view, edit, and delete existing reports. You create reports from the Create 
button; see Creating Objects (on page 88). 

Reports are documented later in this manual. 

Analytics requires separate licensing. A PLM Analytics folder may not appear in your view. There is a 
separate user guide for Analytics. 

Using the Wizard Process Flow Diagrams 
As you proceed through the steps of a wizard, click the Expand Left Navigation button to see process 
flow diagrams in the navigation pane. The process flow diagram displays each step in the task, and 
you can click the next step or a previous step in the diagram to go directly to it. The step you are 
currently on is highlighted. 

The following graphic shows the process flow diagram that appears in the navigation pane when 
you create an item. 

 

Note For information about adding data to an object you are creating, see Adding Data during 
Create with the Process Flow Diagram (on page 90). 

 

Changing Your User Settings 
You access Web Client settings by clicking the Tools button  on the main toolbar. When you 
click Tools > My Settings, the Settings Home page appears, where you can access and edit your User 
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Profile. 

Administrators or user administrators can access other user settings by choosing Tools > 
Administration > Users or other User Settings. For more information about working with User Settings 
(for user administrators), see the Agile PLM Administrator Guide. 

Note Keep in mind that the Agile administrator may have set values in Agile PLM that impact 
what you are able to modify. Most changes made by the administrator are automatically 
implemented systemwide; however, if the administrator makes changes in your role 
assignment, or to the roles and privilege masks themselves, these take effect for a user 
only after the user has logged out and logged back in to Web or Java Client. 

To make changes to a setting: 

1. Open the Settings Home page from the Tools button  (on the main toolbar) > My Settings. 

2. Click the setting you want to change. The relevant information appears in the right pane. 

 

Here are the links on the Settings Home page and where you can find more information about them 
in this manual. 

Link  Where  the funct ion is  descr ibed in  th is  manual  

User Profile Changing Your User Profile (on page 14); see also Choosing Your 
Preferred Start Page (on page 24) 

Change Password Changing Your Password (on page 36) 

Transfer Authority Viewing Signoff Authority Transfers (on page 36) 

Organize Bookmarks Using and Organizing Bookmarks (on page 48) 

Organize Searches Editing and Managing Searches and Search Folders (on page 188) 

Organize Reports  Working with Agile Reports (on page 117) 

Personal Groups User Groups and the Address Book in Web Client (on page 52) 

Deleted Personal 
Groups 

Deleting Personal User Groups (on page 55) 

Personal Criteria Creating Personal Criteria (on page 16); that discussion is specific to Java 
Client but the Web Client procedure is very similar 

Personal Supplier 
Groups 

Creating Personal Supplier Groups (on page 55) 

 

When you are working with Agile settings, a navigation path displays at the top of the main pane, 
indicating how you arrived at the current Web Client page. You can click a link in the path to return 
to the corresponding location. The navigation path in this figure shows that you can return to the 
Settings Home page by clicking Settings Home. 
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Changing Your User Profile 
Your User Profile is simply the settings entered by the Agile administrator when your “user object” 
was created. Your user profile is available for you to modify, within constraints set by the 
administrator. It contains data under various tabs that is either purely informational or is used by the 
Agile applications: 

à General Information, for example, how to contact you; 

à User Preferences, including: 

à System Preferences, for instance, your preferred client to receive email notifications; 

à Format Preferences, for instance, your Windows date and time preferences; and 

à Display Preferences, for instance, whether you see icons or text in the toolbar (or both). 

à Other tabs are for Escalations, User Groups, Share, Subscription, Attachments, and History, which 
you will learn about in other chapters of this manual. 

You have an opportunity to enter information when you first log in to Web Client. Again, your Agile 
administrator determines to what extent you can edit your user profile. 

To edit or add information to your user profile: 

1. Open your user profile by clicki Tools > My Settings > User Profile. ng 

My User ProfileYou can also click  under Quick Links on the Home page. 

2. Click the tab on which you want to make changes. For instance, to make changes to the 
General Info tab, click that tab. 

3. Click the Edit button on that page. Use lists, browse buttons, and text boxes to enter the 
requested information. 

4. When you have finished, click Save. If you wish to cancel your anges, click Cancel. ch

You may change settings on other tabs, but you must click Save for each page you alter. If you 
click another tab after entering new values, you will be prompted to Cancel the move operation 

Saveso you can  the tab you are on. 

 To verify changes you make to your user profile, it is best to log out of Web Client and log back 
in. 

Note If you will be working primarily in Web Client, check this setting in your user profile: 
Preferences > System Preferences > Preferred Client; it should be set to Web Client. Also, 
Receive Email Notifications should be set to Yes. This will ensure that you will receive email 
notifications in the same client you are working in. If there is a discrepancy and you are 
not able to change these properties, see your Agile administrator. 

Important Product Portfolio Management, Product Governance & Compliance, and Product Cost 
Management solutions operate only from Web Client. If one of these solutions is to be 
your primary area of work, your administrator has likely already set Preferred Client to Web 
Client. If you change this setting to Java Client, all your email notifications would include a 
link that opens Java Client; yet you cannot work with PPM, PG&C or PCM objects in Java 
Client, so it may be counter-productive to change this setting. 
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Main Toolbar (Web Client) 

A Display Preference lets you decide whether you want to see icons or text in the toolbar. The 
choices are Icons Only, Text Only, or both Icons and Text. 

User Preferences 

A full list of the user preferences and their descriptions are found in User Properties Defined. 

Persisted User Interface Settings 

For some user interface settings, the most recently used settings are persisted across sessions for 
each user. These settings are stored in a web browser cookie when you log out of Web Client. 

Examples include: 

à Resizable table columns – Resizable table column widths are persisted across sessions for each 
user. 

à Add method – (Search, Type in Known Number(s), Create) 

à Edit Rows After Adding. 

à Continue Creation in Wizard. 

à Agile PPM – Details selections in the Create Program from Template wizard. 
 

Changing Your Password 
These instructions describe how to change your login password. The process is similar for changing 
your approval password using the Change Approval Password option, which is enabled only if your 
Use Login Password for Approval user property is set to No. 

To change your login password: 

1. Click Tools > My Settings > Change Password. The Change Login Password page appears. 

You can also click Change Password under Quick Links on the Home page. 

2. Type your old login password in the Login Password field. 

3. Type your new login password in the New Login Password and Confirm Login Password fields. 
(Passwords are case-sensitive.) 

If you want to change your approval password (and the Change Password dialog displays the 
Change Approval Password fields), fill in the fields as described above. 

4. Click OK. If you have not followed the rules set by the Agile administrator for selecting 
passwords, you are prompted to correct your password. 

 

Viewing Signoff Authority Transfers 
The Agile administrator or user administrator can have signoff authority transferred from you to 
another user, or from another user to you. This is useful when, for example, you are out of the office 
and unavailable to sign off on changes. 

Page - 36 Agile Product Lifecycle Management 

 

 



 Chapter 3  
 
 

To view transfers that have been set up: 

Click Tools > My Settings > Transfer Authority. 

Exploring the Home Page 
Note The page that displays when you open Web Client can be changed, as described in 

Choosing Your Preferred Start Page (on page 24). If you chose a Dashboard page as 
your Preferred Start Page, that Dashboard page will be displayed when you click the  
Home button in the main menu. 

However, you can use the Home button drop-down  list to select a Home page tab (My 
Assignments, Notifications, or Workflow Routings), which displays the Home page tab with the selected 
tab on top. 

Quick Links 
Quick Links, at the top of the Home page, is a list of up to ten links that you use frequently. You 
define your own Quick Links list and you can edit and modify your Quick Links list at any time. Your 
Quick Links list can include predefined system links, saved searches in your Personal Searches 
folder, or bookmarks in your Bookmarks folder. 

To edit your Quick Links list: 

1. Click the Edit link next to the Quick Links: heading at the top of the Home page. The editable list 
appears at the top of the page. 

2. From the drop-down list choose the type of link you want to use. 

The three types of available links are: 
y Links – predefined Agile system links including My User Profile, Change Password, 

Analytics and Reports, and Dashboard. 
y Bookmarks – available values are all the bookmarks in your Bookmarks folders, listed 

individually. 
y Searches – available values are all the searches in your Personal Searches folders, listed 

individually. 

3. Use the arrow buttons to move links from the Available Values list to the Selected Values list. 

Or, double-click to move links from one list to the other list. 

4. You may include more than ten links in the Selected Values list, but only the first ten links in the 
list will be displayed in your Quick Links list. Reorder the list by selecting one or more links and 
using the up and down arrow buttons to move them up or down in the list. 

5. When you are finished, click the Save button. 
 

Home Page Inbox Tabs 
As information passes through the Agile system, users receive news of status changes, requests, 
and other notifications through email. Users with different roles and privileges receive different 
notifications. When you first start Web Client, it is a good idea to view the information collected for 
you on the Home page. 
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à Notifications tab – Notifications inform you of some action or process that has taken place or a 
notification can let you know that you have a request to accept or decline ownership of an 
action item or activity. Delete notifications after you have read them. 

à Workflow Routings tab – lists routable objects that require your review or action. Click the object 
number in the table to open it. 

à My Assignments tab – lists program leaf node objects assigned to you which are not yet 
complete and action items assigned to you which are not yet complete.  

 

Viewing the Home Page 
The Agile Home page provides access to Dashboard, Notifications, Workflow Routings, and My 
Assignments. Dashboard features are documented separately, see "Dashboard". 

To access the Home Page, click the  icon. The page that displays when you first open Web 
Client can be changed, as described in the Getting Started with Agile PLM Guide. If you choose a 
Dashboard page as your Preferred Start Page, that Dashboard page will be displayed when you 
click the  Home button in the main menu. 

To view your Inbox tabs in Web Client: 

You can open and view the Home page using any of the following methods: 

à At any time while you are using Web Client, click the small down-arrow next to the Home button 

 and select an inbox view: My Assignments, Notifications, or Workflow Routings. 

à If your preferred start page is a Home page tab, it is displayed when you login to Agile Web 
Client. 

à If your preferred start page is a Home page tab: 

a. HomeIn the menu bar, click the  button . 

The Home page is displayed with your preferred inbox view tab on top. 
b. To view a different inbox view, click the Home page tab you want to view. 

Note If your preferred start page is a Dashboard tab, you will not see the Home page tabs when 

you click the Home button . Click the small down-arrow next to the Home button  
and select a non-Dashboard inbox view: My Assignments, Notifications, or Workflow Routings. 

 

Notifications 
The Home page Notifications tab lists notifications that have been sent to you. Notifications inform 
you of some action or process that has taken place, such as subscriptions, RFQs, and project 
invitations. A notification can also let you know that you have a request that requires your attention 
in the My Assignments tab. Requests ask you to accept or decline ownership of an action item or 
activity. 

Note To accept or decline a request, use the My Assignments tab. 

You can view or delete a notification. 
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à To view a notification, click the Subject link. 

à To delete a notification, select its row and click  Delete. 

 

I on or  Bc ut ton Descr ipt ion 

 Delete 
Notifications table, and click this button to delete them 

Deletes the selected notifications. 

Select one or more rows in the 
from the table. 

 

 
s table row. Indicates that you have not yet opened this notification. 

New Notification 

Icon in Notification

 
ions table row. Indicates that you have previously opened this 

notification. 

Read Notification 

Icon in Notificat

 
 

Workflow Routings 
The Home page Workflow Routings tab lists routable objects that require your review or action. For 
example, your Workflow Routings table may contain changes for which you are an approver. The
of-box workflow routings are a co

 out-
mbination of base classes and actions that define the kind of 

review  below. , as in the table   

Base c lass . . .  . . . includ ts f rom es  routab le  objec
these c lasses. . .  

. . .combined wi th  these 
act ions of  rev iew 

Change  
e Orders, 

Deviations, and Stop Ships 
 To Me 

 

. Escalated to Me 

Change Orders, Change Requests, Site
Change Orders, Price Chang

... That Require My Approval 

... That I Am An Observer Of 

... That Were Returned

... Transferred to Me

..

 

Quality Change Request s and  
(QCR) 

Corrective and Preventive Action
Audits 

Problem Service Request formance Requests and Problem  
(PSR) 

Non-Con
Reports 

Package Packages  

Program Activities and Gates  

Transfer Order omated  Content Transfer Orders and Aut
Transfer Orders 
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Base c lass . . .  . . . includes routab le  objects f rom 
these c lasses. . .  

. . .combined wi th  these 
act ions of  rev iew 

Declarations Substance Declarations, Part Declarations, 
JGPSSI Declarations, Homogeneous 
Material Declarations, Supplier Declarations 

 

of Conformance, IPC 1752-1 Declarations, 
and IPC 1752-2 Declarations 

To open an object in the table, click its number. To export objects to a text or PDX file (if you have 
privileges), select the object rows and choose Tools > Export. The Print button prints the entire table. 

My Assignments 
The nsible. 
The 
assignm  
the table perform an action on the selected assignments. For example, you can accept or 
decli ing.  

The Ho

à Acti

is blank. If you have 
 of the delegated owner 

er of the activity. 
e Team tab of the activity and your allocation is greater than 0%. 

elled. 
ed. 

ion item is assigned to you and  declined. 
 You are th

My Assignme

Your Agile adminis  in the My Assignments table. If you have 
questions about the strator. 

By default, the My A

 Home page My Assignments tab lists Activities and Action Items for which you are respo
ssignmentsMy A  tab provides a set of tools that allow you to efficiently work with your 
ents. You can sort the assignments table rows, or select one or more assignment rows in
, and then 

ne a program activity assignment, or flag an assignment for easier track

me page My Assignments tab table includes: 

vity objects where: 
y The activity is In Process. The workflow status type is not Complete or Canceled. 
y The activity’s Template attribute is set to Active. Proposed or Template activities are not 

included. 
y The activity is a leaf node. Activities with children are not included. 
y You are the owner of the activity and the Delegated Owner field 

delegated ownership, the Delegated Owner field contains the name
until the activity is accepted or declined. 

y You are the delegated own
y You are a resource on th

à Action Items where: 
y The action item is assigned to you and it is not Complete or Canc
y The action item is assigned to you and it has been accept
y The act it has not been
y

 

e creator of the action item and it has been declined by the assignee. 

nts Table 

trator determines which columns appear
My Assignments tab, contact your Agile admini

ssignments tab includes the following columns: 

Column name Descr ipt ion 

Flag . For more information, see 
Flagging Assignments
Flag icon which you can set to manage your assignments

 (on page 47). 
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Column name Descr ipt ion 

Name The name of the activity or action item. 

Click this link to open the activity or action item. 

Status 

atus column. For more 

Workflow status of the activity or action item. For example, an activity can be Not 
Started or In Process and an action item can be Not Accepted or Accepted. 

If you have the appropriate privileges, you can edit the St
information, see Editing Assignments (on page 44). 

Due Date 

on, see Using the 

The date the activity or action item is due. 

You can sort the assignment list by due dates. For more informati
View Options to Sort your Assignment List (on page 43). 

If you have the appropriate privileges, you can edit the Due Date column. For more 
information, see Editing Assignments (on page 44). 

% Complete 

te column. For more 

For activities, the percentage of the task that has been completed. 

If you have the appropriate privileges, you can edit the % Comple
information, see Editing Assignments (on page 44). 

Related To ity and root parent activity. 

For action items, the Related To column lists the activity or discussion object to which 
the action item is associated. 

mn to open the related activities or discussions. 

For activities, the Related To column lists the parent activ

Click the links in this colu

Actual Hours For activities, the number of hours expended on the activity. 

If you have the appropriate privileges, you ual Hours column. For more 
information, see Editing Assignments

 can edit the Act
 (on page 44). 

 
 

My Assignments Ta

The My Assignments tab tool

b Tools 

s include: 

Tool  Descr ipt ion 

      View View drop-down list. 

Use the list to sort your assignments by pre-defined views, for example, 
pending requests, flagged assignments, due dates, action items, or activities 
where you are a resource. 

For more information, see Using the View Options to Sort your 
Assignment List (on page 43). 

 Edit 

ignments

Edit the selected row objects. 

Allows you to edit object fields displayed in the table, based on your privileges. 

For example, you can modify the Status, Due Date, and Actual Hours fields. 

For more information, see Editing Ass  (on page 44). 

 Page - 41

  

 



Getting Started with Agile PLM User Guide  
 
 
 

Tool  Descr ipt ion 

 Accept Accept the selected activities, program activity assignments, or action items. 

For activities, accept the ownership when you are the designated owner. 

For program activity assignments, accept the assignment as a resource for the 
activity. 

For action items, accept the action item when you are the assignee and the 
action item has not yet been accepted. 

For more information, see Accepting Assignments (on page 44). 

 Decline Decline the selected activities, program activity assignments, or action items. 

tivity assignments, decline the assignment as a resource for the 

 decline the action item when you are the assignee and the 

ignments

For activities, decline the ownership when you are the designated owner. 

For program ac
activity. 

For action items,
action item has not yet been accepted. 

For more information, see Declining Ass  (on page 45). 

 Mark Complete 
0% and changes the workflow status 

 from your 

ete

Mark as complete the selected activities or action items. 

For activities, sets the Complete field to 10
to Complete.  

For action items, changes their status to complete and removes them
assignment list. 

For more information, see Mark Assignments Compl  (on page 45). 

  Show Filter
 Hide Filter 

Displays or hides the filter definition fields. 

For detailed information about using the filter, see Using the Filter to Sort 
your Assignment List (on page 47). 

 Print 
t table that is currently displayed. 

le

Prints the table sorted table. 

Allows you to print the assignmen

For more information, see Printing the Assignment Tab  (on page 45). 

More Actions... 
 

ging Assignments

   Add to Flagged View
Sets the flag for all the selected table rows. 

Allows you to flag multiple rows at one time. 

To display flagged rows, in the View drop-down list, choose Flagged. 

For more information, see Flag  (on page 47). 

More Actions... 
   Add to Hidden 

ew 
ments table. 

ignments
Assignments Vi

Allows you to hide assignments. 

Hidden assignments do not appear in the assign

For more information see Hiding and Unhiding Ass  (on page 
46). 
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Tool  Descr ipt ion 

More Actions... 
   Remove From View 

the Hidden view. 

u to remove (unhide) 

Remove assignments from 

When displaying the hidden assignment view, allows yo
the selected assignment rows. 

See also Hiding and Unhiding Assignments (on page 46) and 
Flagging Assignments (on page 47). 

 Flag not set Flag icon appears in each row of the assignment table. 

 Flag set Set or unset the flag by clicking it. 

The flag helps you to organize your assignments and flag the ones you want to 
track. 

For more information, see Flagging Assignments (on page 47). 

View Details View Details icon button.  

Appears in each activity row next to the activity name. 

 important details about the object and 
allows you to edit, accept, or decline t ntent of this window can 
be configured in 

For more inform

Opens a popup window that displays
he object. The co

Java Client Administrator. 

 Details Dialogation, see Using the Show  (on page 47). 

 
 

Using the View Options to S

y Assignments ta kly find 
which you want s or for 

ments. 

e following pre-defined view categories. 

ort your Assignment List 

Use the Home page M
the assignments with 

b View drop-down list to sort you assignments and quic
to work. For example, you can sort for pending request

overdue assign

Agile provides th

View Descr ipt ion 

All Displays all assignments, except hidden assignments. 

Pending Requests Displays only pending requests. 

Flagged 

ments. This 
flagged. 

Displays only the flagged assignment rows. 

You set or clear flags in order to manage your assign
View list choice displays only the rows that you have 

Due Today or Overdue 

Due this Week 

ys 

Due in 30 Days 

Due in 90 Days 

Due in Two Da

These View list choices display assignment table rows according 
to due dates. 
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View Descr ipt ion 

Hidden Assignments Displays only hidden assignments. 

You decide which assignments you want to hide on your 
assignments list. 

For more information, see Hiding and Unhiding 
Assignments (on page 46). 

Activities where I am a Resource Displays activities where you have been assigned as a resource 
Team tab. on the 

Action Items plays action items assigned to you. Dis

 items are generated and assigned from activities and 
ssions. 

Action
discu

 
 

Editing Assignments 

You can use t ent attributes in the 
odify privileges for the editable fields. 

ivileges, for an activity, you can edit the Status, the Percent 
. 

he Home page My Assignments tab Edit function to edit assignm
table. You must have the appropriate M

For example, depending on your pr
Complete, Actual Hours, and Due Date

To edit My Assignment table rows: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. Select one or more rows in the table. 

3. Click the  Edit button. 

Make the desir4. ed modifications. 

d by which fields your Agile administrator has Note The editable fields are determine
included in the assignments table and your modify privileges. 

5. 
 

cepted and you are the 
nee.  

To accept assignments on the My Assignment tab: 

1. Use the Home button drop-down 

When you are finished, click Save. 

Accepting Assignments 

You can use the Home page My Assignments tab Accept function to accept multiple activities or 
action items at one time. The accept action applies to activities where you are the delegated owner, 
program activities assigned to you, and action items whose status is Not Ac
assig

 list and choose My Assignments to display your list of 

2. ore rows in the table. 

assignments. 

Select one or m

3. Click the  Accept button. 

Page - 44 Agile Product Lifecycle Management 

 

 



 Chapter 3  
 
 

The selected objects are accepted. 

 tab Decline function to decline multiple activities or 
n applies to activities where you are the delegated owner 

, you must enter a reason. 

Declining Assignments 

You can use the Home page My Assignments
action items at one time. The decline actio
and action items whose status is Not Accepted and you are the assignee. 

Note When you decline an activity

To decline assignments on the My Assignment tab: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. Select one or more rows in the table. 

3. Click the  Decline button. 

If one or more 4. of the selected rows are activities, you must enter a reason why you are 
up dialog and click Send. 

e 

You ltiple 
activ n items at one time. 

 item, you cannot mark it as complete. Accept the 

declining. Enter your reason in the pop
 

Mark Assignments Complet

 can use the Home page My Assignments tab Mark Complete function to mark as complete mu
ities or actio

Note If you have not accepted an action
action item first, then mark it as complete. 

When you mark an activity as complete, the Percent Complete field is automatically set to 100%. 

To mark assignments as complete on the My Assignments tab: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. Select one or more rows in the table. 

3. Click the  Mark Complete button. 

rint function to print the currently displayed 
 the Filter to sort the table, then print the displayed 

e button drop-down 

Action items in status Not Accepted cannot be marked complete and an error message is 
displayed. 

Printing the Assignment Table 

You can use the Home page My Assignments tab P
assignments table. Use the View drop-down list or
table rows. 

To print the My Assignment table: 

1. Use the Hom  list and choose My Assignments to display your list of 
assignments. 

2. Use the View drop-down list or the Filter to sort the table to display the assignments you want. 
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3. Click the  Print button. 

A printable version of table is displayed in a new browser window and the Print dialog appears. 

4. Click Print in the Print dialog. 

5. Close the new browser window when you are finished. 
 

Hiding and Unhiding Assignments 

On the Home page My Assignments tab, the More Actions...Add 
allows you to hide assignment rows that you do not

to Hidden Assignments View command 
 want to see. The assignments are still part of 

w 

not the activity owner. You have completed your 
t completed their portions of the task. Therefore, 

ause it has not been marked as 
Complete. You can hide this assignment so it no longer appears on your assignments list, however, 

ts of other resources. 

rs. 
splay your hidden assignments, and 

 view). 

your assignment list, but they are disp d only when you choose Hidden Assignments in the Vie
drop-down list. 

laye

Hiding assignments can be a useful assignment management tool. For example, suppose you are 
assigned as a resource for an activity, but you are 
portion of the task, but other resources have not ye
the assignment still appears on your My Assignments tab bec

it will still appear on the assignment lis

Hiding an assignment removes it from all your My Assignments tab views except your Hidden 
Assignments view. Your Hidden Assignments view has no effect on the assignment lists of other use
You can hide assignments (add them to your hidden view), di
unhide hidden assignments (remove them from your hidden

To add assignment rows to your Hidden View: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. If desired, use the View drop-down list or the filter to sort which assignment rows are displayed. 

ments View. 

nts: 

3. Select one or more rows in the table. 

4. Choose More Actions... > Add to Hidden Assign

To view your hidden assignme

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

2. In the View drop-down list, choose Hidden Assignments. 

To remove assignment rows from your Hidden View: 

1. Use the Home button drop-down  list and choose My Assignments to display your list of 

2. p-down list, choose Hidden Assignments. 

he rows you want. 

4. Cho
 

assignments. 

In the View dro

3. In the hidden assignments view, select t

ose More Actions... > R move from View. e
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Flagging Assignments 

On the Home page My Assignments tab, the flag icon included in each row is a useful assignmen
agement tool. B

t 
man ecause you can sort assignments according to whether or not they are flagged, 

 

ts table row: 

you can use the flag to indicate assignments that you want to track differently from other 
ment table appear only on your My Assignments tab, so you assignments. The flags on your assign

can decide how you wish to use them.

To set or unset the flag in a single assignmen

1. Use the Home button drop-down  list and choose My Assignments to display your list of 

2. on in the row you want. 

assignments. 

Click the flag ic
y If the flag is not set , clicking it toggles the flag to set: . 
y If the flag is set , clicking it toggles the flag to not set: . 

le rows: To set the flags in multiple assignments tab

1. Use the Home button drop-down  list and choose My Assignments to display your list of 
assignments. 

d. 

 flagged view: 

Home

2. If desired, use the View drop-down list or the filter to sort which assignment rows are displaye

3. Select the rows you want to flag. 

4. Choose More Actions... > Add to Flagged View. 

To unset the flags in multiple assignments table rows in the

1. Use the  button drop-down  list and choose  to display your list of 
assignments. 

2. In the View drop-down list, choose Flagged. 

My Assignments

w. 
 

On the Home page My Assignments tab, the Show Details icon 

3. In the flagged assignments view, select the rows you want. 

4. Choose More Actions... > Remove from Vie

Using the Show Details Dialog 

 (in each row next to the name of 
 that displays additional information about the object and 

allows you to perform actio s on that object, for example, edit and bookmark. Your Agile 

obje

ent List 

On ments tab, the 

activity objects) opens a details dialog
n

administrator determines which attributes and actions are available in the details dialog of each 
ct type. 

Using the Filter to Sort your Assignm

the Home page My Assign  Show Filter and  Hide Filter button toggles the display 
 

 Related To column includes the word marketing 
and the  column is less than 

of the table filter. The table filter allows you to define filter criteria based on any column in the table.
You can define multiple filter criteria, which are combined in an AND search of the table rows. 

For example, you can filter for assignments whose
% Complete 50. 

 Page - 47

  

 



Getting Started with Agile PLM User Guide  
 
 
 

The form  row is similar to an Agile search criteria: 

To u ssignments tab filter: 

at of each filter criteria

<attribute> is <Match If Operator> <value to match> 

se the My A

1. Use the Home button   drop-down list and choose My Assignments to display your list of 
assignments. 

2. Click  Show Filter to display the Filter: criteria. 

3. In the first filter drop-down list, labeled --Select an Attribute--, choose from a list of the columns in 
the assignments table. 

4. In the next drop-down list, choose a Match If operator. The list of available Match If operators 
depends on the attribute type you chose as the --Select an Attribute-- drop-down list. 

ld, enter the filter values. 5. In the remaining fie

y To add a filter criteria row, click  Add Row at the end of the row. A filter criteria row is 
added to the display. 

y To delete a filter criteria row, click  Delete Row at the end of the row. The row is deleted. 

6. Click Apply to filter the assignments table. Only assignments that match your filter criteria are 

 set of filter criteria, click Clear to clear the criteria and begin again. 

okmarks 
If th
Visi

displayed. 

7. To define different
 

Using and Organizing Bo
ere are objects that you need to return to frequently, you can use Bookmarks and the Recently 
ted list for quick access. For more information about the Recently Visited list, see Using the 

Recently Visited List (on page 52). 

Bookmarking 
arking lets you keBookm ep a list of objects that you return to frequently. You can click an object 

You

 Web Client:     

4. 

ct’s number or name. You can edit or 
t the bookmark name later. 

5. Then select a folder in which to store it. 

6. To create a new folder, click the 

bookmark to quickly display that object. 

 can also bookmark reports that you use frequently. 

To bookmark an object in

1. Open the object. 

2. From the Actions menu, choose Bookmark. 

3. The Add to Bookmarks dialog box appears. 

Enter a name for the bookmark in the Bookmark Name field. 

By default, the Bookmark Name field contains the obje
replace the bookmark name in this field now, or you can edi

 New button. In the Create New Folder dialog, enter a folder 
name and click OK. 
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7. Click OK in the Add to Bookmarks 

My Bookmarks
dialog box to save the search. 

The object is saved in the  list in the Search Folders link on the navigation pane. 

Using a Bookmark 

To open a bookmarked object in Web Client:     

2. Ex My Bookmarks list by clicking  + . 

Or, highlight the 

1. Click Search Folders in the navigation pane. 

pand the 

 My Bookmarks folder and click the Expand All icon  in the navigation pane to 
 subfolders and their contents. display all bookmark

Click the object in th
 

ing Boo
anize bookmarks, including renaming them and organizing them into folders. 

ons on the Web Client My Bookmarks Toolbar 

s on the My Bookmarks folder in the Web Client 

3. e list of bookmarks. The object opens. 

Organiz
You can org

kmarks 

Butt

The following table lists and describes the button
navigation pane. 

Button  Descr ipt ion 

 Expand All 
Expands all the bookmark folders in the navigation pane to display all available bookmarks. 

Collapses all the bookmarks folders in the navigation pane. 
 Collapse All 

 
Book

marks window. Organize Opens the Organize Book
marks 

 
 

The Organiz

Use the features  or remove folders, rename or 
rks. 

Open the Organize Bookmarks window with either of the following methods: 

ose Tool  the Organize Bookmarks link. 

à Or, click the 

e Bookmarks Window 

in the Organize Bookmarks window to create
d organize and move folders a kmaremove bookmarks, an nd boo

à Cho s > My Settings. On the Settings Home page, click

pencil icon  in the left navigation pane next to  My Bookmarks. 

izThe Organ e Bookmarks page appears. 

Button  Descr ipt ion 

 Remove Removes the selected bookmarks and bookmark folders. 

See Deleting a Bookmark (on page 50) or Removing a Bookmark Folder (on 
page 51). 
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Button  Descr ipt ion 

 Rename 
See Renaming a Bookma

Renames the selected bookmark or bookmark folder. 

rk (on page 50) or Renaming a Bookmark Folder (on 
page 51). 

 New Adds a new bookmark folder within the current folder. 

See Creating a Bookmark Folder (on page 51). 

(drag and drop) Allows you to reorder bookmarks and bookmark folders. 

s and FoldersSee Moving Bookmark  (on page 51). 

Save the modifications you made in the Organize Bookmarks window.  Save 

 Cancel cations you made in the Organize Bookmarks window and closes the Discards the modifi
window. 

 
 

De

okmarks. 

leting a Bookmark 

To delete a bookmark in Web Client:     

1. Click Tools > y Settings > Organize Bo M

Or, click the pencil icon  in the left navigation pane next to My Bookmarks. 

vigate to the bookmark you want to remove and select it. 2. In the Organize Bookmarks w dow nain

3. Click the  Remove button. 

4. When you are finished, click Save. 

s. 

 

Renaming a Bookmark 

To rename a bookmark in Web Client: 

1. Click Tools > My Settings > Organize Bookmark

Or, click the pencil icon  in the left navigation pane next to My Bookmarks. 

2. name and select it. In the Organize Bookma s window navigate to the bookmark you want to rerk

3. Click the  Rename button. 

4. In the text field, enter a new name and press the Return key. 

5. When you are finished, click  Save. 
 

Using Folders to Organize Bookmarks 
s to make them easier to locate and manage. You can 

use the existing folders or create new ones. 
You can organize your bookmarks in folder
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Creating a Bookmark Folder 

To create a bookmark folder in Web Client: 

1. 

Or, cli con 

Click Tools > My Settings > rganize Bookmarks.  O

ck the pencil i  in the left navigation pane next to . 

nize Boo dow navigate to the folder in which you want to create a new 

My Bookmarks
2. In the Orga kmarks win

folder. 

3. Click the  New button. 

4. In the text field, enter a new name and press the Return key. 

5. When you are finished, click  Save. 
 

Rem

 Web Client: 

oving a Bookmark Folder 

You can remove or delete a folder, even if it is not empty. 

To remove a bo kmark folder ino

1. Click Tools > My Settings > Organize Bookmarks. 

Or, click the pencil icon  in e left nth avigation pane next to My Bookmarks. 

ate to the folder you want to remove and select it. 2. In the Organize Bookmarks window navig

3. Click the  Remove button. 

4. When you are finished, click  Save. 
 

Renaming a Bookmark Folder 

To rename a bookmark folder in Web Client: 

1. Click Tools > My Settings > Organize Bookmarks. 

Or, click the pencil icon  in the left navigation pane next to My Bookmarks. 

nt to rename and select it. 

3. 

2. In the Organize Bookmarks window navigate to the folder you wa

Click the  Rename button. 

4. In the text field, enter a new name and press the Return key. 

5. When you are finished, click  Save. 

r or to a different location in the 

 

Moving Bookmarks and Folders 

To move a bookmark or a bookmark folder into another folde
list in Web Client: 

1. Click Tools > My Settings > Organize Bookmarks. 

Or, click the pencil icon  in the left navigation pane next to My Bookmarks. 

he search or folder that you want to move. To 2. In the Organize Bookmarks window, navigate to t
expand a folder, click its folder icon. 
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3. Click the folder or search to select it. 

y Highlighted folder – the dropped folder or bookmark is moved into the highlighted folder. 
folder or 

 are finished, click Save. 

Whe ecently Visited list. The Recently 
Visi
system

To open sited object in Web Client: 

1. 

3. Click the object in the list of recently visited objects. The object opens. 

User Groups and the Address Book in Web 

address book can include: 

y 
er, 

nother user or user group for 

ss Book, instead, 

4. Drag the folder or bookmark to its new location and drop it onto: 

y Grey line between two names in the list of bookmarks and folders – the dropped 
bookmark is moved to that location in the list. 

5. When you
 

Using the Recently Visited List 
n you view an object during a work session, it is listed in the R

ted list includes the last 10 objects viewed (or 25, 50, or 100 if the administrator re-set the 
wide Preference). 

 a recently vi

Click Search Folders in the navigation pane. 

2. Expand the Recently Visited list. 

 

Client 
The address book  is a multi-list window that lets you select users and user groups for various 
functions. The situations in which you use the 
y When you send email notifications 
y When you select people or groups to sign off a workflow 
y When you select users to act as change analyst, component engineer, originator, qualit

analyst, quality administrator, sourcing project owner, RFQ owner, program team memb
and so forth 

y When you share, or grant, one or more of your roles to a
specific objects 

You can also create user groups in the address book. 

Note User groups cannot be modified (adding or deleting users) in the Addre
you must use the Users tab of the group object. To modify a user group or delete a user 

ser groups. group, use Tools > My Settings > Personal Groups to view your u

You can access the address book by clicking Tools > Address Book, or when you are performing 
ns that involve sending an object or a notification (for example, routing a routable object). Y
select individual users o

actio ou 
can r user groups. The address book lists all the individuals and global user 
grou  PLM. 

Whe you can select recipients individually or in user 
grou  group receive the email message. 

ps that have been created in Agile

n you email objects or send notifications, 
ps. When you select a user group, all the members of the
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Note very privileges to limit the users you see in the  Your Agile administrator can use Disco
address book. 

 

Se
Whe
sele

To s sers from the address book: 

1. Click Too
s, 

le: 

ou want to find and then click Find 

match more than one name 
d in the Available 

ype a name that is matched by only one user in the address book, when you click the 
 

lecting Users from the Address Book 
n you use the address book, you can select recipients individually or in groups. When you 
ct a group, all the members of the group receive the message. 

elect u

ls > Address Book to open the View Address Book page. 

2. Section 1 of the page is Find Users. In the Filter By drop-down list, select All Users, All Group
or the name of a specific group. Leave the Name(s) field blank and click Find to see in the 
Available Values tab
y All User — A list of all users. 
y All Groups — A list of group names. 
y A specific group — A list of the users in that group. 

3. To find specific names or groups, type all or part of a name y
to see matches from which you can select. 

You can type multiple names, and even partial names, separated by a semi-colon. The exact 
matches are automatically selected. Those that are partial and can 
(for instance, if you type Jeff and there are several “Jeff” users) are displaye
Values table. 

If you t
Find button, that user’s name goes directly to the Selected Values table. If you decide you do
not want that user, select the name and click the  button. It moves to the Available Values 
table. 

Note You can also move names back and forth with double-clicks. 

4. Section 2 of the page is Select Users. There should be names in the Available Values table 

To go directly to a name in the table, type a value in the Type name or select from list field; the 

s in the Available Values table 

ct multiple names or user groups, use the Shift or Ctrl key. To see more information 
e Details button. 

6. Use the 

from 1–Find Users. 

address book moves to a matching value in the table. 

Click the radio button for First or Last to sort the name
accordingly. 

5. Select a person or user group in the Available Values table. 

To sele
about a user or user group, select it and click th

 button to move your selection(s) into the Selected Values table. 

em rs. 

If you
As G

7. Continue selecting names and using the arrows until the Selected Values table is what you 
want. 

R ember, if you want to choose a user group, return to the Filter By field in 1–Find Use

 want to create a group for another purpose, select the names of users and click the Save 
roup button. 
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8. Click OK to close the address book. 
 

Using the Details and Save As Group Buttons 
When you select a user name that appears in the Available Values or Selected Values lists and click 

 Details

Whe
pers ears in the Selected Values lists are in the 

om 

e

the  button, the user object opens. 

n you click the Save As Group button, the Save As dialog is brought up for you to create a 
onal or global user group. All user’s name(s) that app

group. 

Creating Personal User Groups 
With the appropriate privileges, you can create personal user groups. You create user groups fr
the Settings page. 

Not  You can create personal groups on-the-fly from the address book, which appears 
whenever you follow a process where you can select users. In the address book, click the 
Save As Group button and all users in the Selected Values list are in the new group. 

To c

1.  Personal User Groups page appears. 

ppears. 

3. Select the User Group subclass and type the name of the new group. 

cify general information about the user group, including 
ool 

reate a personal user group:  

Click Tools > My Settings > Personal Groups. The

2. Click Create. The Create User Group wizard a

4. Click Continue. 

5. In the Define the User Group page, spe
description, status (Active or Inactive), and whether you want this group to be a resource p
(part of the Product Portfolio Management solution). 

6. Click . Next

7. On the Add Users page of the wizard, click the Add button  to add users and user groups to
this new group. The address book appears. 

 

s to move them into the Selected 8. Select names in the Available Values list, and use the arrow
Values list. For more information, see Selecting Users from the Address Book (on page 53). 

w group, click Add in the 

appears on the Personal User Groups page. 

 clicking the tabs and the Edit button. See 

9. When you have selected all the users you want to include in the ne
address book window. 

10. Back in the wizard, click Finish. The new group 

You may complete aspects of the user group by
Editing Personal User Groups (on page 54). 

Editing Personal User Groups 
You can edit the groups you have created. 

dit a

1. Click

To e  personal group in Web Client: 

 Tools > My Settings > Personal Groups. The Personal User Groups page appears. 
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2. Click the name of the group you want to edit. The Group page appears. 

3. On the General Info tab, you can click Edit to change the general information about the group. 

4. You can click the Users tab to add or delete user
user. To delete a user, select the user row and click 

s. On the Users tab, click Add to add another 
Delete. 

5. To create or modify escalations, click the Escalations tab. 

6. You can add or remove attachments on the Attachments tab. 

For information about attachments, see Working with Attachments (on page 241). 

Deleting Personal User Groups 
To delete a personal user group from the address book: 

2. Select the personal group you want to delete, and click Remove. The selected group is deleted. 

1. Click Tools > My Settings > Personal Groups. The Personal User Groups page appears. 

Note If the personal group is involved with elements like workflow approval or escalation, you 
will be prompted and prevented from deleting the group. In this case, you can set the 
group to Inactive status, which keeps the group from being involved in new events, but 
does not impact events in which it is already involved. 

From the Deleted Personal Groups node, you can view personal groups that you have deleted from the 
pear in the Address Book. You 

undeleted, it can be edited again. 

ce, a project team (group) was no longer needed 
ject is reinstated, and the same people are on the project 

Acti the Personal 

Cre roup Using Save As on a Deleted Personal Group 

You from a deleted personal group. Once you have opened a 
Actions > Save As

Creating Personal Supplier Groups 
al supplier groups. You create personal 

Agile system. When a personal group is deleted, it does not ap
cannot edit a personal group that has been deleted; if it is 

Undeleting Deleted Personal Groups 

A personal group may be “undeleted” if, for instan
at the end of the project, and then the pro
team. Once the group is undeleted, of course, the users in the group can be changed. 

To undelete a personal user group: 

1. Click Tools > My Settings > Deleted Personal Groups. The Deleted Personal Groups page appears. 

2. Open a deleted personal group by clicking its name. 

3. Choose ons > Undelete. The selected group is undeleted and now appears in 
Groups table. 

By undeleting the deleted user group, it appears again in the Address Book. 

ating a New G

 can also create a new personal group 
deleted personal group, choose . You will be prompted to give the deleted group a 
new name and save it. You can then modify it in the usual ways. 

With the appropriate privileges, you can create person
supplier groups from the Settings page. 
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To create a personal supplier group:  

1. Click Tools > My Settings > Personal Supplier Groups. The Personal Supplier Groups page appears

2. Click Create. The 

. 

Create Supplier Group wizard appears. 

l. 3. Type a name and a description of the new group, and select the supplier group type Persona

4. Click  next to the Suppliers field. The Identify Suppliers dialog appears. 

5. Find su rs’ names using the sea  Search, Saved 
S kmarks. Click Next. 

by checking the box next to each one’s name (or select all with 

ginal created and appears on 
Supp

y modify aspects of a supplier group by selecting the supplier group row and clicking the Edit 

r Proper
The table below lists and . 
The General Info, Preferen , and User Groups tabs are documented. Share, Subscription, 
Attachments, and History tabs are all automatically populated, and do not have fields or properties 

ld that you want, see your Agile administrator to go over your 

nces for users ar b-
ories of user prefer nd display-related. (These “user 

uld not  of 
reference

pplie
earch, Boo

rch options offered: Search, Advanced

6. Select suppliers for the group 
the topmost box). 

7. Back in the ori wizard, click Finish. The personal supplier group is 
your Personal 

You ma

lier Groups page. 

button. 

Use ties Defined 
 describes the properties common to all users in the Agile PLM system

ces, Escalations

per se. If you are not able to set a fie
roles and privileges. 

Prefere e found on the Preferences tab of any user object. There are three su
categ ences: system-related, format-related, a
preferences” sho
“systemwide p

be confused with Administrator > Server Settings > Preferences node
s.”) 

Property  Descr ipt ion  (defau l t  is  under l ined)  

 
General Info tab, required fields 

User ID (username) e. The user’s Agile PLM login user identification, or usernam

First Name and Last 
Name 

The user’s public name. 

Status Active) or disabled (Inactive). A disabled 
user cannot log in. 
Indicates whether the user is enabled (

Email The user’s valid email address for change notification/routing. Example: 
danny.design@agile.com.  

Note: The user will not receive any email notifications if there is no valid address in 
the Email field. 

 
General Info tab, optional user information 

Status Active or Inactive. (This is the same thing as Enabled or Disabled, respectively.) 
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Property  Descr ipt ion  (defau l t  is  under l ined)  

Title The user’s title, for example, Senior Engineer. 

Address fields 
ield is 

There are four address fields that are used for informational purposes only: 
Address (street), City, Postal/Zip Code, and Geography. The Geography f
a series of drop-down lists. 

Phone number fields The user’s Business Phone, Home Phone, and Mobile Phone numbers (
information

for 
al purposes only). 

Fax The user’s fax number (for informational purposes only). 

Pager The user’s pager number (for informational purposes only). 

Secondary Email The Secondary Email is optional, but when the field is filled in, the user receives 
notifications at both email addresses. 

 
 Info tab, Profile fieldGeneral s 

Role(s) The user’s role assignments. This property determines a user’s access to the 
objects in Agile PLM from the point of discovery forward. 

Lists These lists link certain roles, like 
workflows, such as Changes. 

Change Analyst, to routable objects and their 

Searches 
a 

These lists control roles, searches folders, and queries. For example, Change 
Analyst Searches controls whether a user has, in Java or Web Client interfaces, 
Change Analyst Searches folder and Change Analyst queries in My Inbox. 

User Category Power, Concurrent, or Restricted. 

Use Login Password 
for  
Approval 

Each user has a login password and approval password (used to approve 
changes). 

Allow Escalation 
Designation Approval 

s If the user has identified one or more designated escalation persons (DEPs), thi
setting determines when the DEPs can approve or reject a routable object. 

Home Organization l users created from the 
ated from 

The name of the company profile (organization name) for al
Users node and the supplier name and supplier number for all users cre
the Supplier Groups node. 

Site(s) 
and 

Default Site 

e company’s 
d; selecting from the drop-down list for this 

wn list for Default Site. Default Site is the user’s 

Sites are used for distributed manufacturing, and indicate all of th
locations where the user is involve
property populates the drop-do
main base of work. 

Ship-To address fields  
e user can initiate sourcing activity; 

opulates the drop-down list for 

ponsible for sourcing 
activities. 

Authorized Ship-To (called “Site” in earlier versions of PCM), used only by PCM,
indicates all company locations where th
selecting from the drop-down list for this property p
Home Ship-To. 

Home Ship-To is the primary location where the user is res

P
Partners for Packa

rogram Manager for The partners for which this user is program manager (which is the change analyst 
ge objects). 
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Property  Descr ipt ion  (defau l t  is  under l ined)  

Rate fields There are three Rates fields: Labor Rate, Overhead Rate, and Bill Rate. The 
drop-down lists in these fields show all currencies entered in the Currency 
Exchange Rates node. You can select a currency different from the user’s 
Preferred Currency (see Preferences tab). Used by PPM. 

Comment The Agile PLM administrator may enter a comment regarding the user. 

Program Type er can participate in. Types of programs the us

Region Regions the user has belongs to. 

Division Divisions the user belongs to. 

Product Line Product lines the user has access to. 

Customer  associated with. Customers the user is

Launch Year Product launch years the user is associated with. 

Category 7, Category 
8, Category 9, 
Category 10 

Optional Product Portfolio Management Dashboard fields. 

 
Preferences tab: System Preferences 

P
Web Clie

referred Client This field controls the type of link provided in system notifications to the user. Select 
nt, Java Client, or Portal Client. 

 
nt. 

Agile’s PCM, PG&C, and PPM solutions operate only in Web Client. Users who
work primarily in those areas should have their Preferred Client set to Web Clie

Preferred File Server  Select from the list of file servers. For best performance, select a file server that is a
local server for the user. 

Preferred Portal URL  user’s Agile PLM email 
notifications will contain a link to the portal URL. 
Specify the URL used to access the Agile PLM portal. The

Receive Email 
Notification 

enerated email notifications Controls whether the user can receive automatically g
from the system. 
Settings = Yes or No 

File Productivity 
Preference 

Controls whether the user has access to advanced productivity 
standard components, or wants to be prompted in each situati

components, or 
on. If set to Standard 

 user preference will not appear in any user’s Profile if the systemwide 
y Components is set to No. 

mode, non-supported files will not be opened automatically. Instead, the user is 
prompted to choose Save or Open. 
Settings = Prompt, Advanced, or Standard 

Note: this
preference Allow Download of Productivit

 
Preferences tab: Format Preferences 

Language English is available with all Agile PLM licenses. Agile PLM includes Japanese, 
Traditional Chinese, Simplified Chinese, French, or German, per your license. 
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Property  Descr ipt ion  (defau l t  is  under l ined)  

Workweek Settings le. 

Note: this property is not applicable to any Agile PLM module including Product 
. 

This setting is for future use only, and is not referenced in any Agile PLM  modu

Portfolio Management and  Microsoft Project schedules

Preferred Date Format The format in which dates are displayed to the user. 

Time Zone s located. The time zone where the user i

Preferred Time Format The format in which times are displayed to the user. 

Preferred Currency osts are displayed to the user. The currency in which prices/c

Number Format The format in which numbers are displayed to the user. An example of each format 
is displayed in the drop-down list. 

 
Preferences tab: Display Preferences 

Preferred Start Page Select between Home and the available dashboard tabs. 

Preferred Inbox View Select between My Assignments, Notifications, and Workflow Routings. 

Response Edit Mode ced Table Edit, and Advanced Wizard Edit. The 
Basic setting brings the user – generally a “supplier” who does not work at the 
“buyer” company – to a simplified Web Client user interface. The two Advanced 
settings bring the user to the familiar Web Client UI. 

Choose between Basic, Advan

Rows per Table 
Display 

The number of rows that appear in the user’s Agile Web Client user interface. 

Static Table Headers Set to Yes to carry table headers to additional pages. 

Maximum Rows 
isplayed 

The maximum number of rows displayed in any Agile PLM table, including search 
results. The default is 1000. If you set this property to a higher value, searches will 
take longer to display results. 

D

Main Toolbar (Web 
Client) 

Menu “headings” on Web Client’s main toolbar can be seen as Icons Only, Text 
Only, or both Icons and Text. 

Encode Type Select from: Western European (ISO), Japanese (Shift JIS), Traditional Chinese 
(Big 5), Japanese (EUC), Simplified Chinese (GB2312), and Unicode (UTF-8). 

 
Escalations tab 
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Property  Descr ipt ion  (defau l t  is  under l ined)  

Criteria 

and 

Notify Users 
 

Set Criteria and Notify Users, which is an individual user or user group (personal 
or global) to be notified when a workflow status exceeds its escalation time period 
without a signoff by the user. 

 
User Group tab 

Name and Status and 
Role(s) 

The user’s user group assignments for the address book. 
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Introducing Agile Objects 
In the Agile system, you work with objects. Examples of objects are parts, documents, RFQs, and 
change orders. 

The objects you can view and the actions you can perform are determined by the server 
components installed on the Agile Application Server and the roles and privileges you are granted 
to access those components. Privileges can vary from field to field. If you have questions about 
your roles and privileges, contact your Agile administrator. 

How Objects Appear 
When you open an object, it appears with a number of tabs. Different types of objects have 
somewhat different tabs. Each tab contains fields that provide information about that object. For 
example, a part’s Title Block tab includes Number, Part Category, and Description fields, and a change’s 
Cover Page tab includes Originator, Status, and Reason For Change fields. 

Some tabs have fields and tables where you enter data; some fields and tables are filled in 
automatically. Some objects and commonly found tabs are mentioned in the platform-specific 
discussions later in this chapter. For more information about objects and their tabs, see Working 
with Business Objects (on page 81). 

Below is a typical object page in Java Client and the same object window in Web Client  .  
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Agile Object Types 
Business objects that you create in Agile PLM are based on a framework of object types: base class, 
class, and subclass. The base class object type is a framework for classes; the class object type is a 
framework for subclasses. Each class has at least one default subclass; the subclass level is where 
you create specific objects. Every object created in Agile (by users or administrators) is an instance 
of an existing subclass. (Base classes and classes are never objects themselves.) 

The Agile system provides some three dozen default classes of business objects. The default 
classes of objects that are available for your company’s creation and use depend on which Agile 
products and licenses have been purchased. The Agile administrator—that is, any user who has 
been assigned the Administrator privilege mask or role—can create subclasses according to the 
needs of the enterprise; the administrator can also rename the existing (“out-of-box”) base classes, 
classes, and subclasses. You may find that even a relatively new Agile installation has objects that 
have been created with names that are not reflected in this manual, for example, in the next three 
tables that describe the object types. 

The classes represent either a kind of action (business process) or kind of entity (business object). 
Everything that a user can create in Agile PLM—object or process—is treated as an object, and, 
again, each object is a specific instance of a subclass. The child subclass inherits the attribute 
settings of the parent class; where applicable, it inherits lifecycle phase and process extension. 
Tabs—tab names and tab visibility—are inherited from the parent class, but only if these are set at 
the class level; even out-of-box subclasses with the same parent class can differ slightly from their 
“siblings” because of tabs that the administrator has hidden or given different names. 

This table summarizes Agile’s hierarchy of object types. As an Agile user, you do not need to know 
much about base classes and classes, but it is helpful to have an idea of the hierarchy and naming 
behind the subclasses you will be working with. “Items” and “changes” are examples of frequently 
used base class names. 

Object  
type  

Th is  type 
inher i ts . . .  

Rename,  Create,  
or  Delete  

Insta l led  examples  Notes  

Base 
Class 

Does not inherit; is 
the highest level of 
object type that 
user sees (for 
example, in 
searches). 

Administrator can 
rename base 
classes, but cannot 
create or delete any 
base class. 

1. Users base class 

2. Items base class 

3. Changes base class 

4. Suppliers base class 

 

Class ...general properties 
and process 
extensions of its 
parent base class. 

Administrator can 
rename classes, but 
cannot create or 
delete any class. 

1. Users class 

2. Parts class and 
Documents class 

3. Change Orders 
class, Change 
Requests class, Site 
Change Orders class, 
etc. 

4. Suppliers class 

The class object type 
(sometimes called 
main class) is the 
primary level of 
organization in Agile 
PLM. Each class 
represents a specific 
process or kind of 
entity (see 
Routable and 
Non-Routable 
Objects (on page 
68)). 
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Subclass ...all components 
(tabs), properties, 
and attributes of its 
parent class. 
Subclasses arrange 
the information & 
data that describes 
the specific object 
in the Agile system. 

Administrator can 
create and rename 
subclasses, and also 
delete any 
subclasses that have 
not been used by 
Agile users. 

1. User 

2. Part, Document 

3. ECO, ECR, SCO, 
etc. 

4. Broker, Distributor, 
Component Mfr., 
Contract Mfr., and  
Mfr. Representative 

When users create a 
new object in Agile, 
they specify one of 
the Agile-supplied 
subclasses or a 
subclass that the 
administrator has 
created (or renamed) 
per your company’s 
requirements. 
Subclass names 
cannot be used more 
than once within an 
Agile system. A few 
classes offer multiple 
out-of-box 
subclasses. 

 

The object type plays a part in user access and permissions. For example, you can restrict a user’s 
privilege to either the Changes base class, the Change Orders class, or the ECO subclass (or 
another, user-defined subclass of Change Orders class). 

Installed Agile Classes, Base Classes, and 
Subclasses 
The following two tables list all the possible installed object types in Agile PLM. Classes are 
grouped being routable or non-routable, which is discussed further on. Also covered in this section: 

à Discovery and Read Privileges 

à Routable and Non-Routable Objects 

The following two tables list all the possible installed object types in Agile PLM, grouped by the 
routable and non-routable distinction. Your company may have purchased server licenses to a 
subset of this list. A class appears grayed out in the administrator’s list of classes if your company 
has not purchased its server license. 

Base c lass   C lass  Subclass Descr ipt ion 

Routable objects: the means to direct or recommend changes to non-routable objects; these classes have a 
default workflow for changes to seek approval from other users; objects from these classes can be changed 
without approval. 

Changes 
 

Change Orders ECO Directives to change an item; can 
advance the revision (“rev”) of an 
item 
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Base c lass   C lass  Subclass Descr ipt ion 

Change Requests  ECR Requests for a change to an item 

Deviations  Deviation Directives to temporarily substitute 
one item for another 

Manufacturer Orders MCO Changes to AML data, such as 
information about manufacturers or 
manufacturer part numbers 

Price Change Orders PCO Directives to change a published 
price; can advance the revision of a 
published price 

Site Change Orders SCO Changes to BOM and AML 
information for a specific site 

 

Stop Ships Stop Ship Directives to stop shipping/using an 
item 

Substance Declarations Substance 
Declaration 

Seeks compliance information for 
each substance within the 
specification 

Part Declarations Part Declaration Seeks part-level compliance 
information and other composition 
header-level information 
(manufacturing parameters) 

JGP Declarations JGP Declaration Seeks compliance information 
(weights) according to the JGP 
standard 

Homogeneous Material 
Declarations 

Homogeneous 
Material Declaration 

Seeks complete breakdown of parts 
on the Bill Of Substances and 
compliance information at the 
homogeneous material level 

Supplier Declarations of 
Conformance 

Supplier 
Declaration of 
Conformance 

Seeks compliance with specifications 
from customers and government 
agencies 

IPC 1752-1 Declarations IPC 1752-1 
Declaration 

A Joint Industry Guide (JIG) material 
composition declaration for electronic 
products 

Declarations 
 

IPC 1752-2 Declarations IPC 1752-2 
Declaration 

A homogeneous material 
composition declaration for electronic 
products 

Packages Packages Package Packages of data to share with 
partners 

Product 
Service  
Requests 

 

Problem Reports Problem Report Quality incidents with items or 
products 
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Base c lass   C lass  Subclass Descr ipt ion 
 Non-Conformance  

Reports 
NCR Quality conformance issues with 

items or products 

Activities Program; Phase; 
Task 

Components of project planning in 
Product Portfolio Management; 
activities are time-based objects to 
which resources can be assigned 

Programs 
 

Gates Gate Project management milestones in 
Product Portfolio Management; gates 
identify cross-PLM deliverables of the 
product development process to 
enable executive reviews of 
programs 

Corrective and 
Preventive Actions 

CAPA Requests for corrective actions and 
preventive actions 

Quality 
Change  
Requests 

 
Audits Audit Proactive reviews of business 

processes 

Automated Transfer  
Orders 

ATO Transfer or publication of a product 
record that is automatically triggered 
by a workflow 

Transfer 
Orders 

 
Content Transfer  
Orders 

CTO Transfer or publication of a product 
record that is manually triggered 

 

Base c lass   C lass  Subclass Descr ipt ion 

Non-Routable Objects: objects in these classes are not routed to Agile PLM users with workflows; objects from 
some of these classes, however, are changed by a user submitting a workflow (from routable classes) for approval 
from other users. 

Customers Customers Customer Clients of the company 

Discussions Discussions Discussion Informal, threaded dialogue 

File Folders File folders File Folder Objects that include files or URLs; 
this class includes all file folder 
objects except historical report file 
folders 

Documents Document Specifications, blueprints, 
manufacturing data, and so forth 

Items 
 

Parts  Part Parts manufactured within the 
company, or provided by 
manufacturers or suppliers and given 
internal part numbers 

Manufacturers Manufacturers Manufacturer Qualified manufacturers 

Manufacturer 
Parts 

Manufacturer parts Manufacturer Part Parts provided by manufacturers 
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Base c lass   C lass  Subclass Descr ipt ion 

Part Groups Part groups Commodity 

Part Family 

Containers of other parts (items or 
manufacturer parts) that share the 
same properties, such as prices, 
approved supplier lists, and 
composition. 

Note This object was named 
“Commodities” in previous 
releases of Agile PLM. 

Quote Histories Quote History Organizes bid prices from RFQ 
responses; cannot be revised by a 
PCO (see Changes) 

Prices 
 

Published Prices Published Price; 
Contract 

Organizes prices of the company’s 
products; can be revised by a PCO 
(see Changes) 

Standard Reports Administrator 
Report; 
Standard Report 

The out-of-box reports for 
administrators (Administrator 
Reports) and users (Standard 
Reports include Products, Sourcing, 
Quality, Process, Personal, and 
Global reports) 

Custom Reports Custom Report Reports created and used within 
company 

Reports 
 

External Reports External Report Reports created outside Agile PLM 

Requests For 
Quote 

Requests for quote RFQ Requests for quote, which are 
assembled from sourcing projects 
and sent to suppliers for formal bids 

RFQ Responses RFQ responses RFQ Response Bids, that is, responses from 
suppliers to your company’s RFQs 

Sites Sites Site Manufacturing locations within the  
company, or closely partnered with 
the company 

Sourcing 
Projects 

Sourcing projects Sourcing Project Work preparatory to creating RFQs 
and capability for analysis across 
multiple RFQs 

Specifications Specifications Specification Lists of banned substances (or 
substances of concern) and their 
threshold values 

Substances 
 

Substances Substance A single chemical element used in 
composition of items, manufacturer 
parts, and part families 
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Base c lass   C lass  Subclass Descr ipt ion 

Materials Material A compound chemical, a substance 
consisting of multiple substances 

Subparts Subpart A subunit of a component 

 

Substance Groups Substance Group A group of multiple substances, with 
a base substance that is what 
legislation is interested in, for 
example, “Lead and Lead 
Compounds” 

Suppliers Suppliers Broker; Distributor; 
Component Mfr.; 
Contract Mfr.;  
Mfr. Representative 

Qualified suppliers of manufacturer 
parts; used by PCM (which uses the 
out-of-box subclasses) and PG&C 
solutions 

Users Users User Individuals using the Agile PLM 
system 

User Groups User groups User Group Groups of people using the Agile 
PLM system, e.g., departments, 
teams, site-specific groups 

Your Agile administrator may have created or renamed subclasses. The administrator defines new 
objects by creating subclass objects under each object class. For example, under the Deviations 
class, you could see new subclasses such as “MechDev,” “SWDev,” and “Part Switch” in addition to 
the default subclass, Deviation. 

Discovery and Read Privileges 
Together, the Discovery privilege, the Read privilege, and the Enforce Field Level Read privilege 
determine which Agile objects you can find and open, and which object fields you can view. 

The Discovery privilege lets you discover the existence of an object in the Agile database. If you do 
not have Discovery privilege for an object, you cannot view the object, and you cannot find, or 
discover, the object in the Agile database. This includes viewing users in the address book; there 
may be some users that you cannot view due to lack of privileges. 

Once you have the privilege to discover an object, your Read and Enforce Field Level Read 
privileges for that object determine whether you can open and view it, and which individual fields 
you can view. You may be able to read an object, but you may not have Read privilege for every 
field of that object. So it is possible for you to open an object and, at the same time, be unable to 
view specific fields of that object. For more information about the Discovery and Read privileges, 
see the Agile PLM Administrator Guide. 

Routable and Non-Routable Objects 
Each class represents a specific process or kind of entity: 

à Routable objects are created from classes that represent processes, such as a change in the 
change control process, or a transfer order, or a product service request. These objects can be 
routed to Agile users for approval or other input via workflows (see Workflows (on page 73)). 

à Non-routable objects are created from classes that represent entities or things, such as parts, 
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sites, RFQs, users, prices, or reports. These objects can be “flagged” for progress via lifecycle 
phases. Note, however, that non-routable objects—especially parts and documents—can be 
changed by the process of information-gathering via workflows, which are created through such 
routable objects as change orders or change requests. 

Note File folder objects have lifecycle phases and, as they represent the entity of “attachment 
wrapper,” are not considered routable objects; however, the File Folders class has a 
default, non-editable workflow with a single Review status (and no other status), which 
provides a Routing Slip tab where approvers can sign off and comment. 

 

Routing Managers 

Any object that can be routed for approval is a routable object. The user who oversees the routing 
and approval process is the routing manager. The various routing managers (see the table below) 
are simply roles assigned to users by the administrator. Once a user has been assigned a role of, 
say, change analyst, his name appears on the Change Analyst List and can be selected manually 
by a Java Client or Web Client user. Routing managers evaluate and assign routable objects, and 
they receive email notifications pertaining to the objects to which they are assigned. 

The following table lists routable objects and the corresponding default routing manager. 

Routable  Object  (wi th  base c lass)  Defau l t  Rout ing  
Managager  

Changes base class: Change orders (ECOs), Change Requests (ECRs), 
Stop Ships, Deviations, Site Change Orders (SCOs) 

Change analyst    

Changes base class: Manufacturer Orders (MCOs) Component engineer     

Changes base class: Price Change Orders (PCOs) Price administrator     

Declarations base class: Part Declarations, Substance Declarations, 
Homogeneous Material Declarations, JGPSSI Declarations, Supplier 
Declarations of Conformance 

Compliance manager 

Packages base class: Packages Program manager     

Product Service Requests base class (PSRs):  
Problem Reports and NonConformance Reports (NCRs) 

Quality analyst     

Programs base class: Activities and Gates PE program manager     

Quality Change Request base class (QCRs):  
Corrective and Preventive Actions (CAPAs) and Audits 

Quality administrator   

Transfer Orders base class:  
Content Transfer Orders (CTOs) and Automated Transfer Orders (ATOs) 

Content manager 

  
 

Other Important Concepts in Agile 
Familiarity with the topics discussed in this section will help you use the full features of Agile. 
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Login Security and Passwords 
Depending on how your Agile administrator has configured your password settings, you may have 
two separate passwords for login and approval, or you may have one password for both login and 
approval. 

Your username and approval passwords are the same for both Java Client and Web Client. 

For system security, your administrator may configure the Agile system so that you are not allowed 
to log in after a specified number of password failures (entering the wrong password). The lockout 
applies to your login password only, not your approval password. 

Depending on system settings, one of the following occurs: 

à The login lockout lasts until a specified time has passed (for example, one minute). 

After the specified time has passed, a small Login dialog box appears, telling you that there 
have been too many login failures. Click OK and continue. 

à The login lockout lasts until your Agile administrator unlocks your account by changing your 
password. If you are locked out, Web Client does not accept further input for the time period 
specified by the Agile administrator (for example, one minute), before you can attempt to log in 
again. 

If you are having difficulty logging in to Agile, or had a failed logon and the lockout is lasting too 
long, see your Agile administrator. 

Object Subscriptions, Relationships, and Sharing 
“Sharing,” “subscriptions,” and “relationships” all describe operations with objects in Agile PLM that 
provide better collaboration and enhanced automation as they proceed through the manufacturing 
process. These features are detailed in Working with Business Objects (on page 81). 

à Object sharing—Lets you grant one or more of your roles to another Agile user for specific 
objects and specific classes listed in object tabs. 

à Object subscription—You can subscribe to objects so that you are notified when certain events 
happen to that object. For example, you could subscribe to a change in order to be notified 
whenever the change was promoted to a new status. 

à Object-to-object relationships—Lets you set up communication between Agile objects, and the 
actions resulting from (triggered by) that communication. For example, the implementation of 
an ECO could trigger the close of a related ECR. 

 

File Folder Objects and Attachment Files 
Attachments to objects may contain information about the object or a manufacturing process. You 
can attach files and URLs by referencing them in a file folder object. The file folder holds pertinent 
content, or attachments. 

In previous versions of Agile, files and URLs that are attached—associated—to parts or other 
business objects are called attachments. In Agile 9, attachment files and URLs may be referred to 
generally as attachments, but it is important to remember that what is really attached to Agile 
business objects are file folders. 
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You can still view, copy, delete, and print attachment files. With appropriate roles and privileges, 
you can mark up or redline an attachment file in the Viewer. See Viewing and Redlining 
Attachment Files in the Viewer (on page 272). 

The Attachments tab of an Agile object lists attached file folders. The Files tab of a file folder object 
lists the files and URLs that are referenced, and it is where you add and remove files and URLs in 
the file folder. A file folder’s Where Used tab is populated automatically with any objects that have a 
link to the file folder. A single file folder object can be referenced from the Attachments tab of multiple 
objects. 

For more information, see Working with Attachments (on page 241). For details about searching 
attachment content, see Full Text Search for Content in Attachment Files (on page 145). Also see 
Viewer Supplement. 

Searching for Data 
When you want to find data in the Agile system, you perform a search. Agile provides several types 
of searches: 

à Simple searches find objects of all types that match the text you specify. 

à Quick searches find objects that match two basic conditions: the text and the object type that 
you specify. They also have the ability to search attachment file content. 

à Advanced object searches find all the objects with fields that match the conditions of the 
search. For example, you could search for parts where the Description field contains 
“Computer.” 

à Where-used searches (a specific type of advanced search) find the assemblies in which the 
BOM contains the items that match the search criteria. 

à Relationship searches (a specific type of advanced search) find objects related to the objects 
that meet the search criteria. For example, you can search for the problem reports that appear 
on the Relationships tab of changes that meet search criteria. 

à Attachment content searches find attachment objects that contain attachment files including the 
text specified in the search conditions. 

For instructions about searching, see Finding Agile Data with Searches (on page 135). 

Agile Packages 
Agile packages are sets of product information that can be created, viewed, and routed through 
Agile to users up and down the supply chain. 

For example, suppose an electronic manufacturer service (EMS) provider must receive a certain set 
of documents to respond to a request for quotation from an original equipment manufacturer (OEM). 
The EMS defines the required documents in Java Client or Web Client. OEM employees then log in 
to Web Client, where they create Agile packages and are prompted to attach the required files. The 
Agile packages are submitted to the program manager at the EMS. 

The EMS is immediately notified when the OEM submits the packages. The EMS can review the 
packages and their contents. The packages pass through workflow stages in Agile, where they are 
routed for review, accepted, or returned to the submitting partner if additional work is needed. 

OEM personnel can monitor all this activity anytime they log in to Web Client for that EMS provider. 
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The OEM can also use Agile Content Service (ACS) to automatically create and populate the Agile 
m of the EMS. 

port files can be comma-delimited 

data 

uct content (BOMs, AMLs, drawings, and so on), ECRs, ECOs, and deviations in an 

 

eate a 

 
s. The EMS can 

se. 

e PDX standard, visit the PDX organization Web site at 
http://www.pdxstandard.org

package in the Agile syste

Exporting Data 
Users at Agile sites can export product definition data to a file. Ex
text format (CSV) or Product Definition eXchange (PDX) format. 

PDX is the Product Definition eXchange standard designed for the e-supply chain. The standard is 
based on XML because it provides a simple yet powerful and flexible way to encode structured 
into a format that is both human- and machine-readable. The PDX standard provides a way to 
describe prod
XML format. 

In a typical case, an OEM with Agile has a design to communicate to an EMS, also called contract
electronics manufacturer (CEM), who builds the component or assembly. The product data might 
include items, BOMs, approved manufacturer lists, drawings, and so on. When a design changes, 
the manufacturer needs to communicate the changes to the EMS. The Export wizard can cr
text file or PDX package of this information from the Agile database to be sent to the EMS. 

At the receiving end, the EMS then views that data (in Agile eXpress, if the file is a PDX package)
and prints it or extracts it as needed for use in spreadsheets or other application
use Agile Import to import the PDX package or text file into the Agile databa

Agile Import and Export are documented in Agile Import and Export Guide. 

For more information about th
. 

, and most Agile users 
 BOMs, AMLs, and the change control process. 

r 

n be a single item or an assembly of several items. The BOM for each 
BOM

art, 
rmation, appears on its Manufacturers tab. 

sts for change to 
any part, document, step, or instruction in your company’s manufacturing process. 

Product Collaboration Process 
Agile’s Product Collaboration (PC) solution helps supply chain partners define, store, change, and 
manage product content information. The PC solution is central to Agile PLM
will need to be familiar with

Bills of Material 
Bills of material (BOMs) show all the items (parts, documents) that make up the current part o
subassembly. (Documents may or may not have bills of material, depending on your system 
settings.) Items on a BOM ca
part appears on its  tab. 

Approved Manufacturer Lists 
An approved manufacturers list (AML) is the list of manufacturers that have been approved to 
supply a particular item. The list identifies the manufacturer part for that item. The AML for a p
plus the manufacturer’s part numbers and other info

Change Control Process 
The change control process includes all procedures that manage changes or reque
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Objects and Change Control 

Items are subject to change control, that is, modification by an approved and released change 
order. To modify an item’s BOM or Manufacturers tab, you must create a change against the item. 

The Title Block and Sites tabs of items are not under change control; this means, with the appropriate 
privileges, you can edit them at any time. Site objects and manufacturers are also not under change 
control. 

Affected Items 

The Affected Items tab of a change lists the items that are affected by the change. Users with 
sufficient privileges can use the Affected Items tab to: 

à List the items affected by the change, and assign a pending revision (or rev) to the affected 
items of the ECO 

à Open the affected items 

à Work with BOM, manufacturer, and attachment redlines 
 

Redlining BOMs, Manufacturers, and Attachment Files 

When you redline a BOM, you change it in some ways. For example, you can add or delete parts 
and assemblies from the BOM or change quantities of existing parts. Likewise, when you redline an 
AML, you can change associated manufacturer parts information. When you redline an attachment 
file, you mark it up in the Viewer by adding new drawing lines, adding annotations, or adding 
measurements. 

Redlining activities begin on the Affected Items tab of an ECO (for BOMs, AMLs, or attachment files), 
SCO (for BOMs or AMLs), or MCO (for AMLs). 

Workflows 

A workflow is a sequence of statuses that a routable object (such as a change) follows. Workflows 
automate many processes; for example, when a change is released, Agile users on the notification 
list receive automatic email with this information. 

Agile provides default workflows for routable objects, and your Agile administrator can create 
workflows. For each workflow made available to Agile users, the administrator specifies workflow 
name, ID number, names of the statuses, and the properties that define each status. 

Agile workflows are covered in detail in Routing Objects with Workflows (on page 197). 

Change Control Tasks 

With the necessary server license, you can create changes against items and route them to Agile 
users for approval. Agile PLM lets you do the following: 

à Approve or reject the routed changes 

à Attach comments to changes 

à Change the lifecycle phase of an item without changing its revision (MCO) 

à Add, edit, and delete bill of material, manufacturer, and price data on items 
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à Change site-specific information on an item 

à Redline attachment files associated with an item. 
 

A Typical Change Control Process 

Agile supports change control processes, including default and custom Agile workflows. 

The following is an example of a typical change control process for a change using Agile workflows: 

1. An Agile user creates a change (for example, an ECO or MCO), and then selects a workflow to 
route this change. 

2. The user selects approvers (members of the change control board) and observers for the 
change, then submits it to the routing manager. 

3. The routing manager switches the change to the next status, which routes the change to the 
specified approvers and observers. 

4. The members of the change control board, or CCB, enter their approval or rejection on the 
Workflow tab of the change. 

5. If all the approvers approve the change, it is automatically promoted to the next status 
(depending on the AutoPromote setting). If any approvers reject the change, the routing 
manager is notified. The routing manager may elect to do any of the following: 
y Cancel the change by switching the status to Canceled. 
y Return the change to the originator by switching the status to Pending. 
y Release the change in spite of the rejection. 
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The following figure illustrates this change control process. Agile packages and content transfer 
orders can follow a similar process. 

 
 

Product Portfolio Management Process 
Agile Product Portfolio Management (PPM) is a Web Client application for program management 
that allows you to: 

à Plan a program in terms of its schedules, resources, and deliverables 

à Execute and manage multiple related programs and projects in a collaborative environment 

à Associate product deliverables – such as Items, RFQs, ECOs, and CAPAs – to tasks on a 
project plan 

à Establish project plan templates for rolling out best-practice processes 

à Allocate work to users or resource pools and monitor capacity and future demand 
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à executive dashboards for cross-program rollups and quick access to high risk 

The ment process involves: 

y Resource management 

Liste

e it opens.   

. Tasks 

 it. Deliverables are used to control the status of gates.      

ister, and track 

à Activity: A program, task or phase.   

t User Guide.  

 failures, product or manufacturing defects, and requests for 
ventive actions. PQM unifies the company’s organizations in 
acturing, and engineering, and links the organization to its 

t

PQM

à agement (CRM) systems—The 

Establish 
activities 

 program manage
y Scheduling 
y Task management 
y Issue management 
y Document management 
y Phase/Gate management 

y Deliverable management. 
 

Common Terms in PPM 
d below are some of the common terms used in PPM: 

à Program: A set of related activities and gates that is created to monitor and manage progress 
on a specific project.  

à Phase: A segment of a program, also referred to as a stage. Phases are often used to define 
the activities required to create a set of deliverables. 

à Gates: Indicates the completion of a set of related activities, such as a phase. A gate's status is 
closed until all it's deliverables are complete, at which tim

à Task: A segment of work that one or more resources can complete over a period of time
may be embedded in programs, phases or other tasks. 

à Deliverable: An Agile PLM object whose state change can trigger a state change in the 
program element that contains

à Gantt Chart: A program management tool that helps you to plan, admin
programs from start to finish. 

à Content: Contains all program-related content including deliverables.   

For more information on PPM, see Agile Product Portfolio Managemen

Product Quality Tracking Process 
The Agile Product Quality Management (PQM) solution consists of a comprehensive set of tools 
that allows companies to track and manage quality data across the enterprise. This includes 
customer complaints, field
enhancements or corrective and pre
customer service, field sales, manuf
cus omers and partners. 

 features offer these benefits: 

Integration with external enterprise Customer Relations Man
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ability to import customer complaints, manufacturing issues, and additional quality-related 
information from other enterprise applications streamlines the quality tracking process and 
offers a central repository for tracking product quality data. 

nd improved product 

à d customer complaints 

uct Service Requests (PSRs) and Quality Change Request 
blem Reports and Non-Conformance Reports (NCRs). The 
ctive and Preventive Actions (CAPAs). You can associate 

Liste

à 

that 

cations or 

à Qua

dit: The pro-active process of verifying compliance with quality requirements. 
 

à : A list of all similar product service requests that are combined to form a single 

à 

à reates a relationship with other Agile objects; the relationship is bi-

à 
u can create a relationship between two objects without 

onship are 
ns that can be performed 

à Improved product quality—Tracking defects, finding trends, and determining the root causes of 
defects in a timely manner are the keys to effective defect reduction a
quality. 

Improved customer satisfaction—The ability to track problem reports an
lets you respond quickly to customers and resolve problems quickly. 

à Lower production, repair costs, and warranty costs—Tracking and correcting defects can help 
reduce scrap, cycle time, and costs associated with rework and repair. 

à New features enable compliance with ISO-9000, FDA, and other regulations. 

The Agile PQM solution consists of Prod
(QCRs). The two types of PSRs are Pro
two types of QCRs are Audits and Corre
QCRs with problem reports. 

Common Terms in PQM 
d below are some of the common terms used in PQM: 

Product Service Request (PSR): A PSR is used to report a defect or a quality incident about a 
product. The PSR can be either a Problem Report or a Non-conformance Report.   
y Problem Report (PR): Contains a basic description of a problem, issue, or incident 

occurred, from the customer’s perspective.  
y Non-Conformance Report (NCR): Reports a basic material deviation from specifi

requirements in one or more products.  

lity Change Request (QCR): Creates and manages quality records that aggregate 
problems related to products, documents, suppliers, and customers. 
y Au
y Corrective and Preventive Action (CAPA): A formal process of addressing any quality

problem and analyzing the root cause to implement corrective and preventive action. 

Related PSR
PSR. 

Affected Items: A list of items that are affected by the change in either a PSR or a QCR. 

Relationship tab: C
directional.  

Relationship Rule: Specifying a rule for a relationship defines how the related Agile objects 
affect each other. Rules are optional; yo
specifying a rule.  

à Preview Pane: When you add a relationship to an object, the details of the Relati
displayed in the Preview pane. It also displays the attributes and actio
on the relationship object.       

For more information on PQM, see Agile Product Quality Management User Guide. 
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Product Cost Management Process 
Agile’s Product Cost Management (PCM) solution consists of the Product Sourcing and Price 
Management components. They allow you to integrate and leverage price and cost informatio
within your company’s business proces

n 
ses in the Agile Web Client. 

d pricing activities, since the project lets multiple users view and modify the same 
u to execute sourcing activities, including RFQs and 

ontrolled process for managing price 
tions, business processes, and key 

e

à s that 

à ng. Tracks data required for sourcing 

à ther user-defined 

à tems added to a project. These can be items that exist in the Item Master, 

à r, manufacturer part number, 

à en 

à 
the market cost per unit of the item or the manufacturer part. 

ciating each 
 

à Request for Quotes (RFQs): Using RFQs, you request quotes for items involved in the project 

ent User Guide.  

 
anufacturers audit 

sponsibly dispose 

A sourcing project holds the data you gather, such as items and assemblies, bills of material, and 
approved manufacturers lists. Using the project, multiple users can work as a team to complete 
sourcing an
components. Sourcing projects allow yo
analysis, on your Item Master content. 

The Price Management solution provides you with a single c
and terms information that can be leveraged across organiza
analyses. 

Common Terms in PCM 
List d below are some of the common terms used in PCM. 

Approved Manufacturer's List (AML): Lists all the preferred or alternate manufacturer part
correspond to an internal part.  

Sourcing Projects: An entry point for sourcing and prici
and pricing, to perform analysis for effective pricing. 

Item Master: The entire collection of Items - Parts, Documents, and o
subclasses of the Items class maintained under change control in the Agile system. 

Project Items: I
created within the project or imported into the project. 

Project Data: Information about the supplier, item, manufacture
revision, price information, RFQ response information of a project.   

Subscriptions: Subscribing to an object sets you up to receive notification of events that happ
to the object.  

Target Price: The price you quote for an item with the standard cost in mind. Standard cost is 

à Commodities: Lets you categorize parts for sourcing and analysis process. By asso
item with a commodity, you can distribute RFQs to suppliers based on the commodities they
offer. 

and suppliers respond to the Quote. RFQs can be sent to one or more suppliers.     

For more information on PCM, see Agile Product Cost Managem

Product Governance and Compliance Process
Agile Product Governance and Compliance (PG&C) is designed to help OEM m
the amount of regulated substances used in their products, and show that they re
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of, recycle, or reuse electronics containing those substances. 

PG&C helps companies address the growing number of environmental specifications and policies 

g reports 

 Manager, who creates a new declaration, or modifies an 
arts assembly. An RFI is comprised of a 

t assembly and shows the substances and 
 

part

Co

à ust comply. 
es or 

d to validate 

à 

e 

à 

substance with the same name exists in the buyer’s system. The system adds the invalid 
substance as an alias to the substance. Whenever the same invalid substance is imported, it 
automatically maps to the objects.   

à Supplier: A supplier is a company that provides compliance information about parts that are 
used in your company’s manufacturing process. 

For further information about PG&C, see Agile Product Governance & Compliance User Guide. 
 

that affect product definition, the import and export of products, and the disposal of restricted 
substances. It provides a solution that manages the entire product compliance process: 

1. Collection of data from vendors through a Request For Information (RFI) 

2. Determination of compliance by analyzing data and comparing it to established standards 

3. Documentation of compliance by runnin

The RFI process is initiated by Compliance
existing declaration, to specify the components for a p
Material Declaration, which lists the parts in a produc
materials that comprise those parts. It is linked to specifications which may restrict how much of a

icular substance that product assembly may contain. 

mmon Terms  in PG&C 
Listed below are some of the terms used in PG&C.  

Specification: Tracks the different legislations with which an assembly or part m
Environmental specifications are substance-based, and contain a list of banned substanc
substances of concern and their threshold values. In Agile, specifications are use
declarations and assess the compliance of parts by evaluating whether a given restricted 
substance in the composition of a part surpasses its specified threshold value.  

à Declaration : A structured way of bringing information concerning the environmental 
compliance of parts into Agile PLM. Each declaration is for a single supplier.  

à Composition: A composition represents the total collection of information contained in a 
completed declaration and is not a configurable "business object " in Agile PLM. 

Substance: A substance is any chemical element or compound that is tracked within Agile 
PLM. 

à Bill of Substance (BOS): A way to manage compliance information-gathering with regard to th
parts and materials used in the manufacturing process. 

Alias: Informs the PG&C system of  "substitute names" of substances. For example: When a 
supplier provides information about substances for a part, there is no guarantee that a 
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Working with Business Objects 
This chapter includes the following: 

� Interacting with Agile Objects: Actions and Tabs................................................................................................. 81 
� Creating Objects .................................................................................................................................................. 88 
� Direct Addition of Objects to BOM, AML, and AI Tables ..................................................................................... 92 
� Modifying Date and Time Fields .......................................................................................................................... 93 
� Printing Object Tabs ............................................................................................................................................ 95 
� Emailing Objects.................................................................................................................................................. 96 
� Quick Access to Objects and Files ...................................................................................................................... 97 
� Discussion Objects .............................................................................................................................................. 98 
� Sharing Objects with Other Users ....................................................................................................................... 99 
� Subscribing to Objects......................................................................................................................................... 101 
� Relationships and Dependencies Between Objects ............................................................................................ 103 
� Relationships Tab ................................................................................................................................................ 104 
� Deleting Agile Objects ......................................................................................................................................... 113 

 
 

Interacting with Agile Objects: Actions and Tabs 
Finding and opening Agile objects is a straightforward process: the easiest way is to run a simple 
search. You can type a word in the Simple Search field—on the main toolbar of both clients—that 
describes the Agile content you are interested in. For example, typing computer will return a list of all 
objects with the word “computer” in their name or description. If you already know an object’s ID 
number, typing it in the Simple Search field returns the object. 

For more information about finding objects or data in Agile, see Finding Agile Data with Searches 
(on page 135). 

Once you have found an object that you will want to refer to often, you can bookmark it to return to it 
easily. 

The two main ways of interacting with Agile business objects are, with an object open, via the 
Actions menu or via the fields and attributes on its various tabs. 

Actions Menu 
An important feature for working with objects in both clients is the More menu (Java Client) and the 
Actions menu (Web Client). Generally, objects in Web Client have an Actions button that opens to a 
drop-down list of available actions. In Java Client, right-click anywhere in the opened object to see a 
shortcut menu with the same commands as the More menu. 

Note In Java Client, on most tabs, if you right-click outside any table rows within the object, that 
object’s main shortcut menu opens (Changes, Quality and Where Used tab excepted). 
However, on any tab with a table, you can also select a row in a displayed table and right-
click, and a shortcut menu for the object referenced in that row opens. 
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Command Descr ipt ion 

Save As Creates a new object based on the current object. 

Delete Deletes the object (a “soft delete”). For more information about deleting objects, see 
Deleting Agile Objects (on page 113). 

Print Choose either All Tabs or the tabs you want. The list of tabs changes with the current 
object’s class. 

Copy URL to 
Clipboard 

In Web Client, copies the URL of the object to the clipboard, so it can be pasted 
elsewhere. 

For Internet Explorer: the URL is copied when you click the action; the prompt indicates 
it is copied. 

For Netscape: when you click the action, a popup displays the URL, manual Ctrl-c 
copies the URL. 

Incorporate and 
Unincorporate 

Available for items: incorporation locks the checkout and checkin capabilities of file 
folders on the Attachments tab of the item. This important capability is available only 
on the More menu. For more information about incorporating, see the Product 
Collaboration User Guide. 

Bookmark or Add 
Bookmark 

Saves a pointer to the object on your Bookmarks (or “Favorites”) list. 

Send Opens the address book and lets you select one or more users to send the object to, 
including a comment. A notification is then sent to the designated users with a link to 
the object. 

Share or Sharing Opens a page linked to the current object that lets you share the object or delete an 
existing share. For more information, see Sharing Objects with Other Users. 

Subscribe or 
Subscriptions 

Allows user to subscribe to receive a notification when certain attributes change. Offers 
a list of subscriptions for the current object: Lifecycle Phase Change or Status Change, 
Add File, Delete File, Checkin File, Checkout File, and Cancel Checkout File. See 
Subscribing to Objects (on page 101). 

Export Opens to the Export wizard in Web Client (even if you have activated it from Java 
Client). 

Process Extensions Offers a list of currently available process extensions, which have been created by your 
administrator. 

Audit Status Audits the remaining statuses in the object’s workflow to test whether the workflow can 
advance through those statuses. 

Audit Release Audits the remaining statuses in the object’s workflow to test whether the workflow can 
be released per the existing conditions in the statuses. 

View Workflows Shows eligible workflows for this (routable) object, in visual form. Offers drop-down list 
to select another workflow to view. 

Create Change Creates a new change order with the open item (part or document) already added to 
the Affected Items tab. 
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Command Descr ipt ion 

Create Product 
Service Report, 
Create Quality 
Change Request 

Creates a new PSR or QCR with the open item already added to the Affected Items 
tab. 

Create Declaration Create a new Declaration with the open item already added to the Affected Items tab. 

Actions available from selecting a row in a table 

Open, Copy, or 
Paste 

Select a row in a table, then open the object on the selected tab, or copy the selected 
tab and paste it into another table. 

Print Select a row in a table, then print the object’s selected tab or tabs. 

Create Product 
Service Report, 
Create Quality 
Change Request 

Creates a new PSR or QCR with the item in the selected row already added to the 
Affected Items tab. 

 
 

Object Tabs 
Tabs are used to organize the content of Agile objects. A brief list of the most common tabs found in 
many objects across Agile PLM’s solutions follows. This table gives basic information about tabs 
that is elaborated on later in this manual and elsewhere in the Agile documentation set, such as the 
platform-specific user guides. Some Agile solutions—such as Product Cost Management and 
Product Portfolio Management—have specialized tabs not listed below. 

Note For more information about Web Client tab indicators (a grey or red dot that appears next 
to the tab name when you view the object), see Web Client Tab Content Indicator Icons 
(on page 27). 

All the out-of-box business classes with all their default tabs are described in the Agile PLM 
Administrator Guide. 

Note Remember that part of Agile PLM’s flexibility includes the administrator’s ability to rename 
business classes and subclasses, tabs within objects, and fields within tabs, so some tabs 
listed below may have a different name within all classes or within a particular class of 
object that your company works with. 

Important Your ability to see or work with any object or any tab in Agile is governed in large part by 
your roles and privileges. If you are having trouble opening, seeing, or modifying an 
object, tab, or field, see your Agile administrator. 
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Tab Descr ipt ion:  what  informat ion th is  tab  col lects  Found in  these 
c lasses of  business 

ob jects  

“Page One” The Cover Page tab is the Page One for all routable 
objects—the Change, PSR, QCR, Transfer Order, Package, 
and Program base classes—as well as RFQ and RFQ 
Response objects. 

The Title Block tab is the Page One for all item and file folder 
objects. 

The General Information tab is the Page One for all 
remaining (non-routable) classes. 

All objects have a “Page 
One” that uses one of 
the names to the left. 

Page Two and 
Page Three 

Further information about the object. These are added by the 
administrator as extensions of “Page One.” Page Two fields 
are the same for all objects in same business object class. 
Page Three fields are the same for all objects in the same 
subclass. Both “Page Two” and “Page Three” can be replaced 
by more specific names. 

Depends on how classes 
have been set up. 

History Summary of actions taken on this object. History is recorded 
for all objects in your Agile system’s database, and shows all 
actions by users and administrators. The History tab is 
populated automatically. 

All. 

Attachments 
(and Files) 

View, copy (get), or print attached files. Attach files and URLs 
to the current object by adding them to a file folder. Access 
Viewer to redline attached files (once the object is on an ECO, 
only from the Redline Attachment table on the Affected Items 
tab). 

Note The Files tab lists all contents of file folder objects; so, 
an item’s Attachments tab lists file folder objects, and 
file folder objects have a Files tab listing contents. (For 
more information, see Working with File Folders 
(on page 284).) 

All objects except file 
folders (which contain 
attachment content) and 
reports. 

Changes Information about change objects that involve the item or 
published price object. 

Pending Changes and Change History tables are the two 
tables on the Changes tab. 

Items and published 
prices. 

BOM All the items that make up the current part. (Documents may 
or may not have bills of material, depending on your system 
settings.) Items on a BOM can be a single item or an 
assembly of several items. 

Items. 

Manufacturer Lists manufacturers that have been approved to supply a 
particular item. The list identifies the manufacturer part for the 
current item. 

Items & Sourcing 
Projects. 
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Tab Descr ipt ion:  what  informat ion th is  tab  col lects  Found in  these 
c lasses of  business 

ob jects  

Where Used Lists other objects where the current object is used. The 
Where Used tab is populated automatically. To open an 
object listed on the tab, click its Number or Name link; in Java 
Client, double-click the row. 

The type of objects that appear on the Where Used tab 
depends on the current object: 

Item—Assemblies and manufacturing sites that use the item. 

Manufacturer—(Item/MPN Where Used tab) Parts and 
assemblies that use manufacturer parts provided by the 
manufacturer. 

Manufacturer Part—Parts and assemblies that use the 
manufacturer part. 

File Folder—Objects with attachments contained in the file 
folder. 

Discussion—Objects that use the discussion, including 
projects, RFQs, RFQ responses, activities, and gates. 

Items, Manufacturer 
Parts, Discussions, File 
Folders. 

Affected Items (in 
PCOs: Affected 
Prices) 

Lists the items that are affected by the current change object. 
Users with sufficient privileges can use the Affected Items 
tab to: 

List the items affected by a change and give the affected 
items of an ECO a pending revision (or rev) 

Open the affected items 

Work with BOM, manufacturer, and attachment redlines 

Affected Prices replaces Affected Items in PCOs. 

Note When you add an item to the Affected Items tab of a 
change, if the site you have selected during the “add” 
process is not associated with the item, you are 
prompted to add the site association to the item. That 
site association remains in effect for that item, even if the 
change is canceled or if you remove the item from the 
Affected Items table of the change. 

Changes, PSRs, QCRs 

Workflow 
(routable objects 
only) 

Shows where the routable object is in the assigned workflow 
(via a flow chart), and lists present and past signoff 
information. Add or remove approvers and observers. Move 
the object to another status in the workflow. 

Summary table lists signoff information for the current 
workflow status. 

Signoff History table lists past workflow and signoff 
information for the routable object. 

Changes, PSRs, QCRs, 
Packages, Transfer 
Orders, Programs 
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Tab Descr ipt ion:  what  informat ion th is  tab  col lects  Found in  these 
c lasses of  business 

ob jects  

Sites Shows where each object is being produced at specified 
manufacturing locations within the company. 

See the Note for Affected Items in this table. 

Items 

Escalations When a workflow status exceeds its escalation time period 
without a signoff, user groups or individual users can be 
notified. This tab shows whose escalations (other users’) can 
be signed off by the current user (myself). Note that the 
settings in a user’s Allow Escalation Designation Approval 
property (on the General Info tab) comes into play. 

Users and User Groups 

Shares A user’s or user group’s Shares tab – it exists for these 
objects only – lists those objects for which the user/user group 
has been granted “shared roles” by a different user. The user 
(or members of the named user group) can then perform 
actions permitted by the roles for that object only. See Sharing 
Objects with Other Users. 

Users and User Groups 

Subscriptions See Subscribing to Objects (on page 101). Users 
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Tab Descr ipt ion:  what  informat ion th is  tab  col lects  Found in  these 
c lasses of  business 

ob jects  

Relationships 
(in programs: 
Content) 

The relationships and dependencies between this object and 
other routable objects or non-routable objects (with lifecycle 
phases). 

If the current object is a routable object, the Rule column 
displays the rule that defines how the workflow status or 
lifecycle phase of other objects affect the workflow 
progression of the current routable object, or how the 
workflow progression of the current routable object affects the 
workflow progression of the related objects. 
If the current object is a non-routable object (with lifecycle 
phases) and the related object is a routable object, you can 
specify a rule for the relationship, thus creating a dependency 
between the current non-routable object and the routable 
object. A relationship with a rule indicates a routable object 
whose workflow progression is affected by the lifecycle phase 
of the current non-routable object. 
A relationship with no specified rule does not limit or affect the 
workflow progression of the related routable object. You can 
use non-rule relationships to record objects that are somehow 
related to the current object, but do not have any 
dependencies with the current object. 

You cannot specify a rule for a non-routable object 
relationship with another non-routable (lifecycle phase) object. 

See Relationships and Dependencies Between 
Objects (on page 103). 

In Product Portfolio Management objects (Programs), 
relationships are included on the Content tab. All Program 
object Content table rows with rules are named deliverables. 

You can add file attachments to the Content tab as program 
content. By default, the Program object Attachments tab is 
disabled and not visible. You can enable this tab from Java 
Client Administrator. Attachments that were already added in 
the Attachments tab are not displayed in the Content tab. To 
transfer existing attachments from the Attachments tab to the 
Content tab, contact your support team. 

All classes (except 
Actions Items and 
Reports) 

For Programs classes, 
relationships are 
included on the Content 
tab and relationships 
with rules are named 
deliverables. 

Prices Prices tab of an item includes information about price objects 
associated with the item, including “priceline” information. 

Prices tab of a manufacturer part includes information about 
price objects associated with the manufacturer part. 

Items & Manufacturer 
Parts 
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Tab Descr ipt ion:  what  informat ion th is  tab  col lects  Found in  these 
c lasses of  business 

ob jects  

Quality Information regarding PSRs and QCRs created with regard to 
the item. Those objects have these cross-linked tabs: 

Related PSR tab for PSRs 

PSR Items tab for QCRs 

PSRs tab for Suppliers and Customers 

Items 

 
 

Creating Objects 
To create an object, you must be assigned the Create privilege for the kind of object that you want 
to create. See your Agile administrator. 

In Java Client, you can create a business object in these ways: 

à use the New Object menu  to choose a base class and a class from the expanded lists 

à use the File > New command to choose a base class and a class from the expanded lists 

à use the File > Save As command if you have an object open 

In Web Client, you can create a business object in these ways: 

à use the Create menu to choose a base class and a class from the expanded lists 

à use the Actions > Save As command if you have an object open 

You can also create some objects as you add them to an Agile table. For example, you can create 
an item to add it to the BOM tab of a parent item or to the Affected Items tab of a change. 

There are some options to create objects from “within” another object. For example, from within an 
item, the Actions menu includes Create Change, Create PSR, Create QCR, and Create Declaration. From 
within a manufacturer, you can choose Create Manufacturer Part. 

Once you create an object, that item exists until you delete it. If you create a new object, then 
decide you do not wish to keep it, be sure to delete the object; otherwise, the new object is still in 
the database and the object’s identifier (such as the item number) cannot be reused. See Deleting 
Agile Objects (on page 113). 

Note Although all characters are supported within Agile PLM, and should not create issues 
within Agile's clients, it is recommended that you avoid using the following characters 
when creating objects, due to issues that could potentially arise in integrations or custom 
applications written on the SDK. 

¾         ,   comma      .  period (dot)      :   colon      ;   semicolon      =   equal sign 
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Creating Objects in Java Client Using the New Command 
The process for creating new business objects in Java Client involves two main steps: creating an 
empty object, then filling in the object tabs with information specific to the object. 

To create and complete an object in Java Client: 

1. Choose File > New on the main menu bar or click the New Object button  on the main toolbar. 

2. From the drop-down menu that opens, choose the base class for the business object you want 
to create. Any base class with two classes expands to offer choices in all possible child classes 
(for this reason, Transfer Order will offer Content Transfer Order but not Automated Transfer 
Order). The New dialog box opens. 

3. The New dialog specifies the object type and, for some objects, assigns an Autonumber. 

The autonumber format and sequence are determined by the Agile administrator. The 
administrator also determines whether using autonumbers is required or optional. 

4. Click OK. The new object appears with the Cover Page, Title Block, or General Information tab 
showing. 

Fill in information on the object’s tabs, as necessary. Some tabs are completed automatically, 
such as the Changes, Where Used, and History tabs. You do not enter information on these tabs. 

Note that in Java Client, the object has been created as of step 4 in the procedure. (In Web Client, 
objects are created through wizards.) All object-required fields are depicted by the name of the field 
appearing in bold type. If you attempt to close the object with any required fields empty, an error 
message will advise “You have not completed all required fields. Please complete all fields in bold.” 

Creating Objects in Web Client Using the Create Command 
A wizard in Web Client leads you through the process of creating an object and specifying 
information on its tabs. 

To create and complete an object in Web Client: 

1. Click the Create button on the main toolbar. 

2. From the drop-down menu that opens, choose the base class for the business object you want 
to create. Any base class with two classes expands to offer choices in all possible child classes 
(for this reason, Transfer Order will offer Content Transfer Order but not Automated Transfer 
Order). The Create wizard opens. 

3. Follow the instructions onscreen to complete the wizard. Some points about the wizard: 

All object-required fields will be present in the first screen of the wizard – the “required” aspect 
is depicted by the name of the field appearing in bold type. All these fields must be filled in to 
create the object. If you attempt to finish the wizard with any required fields empty, an error 
message will advise “You have not completed all required fields. Please complete all fields in bold.” 
If you click the Continue Creation in Wizard checkbox, Continue or Next buttons are available. 

If you leave the Continue Creation in Wizard checkbox unfilled, the Finish button is available. You 
can click Finish at any point in the wizard, and the object will be created. Later, you can open 
the object and enter more data. 

You can always click Cancel to end the wizard without saving the new object. 
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The Autonumber format and sequence are determined by the Agile administrator. The 
administrator also determines whether using Autonumbers is required or optional. 

4. As you proceed through the steps of the Create wizard, the process flow diagram in the 
navigation pane is interactive. For information about using the process flow diagram, see 
Adding Data during Create with the Process Flow Diagram (on page 90). 

5. Click Finish. The new object appears with the Cover Page, Title Block, or General Information tab 
showing. 

Fill in information on the item tabs, as necessary. Some tabs are completed automatically, such 
as the Changes, Where Used, and History tabs. You do not enter information on these tabs. 

Adding Data during Create with the Process Flow Diagram 

While you proceed through the steps of the Create wizard in Web Client, the process flow diagram  
(see Using the Wizard Process Flow Diagrams (on page 33)) in the navigation pane tracks the 
steps of the wizard. The steps that you have not reached can be accessed—if a step is enabled, 
you can open and close it at any time you are in the wizard, and you can fill in information or not as 
you choose. Some common steps you will see are Enter Cover Page Information, Add Attachments, and 
Add Affected Items. 

When you have clicked an “Add step” in the process flow diagram, a dialog opens. This dialog will 
vary according to the kind of information you are adding, but it will be familiar and self-guiding, for 
example, using Available and Selected tables. 

Most of these dialogs have, of course, an Add button . If you click the drop-down triangle, you 
can choose Create new or Search. If you click the Add button itself, a full dialog opens, where Create 
and Search buttons are often present: 

à Create (button) and Create new (menu choice) open a dialog to create a new object. Follow the 
task preceding this topic. 

à Search (button and menu choice) opens a dialog with three Search tabs (see Add Files by 
Search Options (on page 259)). 

à For Add procedures that involve items (parts or documents), the Item Number(s): field can be 
used to type in known object ID numbers, one per line. After entering one or more ID number, 
click Add, you are returned to the Create wizard with the objects you listed added as 
appropriate. 

These “Add” elements are meant to make certain procedures easier, but they could be somewhat 
confusing while you are learning Agile. The main thing is that you can go in and out of them without 
“harming” the wizard you are in. The Add steps become more useful as you work in Agile PLM 
every day. 

If you check the Edit Items After Adding checkbox, the newly added items will be displayed in Edit 
mode (after they are added to the table). 

Add Files by Search Options 
In various “create” or “add” operations that are detailed in this manual, when you click the Add 
button, the dialog that opens may have a Search button. This is the procedure to decide what route 
to take to identify objects in the database that you can select in your “add” operation. 

à Search (button and menu choice) opens a dialog with three Search tabs: 

Page - 90 Agile Product Lifecycle Management 

 

 



 Chapter 5  
 
 

y Search tab lets you run a simple search by entering a value in the field and clicking the 
Search button. 

Click the Advanced Search link to set up an advanced search. 

Click the Search Attachment Contents checkbox to include attachment files in your search. 

When the results of your search are returned, you can select and move objects from the 
Results table to the Selected table. 

Then Click OK, and you are returned to the Create wizard, and the objects you selected 
have been added where appropriate. 

y Saved Searches tab opens to your navigation pane where you can browse in search folders, 
select a search, and run it. Again, returned results may be moved to the Selected Items 
table, and click OK. 

y Shortcuts tab opens to your navigation pane where you can select objects from My 
Bookmarks or Recently Visited. The system displays shortcuts to only those objects that are 
appropriate to the operation you are performing. 

Generally you can run multiple searches before completing the wizard step. Also, after the object is 
created, you can still run multiple searches. 

Creating an Object Using Save As 
Using the Save As feature is a quick way to create an object that is similar to an existing object. 

Note In general, you should not use Save As to create an object in a different class or subclass 
from the original object. The different classes or subclasses may not have the same tabs 
or defined fields, and you may lose access to some data in the newly created object. 

¾ For example, parts generally have a BOM tab. By default, documents do not. When you 
save a part as a document, you cannot view the part’s BOM in the resulting document 
unless your Agile administrator has configured your system to permit documents to have 
BOMs. 

To create an object using Save As in Java Client: 

1. Select and open an existing business object. 

2. Choose File > Save As. The Save As dialog appears. 

3. The two fields in the Save As dialog box are (object) Type and (Auto)Number. Choose an 
available object type from the drop-down list, and click for an autonumber or fill in an ID number 
manually. 

4. Depending on the selected object type, the Save As dialog may display additional required 
fields. Complete any required fields. 

5. Click OK. The new object is created and automatically opens. 

6. Make any appropriate modifications on the tabs of your new object. 

To create an object using Save As in Web Client: 

1. Select and open an existing business object. 

2. From the Actions menu, choose Save As. A dialog appears with the heading: “Save [object] [ID 
number] As...” with defaults naming the object and number. 

3. The two fields in the dialog are Subclass and (Auto)Number. You can choose an available 
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subclass from the drop-down list, and fill in an ID number manually if you want. 

4. Depending on the selected object type, the Save As dialog may display additional required 
fields. Complete any required fields. 

5. Click Save. The new object is created and automatically opens. 

6. Make any appropriate modifications to the tabs. 

If the Agile administrator has set the appropriate preferences, fields in the optional Page Two and 
Page Three sections are copied to the new object. For information about the behavior of Page Two and 
Page Three fields in your Agile system, see your Agile administrator. 

Save As copies data from a field in the existing object to the same field in the new object. If a field 
or list value in the existing object is not available in the new object, then that field or list value is not 
copied to the new object. 

Note Because Page Three data applies to a specific subclass only, if you use Save As to create a 
new business object in a different subclass, the Page Three data is not copied to the new 
object. 

 

Site Change Order Save As Limitations 

You  cannot initiate Save As from a non-Site Change Order (SCO) change object in order to create 
an SCO object, nor can you initiate Save As from an SCO object in order to create a non-SCO 
change object. Because Site Change Orders (SCOs) affect only site-specific information, and other 
types of changes are not limited to site-specific information (for example, ECOs and MCOs), SCOs 
can be Save-As-created only from another SCO. The Site Change Order's site-specific only usage 
makes it incompatible with other change types when using the Save As feature. 

Direct Addition of Objects to BOM, AML, and AI 
Tables 
The Product Collaboration User Guide describes procedures for adding objects—for example, 
parts, documents, manufacturer parts—to BOM tables on items, AML tables on items, and Affected 
Items tables on changes. Generally, you have to search for each object to add it to a table. An 
additional method is called direct addition of objects. 

Note The “direct addition” capability applies only to Java Client. However, this process in Java 
Client is very similar to Web Client’s Adding Data during Create with the Process Flow 
Diagram (on page 90). 

In the tables just listed, when you click the drop-down arrow next to the Add button , you are 
given the option to Search... for the object(s) you want to add, Create... an object you want to add, and 
to Type in known number(s)... of objects you want to add. 

When you select the latter, a popup dialog appears called, for example, Add BOM. This method is 
useful when you work with certain items or subassemblies every day, and you are familiar with their 
Agile numbers. You simply type in the number of the item that you want to add (one per line), and 
click the Add button. The item is added to the table and the popup dialog disappears. 
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Item Addition Rules 
Whenever a user adds an item to a BOM or adds an affected item to a change, the user is 
prompted to set a warning mask (by choosing Yes or No). If an item then happens to violate an 
“Item Addition Rule,” the system knows how to handle it. 

These are some item addition rules, that is, the question stemming from a potential violation of the 
rule: 

à If there are duplicate items, would you still like to continue? 

à Some items may not be associated with some sites; would you like to add the association? 

à If one item does not exist, do you want to use it anyway? 

à Do you want to add items whose lifecycle phase is in the warning list to the BOM? 

 
 

Modifying Date and Time Fields 
In both Java and Web clients, you can modify date fields by using the calendar tool, as well as by 
typing in the field.     

Using the Calendar to Modify Date Fields in Java Client 
To use the calendar tool in Java Client: 

1. In a date field, click the calendar icon  to open the calendar (if it is enabled). 

2. Select a date from the calendar. Java Client enters the new date and sets the times to 12:00:00 
am. 

Note The default time format is “12 hours” with am and pm. 

Double-clicking the date enters it directly to the field. 

3. To switch to a different month or year, click the appropriate Forward or Reverse button. 
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4. Click the red icon to close the calendar and clear any date you entered.  
Click the green icon to close the calendar and keep your date entry. 
There is also a button in the right bottom corner (not pictured) that sets the date back to the 
present day. 

 
 

Using the Calendar to Modify Date Fields in Web Client 
To use the calendar tool in Web Client: 

1. In a date field, click   to open the calendar (if it is enabled). 

2. Select a date from the calendar. Web Client enters the new date and sets the time to 12:00:00 
am. 

Note The default time format is “12 hours” with am and pm. 

Double-clicking the date enters it directly to the field. 

3. To switch to a different month or year, click the Forward or Reverse button. 

4. Click the x button to close the calendar and clear any date you entered.  
Click the ^ button to close the calendar and keep your date entry. 
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Manually Modifying Date and Time Fields 
To edit the date and time: 

1. Select the date and time you want to change. 

2. Enter the new date in the format specified in your user profile (by default, mm-dd-yyyy). 

3. Press the Spacebar. 

4. Enter the time in the format specified in your user profile. This step is optional; if you do not 
enter a time, by default the time displays midnight in the specified format. 

Note Web Client does not accept the new date without a space between the date 
and time. 

To edit just the timestamp:     

1. Select the time you want to change. 

2. Enter the new time in the hh:mm:ss format. 

3. Press the Tab key or the Enter key. 
 

Printing Object Tabs 
You can print information from any tabbed object. 

Attachments are printed from their native applications or the Viewer. For more information, see 
Printing Attachment Files (on page 254). 

To print an object in Java Client: 

1. Open the object. 

2. To print all tabs, click the Print button  in the object window. To print a single tab only, click 

the down arrow next to the Print button  and select the appropriate option. 

Note If any of the tabs are blank, that is, contain no visible fields, you cannot print all 
tabs. Instead, select individual tabs to print. 

3. If you select the BOM, the Choose BOM Depth dialog box appears. Select the levels to print, or 
select the All depth checkbox to print all levels. Click OK. A preview of the printout appears in a 
separate dialog box. 

4. Click the Print button  in the Print dialog box. 

To print an object from within a table in Java Client: 

1. In a table, such as Search Results, select the row you want to print. If you want to print more 
than one object at a time, use the Ctrl and Shift keys to select the objects, and then right-click. 

2. Choose Print. 
3. Specify the data that you want to print—all tabs, or a specific tab of information. 
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Note If the selected objects belong to different subclasses (and therefore may 
contain different tabs), the specific first tab name is replaced by Page One. For 
example, for parts and documents, choosing Page One prints the Title Block. 

4. A preview of the printout appears in a separate dialog box. Click the Print button  in the Print 
dialog box. 

For information about the buttons in the Print dialog, click the Help button from within the dialog. 

To print an object in Web Client: 

1. Open the object. 

2. Choose Print from the Actions menu. Indicate whether you want to print all tabs or just the 
current tab. 

If you choose All tabs, specify whether you want the printout to include all levels (for example, of 
the BOM). 

3. Click OK. A preview of the printout appears in a separate window. A Print dialog box opens. 

4. Click the Print button. 

5. Make sure the appropriate print options are selected, and click Print. 
 

Emailing Objects 
You can email any Agile object to another user listed in the Agile address book. Email is sent to the 
email address specified in the Agile user profile. The email contains a URL that links to the mailed 
object, and the recipient can click the URL to view the object in Agile PLM. 

Note The Agile administrator sets your user profile Preferred Client preference to determine 
whether you receive links to Web Client or Java Client. 

To email an Agile object in Java Client: 

1. Open the object. 

2. Choose File > Send, or click the Send button.  

3. In the Send dialog box that opens, click To to open the address book. 

4. In the address book, use the right arrow to move names to the Recipients list, and click OK. 

For information about using the address book, see Selecting Users and User Groups from the 
Address Book (on page 19). 

5. Enter any comments in the Comment field. 

6. Click Send to mail the object. 

To email an Agile object in Web Client: 

1. Open the object. 

2. Choose Actions > Send. 

An Available Values list appears on the Send page. Use the right arrow to move names to the 
Selected Values list. 
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3. Enter any comments in the Comments field. 

4. Click Send to mail the object. 
 

Quick Access to Objects and Files 
You can generate quick access URLs that provide direct pointers to either Agile objects or to Agile 
attachment files. 

These quick access URLs can be pasted into other applications or files such as spreadsheet files, 
word processing files, a company Intranet web page or WIKI page, or into an email. 

For information about quick access to Agile objects using quick access URLs, see: 

à Agile-Generated Quick Access Object URLs (on page 97) 

à Formats for User-Generated Smart Object URLs (on page 97) 

à Using Quick Access Object URLs (on page 98) 

For information about quick access to attachment files using attachment quick access URLs, see: 

à Generating Attachment Quick Access URLs (on page 275) 
 

Agile-Generated Quick Access Object URLs 
From Web Client, you can generate Agile PLM object quick access URLs from the Web Client 
Actions menu. 

To generate an Agile PLM object quick access URL: 

1. Login to Agile PLM Web Client and open the desired object. 

2. In the Actions menu, choose Copy URL to Clipboard. 

3. The URL is copied to your clip board. You can then paste it into another application or file, such 
as a word processing file, a spreadsheet file, or an email. 

 

Formats for User-Generated Smart Object URLs 
The Agile Smart Object URL feature is designed to enable effective collaboration through email, 
spreadsheets, documents, WIKIs, and so forth. Users or automated tools can generate smart 
readable URLs that point to a specific object in Agile. By using the following format, a user does not 
need to log into Agile to generate the object URL. Automated tools can also use this format to 
generate object URLs. 

Smart Object URLs can be used for objects available from Web Client. 

Smart Object URL Format 

URLs for pointing to Agile objects use the following format: 

http://server:port/VirtualPath/object/ObjectType/ObjectName

The following table defines the Smart Object URL parameters: 
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Parameter  Descr ipt ion 

 
http://server:port/<VirtualPath>/object/<ObjectType>/<ObjectName> 

 

server 

port 

VirtualPath 

Server, port, and VirtualPath identify the Agile PLM instance. 

object The text "object" indicates to Agile that the URL is an object URL. 

ObjectType ObjectType refers to the subclass (type) of object, for example, ECO, Part, 
Manufacturer, File Folder,  Program,  Activity, or Discussion.  

ObjectName ObjectName refers to the unique identifier for the object. Depending on the 
object class, the unique identifier is either an object number or a name. 

Note Manufacturer Parts are a special class of objects that are uniquely 
identified by two parameters: a Manufacturer Name and a 
Manufacturer Part Number. Therefore, a URL referring to a specific 
Manufacturer Part uses the following format: 

http://server:port/VirtualPath/object/ObjectType/MfrName/MfrP
art Number 

Agile PLM identifies and handles special tags (such as %20) added to URLs to handle special 
characters (such as spaces and other special characters such as asterisk "*") in an object's unique 
identifier. For example, the URL 

http://server:port/VirtualPath/object/Manufacturer/Philips%20Semiconductor

resolves to the manufacturer "Philips Semiconductor". 

Using Quick Access Object URLs 
When a user clicks a Quick Access Object URL, the user actions are the same whether the URL is 
an Agile-generated quick access URL or a user-generated Smart Object URL: 

1. The user clicks the URL and the Agile PLM login screen is displayed in a browser window. 

2. The user enters her login information. 

3. Upon successful login, Agile PLM searches for the object specified in the link. 

(If the object is not found, Agile PLM displays an error and returns to the user's Home page.) 

When the object is found, Agile PLM verifies that the user has the appropriate privileges to read the 
object and displays the object's first tab, for example, the Title Page. 

Discussion Objects 
A Discussion can be created from the main toolbar Create menu, or from a business object’s 
Discussions tab. Discussions were implemented for the Product Portfolio Management solution, and 
are also applicable to the Product Cost Management solution; however, discussions can be created 
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without special licensing, and their utility can be applied to the other Agile PLM solutions, Product 
Collaboration, Product Governance & Compliance, and Product Quality Management. 

Discussions are always created and viewed in Web Client. To access a discussion while using Java 
Client, you can search to locate an existing discussion and open the object, which will open Web 
Client. Or you can simply open Web Client and proceed from there, including creating discussions. 
A discussion object always displays as a popup. 

The following objects classes have a Discussions tab: Sourcing Projects, Request for Quote, RFQ 
Responses, Activities, and Gates. 

Creating and Viewing Discussions 
When you create a discussion, starting at the Create menu (see Creating Objects in Web Client 
Using the Create Command (on page 89)), you fill in information on the Discussion tab and click OK. 
The new Discussion object appears as a “pop-up,” that is, it displays differently than all other 
business objects in Agile. On the Discussion tab of a discussion, there are four main sections: 

à Page One–type information, such as the discussion’s ID number, Subject, Status, Priority, 
Subject, and Notify List 

à Message Thread table, which is a list of all the replies in the discussion 

à Message table, which is the specific reply message based on the row selection in the Message 
Thread table 

à Action Items table, which lists action items that have been associated with the discussion 

At the top are navigation buttons: Add Action Item, Add Attachment, Join, Print, and the Actions menu. 
The Join action adds the user to the Notify List.  

When you click the Preview Message checkbox, the Message Thread table expands to show the 
beginning of the reply message. The message is truncated; you can “mouse over” the reply 
message to see the full reply message as a tooltip. You can also click on a reply message to see 
the full reply message in the Message table. 

Adding To and Editing Discussions 
When the owner/creator opens the Discussion popup, the Page One–type information is editable. 
The owner can update the discussion. 

When you select a specific reply in the discussion thread table, and then click the Reply button, you 
can add users to the Notify List—but not remove any—and enter a reply. The author of any reply 
can edit the reply at any time. 

Action Items can be created or deleted by users (on the Notify List) who have sufficient privileges. 

Sharing Objects with Other Users 
Sharing lets you grant one or more of your roles to another Agile user or user group for specific 
objects. The capability to share a given role requires being assigned the Grant privilege specific to 
that object. You can share only your assigned roles, that is, the roles that are listed in the Roles field 
on the General Info tab of your user profile, and the roles that are listed in the Roles field on the 
General Info tab of any groups of which you are a member. 
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You cannot share roles that have been shared with you by another user, and you cannot share 
roles that have been shared with a user group to which you belong. 

When a role has been shared with a user (or members of a user group), each user can then 
perform actions permitted by the roles for that object only; a user does not “acquire” the role in any 
permanent or far-reaching way. 

A user’s or user group’s Share tab lists those objects for which the user has been granted “shared 
roles” by a different user. Click the Share tab in your user profile to see objects being shared with 
you and what role(s) allow and define your interaction with each object. If you belong to a user 
group, you can see objects being shared with you via the user group by opening the group object 
and clicking the Share tab. 

To share an object in Java Client: 

1. Display the object. 

2. Right-click anywhere in the object and choose Sharing. 

Or, use the More menu and choose Sharing. 

The Share <named object> window appears. 

3. Click the Add button. The Add Access Control Entry dialog box appears. 

4. Click ; the Address book appears. Select the Names or Groups tab, and move those you want 
to the Recipients list. 

5. Click OK. All users in the Selected Users list will appear in the Users field. 

6. Now select an appropriate role or roles for your chosen users to have available in connection 
with this object. 

7. Click OK. The Share <named object> window appears again displaying the selected users and 
selected roles. 

8. Click Close. This returns you to the original object. Click Refresh. Note that when you right-click 
and choose Sharing, the Share window now shows you the complete list of users who have 
access to this object and the roles you specified. 

To share an object in Web Client: 

1. Display the object. 

2. In the Actions menu, choose Sharing. The Access Control List: Share with Users page appears. 

3. Click Add. The Identify Users page of the Add to Access Control List wizard appears. 

4. Use the Filter by drop-down list to choose All Users, All Groups, or a specific group. The list you 
selected appears, and you can select one by one or select multiple users/user groups. 

You may type a user’s name, fully or partially, but you have to select a group first to populate 
the Available Users list. 

The Save As Group button allows you to create a group on the fly of the users that appear in the 
Selected Users list. Note, however, that this process only creates a new user group (personal or 
global); it does not add the new group to the Share list. 

5. Click Next. The Assign Roles page appears. Select appropriate role or roles for your chosen 
users to have available in connection with this object. 

6. Click Finish. The Share with Users page appears again displaying the selected users and 
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selected roles. 

7. Click Return. This returns you to the original object. Note that choosing Actions > Sharing now 
shows you the complete list of users who have access to this object and the roles you 
specified. 

To remove a shared object from the Share tab of your user profile, select the object and click 
Remove. 

Subscribing to Objects 
Subscribing to an object sets you up to receive notification of events that happen to that object. For 
example, you might subscribe to a change in order to be notified when the change is released, or 
you might subscribe to an attachment in order to be notified when the attachment is checked in. 
You can also be notified when specified fields are modified. You select the events about which to be 
notified. If you want to be notified when certain fields change, you specify those fields. 

You must have the Subscribe privilege for a specific object class to be able to subscribe to that 
class’s objects. See your Agile administrator if you need to be assigned additional privileges. 

On the Subscription tab of your user profile, you can view the objects to which you have subscribed. 
To cancel or remove a subscription, select the object, and click Remove. 

Subscription events trigger two types of notifications: Email and Inbox. Email notifications are sent 
only if your Receive Email Notification preference is set to Yes; this field is on the Preferences tab of 
your User Profile. The ability to edit user information is determined by your privileges. 

Subscribing to an Item or Price Revision 
It is possible to subscribe to an item revision change and a price revision change. Since you cannot 
subscribe to specific status change (for example, changed to Released) for a change that “revs” the 
Item (an ECO) or the Price object (a PCO), subscribing to the object itself—the part, document, or 
price—is the way you can be notified that the object has been “rev’d.” 

Subscribing to Attachments via the File Folder 

Should you want to be notified of changes to a file folder, subscribe to its “checkin” events. The 
version number of File Folder objects automatically increments every time they are checked in. 
However, it is not possible to subscribe to file folder versions, which work differently than item 
revisions. So, subscribing to a file folder’s Checkins is the way you can be notified that the file folder 
has been altered; file folders are not subject to changes (objects from the various change classes). 

Subscribing to Objects in the Clients 

To subscribe to an object in Java Client: 

1. Display the object. 

2. Right-click the object and choose Subscribe. 

Or, use the More menu and choose Subscribe. 

3. Indicate whether you want to be notified when the subscribed object is modified by selecting 
the appropriate Subscriptions checkboxes. You can select one or more: 
y Lifecycle Phase Change (or Status Change if it is a routable object) 
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y Field Change 

Select from the displayed list of fields. Your Agile administrator determines which fields are 
available for subscription. 

y Revision Change (items and prices) 
y Add File 
y Delete File 
y Checkin File 
y Checkout File 
y Cancel Checkout File 

4. Click Save. A message indicates that your subscription was saved. 

t in Web Client: 

3. odified by selecting 

e Change (or Status Change if it is a routable object) 
y 

st of fields. Your Agile administrator determines which fields are 

hange (items and prices) 

Checkout File 

bscribe to vary per object. Product Portfolio Management has the following 
ription events that do not apply to other objects: 

à Add Action Item 

 

ut-

To subscribe to an objec

1. Display the object. 

2. Choose Actions > Subscribe. The Define Subscriptions page appears. 

Indicate whether you want to be notified when the subscribed object is m
the appropriate Subscriptions checkboxes. You can select one or more: 
y Lifecycle Phas

Field Change 

Select from the displayed li
available for subscription. 

y Revision C
y Add File 
y Delete File 
y Checkin File 
y Checkout File 
y Cancel 

4. Click Save. 
 

Subscription in Product Portfolio Management 
The events you can su
Activity-specific subsc

à Add Discussion 

à Reply to Discussion 

à Add News 

à Modify Schedule 

The Apply to Children checkbox in activities and gates “push” a subscription to all child objects. If you
subscribe to an activity that has a schedule and select this checkbox, you will automatically 
subscribe to all of the activity’s programs, phases, and tasks (that is, any object created in the o
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of-box subclasses of Activities class). Because Page Two and Page Three fields can be def
differently for programs, phases, and tasks, any of the attributes that do not apply are ign

ined 
ored. 

Relationships and Dependencies Between 

This t

à 

Objects 
 sec ion includes the following topics: 

What are Relationships? (on page 103) 
y Relationships Tab (on page 104) 
y Relationships Tab Views (on page 104) 
y Relationship Tab Actions in Java Client (on page 105) 
y Relationship Tab Actions in Web Client (on page 105) 
y Using the Table Filter (on page 107) 

à Adding Relationships to Objects (on page 107) 

à Editing the Relationships Table (on page 108) 

à Removing Relationships (on page 109) 

à What is a Relationship Rule? (on page 109) 
y Relationship Rule Guidelines (on page 
y ationship

110) 
Adding a Rule to a Rel  (on page 111) 

y Editing a Relationship Rule (on page 111) 
y Removing a Relationship Rule (on page 112) 

à Relationships in PQM (on page 112) 
 

Wh are Relationships? 
associate objects to each ot

at 
You can her by using the Relationships tab. A relationship between two 
Agile objects is bi-directional and is displayed on the Relationships tab of both objects. 

 Note In Agile PPM, relationships are called deliverables and are managed on the PPM object
Contents tab. For more information about the PPM Contents tab, see Agile Product Portfolio 
Management User Guide. 

Specifying a rule for a relationship defines how the related Agile objects affect each other. For 
example, you can define a relationship rule so that ECO_100 affects ECR_250. When ECO 100 

 between two objects without specifying a 

reaches the Implemented status, ECR_250 is promoted to the Complete status automatically. 

Note Rules are optional; you can create a relationship
rule. 

A re ted when you add an object to a table in the Relationships tab of another object. lationship is crea
The classes of objects that can reference each other on a Relationships tab are: 

à All object classes, except Reports and Action Items. 
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à For Agile PPM Programs classes, relationships are named deliverables and are included on 
the Content tab. 

Your Agile administrator configures the Agile PLM system to enable the Relationships tab for each 
object class, making it visible. If you find that you want to create a relationship between objects and 
those tabs are not visible, see your Agile administrator. 

 objects, you can also create an advanced search for such 
es

Once you create relationships between
relationships. See Relationship Search  (on page 179). 

A relationship without a rule is a simpler, less dynamic instance of object-to-object relationship; it 

R ips Tab 
By default, the Relation ays the following columns. Your Agile 

strator may ena tion of the 
ships tabs in yo

simply lists references to other objects. It can be thought of as “bi-directional” information, because 
relationships without rules do not trigger events. 

elationsh
ships table for each object class displ

admini
Relation

ble additional columns. If you have questions about the configura
ur Agile system, see your Agile administrator. 

Defaul t  at t r ibute  Descr ipt ion 

Criteria Met If the relationship has a rule, the Criteria Met icon  in this column indicates that the 
criteria specified in the rule has been met. 

Name The object name or object number that uniquely identifies the related object. 

Description The description that appears in the Description field of the related object. 

Current Status The current workflow status or lifecycle phase of the related object. 

Rule The rule defined for the relationship. If no rule is defined, this column is blank. 

Type The object type (or subclass) of the related object. 

 
 

ips T
Use the  drop-down list to sort the relation ilter

Relationsh ab Views 
View ships table rows. See also Using the Table F  (on 

page 107). 

View opt ion Descr ipt ion 

All Relationships Displays all relationship table rows. 

Complete Displays relationships that have a rule specified and the criteria of the rule has 
been met. 

Pending Displays relationships that have a rule specified
not been met. 

 and the criteria of the rule has 

Rule Not Specified Displays relationships that do not have a rule specified. 
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Relationship Tab Actions in Java
In Java Clie ttons on th llow you to add, edit, and remove relationships and 

. 

 Client 
nt, bu

relationship rules
e Relationships tab a

Button or  Descr ipt ion 

 lected rows. See Editing the Relationships 

Edit Relationship 

Allows you to edit the se
Table (on page 108). 

If your Agile administrator has enabled relationship table attributes in addition 
e the to the default attributes, you can edit the additional attributes if you hav

appropriate privileges. 

 Add > Search Add a relationship to the table by searching for the object you want. See 
Adding Relationships to Objects. 

 Add > Create Add a relationship to the table by creating a new object. See Adding 
Relationships to Objects (on page 107). 

 

Remove Relationship 

Removes the selected relationship table rows. See Removing Relationships. 

 

Edit Rule 

a Edit the rules in the selected relationship table rows. See Editing 
Relationship Rule. 

 

Add Rule 

dialog for Adds a rule to the selected row by opening the Relationship Rule 
you to specify a rule. See Adding a Rule to a Relationship. 

 

Remove Rule 

Remove the rules from the selected relationship table rows. See Removing a 
Relationship Rule. 

 

 

Opens the filter tool, which allows you to sort the relationships table by 
multiple criteria. 

 this button hides the filter tool. 
Show Filter
Hide Filter If the filter tool is presently displayed, clicking

See Using the Table Filter. 

 
 

Rela  Tab Actions in Web 
In Web Cli ttons on th ne allow you to add, 

 relationships a

tionship Client 
ent, bu

edit, and remove
e Relationships tab and buttons in the preview pa

nd relationship rules. 

Button or  Descr ipt ion 

 lected rows. See Editing the Relationships 

Edit Relationship 

Allows you to edit the se
Table (on page 108). 

If your Agile administrator has enabled relationship table attributes in addition 
e the to the default attributes, you can edit the additional attributes if you hav

appropriate privileges. 

 Add > Search t. See Add a relationship to the table by searching for the object you wan
Adding Relationships to Objects (on page 107). 
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Button or  Descr ipt ion 

 Add > Create New Add a relationship to the table by creating a new object. See Adding 
Relationships to Objects (on page 107). 

  Remove Removes the selected relationship table rows. See Removing 
Relationships (on page 109). 

Show Filter s you to sort the relationships table by Opens the filter tool, which allow
multiple criteria. See Using the Table Filter (on page 107). 

Modify rule buttons which appear in the preview pane: 

Add Rule Add a rule for the selected relationship. See Adding a Rule to a 
Relationship (on page 111). 

Edit Rule Edit the rule for the selected relationship. See Editing a Relationship 
Rule (on page 111). 

Remove Rule Remove the rule from the selected relationship. See Removing a 
Relationship Rule (on page 112). 

 
 

Relationships Tab Preview Pane in Web Client 
In W  row in the relationships table, additional information about the 

ane under the table. 

e relationship rule is displayed in the preview pane. Use the buttons in the preview pane to 

à 

In a
pane: 

à For 
to select a different revision to view. 

le. You can use the Create Change button to create a new change for 

e Remove, Add, Checkout, Cancel Checkout, Checkin buttons 
 the item’s attachments. 

able. 

ou can view: 

eb Client, when you select a
related object is displayed in the preview pane, which is the lower p

For all Agile objects that are listed on the relationships table: 

à Th
add, edit, or remove a rule. 

The attachments table is displayed in the preview pane. 

ddition, specific Agile object types include additional information and actions in the preview 

Item objects, you can view and perform actions: 
y Use the Revision drop-down list 
y Pending Changes tab

that item. 
y Attachments table. You can use th

to work with

à For Change objects, you can view: 
y Affected Items t

à For File Folder objects, you can view: 
y Files table. 

à For Agile PPM Gates objects, y
y Contents table 
y Signoff table 
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à F r Agile PPM Acti ty objects, you can view and perform actions: 
y Contents table. You can Open the content objects. 

 

o vi

Using the Table Filter 
The Relationships tab in both Java Client and Web Client includes a table filter. 

The  Show Filter and  Hide Filter button toggles the
allows you to define filter criteria based on any colum

 display of the table filter. The table filter 
n in the table. You can define multiple filter 

ined in an AND search of the table rows. 

s the word marketing 

The w is similar to an Agile search criteria: 

t

To u

criteria, which are comb

For example, you can filter for relat nships whose Description column includeio
and the Rule column is Not Null (the relationship has a rule). 

 format of each filter criteria ro

<at ribute> is <Match If Operator> <value to match> 

se the Table filter: 

1. On the Relationships tab, click  Show Filter to display the Filter: criteria. 

2. 

3. ors 

In the first filter drop-down list, labeled --Select an Attribute--, choose from a list of the columns in 
the assignments table. 

In the next drop-down list, choose a Match operator. The list of available Match If operat
depends on the attribute type you chose as the --Select an Attribute-- drop-down list. 

If 

For more information, see Search Operators and Attribute Types (on page 165). 

In the rema4. ining field, enter the filter values. 

y To add a filter criteria row, click the  Add Row at the end of the row. A filter criteria row is 
added to the display. 

y To delete a filter criteria row, click the  Delete Row at the end of the row. The row is 

o clear the criteria and begin again. 

s 
You lationship is listed on the 
Relat  for both objects 
in th ted object. 

To a bject in Java Client: 

1. 

2. 

deleted. 

5. Click Apply to filter the relationships table. Only relationships that match your filter criteria are 
displayed. 

6. To define different set of filter criteria, click Clear t
 

Adding Relationships to Object
 can add objects to the relationships table of any object. The re
ionships tabs of both objects. You must have the appropriate modify privileges
e relationship: the object to which you are adding the relationship and the rela

dd a relationship to an o

Go to the Relationships tab of the object. 

To add by search, click the Add button drop-down list and select Search. 
In the Add Rea. lationship dialog, choose a search method: 

y Enter the value to search for and click Search to perform a quick search. 
y Define an advanced search. 
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y Run a saved search. 
y Select a bookmarked or recently visited item (Shortcuts). 
a. In the search results, select the objects you want, move them to the Select Related 

ated Objects list are 

 select Create. 
n list. 

c. ded to the relationships table. 

To a

1. 

2. 
a. rch method: 

y 

Objects list. 
b. When d, click OK. All the objects in the Selected Rel you are finishe

added to the relationships table. 

3.  To add by creating a new object, click the Add button drop-down list and
a. In these New dialog, select a type from the Type drop-dow
b. propriate, enter an object number and complete a required fields. 

Click OK. The new object is ad
If ap ny 

dd a lationship or reference to an object in Web Client: 

Relationships tab of the object. 

 re

Go to the 

To add by search, click the Add button drop-down list and select Search. 
In the Add Relationship dialog, choose a sea

 Quick Search — Enter search criteria and click  to run search. See Web Client 
Quick Search (on page 142). 

y  Search Folders — Opens a Saved Searches dialog. From your search folders, select a 
saved search and click OK. See Saved Searches (on page 138). 

y  Bookmarks — Displays the Bookmark table. Click + to open bookmark folders. Selec
a bookmark, and click Add Selections. 

t 

y  Recently Visited — Displays the  table. Select one or more rows, and 
click Add Selections. 

 Recently Visited

y  Advanced Search — Opens the Advanced Search definition dialog. Define a search
and click Run. In the search results table, ct one or more rows and click Add Selectio

, 
ns.  sele

See Advanced Searches (on page 155). 

y  Parametric Search — Opens a parametric search dialog. Define a search, and click 
d click Add Selections. See Search. In the search results table, select one or more rows an

Pre-configured Parametric Searches (on p
a. When you are finished making your selecti

age 148). 
ons, click OK in the Add Relationships dialog. 

The objects are added to the relationships table. 

uired fields. 
 Clic

Editin
 edit the non-default attributes of the relationships table of 

r a list default relationship table 

3.  To add by creating a new object, click the Add button drop-down list and select Create New. 
a. In the New dialog, select a type from the Type drop-down list. 
b. If appropriate, enter an object number and complete any req
c. k OK. The new object is added to the relationships table. 

 

g the Relationships Table 
With the appropriate privileges, you can
any object. Default relationship table attributes cannot be edited. Fo
attributes, see Relationships Tab (on page 104). If no non-default attributes are enabled for the 

 may be disabled. relationships table you are viewing, the Edit button
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Not  You cannot add, edit, or remove e relationship rules with the relationship table edit feature. 
For more information about relationship rules, see Relationships and Dependencies 
Between Objects (on page 103). 

To edit a relationship in Java Client: 

1. Open the object you want and click the Relationships tab. 

nt to edit. 

edit mode. 

Removing Relationships 

 

objects, select the object that you want to remove. 

2. In the table, select the rows you wa

3. Click the Edit button.The rows are in 

4. Make the changes, and click Save. 

To edit a relationship in Web Client: 

1. Open the object you want and click the Relationships tab. 

2. In the table, select the rows you want to edit. 

3. Click Edit.The fields become editable. 

4. Make the changes, and click Save. 
 

When you remove a relationship, it is removed from the Relationships tab of the current object and 
from the Relationships tab of the related object. Any rules associated with the relationship are also
removed. 

To remove a relationship in Java Client: 

1. In the table from which you want to remove 

2. Click the corresponding  Remove Relationships button. You are prompted to confirm your 
choice. 

To r

1. In the table from which you want to remove objects, select the objects you want to remove. 

2. 

emove a relationship in Web Client: 

Click the corresponding  Remove button. You are prompted to confirm your choice. 
 

at is a Relationship Rule? Wh

wor us of another Agile object. A relationship rule includes a Source Object, an Event, a 
g  the following sentence: 

 Result in the Target Object. 

à rkflow (for example, a change order 
e phase (for example, a part or a 

à hase of the Source 

Specifying a rule for a relationship defines the manner in which one Agile object can affect the 
kflow stat

Tar et Object, and a Result. The format of a relationship rule is shown in

When <Source Object> is <Event>, set <Target Object> to <Result>. 

That is, an Event in the Source Object triggers a

A Source Object can be either a routable object with a wo
or a program object) or a non-routable object with a lifecycl
document). 

An Event is a change in the workflow status or a change in the lifecycle p
Object. 
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à 

à status. 

When Part_D457 is Prototype, set Task_Promote_BOM_to_Prototype to Complete. 

061 to Initiated. 

uires that all other the 

cha
man ot 
occu e. In both cases, when all the required 

à 

e 
efine a different rule for each row. 

à dvance through their respective workflows simultaneously, you 

à 
ject’s workflow status changes 

n occur. 

A Target Object is always a routable object with workflow statuses. 

A Result is always a change in the Target Object’s workflow 

Here are some examples of relationship rules: 

When ECO_100 is Implemented, set ECR_334 to Closed. 

When ECO_565 is Released, set NCR_009 to Closed. 

When Part_945 is Production, set Task_Design_Assembly to In Process. 

When Document_934 is Prototype, set ECO_3445 to Released. 

When FileFolder0098 is Concept, set Audit_0

The resulting change in the Target Object’s workflow status also req
conditions required for the workflow to advance have been met. For example, for a change order to 
be released, it must pass a release audit. If the relationship rule triggering event occurs, but the 

nge order does not pass the release audit, its workflow status will not change. In a similar 
ner, if a change order passes its release audit, but the relationship rule triggering event has n
rred, the change order workflow status will not chang

criteria are fulfilled and the relationship rule triggering event has occurred, the Target Object’s 
workflow status will change. 

Relationship Rule Guidelines 
The following guidelines and restrictions apply to relationship rules: 

You cannot define a rule for a workflow object if no workflow has been selected for that object. 
Rules are based on workflow statuses and workflow statuses are defined by each workflow. If a 
routable object is Unassigned (it has no workflow assigned) then there is no identified list of 
statuses to select when defining a relationship rule. 

à Only one rule can be defined for each relationship table row. However, you can add the sam
object to the relationship table in multiple rows and d

If you want two objects to a
create relationship entries for each status. 

The Criteria Met column in the relationship tables indicates that the Source Object’s triggering 
event has occurred. If the triggering event is that the Source Ob
to Status_02, but the workflow status was manually changed to Status_03, skipping over 
Status_02, the Target Object’s event (workflow status change) will not occur. If you remove the 
relationship row or you remove the relationship rule, the Target Object’s event ca

à The Criteria Met field, once checked (the Complete icon  appears) is not “unchecked” if an 

à 

à 

à  

object is returned to earlier status for other reasons. 

A relationship rule causes the Target Object only to advance in its workflow, never to return to 
a status it has already left. 

A non-routable object with no workflow, for example, an item, can be a Source Object but it 
utable cannot be a Target Object. You can create a rule between a non-routable object and a ro

object only when the non-routable object is the Source Object. 

You can create a relationship without a rule between two lifecycle phase, non-routable objects.

Page - 110 Agile Product Lifecycle Management 

 

 



 Chapter 5  
 
 

Agile PLM will not allow you to create a rule between two non-routable objects. 

he 

à You 
relat
you m

The bject in a rule. 
That is, it allows you to specify a rule that triggers a modification (Result) in the Target Object. 

 objects, if you do not have “modify rule” 
p, in any rule you create, that object can be 

 modified when the rule criteria is met); it cannot 

Note lationships with rules defined for multiple statuses of a single routable Target 

à T relationship rule can be defined from the Relationships tab of either object. 

must have the appropriate “modify relationship” privilege for both objects to create a 
ionship without a rule between two objects. To create a rule between two related objects, 

ust, in addition, have the appropriate “modify rule” privilege for both objects. 

“modify rule” privilege allows you to specify a routable object as the Target O

When both objects in a relationship are routable
privilege for one of the objects in that relationshi
only the Source Object (because it will not be
be the Target Object. 

 If there are re
Object cks that related events that apply to earlier result statuses have 

re ng the workflow. For example, for a specific Target Object, if 
there a
Rele to 
Rele  satisfied. 

, the system che
been met befo  advanci

re events defined for both Submitted and Released statuses, and the events for the 
ased status are satisfied, the system will not advance the Target Object’s workflow 
ased status until the events for the Submitted status are also

 

Adding a Rule to a Relationship 
To add a rule to a relationship in Java Client: 

1. On the Relationships tab, select the table row of the related object to which you want to add a 
rule. 

2. Click the Add Rule  button. 

Note If the Add Rule button is disabled, it is not possible to add a rule to the selected 
relationship because both objects are non-routable objects. 

3. In the Relationship Rule dialog, use the drop-down lists to define the rule. 

4. When you are finished, click OK. 

To add a rule to a relationship in Web Client: 

lated object to which you want to add a 

 button in the preview pane, it is not possible to add a rule 

1. On the Relationships tab, select the table row of the re
rule. 

2. In the preview pane, click the Add Rule button. 

Note If there is no Add Rule
to the sel ted relatioec nship because both objects are non-routable objects. 

3. In the Relationship Rule dialog, use the drop-down lists to define the rule. 

To edit a rule to a relationship in Java Client: 

ated object to which you want to edit a 

4. When you are finished, click Save. 
 

Editing a Relationship Rule 

1. On the Relationships tab, select the table row of the rel
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rule. 

2. Click the Edit Rule  button. 

3. In the Relationship Rule dialog, use the drop-d

4. When you are finished, click OK. 

own lists to edit the rule. 

 Rule button. 

p-down lists to edit the rule. 

 of the related object to which you want to remove 

To edit a rule to a relationship in Web Client: 

1. On the Relationships tab, select the table row of the related object to which you want to edit a 
rule. 

2. In the preview pane, click the Edit
3. In the Relationship Rule dialog, use the dro

4. When you are finished, click Save. 
 

Removing a Relationship Rule 
To remove a rule to a relationship in Java Client: 

1. On the Relationships tab, select the table row
a rule. 

2. Click the Remove Rule  button. 

1. On th ve 
a rul

3. You
 

Re
This ditional information about relationships as they are used in the PQM solution: 

o
 the blank rule to define how you want the PQM objects to 

à 

, set <PSR target object> to <result> 

 displayed on the PSR Items table of the QCR. If 

d the 

When <PSR source object> is <event>, set <QCR target object> to <result>. 

3. You are prompted to confirm your choice. 

To edit a rule to a relationship in Web Client: 

e Relationships tab, select the table row of the related object to which you want to remo
e. 

2. In the preview pane, click the Remove Rule button. 

 are prompted to confirm your choice. 

lationships in PQM 
 is some ad

Imp rtant When relationships are created between PQM objects, a blank rule is created for the 
relationship. You must edit
affect each other. 

When a QCR affects the PSR, that is, when a QCR and PSR are related and the relationship 
rule follows the format: 

When <QCR source object> is <event>

all items from the PSR Affected Items tab are
the PSR was used to aggregate multiple PSRs, then the related PSRs’ affected items are 
displayed. 

à When this QCR is affected by a PSR, that is, when the QCR and the PSR are related an
rule follows the format: 
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a ms from the PSR Affected Items tab and the related PSR’s affected items are not displayed 
o e PSR Items table of the QCR. 
ll ite
n th

s 
and “hard” deletes. When you soft-delete an object in the 

ed object is marked “Deleted” in the database, 
t create another object with the same type and 

Deleting Agile Object
Java Client and Web Client support “soft” 
database, it is not permanently deleted. A soft-delet
and its object number is reserved. You canno
number as a soft-deleted object. 

Note You can undelete a soft-deleted object, if you have the appropriate privileges. If you need 
to do so, but do not have privileges, contact the Agile administrator. 

This se ion contains the following topics: 

Deleting an Object

ct

à Soft-  (on page 115) 

leting an Objectà Unde  (on page 115) 

à Hard-Deleting an Object (on page 116) 

When you run a search, soft-deleted objects do not appea
soft-dele ed objects, you must run the predefined dele

r in the search results table. To locate 
t ted object searches in the Recycle Bin Searches 

folder. 

You have access to the Recycle Bin Searches folder if Recycle Bin Searches is included in the Note 
Searches field of your user profile. If you have the appropriate privileges, you can edit your 
user profile and add Recycle Bin Searches to the list of searches in the Searches field. If you 
do not have the appropriate privileges to modify the Searches field in your user profile, ask 

 Agile admthe inistrator to modify your user profile. 

A  object is permanently removed fr se. 

n You ca

Before you can d

Note You canno re removed. 

 hard-deleted om the databa

Cautio nnot undelete a hard-deleted object. 

elete an object, it must meet the conditions described in the following table. 

t delete an object unless all of its relationships and subscriptions a
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Class  or  You can dele te  th is  k ind of  ob ject  that  meets  the fo l lowing 
base c lass  condi t ions:  
of  ob ject  

Item à The item has no released changes against it. 
The item is not listed on the Affected Items tab of any pending change. (You must
remove the item from the Affect

à  first 
ed Items tab of each pending change before you can 

p
à The item is not used on any other item's Bill of Materials, that is, the item to be deleted is 

delete the item.) 
à The item has no content on its BOM tab for the current revision or any pending 

revisions. 
à The item has no content on its Manufacturers tab for the current revision or any 

ending revisions 

not a child item on the BOM tab of a parent item revision, including the  latest released 
revision, past released revisions, or pending revisions of the parent item. 

Change  Agile 

à T
à You have Discovery and Read privileges for any items on the Affected Items table, 

Note the 
nrelease a change by using the 

à You created it; or you are the change analyst or component engineer, and the
administrator has given change analysts or component engineers the appropriate 
privileges to delete a change. 

he change is at the Pending status type or the Unassigned status. 

otherwise, you cannot delete the change. 
To delete a change that has already been released, you must first unrelease 
change. You need the appropriate privileges to u
Workflow tab to switch it to a different status. 

Manufacturer eck the Where Used tab of the 

elete 
s 

à It is not listed on the Manufacturers tab of an item. (Ch
manufacturing object.) 

à If the object is a manufacturer, no manufacturer parts are associated with it. 
Note If all manufacturer parts associated with a manufacturer have been deleted, then the 

manufacturer can be deleted as well.  However, you will not be allowed to und
the soft-deleted manufacturer parts until the soft-deleted manufacturer object i
undeleted. 

Site Note

à 

Note

here it is listed. 

isabled, but 

 Unlike other Agile objects, site objects can be soft deleted, but soft-deleted sites 
cannot be undeleted or hard deleted. If you are no longer using a site, Agile 
recommends that you disable it. 

à The site does not appear on any item’s Sites tab. 
à The site is not associated with any other Agile object. 

The site has a lifecycle of Disabled. 
 If it meets the conditions listed above, a disabled site can be soft-deleted even when it 
is listed in the Sites or Default Site field of user profiles. The deleted site is 
automatically removed from the Sites list in any user profile w

Once the site has been associated with an item, you can change its status to D
you cannot delete it. 

Package , and the Agile administrator has given 

à T

à 
program managers the appropriate privileges to delete a package. 

he package is at the Pending status type or the Unassigned status. 

You created it; or you are the program manager
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Class  or  You can dele te  th is  k ind of  ob ject  that  meets  the fo l lowing 
base c lass  condi t ions:  
of  ob ject  

Transfer 
Order 

ven you the appropriate privileges to 
delete a transfer order. 

à The transfer order is at the Pending status type or the Unassigned status. 

à You created it, or the Agile administrator has gi

PSR or QCR à You created it; o
engineers the ap

r the Agile administrator has given change analysts or component 
propriate privileges to delete a PSR or QCR. 

ending status type or the Unassigned status. 
es for any items on the Affected Items table, 

 it. 

à The PSR or QCR is at the P
à You have Discovery and Read privileg

otherwise, you cannot delete the PSR or QCR. 
Note To delete a PSR or QCR that has already been released, you must first unrelease

You need the appropriate privileges to unrelease a PSR or QCR by using the 
Workflow tab to switch it to a different status. 

RFQ à The RFQ has no released changes against it. 

 
 

Soft-Deleting an Object 

To soft-delete an object in Java Client: 

1. Select and open the object you want to delete. 

2. Click the Delete button , and respond Yes to the confirmation prompt. 

no longer available for use. However, until it is hard-deleted, its 
se and cannot be reused. 

t: 

t to delete. 

for use. However, until it is hard-deleted, its 
 Agile database and cannot be reused. 

The object is soft-deleted. It is 
number or name is reserved in the Agile databa

To soft-delete an object in Web Clien

1. Select and open the object you wan

2. Choose Actions > Delete, and respond OK to the confirmation prompt. 

The object is soft-deleted. It is no longer available 
number or name is reserved in the 

See also: Deleting Agile Objects (on page 113), Undeleting an Object (on page 115), and Hard-
Deleting an Object (on page 116). 

Undeleting an Object 

You can undelete soft-deleted objects. 

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder. 

ant to restore. 

To undelete an object in Java Client: 

2. Open the deleted object you w

3. Click the Undelete button . 
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To undelete an object in Web Client: 

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder. 

2. Open the deleted object you want to restore. 

3. Choose Actions > Undelete. 
 

See also: Deleting Agile Objects (on page 113), Soft-Deleting an Object (on page 115), and Hard-
Deleting an Object (on page 116). 

Hard-Deleting an Object 

To hard-delete a soft-deleted object (if you have the appropriate privileges) in Java Client: 

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder. 

2. Open the object. 

3. Click the Delete Object button

Soft-deleted objects still exist in the database. To remove an object permanently, you hard-delete it. 
While an object is still only soft-deleted, you can undelete it. Run the appropriate Deleted object 
search from the Recycle Bin Searches folder. 

, and respond Yes to the confirmation prompt. 

To hard-delete a soft-deleted object (if you have the appropriate privileges) in Web Client: 

1. Run the appropriate Deleted <objects> search from the Recycle Bin Searches folder. 

2. Open the object. 

3. Choose Actions > Delete, and respond OK to the confirmation prompt. 
 

See also: Deleting Agile Objects (on page 113), Undeleting an Object (on page 115), and Soft-
Deleting an Object (on page 115). 
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� Schedule Tab....................................................................................................................................................... 125 
� Historical Report Tab ........................................................................................................................................... 126 
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� Working with Standard Reports ........................................................................................................................... 127 
� Working with Custom Reports ............................................................................................................................. 128 
� Working with External Reports ............................................................................................................................ 132 
� The Report Output Window ................................................................................................................................. 133 

 
 

About Reports 
Reports provide you with the basic information you need to analyze your business processes. By 
accessing and summarizing this information in a meaningful way, reports provide an insight into 
your business processes and can help guide better-informed decisions. Agile PLM provides a 
robust reporting platform that allows you to: 

à Measure and monitor business performances using standard out-of-the-boxes reports. These 
standard reports capture the best practices in product lifecycle management business 
processes. 

à Configure reports with Agile's custom reporting to obtain the specific information you need. 

à Use a single point of access to all relevant reports - even those developed outside of the Agile 
PLM application - through Agile's external reporting capability.       

 

Types of  Reports 
Agile provides the following types of reports: 

Report  type Image 
type  

Descr ipt ions 

Standard Reports   Standard reports provide you with the information you commonly need 
to analyze your business processes. You select predefined criteria and 
specify the results you want. 

Each solution has its own set of reports. Specific reports are described 
in the user guides. 

For more information, see Working with Standard Reports (on 
page 127). 
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Custom Reports  You can create custom user-specific or company-specific reports 
directly within Agile. You define your query using the Query Definition 
feature, which is similar to an Advanced Search. The custom reports 
provide a high level of flexibility. You can select which objects to report 
on, define the filtering criteria, and specify report output. 

For more information, see Working with Custom Reports (on 
page 128). 

External Reports  You can create reports outside of Agile using any third-party solution, 
such as SDK or other tools. Then you can create linked access directly 
within Agile to launch those external reports. This is accomplished 
through configuring process extensions in Agile Administrator and 
adding URLs. 

For more information, see Working with External Reports (on 
page 132) and see Agile PLM Administrator Guide. 

 
 

How Your Roles and Privileges Affect Reports 
The reports that you are allowed to manage or run, and the content of those reports, are affected by 
the privileges assigned to you, for both business objects and report objects. 

You can create, view, edit and delete reports depending on the roles and privileges assigned to 
you. To run a report on a particular type of object, a user must be granted the following privileges:   

à Business object privileges 

If you do not have the Discovery privilege for a given business object, you cannot include that 
object in a report. Parts for which you do not have the Discovery privilege are displayed in the 
same way as they are displayed on BOMs. 

All the Discovery privileges that are set up for your Agile content will be observed when you run 
a report with that content, including all Discovery-related SmartRule settings and warnings that 
the Agile administrator has specified. For more information about Discovery privilege and 
SmartRules, see Agile PLM Administrator Guide. 

à Report object privileges for standard reports 

To run and view standard reports, you must have Run Report, Discover, and Read privileges 
for the standard report you want to run. Agile supplies a number of predefined roles that 
provide the ability to use specific types of business objects and to run standard reports relating 
to those business objects. For example, depending on your assigned roles, you may be able to 
run standard reports in the Products Reports folder, but not standard reports in the Quality 
Reports folder. 

à Report object privileges for custom reports 

In addition to Run Report, Discover, and Read privileges, custom reports require additional 
privileges: Create, Delete, Modify. The Undelete, SaveAs and Send privileges provide 
additional custom report capabilities.  

à Report management privileges 

To modify and delete report schedules and layouts, or to create and delete global reports 
folders, you need the Manage Report privilege. 
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The Agile-provided predefined roles Report User and Report Manager contain the privileges you 
need to work with custom reports. 

Note In addition to assigning Agile-provided predefined roles, your Agile administrator is able to 
create customized roles for your company. Your assigned roles (either predefined roles or 
customized roles) determine which types of standard reports you can run and whether or 
not you are able to create and run custom reports. 

For more information about the privileges that affect reports or about roles and predefined roles, 
see Agile PLM Administrator Guide. If you have questions about your assigned roles and privileges 
or about your ability to run reports, contact your Agile Administrator. 

General Info Tab 
The General Info tab contains the general information about the reports. It has the following fields by 
default; your Agile Administrator may have modified the fields: 

à Name — the name of the report. 

à Report Type — indicates the report type (subclass) for each class of reports. 
y Standard Report Type — indicates the standard report type, either Standard or Administrator. 
y Custom Report Type — indicates the custom report type (subclass). The default is Custom 

Report; your Agile administrator may define additional custom report types. 
y External Report Type — indicates the external report type (subclass). The default is External 

Report; your Agile administrator may define additional external report types. 

à Description — text that describes the report. 

à Folder — click  to specify the report folder location. You can choose to share or not share 
cation with users. the report folder lo

Query Definià tion — (Custom Reports only) allows you to define criteria on which to base the 

à ternal Reports only) a drop-down list of Process Extensions that are set 

à 
y ort cannot be executed because 

y hase is Inactive if no Process Extension is defined, and 

à  — the name of the user who created the report. This field is blank on standard 

à General Info tab, click 

search. 

Process Extension — (Ex
by your administrator. 

Lifecycle Phase — the lifecycle phase of the report: Active or Inactive. 
Custom Report — the lifecycle phase is Inactive if the rep
it does not have a query defined or a layout defined yet. 
External Report — the lifecycle p
the report cannot be executed. 

à Create Date — the date the report was created. 

à Modified Date — the date the report was last saved. 

Create User
reports. 

This tab has the following buttons standard: 

Edit — appears when the General Info tab is not in edit mode. To edit the 
Edit. 
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Custom reports include the following General Info tab edit variations: 
y 

y u 
es 

à  

à Cancel — app en the General Info do the changes that you 

You can use the Actions menu on the General Info tab to perform various actions on the standard 
ng. 

For more detailed information about bookmarking and other commonly used functions, see 
Client

Edit Information — appears when the custom report General Info tab is not in edit mode and 
you place the pointer over the Edit button. To edit the General Info tab, click Edit Information. 
Edit Query — appears when the custom report General Info tab is not in edit mode and yo
place the pointer over the Edit button. To edit the query, click Edit Query. Make any chang
to the query on the Define Query page. To save changes that you made on the Define 
Query page, click Finish. 

Save — appears when the General Info tab is in edit mode. To save the changes that you made
to the tab while it was in edit mode, click Save. 

ears wh  tab is in edit mode. To un
made to the tab while it was in edit mode, click Cancel. 

report. These commands are Bookmark, Save As, Delete, Copy URL to Clipboard, Send, and Shari

Navigating in Agile Web  (on page 23). 

. To edit the information on the Layout tab or to delete a layout, select 
d click Edit or Delete. 

à 

You can create layouts for standard rep rts that are available only to you (personal layouts), or 

Layout Tab 
Some standard reports do not include a Layout tab; the layout is predefined for you. For example, 
the IP Transfer does not include a Layout tab. 

Use the Layout tab to add or modify a standard report or a customized report layout with the fields 
your business requires in the required order. 

To create a layout, click Create
the appropriate checkbox, an

Standard report layouts 

Each standard report that includes a Layout tab has a default layout. If you have the appropriate 
privileges, you can edit the default layout. 

o
you can make the layouts available to all users (global layouts). 

To edit the layout fields, click the Layout   icon. You can select fields from the Available 
Values list. Some standard report layouts allow you to select values for a main heading and an 

eading. For information, see Creating Standard Report Layoutsadditional subordinate h  (on 

à 

 you create a new custom report. You 
can create layouts for custom reports that are availabl nal layouts) or you 

page 121). 

Custom report layouts 

The custom report default layout is the one created when
e only to you (perso

can make layouts available to all users (global layouts). 

To edit the layout fields, sorting and grouping, click the Layout   icon. You can select fields 
e the filter criteria on the Select Layout Fields page. 
port Layouts

from the Available Fields list. You can chang
For information, see Creating Standard Re  (on page 121). 

The Layout tab contains the following buttons: 
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à Edit — lets you edit the attributes like paper size, orientation on the Layout table. 

g fields by default; your Agile administrator may have modified the 

ch as Legal or Letter. 

à Orient  — the page orientation: Landscape or Portrait. 

ser who created the report. 

youts you want to edit, and then click Edit. 
3.  In the Name, Access, Paper Size, and Orientation fields, make the desired modifications. 

Clic

Note arty solution that generates the 

à Delete — deletes the layouts you have selected. 

à Create — lets you create a layout using the Create Report Layout wizard. 

The Layout tab has the followin
fields: 

à Name — the layout name. 

à Access — indicates whether the layout is available to all users (Global) or only to you 
(Personal). 

Paper Size — the size of the paper the report will be printed on, su

ation

à 

à Owner — the name of the u

To edit the Layout tab table: 

1.  Display the Layout tab. 

2.  Select the la

4.  k Save. 

External reports do not have a Layout tab. The third-p
report also defines the report layout. If you have que
Agile PLM system, contact your Agile administr

stions about external reports on your 
ator. 

 

Creating Standard Report Layouts 
Use the Create Report Layout wizard to create a new layout for a standard report. 

About Standard Report Layouts with Multiple Headers 
Some standard report layouts include two headings in both the Available Values list and in the 
Selected Values. list. The values under the first header are field attributes of the object the report is 
intended to locate. The values under the second header are field attributes of objects that are 
subordinate to the report object. For example, in layouts for the Change Activity report, the values 
under Main Header Attributes are fields of the change objects upon which Agile PLM is reporting. The 

ilar manner, the 
for field 

Whe

à sort each header section independently. For example, you can sort the attributes 
 

values under the Affected Items header are fields of the affected items of each change that appears 
in the report. 

When you run the Change Activity report, each change is listed in its own row. Under each change 
row are rows with a different background color that list each of the affected items of the change; 
these affected items appear on the Affected Items tab of the change object. In a sim
Item Manufacturers report has a header for item field attributes and a subordinate header 
attributes of the manufacturer parts that are listed on the item’s Manufacturers tab. 

n you create a standard report layout with multiple headers, keep these tips in mind: 

You can 
under the main header without affecting the order of the attributes under the subordinate
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header. 

The Available Valuesà  list is also organized by headers. You must select values under the 

à uired to specify any attributes under the subordinate header. For example, in a 

à -

d 

also be available. For example, under Affected 
Items.BOM you can select field attributes of the items that appear on the BOM tabs of the 

 Items tab. For example, you might select 

To c

t the report you want customize. Click the Layout tab, and then 

2. 

lobal—available 

4. 

5. ctivity 
report allo ders and price change orders. 

 only a few specific report layouts. If you do not 

appropriate Available Values header in order to add it under the corresponding Selected Values 
header. 

à Attributes under one header cannot be moved to be under a different header, although you can 
select as many attributes as you want under each header. 

You are not req
Change Activity report, if there are no values under the Affected Items header in the Selected 
Values list, then no affected items will be listed on the report; only a list of changes will appear 
on the report. 

The Change Package report, which assembles all the information about a change in an easy
to-read, printable format, includes more than two headers in the Available Values and Selected 
Values lists. Each tab of the change object has a header (for example, Cover Page, Affecte
Items, or Workflow). In addition, depending on which type of change you select in the Layout 
Type drop-down list, additional headers may 

affected items listed on the change’s Affected
Items.BOM.Qty and Items.BOM.Find Num. 

 

Creating the Standard Layout 
reate a standard report layout: 

1. In the navigation pane, selec
click Create. The Create Report Layout wizard appears. 

Type a name for the layout. 

3. In the Access list, select the location for the layout. Your report layout can be G
to all—or Personal—available only to you. 

Select the paper size and orientation from the corresponding drop-down lists. 

If there is a Layout Type list, choose a layout type from the list. For example, the Change A
ws you to create layouts for change or

Note The Layout Type list appears on
see a Layout Type list, ignore this step. 

6. 
y o the Selected Values list, select them in the Available Values list, and double-

y e values from the Selected Values list, select them and double-click (or click the left 

 to 

7. 
ria

informatio

Select the fields you want in the report. 
To add values t
click (or click the right arrow button). 
To remov
arrow button). 

y To change the order of fields, select a field and use the up arrow or down arrow button
move it. 

If there are multiple headers in the Available Values and Selected Values lists, select the 
approp te values under each header and arrange them in the order you want. For more 

n, see About Standard Report Layouts with Multiple Headers (on page 121). 
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Note Multiple headers do not appear on all standard report layouts. If you see only 
one header (for example, Main Header Attributes) in the Selected Values list, 
ignore this step. 

8. When you are finished, click Save
 

. 

ard to create a new layout for a custom report. 

1. stomize. Click the Layout tab, and then 

3. In 
to a

4. e

5. 
y lues to the Selected Values list, select them in the Available Values list, and double-

e left 

 arrow or down arrow button to 

6. In d. 

chec rther organize the report data. 
t level Sort By list is applied to all the report rows. 

e any ties in the first level of sorting. 
ny ties in the second level of sorting. 

You edit
the infor

Creating Custom Report Layouts 
Use the Create Report Layout wiz

To create a custom report layout: 

In the navigation pane, select the report you want cu
click Create. The Create Report Layout wizard appears. 

2. Type a name for the layout. 

the Access list, select the location for the layout. Your report layout can be Global—available 
ll—or Personal—available only to you. 

Sel ct the paper size and orientation from the corresponding drop-down lists. 

Select the fields you want in the report. 
To add va
click (or click the right arrow button). 

y To remove values from the Selected Values list, select them and double-click (or click th
arrow button). 

y To change the order of fields, select a field and use the up
move it. 

the Sort By and Then By lists, you can specify how you want the report data to be sorte
Select Ascending or Descending to specify the sort order. You can also select the Group By 

kboxes to fu
y The firs
y The second level Then By is applied if there ar
y The third level Then By is applied if there are a
y Group By organizes the report by grouping the results according the value selected in the 

sort-by list. 

7. Click Save. 
 

Editing Standard Report Layouts 
 a report layout o e Report Layout Details page. For information about how to change 
mation in the fields on the Layout tab, see Layout Tab

n th
 (on page 120). 

To e

1. Disp
y , and then 

dit a standard report layout: 

lay the Report Layout Details page in one of the following ways: 
In the navigation pane, select the repor u want customize. Click the Layout tabt yo

click the Layout  icon for the layout you want to edit. The Report Layout Details page 

y ze. Click the 

appears. 

Select the report you want to customi  Execute button. On the Select Layout 
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and Configuration page of most Report wizards, click Layout Manager. The Report Layout 

Details page appears. Click the Layout  icon for the layout you want to edit. 

nge the fi2. Cha elds you want the report to include, as necessary. 
 double-

the left 

y To change the order of fields, select a field and use the up arrow or down arrow button to 

3. If there are multiple headers in the  and Selected Values lists, select the 

ultiple Headers

y To add values to the Selected Values list, select them in the Available Values list, and
click (or click the right arrow button). 

y To remove values from the Selected Values list, select them and double-click (or click 
arrow button). 

move it. 

Available Values
appropriate values under each header and arrange them in the order you want. For more 
information, see About Standard Report Layouts with M  (on page 121). 

r changes to the layout. 

You edit
the infor ds on the Layout tab, see page 6-4. 

To e

1. Disp
y n 

4. Click Save to save you
 

Editing Custom Report Layouts 
 a report layout on the Re rt Layout Details page. For information about how to change 
mation in the fiel

po

dit a report layout: 

lay the Report Layout Details page in one of the following ways: 
In the navigation pane, select the report you wan stomize. Click the Layout tab, and thet cu

click the Layout Manager  icon for the layout you want to edit. The Report Layo
page appears. 

ut Details 

y Select the report you want to customize. Click the  Execute button. On the Select Layout 
and Configuration page of the Custom Report wizard, click Layout Manager. The Report 

Layout Manager page appears. Click the Layout  icon for the layout you want to edit. 

2. Cha elds you want the report to include, as necessary. 
t, and double-

y To remove values from the Selected Values list, select them and double-click (or click the left 

To change the order of fields, select a field and use the up arrow or down arrow button to 

nd select or clear the Group By checkbox as necessary. 

changes to the layout. 

You can delet ed. 

The Report Layout Details page appears. 

nge the fi
y To add values to the Selected Values list, select them in the Available Values lis

click (or click the right arrow button). 

arrow button). 
y 

move it. 

3. Change the sort order a

4. Click Save to save your 
 

Deleting Report Layouts 
e report layouts that are no longer us
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To delete a report layout: 

1. Display the Layout tab. 

2. Select the layouts you want to delete, and then click Delete. A confirmation message appears.
Click OK in the confirmation message. 

 

Note You must retain at least one layout. 
 

Schedule Tab 
Use the Schedule tab when you want a report to run base
date and time. You can add, edit, or delete the schedules. 

d on a specific schedule or on a specific 

You

This tab ha

Schedule tab. 

 a new schedule frequency (Run Once, Every Day, Weekdays, Mondays, 
 Fridays, Saturdays, Sundays, First Day of the Month, and 

edule using the Report wizard. 

 the 
field

 must have the appropriate privileges to work with the Schedule tab. 

s the following buttons: 

à Edit — lets you edit the schedule. The Edit button affects only the schedules you have selected 
on the 

à e — deletes the schedules you have selected. Delet

à Create — lets you add
Tuesdays, Wednesdays, Thursdays,
Last Day of the Month) to the report sch

The Schedule tab has the following fields by default; your Agile administrator may have modified
s: 

à  — click to view the schedule details of the report being run for the schedule. They c

The layout selected 

an be: 

à 

à 

tions: Run Once, Every Day, 
s, Tuesdays, Wednesdays, Thursdays, Fridays, Saturdays, Sundays, First 

nth. 

rt should run. You specify the date only if the 
 any other schedule, you specify only the time. 

à 

1. 

3. 

à Fields filled out in the report wizard 

Parametric fields (custom reports only) 

à Enable — select Yes to activate the schedule and run reports automatically, or select No to 
disable the automatic schedule. 

à Schedule Frequency — a drop-down list with the following op
Weekdays, Monday
Day of the Month, or Last Day of the Mo

à Schedule Time — the date and time when the repo
Schedule Frequency option is set to Run Once. For

à Share W/Users — list of users who will be notified when the report is generated (based on the 
schedule) and who will have access to the reports generated from the schedule. 

Owner — the name of the user who created the schedule. 

To create a schedule: 

Display the Schedule tab for the report. 

2. Click Create. The Add Schedule wizard appears. 

Follow each step in the wizard in order to define and specify your report. These are the same 
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wizard steps you use when you click the Execute button to run the report. For details about 
running specific reports, see the appropriate user guide. 

The last wizard step in the Add Schedule wizard is the Define Schedule page. 

Run Once, click the calendar button and select a date. Specify the time you want 
ult time is 12:00 a.m. If you want to enter a time to run the report, use 

he t

6. If you rt. 
The 
the report at 8 p.m., enter 08:00 PM 

4. On the Define Schedule page, in the Schedule Frequency drop-down list, select Run Once, or 
select the recurring day you want the report to run. 

5. If you select 
the report to run. The defa
t ime format hh:mm:ss AM or PM. For example, to run the report at 8 p.m., enter 08:00 PM 

 select a recurring day you want the report to run, you can specify a time to run the repo
default time is 12:00 a.m. Use the time format hh:mm:ss AM or PM. For example, to run 

7. Click  next to the Share with Users field
this report. 

 to select the names of users who will have access to 

n 

8. Click Finish. 

Note External reports do not have a Schedule tab. If there is a schedule, the third-party solutio
that generates the report also defines the report schedule. If you have questions about 

t your Agile aexternal reports on your Agile PLM system, contac dministrator. 
 

Historical Report Tab 
 can save the report results. The Historical Report tab displays all previously 

me stamp and the name of the user who executed the 
opriate checkbox and click Sharing. To delete or view a 

 click the 

After you run a report, you
saved report instances with a date and ti
report. To share a report, select the appr
report, select the appropriate checkbox, and click Delete or View. 

To save the generated report as a historical report,  Save button in the Report Output 
d not access 

that instan

schedule, then the Type field in the report displays 

ow of the selected report. 

isto

win ow. If you do not save a report, once you close the report results window, you can
ce of the report again. 

If a historical report is generated according to a 
Sch e Generated. edul

This tab contains the following buttons: 

à Sharing — lets you specify other users who can view the selected report instance. 

à Delete — deletes the selected report instance. 

à View — lets you view the generated Report Output wind

The H rical Report tab has the following fields: 

 — lets you view the generated Report Output window of the selected report. 

s the date and time the report was generated. 

rical report is saved by the user or generated by a schedule. 

à 

à Create Date — indicate

à Type — indicates if the histo

à Share W/Users — users who can view this report instance. 
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à Owner — the name of the user who created the report. 

Note External reports do not have an Historical Reports tab. If you have questions about external 
reports on your Agile PLM system, contact your Agile administrator. 

 

Hi

automatically. 

The History table has the following columns by default; your Agile administrator may have modified 

ad

à Comments — comments made by users. 

Working with Standard Reports 
r business 

processes. You select predefined crite  and specify the results you want. These out-of-the-box 
. Y outs, 

 standard reports from Java Client, Agile PLM opens a Web Client window 

story Tab 
The History tab shows a summary of actions taken on the report. This tab is completed 

the table: 

à Action — the action that was taken. 

à User — the user who took the action. 

à Local Client Time — the time that the action was taken, according to the time zone of the user 
viewing the History table. 

à Details — the description of the action (for example, the description of the change that was 
m e). 

 

Standard reports provide you with the information you commonly need to analyze you
ria

reports are applicable in most situations ou can run them as they are, modify the default lay
or create your own layouts. You can run Agile reports from Agile Web Client or Java Client. 

Note When you run 
with the selected report displayed. 

 

You  + button next to Reports in the left pane to view the top-level folders such as 
Produc

To e rd report, click the 

Accessing Standard Reports 
 can click the

ts Reports and Process Reports. You can access the reports from these folders. 

xecute a standa  Execute button and follow the wizard steps. If the 
you click 

the 

standard report does not have any wizard steps, the report is generated immediately after 

 Execute button. 

à For information about standard report layouts, ard Report Layouts see Creating Stand  (on page 
iting Sta121) and Ed ndard Report Layouts (on page 123). 

à For information about scheduling standard reports, see Schedule Tab (on page 125). 

bou s tab, see Historical Report Tabà For information a t standard reports Historical Report  (on 
page 126). 
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à For information abou  guide, listed in the 
following table. 

The Standard Reports folde ins the predefined folders as listed in the following table. 

t running standard reports, refer to the appropriate user

r conta

Report  fo lder  Descr ipt ion  and locat ion to  f ind more informat ion  about  
speci f ic  reports  

Product Reports s the standard Product Collaboration (PC) reports. 

uct Collaboration Guide. 

Contain

For more information about these reports, see Prod

Administrator Reports Contains all administrator user reports. 

For more information about these reports, see Agile PLM Administrator Guide. 

Sourcing Reports Contains the standard Product Cost Management (PCM) reports. 

For more information about these reports, see Product Cost Management Us
Guide. 

er 

Quality Reports 

rmation about these reports, see Product Quality Management User 

Contains the standard Product Service and Improvement (PQM) reports. 

For more info
Guide. 

Process Reports 

ser 

Contains reports for changes and transfer orders. 

For more information about these reports, see Product Collaboration Guide. 

For more information about the IP Transfer Report, see Agile Content Service U
Guide. 

Program & Portfolio 
ts 

Contains standard reports for Product Portfolio Management (PPM) solutions. Sub 
folders include End User Reports, Portfolio Reports, Program Reports, and 
Resource Pool Reports. 

For more information about these reports, see Agile Product Portfolio Management 

s, then the Portfolio Analytics 
Analytics Program & Portfolio Reports 

Repor

User Guide. 

If your company has installed Portfolio Analytic
reports appear in the  folder under the 
folder. For more information, see Portfolio Analytics User Guide. 

Compliance Reports Contains the standard Product Governance & Compliance (PG&C) reports. 

For more information about th
Compliance User Guide. 

ese reports, see Agile Product Governance and 

 

 
 

Working with Custom Reports 
You can create user-specific or company-specific reports directly within Agile. When you define 

 for 
up. 

You can customize reports in the following ways: 

your query on the Define Query page of the Custom Reports Creation wizard, the search looks
objects with fields that match the search conditions that you set 
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à Change the way each report looks by editing the report layout. 

en you want a report to be executed. 

If yo
spe

To c

2. 

4. 

à Specify a schedule (date and time) wh

à Save and view report instances. 

à See what actions have been taken on the report. 
 

Creating a Custom Report 
u have the appropriate roles and privileges, you can create any user-specific or company-

cific custom report from the Create icon on the main toolbar. 

reate a custom report: 

1. Click Create Report > Custom Reports. 

The Custom Reports Creation wizard appears. Select the subclass, and type a name for the 
report. 

3. Click the Continue Creation in Wizard checkbox. Click Continue. 

On the General Information page, enter a description. Click  next to the Folder field to select
a folder in which to save the report. The Select Folder window appears. All the available re
folders are listed on the left side in the Available F

 
port 

olders list. Select a folder from the Available 
s lis  one or 
 fold on 

General I

an click the appropriate radio button to 
complete the remaining fields, and click 

ppears. In this wizard step, you specify which fields to include 
results table. To include a field, move it to the Selected Values 

ecify how you want the report data to be sorted. 

in this step are saved as the Default Layout for the 

Folder t and click the right arrow to move it to the Selected Folders list. You can select
more er locations. Click OK. The folder field is populated with the selected folder name 

nformation page. Click Next. 
5. The Define Query page appears. On this page, you c

create a new query or select from an existing query, 
Next. The options are described in the following section. 

6. The Select Output Fields page a
in the report and how to sort the 
list. In the Sort By and Then By lists, you can sp
Select Ascending or Descending to specify the sort order. You can also select the Group By 
checkboxes to further organize the report data. 

Note The settings you specify 
report. For more information about custom report layouts, see Creating Custom 
Report Layouts (on page 123). 

7. e last step. 

Cr
m 

the pe and Search For fields, and specify at 
s

à  the type of object (class or subclass) that you want to search for—for example, 

Click Finish when you have completed th

You can view general information about the newly created report on the General Info tab. 

eating a New Query 
If you select the Create New button on the Define Query page, you can create your own query fro

drop-down lists. For a new query, complete the Search Ty
lea t one search condition. Click Next. 

This wizard step contains the following options: 

Search For —
ECO, document, or manufacturer part. 
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à t you are creating. An Object search finds Agile objects 

 

à 
 that you enter them. 

 

n 

 prompt the report user to fill in the value when 
heckbox, the Value field is disabled and you 

zard step. See also 

Search Type — the type of search tha
that match the search conditions. A Where-used search finds the assemblies that use the items 
defined by your search criteria. The assemblies in which the defined items are used appear in
the search results. 

Match Case — if checked, the search will be case-sensitive; that is, it will find uppercase or 
lowercase values exactly the way

à Clear button — clears the information on this page. 

à Field — the field on which you want to search. The contents of this list depend on the Search
For value. 

à Match If — a search operator, such as Equal To or Contains. The contents of this list depend o
the value specified in the Field field. 

à The Prompt? field — check this box if you want to
the custom report is executed. If you check the c
do not enter a value now as you create the custom report query; however, when you execute 
the custom report, you will be prompted to enter a value in a wi Executing 
Custom Reports (on page 131). 

e à Value — the value for which you want to search. Click th  button and specify a value. 

n you specify multiple search conditions. If you want both conditions to be 

lient to group or ungroup conditions. In 
ckets to group conditions in 

low 

à Validate b

For more deta  Data with Searches

à And/Or — for whe
met, select And. If only one condition needs to be met, select Or. 

à Add ( ), Add [ ], and Remove ( ) buttons — tell the Web C
most searches, use parentheses to group conditions. Use bra
workf searches. 

utton — verifies that the query is valid. 

iled information about defining a query, see Finding Agile  (on 

eral Info tab on the Cover page.  

page 135). 

Conditions to Edit and Save a Query 
To edit a Query:  

1. Choose Edit Query under the Gen

2. In the Define Query page, edit the necessary fields.  

Note Layout settings can be affected when you edit a query. If you edit the values in 
the Search For, Search Type, or With Related Content fields, custom layout 
settings are reset to default layout settings. If you only edit the fields under 

ned. Criteria Conditions, custom layout settings are retai

3. Click Finish. 

The General Info page is then displayed with the latest details that have been entered in the Define
Query page.  

 

earch Using a Saved S

If you select the Use Saved Search button on the Define Query p e, you can click ag  to select an 
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existing search to customize. The Define Query page appears. All the search criteria are copied 
from the saved search. You can modify the criteria to suit your needs. Default Layout output fields 

copied from the output display of the saved search. are 

Ex
u les 

and privile splayed only in 
Web

1. 

ecuting Custom Reports 
Yo  must have sufficient privileges to execute a report. For more detailed information about ro

ges, see the Agile PLM Administrator Guide. The report outputs are di
 Client. 

To run a custom report: 

Select the report that you want to execute, and click the   Execute button. 

2. In the report wizard, select a layout or click the Layout Manager   icon to create a new layout. 
more information aboutFor  custom report layouts, see Creating Custom Report Layouts (on 

Whe sabled, click Next. 
3. e 

the required information. Click Finish. 

 omitted. 

Report Output window to save, 

page 123). 

n you are done with this step, click Finish. If the Finish button is di

If there are any parametric fields in the report, the Enter Parameter Values wizard pag
appears. Fill in 

If there are no parametric fields in the report, this wizard step is

4. Once the output appears, you can use buttons at the top of the 
export, or print the report. 

y Click the  Print button to print the generated custom report. 

y Click the  Export button to exp
Ex rkbook files. 

ort the report as delimited text files (.CSV) or as Microsoft 
cel Wo

y Click the  Save button to save the report instance. 

For more information, see Historical Report Tab (on page 126). 

 Reports 
elete it from the report folder. 

1. Sele

2. From Actions menu, choose Delete. A warning message appears asking you to confirm that you 

 

te. 

You can also use buttons to move from page to page in the report and to change the 
magnification. 

Deleting and Undeleting Custom
When you no longer need a report, you can d

To delete a custom report: 

ct the report you want to delete. 

want to delete this report. Click OK. 

To undelete a custom report: 

1. Under Searches in the navigation pane, select Deleted Reports from the Recycle Bin Searches
folder. 

2. Open the deleted report you want to undelete. 

3. From Actions menu, choose Undele
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Note Although the report users can run reports and do analysis on assigned projects, including 
those to which they do not have direct access, they cannot delete reports that they do not 
own. Only the report manager can delete reports that belong to other users. 

 

Working with External Reports 
You can create reports and generate them from an external report engine. Process exte
provides a URL address that can be initiated from within Agile reports and that will launc

nsion 
h the 

ile administrator sets the Process Extensions based on your 
uestions or comments about the Process Extension settings, please 
 

Cr
 create an external report from the Create 

ct to an external resource or URL 
rt, you must add the URL 

nsion Library. For more information about Process 
te

To c

To creat

1. Log

ent. 

specified Web address. Your Ag
requirements. If you have any q
contact your Agile administrator.

eating an External Report 
If you have the appropriate roles and privileges, you can
icon on the main toolba b Client, you can r. In the Agile We conne
to generate an external report. Before you create an external repo
associated with the report to the Process Exte
Ex nsions, see the Agile PLM Administrator Guide. 

reate reports in the Agile Web Client, you must have the Create Reports privilege. 

e an external report: 

 in to Agile Web Client. 

Note not create external reports in Agile Java CliYou can

2. Click Create > Report > External Reports. The External Reports Creation Wizard appears. 

eport. 

inue. 

 Enter a brief description of the report. 

rom: External 
Reports” in the Process Extension Library. 

ort. 

6. Click Finish. 

ur Roles and Privileges Affect 

3. Select a subclass, and type a name for the r

4. Click the Continue Creation in Wizard checkbox. Click Cont
5. Enter the following general information: 
y Description —
y Process Extension — Select a Process Extension. The Process Extension you select is 

associated with a URL, such as the location of Web-based report. The only Process 
Extensions that appear in this list are those that are designated as “Initiate F

y Folder — Select a folder in which to store the rep

 

Executing an External Report 
You must have ufficient privileges to execute a report; see How Yo s
Reports (on page 118). For more detailed information about rol

inistrator Guide. 
es and privileges, see the Agile PLM 

Adm

To run the new  created external report, click the ly  Execute button. The Process Extension that 
refe e in a new browser window. rences a URL is invoked, and you see the Web pag
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The Report Output Window 
Whe
outp op of the Report Output window to save, export, or print 
the report. 

n you execute a report, you see the report displayed in a new browser window. Once the report 
ut appears, you can use buttons at the t

à Click the  Print button to print the generated custom report. 

Follow the onscreen instructions to print the report. 

à Click the  Export button to ex ort. Follow the onscreen instructions. 

ft Excel Workbook. 

can also be opened with any 
applic at uses the CSV file type. 

à To move from page to page, use the Page drop-down list and the 

port the rep

The report can be exported in one of two formats: 
y File type CSV (comma delimited text file) 
y File type Microso

Both file types can then be opened in Microsoft Excel. CSV files 
ation th

 First Page,  Previous 

Page,  Next Page, and  Last Page buttons. 

à To change magnification, use the  Zoom In and  Zoom Out buttons. 

à Click the  Save button to save the report instance. The saved report instance appears on the 
Historical Report tab. 

For more information, see Historical Report Tab (on page 126). 

à Click the  Close button to close the report window. 
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Finding Agile Data with Searches 
This chapter includes the following: 

� Overview of Search Tools.................................................................................................................................... 135 
� Saved Searches .................................................................................................................................................. 138 
� Quick Searches ................................................................................................................................................... 140 
� Quick Searches and Wildcard Characters........................................................................................................... 143 
� Full Text Search for Content in Attachment Files ................................................................................................ 145 
� Pre-configured Parametric Searches................................................................................................................... 148 
� Saving a Search .................................................................................................................................................. 152 
� Using Save As to Save a Search......................................................................................................................... 154 
� Advanced Searches............................................................................................................................................. 155 
� Where-Used Searches for Items ......................................................................................................................... 169 
� Where-used Searches for File Folders ................................................................................................................ 179 
� Relationship Searches......................................................................................................................................... 179 
� Searching for Users and User Groups................................................................................................................. 181 
� Searching for Routable Objects with Workflow Attributes ................................................................................... 181 
� Editing and Managing Searches and Search Folders ......................................................................................... 188 

 
 

Overview of Search Tools 
When you want to find specific Agile objects, content found in documents or attachments, or other 
kinds of information contained in the database, you perform a search. 

The main Searches folder has subfolders of saved searches. 

à In Java Client, to display the search window, click the Search tab in the left navigation pane. 
Select the top Search folder and click the Expand All  icon to display all the searches. Or, for a 
specific folder, click the  + icon to display the searches in that folder. 

à In Web Client, if the left navigation pane is not already displayed, click the Searches icon  to 
display the search folders. Click the Expand All  icon to display all the searches. Or, for a 
specific folder, click the +  icon to display the searches in that folder. 

For more information about the predefined searches in Agile PLM, see Saved Searches (on page 
138). 

For more information about saving, editing and managing your personal searches, see Editing and 
Managing Searches and Search Folders (on page 188). 

Types of Searches 
Several types of searches are available from the toolbar of both Java and Web Clients. 

à Simple Search— Searches for objects whose name, number, or description matches the criteria 
in the main toolbar Search text box. See Quick Searches and Wildcard Characters (on page 
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143). In a Simple Search, the object class drop-down list is set to All and a wildcard character 
is used in the main toolbar Search text box. 

When the object class drop-down list is set to All, the Search Attachments Context check box is 
inactive and not available. 

à Quick Search—Searches for objects whose name, number, or description matches the criteria in 
the main toolbar Search text box. See Quick Searches and Wildcard Characters (on page 143). 

By default, the Search object class drop-down list is set to All, and Agile performs a Simple 
Search to search all objects in the database. Narrow your Quick Search by selecting a base 
class in the drop-down list that limits the search to any object with that base class as its 
“ancestor.” 

You can also extend the Quick Search to attachment files. See Quick Searches (on page 140). 

à Pre-configured Parametric Search—From the Search... button drop-down list, select a base class 
that limits the search to any object with that base class as its “ancestor” similar to a Quick 
Search. Click the +  to expand and display the parametric search your Agile administrator has 
configured. Your Agile administrator configures Agile PLM to present the most commonly used 
search attributes for that class or type. Select the search operator and search value for one or 
more of the displayed attributes. See Pre-configured Parametric Searches (on page 148). 

à Last Search Results—Return to the results of the last search that you ran. 

à Attachment content search—You can use a quick, parametric, or advanced search to find 
specified content in attachment files. See Full Text Search for Content in Attachment Files (on 
page 145). 

à Advanced Searches—For greater precision, you can perform an advanced search, which allow 
you to use more specific search conditions and multiple conditions which have not been pre-
configured in the parametric search. See Advanced Searches (on page 155). 

à Where-used Searches—An option in Advanced Search, it searches specific levels of the BOM and 
revisions, such as “All Levels Latest Released Revision Only.” See Where-Used Searches for 
Items (on page 169) and Where-used Searches for File Folders (on page 179). 

Relationship searches—An option in Advanced Search, it finds objects that are related à to the 
object that meets the search conditions. See Relationship Searches (on page 179). 

In Java Client, when you run a search, the results appear in a sea ch results window. The window 

ame of the search. The search Results icon 

 

Search Results 
r

title bar displays the n  appears in the left corner of 
the window title bar. 

In Web Client, when you run a search, the results appear in the right pane. 

e 
ou that the results returned were more than allowed. Refine your search criteria as 

needed. 

 results are sorted when the number of search 
results displayed is less than or equal to 1,000. 

The maximum number of search results that can be displayed is based on the Maximum Query 
Results Displayed property in Agile Administrator under Admin > Server Settings > Preferences. In 
addition, your Maximum Rows Displayed (MRD) user preference controls how many rows are 
displayed for you. If the system found more than your MRD user preference allows, a messag
informs y

For Quick Search and Simple Search, the search
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Note If a user’s Maximum Rows Displayed user preference is set to fewer rows than Maximum 
Query Results Displayed systemwide preference, the former value will override the latter 
value. If the system found more results than the MRD user preference allows, a message 
informs you of that fact. 

If you do not have Discovery or Read privilege for an object, it does not appear in search 
results. Depending on Agile Administrator SmartRule settings, you may see a warning that 
rows are missing due to insufficient privileges. For more information, see your Agile 
administrator.  

When you search for items (part or document objects), the items displayed are the latest released 
revision or the most recent pending revision (which was created when the item was added to the 
Affected Items tab of an ECO or an MCO). See also Searching on Rev-Specific Values (on page 
169). 

Important The Specify Output Column privilege is removed from Agile PLM; therefore, all users can 
potentially specify output attributes in advanced searches. However, if you find that you 
cannot do so, you have probably been assigned the Enforce Field Level Read privilege by 
your administrator. 

To open and view objects in the results table in Java Client, use one of these methods: 

à To open one object, double-click the object’s row in the search results table. 

à To open an object with a specific tab on top: 
a. Select the object’s row in the search results table. 
b. Right-click. 
c. In the displayed menu, choose Open and the tab you want. 

à To open multiple objects: 
a. Select multiple rows in the search results table. 
b. Either press Enter on the keyboard or click the Open button  in the main toolbar. 

To open and view objects in the results table in Web Client: 

Click the Number link of the object. 

To print a list of objects found by the search:     

In Java Client, click the Print button  in the search results toolbar. 

In Web Client, click the Print button on the Search Results page. 

To view the results of the last search you performed:    

In Java Client, click the Last Search Results button.   

In Web Client, click the  Last Search Results button.  
 

Exporting Search Results 

In both Java Client and Web Client, you can export some or all results of a search (Advanced 
Search or saved search) to a CSV (comma separated value) file for use in another application, for 
instance, Microsoft Excel or Microsoft Word. You can also export the search results in Microsoft 
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Excel format. 

To export search results in Java Client and Web Client: 

2. ults table, click the Export drop-down button and choose a file format: .CSV or 

3. rted file in the chosen 
format, or Save to save the file to your local drive. 

lobal searches that your Agile administrator created, or 

ose 
Only you can see them, under your own login. 

Predefined System Searches 
 as they are, or you can use them 

m 
s. If you do not hav

Note 

1. Run a search. 

In the search res
Microsoft Excel 

In the File Download dialog that opens, click Open to view the expo

 

Saved Searches 
Saved searches are advanced searches that have been saved for future use. They include the 
predefined searches shipped with Agile, g
personal searches you created yourself. 

Global searches are seen by all Agile users with appropriate Discovery and Read privileges. 
Personal searches are seen only by the user who created the search. Although personal searches 
are created on a local computer, they are stored on the server. This means you can log in to any 
computer that runs your usual client and see the personal searches you have created, even if th
searches were created on a different computer. 

Agile comes with a set of predefined searches. You can use them
as a template to modify and save as your own custom searches. 

Which searches you see depends on your company’s licenses and your user profile settings, roles, 
and privileges. If you have the Global Search privilege, you can edit or delete the predefined syste
searche e the Global Search privilege, you can still view the system searches. 

Some predefined system searches cannot be edited, viewed or saved because they 
internally defined and are not based on an advanced search. For example, the Recycle 
Bin searches for soft-deleted objects are not editable. 

The search Save As feature allows you to create a shortcut (link) to a non-editable system search
but does not allow you to make a copy of that search in your personal searches folder. For mor

, 
e 

information, see Using Save As to Save a Search (see "Using a Saved Search" on page 130). 

You also need to have the Searches property in your user profile include the kind of searches you 
want to see. Your administrator may have already set that up when your profile was created as an 

 folder of searches: 

1. 

object in the Agile database; if not, follow this sequence: 

To add the capability to see a

Display your user profile: 
y In Java Client, click the View/Edit Current User button  in the main toolbar. 

In Web Client, choose Tools > My Settings. On the Settings Homy e page, click the User Profile 
fo tab). link to display your profile. Click Edit (on the General In

2. On the General Info tab, scroll down to the Profile section. 
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3. At the Searches field, click the  or  button, per your client. 

4. Use the mu
click OK. 

ltilist dialog box to select the Searches you want access to. When you are done, 

The Gl er has a subfolder name ples with additional 
predef

5. Click Save. 

If you have questions about your ability to discover, read, or edit searches, see your Agile 
administrator. 

obal Searches fold
ined searches. 

d Workflow Search Sam

Name of  fo lder  Purpose of  searches 

Compliance Searches Searches that find product governance and compliance data. 

Global Searches > Workflow n Workflow Routings
Search Samples 

Workflow Search Samples are described i  
th (on page 12). Also see Searching for Routable Objects wi

Workflow Attributes (on page 181). 

Change Analyst Searches Searches that find changes, items, and redlined attachment files. 

Component Engineer Searches Searches that find manufacturers and manufacturer parts. 

Workflow Routings Searches that find workflows, as described in Workflow 
Routings (on page 12). Also see Searching for Routable 
Objects with Workflow Attributes (on page 181). 

Content Manager Searches transfer orders and packages. Searches that find content 

Price Searches Searches that find prices. 

Program Searches Searches that find programs. 

Quality Searches Searches that find product service requests and quality chang
requests. 

e 

Sourcing Searches Searches that find requests for quote and sourcing projects. 

Supplier RFQ Searches Searches that find supplier RFQ requests. 

Recycle Bin Searches  in every base class in Agile PLM. Searches that find deleted objects

Personal Searches Searches that you have created. 

 
 

Running a Saved Search 
In Java Client, when you run a saved search, the found objects are listed in the search results 

1. 

window with the name of the search in the window title bar. In Web Client, when you run a saved 
search, the found objects are listed in the right pane, below the name of the search. 

In Java Client, to use searches shipped with Agile, create by your Agile administrator, or 
saved by you: 

d 

If the folders of s ed searches are not displayed in the av  Searches folder on the Search tab of
the left navigation pane, double-click the Searches folder. 

 

Or, highlight the  Searches folder and click the Expand All icon  in the Searches toolbar to 
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display all search subfolders and their contents. 

2. Double-click the name of the folder that you want to open. 

Double-cl3. ick the name of a search in that folder to run it. Results appear in a search results 

o use searches shipped with Agile, created by your Agile administrator, or 

1. earch tools are not already displayed, click the Search Folders button 

window. 

In Web Client, t
saved by you: 

If the s  in the navigation 

2. 

pane. 

Click a Searches folder to display the list of saved searches in that folder. 

Or, highlight the  Searches folder and click the Expand All icon  in the navigation pane to 

ght pane. 

Running Saved "Prompt at Runtime" Searches 
h you want to search. 

u run a saved “Prompt at Runtime” search, a dialog appears that allows you to fill in search 

Search in Java Client

display all search subfolders and their contents. 

3. Click the name of a search in that folder to run it. Results appear in the ri
 

You can create and save searches that prompt you to fill in the values for whic
Each time you run the saved search, you can specify different search values. 

When yo
values. 

Fill in the fields provided, then click Run. 

To create and save a “Prompt at Runtime” search, see Creating an Advanced  
(on page 158) or Creating an Advanced Search in Web Client (on page 161). 

t 
ile objects 

n contain the search criteria that you specified. 

Quick Search Overview 

n 

he search to attachment files; see Full Text Search for 

Quick Searches 
Use the main toolbar quick search features in both clients to run quick searches. Quick searches le
you quickly locate objects in the Agile database. The quick search returns a list of all Ag
whose name, number (ID), or descriptio

In a default quick search (main toolbar class drop-down list set to All, also referred to as a simple 
search) Agile searches all classes to find any object in the database that matches the criteria. Whe
you choose a base class in the drop-down list, Agile limits the search to any object with that base 
class as its “ancestor.” You can also extend t
Content in Attachment Files (on page 145). 

Quick searches behave like Contains searches for text strings. The search criteria is treated as a 
single string and Agile PLM searches for names or descriptions that contain the search criteria 
string. In the case of ID numbers, Agile PLM searches for an exact match, however, you may use 

 
r 

wildcard characters to specify part of an ID number as a search criteria. 

The columns included in the search results table depend on what you searched for. You can 
change the number of rows displayed per page of search results by choosing Tools > My Settings >
User Profile (Web Client) or by using the View/Edit Current User button (Java Client) to display you
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user profile. On the Preferences tab of your user profile, edit the Rows per Table Display attribute. 

Using Wildcard Characters (on page 144) gives some examples of values for quick searches and 

rches, see: 

the returned results that can be expected. 

For detailed information about using quick sea

à Java Client Quick Search (on page 141) 

à Web Client Quick Search (on page 142) 

à Using Wildcard Characters (on page 144) 

à Using Quick Search to Find Attachment File Content (on page 146) 

The following ent and summarizes what each 
feature does. 

 

Java Client Quick Search 
 table shows the Quick Search interface in the Java Cli

 

Base Class drop-down list 

Use  to select a specific 
base class. Agile limits the 
search to any object with th
base class as its “ancestor

All (default)

at 
.” 

 – searches all 
object classes in the 
database. 

t 

attachment files in your 
search, check the box. 

 
n 

ber 

à 

à 
e 

rds. 

h 

the 
 the 

Results 

Search Attachmen
Text checkbox 

When you select a 
base class, this 
checkbox is enabled. 

If you want to include 
the content of 

Search Criteria field 

The search criteria text is
not case-sensitive. You ca
enter as search criteria: 
à a product ID num
à an entire word 

multiple words 
partial numbers or 
partial words, using th
* and ? wildca

Run Searc
button 

Runs the 
search you 
specify and 
displays 
results in
Search 

window. 

See Perform a Qu See Quick Searches 
and Wildcard 

See Full Text 
Search for Conten

See Search 
Results (on 
page 136) for

ick 
Search in Java Client (on 
page 142) for more 

t 
in Attachment 

information. Files (on page 145)  
for more information. 

Characters (on page  
143) for more information. more 

information. 

The following table lists and describes the search buttons on the m r in Java Client. ain toolba

Bu on t t Name Descr ipt ion 

 Run Search  Simple Search or a Quick Search. See Quick Searches and Runs a
Wildcard Characters (on page 143) and Quick Searches (on page 
140). 

 Search... Opens a dialog box to create an advanced search. See Advanced 
Searches (on page 155). 

 
 t of base classes to select for Clicking the drop-down arrow displays a lis

a pre-configured parametric search. See Pre-configured 
Parametric Searches (on page 148). 
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Button  Name Descr ipt ion 

 Last Search 
Results 

Displays the results of the last search you performed. 

 
 

Perform a Quick Search in Java Client 

To p

1. 

2. Use nt to search for. Select a 

erform a quick search in Java Client: 

Enter the search characters in the Search Text field in the main toolbar. 

the Object Type drop-down list to select the type of object you wa
base class to limit the search to any object with that base class as its “ancestor.” 

When you select All, Agile performs a Simple Search and searches across all classes. The 
Search Attachment Text checkbox is disabled for Simple Searches. 

3. When you select an object type, the Search Attachment Text checkbox  is enabled. If you w
to include the content of attachment files in your search, check the box. See Full Text Searc

ant 
h 

for Content in Attachment Files (on page 145) for more information. 

4. Click the Run Search  button. The s
where the ID number matches or a w

earch returns all objects in the specified base class 
ord in the description contains the search characters. 

Web Client Quic
The following marizes what each 
feature does. 

5. To open an object in the search results table, double-click its row. 
 

k Search 
 table shows the Quick Search interface in the Web Client and sum

 

Base Class drop-down list 

Use  to select a specific 
base class. Agile limits the 
search to any object with that 
base class as its “ancestor.” 

All (default) – searches all 
object classes in the 
database. 

. 

t to include 
the content of 
attachment files in 

ck 

 

à 

rs or 
he 

search you 
specify and displays 
the results in the 
Search Results 
window. 

Search Attachment 
Text checkbox 

When you select a 
base class, this 
checkbox is enabled

If you wan

your search, che
the box. 

Search Criteria field 

The search criteria text is 
You not case-sensitive. 

can enter as search
criteria: 
à a product ID number 

an entire word 
à multiple words 
à partial numbe

partial words, using t
* and ? wildcards. 

Run Simple Search 
button 

Runs the 
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See Perform a Quick 
Search in Web Client (

r more 
on 

page ) fo
information. 

See Full Text 

 143
Search for 
Content in 
Attachment Files 
(on page 145)  for 
m

See Q  

ore information. 

uick Searches
and Wildcard 
Characters (on page 
143) for more information. 

See Search 
Results (on page 
136) for more 
information. 

The following table lists and descri tons on the main toolbar in Java Client. bes the search but

Button  Name Descr ipt ion 

 Run Search arches and Runs a Simple Search or a Quick Search. See Quick Se
Wildcard Characters (on page 143) and Quick Searches (on page 
140). 

 
Search... Opens a dialog box to create an advanced search. See Advanced 

Searches (on page 155) 

 
 Move the mouse pointer over

classes to select for a pre-con
 the drop-down arrow to display a list of base 
figured parametric search. See Pre-

configured Parametric Searches (on page 148) . 

 
Last Search 
Results 

Displays the results of the last search you performed. 

 
 

Perform a Quick Search in Web Client 

 p

1. rch for. Select a 
se class as its “ancestor.” 

To erform a Quick Search in Web Client: 

Use the Object Type drop-down list to select the type of object you want to sea
base class to limit the search to any object with that ba

When you select All, Agile performs a Simple Search and searches across all classes. The 
Search Attachment Text checkbox is disabled for Simple Searches. 

2. When you select an object type, the Search Attachment Text checkbox  is enabled. If you 
want to include the content of attachment files in your search, check the box. See Full Text 
Search for Content in Attachment Files (on page 145) for more information. 

3. Enter the search characters in the Search Criteria field. 

4. Click the Run Simple Search  button. The search returns all objects in the specified base 

5. To open a returned object, click its link in the search results table. To display the next page of 
utton 

class where the ID number matches or a word in the description contains the search 
characters. 

search results, click the Go to Next Page b . 

You can use wildcard characters when you perform a quick search in Java Client (Java Client Quick 

 

Quick Searches and Wildcard Characters 

Search (on page 141)) or Web Client (Web Client Quick Search (on page 142)). 
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Using Wildcard Characters 
Agile accepts two wildcards: the asterisk (*) and the question mark (?), and they can be used in any 
of the sea uestion mark find h any other single characte sk 
fi more than one 

stems on SQL Serv re some limitations on end on the 

rches. The q
nds matches with 

s matches wit
character. 

r. The asteri

Note For sy er, there a searches that dep
available res se server. On SQL Serve or 
renamed obj rched on immediately. There is a delay of 10–15 seconds. 

ources of the databa r, the newly created 
ect cannot be sea

Also, on SQL Server, t “value*” is supported. The *value”, 
value*value”, a ported. 

some examp wildca

he wildcard search searches “value?”, “
“?value”, “ nd “value?value” are not sup

Here are les, using each of the wildcards and no rds: 

Search cr i ter ia  wi l l  be returned wi l l  not  be re turned 

Hello World rld Java output hello wo Hello Dolly 

at Item is at Phoenix site bat, atlas 

?at bat, cat (and so on) splat 

*at bat, cat, splat, big hat batter, catfood, hatpin 

1001-0?2 1001-0029 1001-002, 1001-012, 1001-0A2 

1001-0*2 1001-012, 1001-0A2, 1001-0A12, 1001-03742 
(and so on) 

1001-0129 

Semi ABC Semi Haulers ABC Semiconductor 

Semi* ABC Semi Haulers, ABC Semiconductor ABC Nonsemi Haulers 

Note The only advanced search operator that allows wildcard characters is the Like operator. 
The Like operator is located in the Match If list. (See Advanced Searches (on page 155).) 

If you need to search for objects that contain “*”, type the backslash 
wildcard (so, “\*”) to indicate that you mean the * character, not the * 
search for “10*18”, type  10\*18 . 

character (\) in front of the * 
wildcard. For example, to 

Note You cannot search for the “?” character, that is, you cannot enter the string “\?”. Nor can 
you search for the backslash character by entering the string “\\”. 

 

l Characters as Part of Words 

ing characters are considered to be part of the word or number in which they are found: 

ore    - hyphen 

Specia

The follow

_ undersc    ~ tilde    * asterisk    ’ apostrophe    @ at 
sign    # number    % percent    ^ caret    & ampersand 

For instance, if an item’s number is 10#40, the search treats it as a single word; “10” and “40” would 
not be found. So, if you use the * wildcard character, 1* would find 10#40 but 4* would not. 
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Cauti Do not use wildcards to create searches that match too many rows in the database, for
example, a search for “P*”. When you run a search with a wildcard, the criteria must be 
matched against all words in the index (formed by combining autonumbers, descriptions, 
and text in attachments), which can run into several million rows on a large database. 
a good idea to further refine such a search so performance of the database is not 
compromised

on  

It is 

. 

u can provide, the more specific your search will be. For example, 

ity 

If you enter “*” without any criteria, Agile PLM does not attempt to match all the words in 

Note d 

¾ If your wildcard search matches too many rows in the database, you may see an error 
message telling you that your wildcard query resulted in too many results, please refine 
your criteria and try again. In this case, enter a more specific search string and try again. 
The more clues yo
“Resistor*” is more specific than “R*” and “MOSFET Transistor” is more specific than 
“Transistor”. 

¾ Wildcard searches that specify only one or two characters, including the space character 
and punctuation characters, may return this error. Whether or not a specific wildcard 
search matches too many rows in the database also depends on the size and complex
of your database. 

the index. 

For multi-byte language Agile installations (Japanese and Chinese), simple searches an
quick searches, that use wildcard characters to search for text strings that include the 
following special characters, produce inconsistent results or do not return the c
search results. 

orrect 

¾ 

mma  ,    less than sign  <    period  .    greater than sign  >    forward 
slash  /    question mark  ?    

tilde   ~    grave accent  `    exclamation point  !    at sign  @    number sign  #    dollar 
sign  $    per cent sign  %    caret  ^    ampersand  &    asterisk  *    open 
parenthesis  (    close parenthesis  )    hyphen  -    underscore  _    equal sign  =    plus 
sign  +    back slash  \    vertical bar  |    open bracket  [    open brace  {    close 
brace  }    close bracket  ]    semicolon  ;    colon  :    apostrophe  ’    quotation 
mark  ”    co

¾ Instead, use an advanced search to use wildcard characters to search for text strings that 
include these special characters. Specify Like as the search operator. The Like search 
operator allows you to use wildcard characters in advanced searches. When you have 
defined the advanced search, you can save it for later use. See Advanced Searches (on 
page 155). 

 

Text Search for Content in Attachment Files 
search attachment files to find a particular word or phrase. You can use Quick Search
 Search to find attachment file content. 

Full 
You can  or 
Advanced

Note Full Text Search (FTS) is available in localized versions. Agile PLM 9.2.x localized in 
French and German are supported for FTS, which works similarly to the English version 
as these languages are “whitespaced-delimited.” Agile PLM 9.2.x localized in Japanese, 
Simplified Chinese, and Traditional Chinese are supported for FTS of Asian characters; 
however, in the Asian versions, FTS for English text may not be fully successful, for 
example, in wildcard searches using the characters described in Special Characters as 
Part of Words (on page 144). 
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Whe u search for attachment file content, the search results list each object that contains files 
 the search criteria. Only the latest versions of attachments are listed. 

If an object contains multiple files, even if only one of the files contains the search text, the 

n yo
matching

Note 
entire object is returned. The file that contains the text is not indicated, and you may need 
to look through all attachment files to find the appropriate one. 

¾ For non-English text in documents, Full Text Search is not supported for Stem search or 
st 

Search to Find Attachment File Content 

Concept search. Moreover, attachment files that can be returned by a full text search mu
be created and saved in Microsoft Word (.DOC) or Excel (.XLS). Non-English–text 
attachment files created in .RTF or .TXT formats are not returned (although .TXT files may 
work if the encoding type is Unicode). 

 

Using Quick 
To include attachment file content in an quick search, select the Search Attachment Text checkbox. 
For detailed information about running quick searches, see Java Client Quick Search (on page 141
and Web Client Quick Search

) 
 (on page 142). 

"Stop" Words 

The followi  system in
attachmen us s for “mo
attachment c uence “the mouse” because the stop word “the” is ignored. (To 
contrast, a  not attachments – for “mouse” would n

Note  string c . Fo ple, you would 

ng words are called “stop” words a
t files. So, a search for “the mo

ontent with the seq

nd are ignored by the
e” will return all matche

 searching against 
use”—which includes 

 simple search of objects – ot return “the mouse”. 

On SQL Server, the query annot contain any stop words r exam
n ouse” asot be able to input “the m  a query string. 

à a, about, after, all, also, an, and, 
any, are, as, at 

, into, is, it, its 

an, that, the, their, there, they, 
this, to 

à can, co, Corp, corp, could à more, most, Mr, mr, Mrs, mrs, 
Ms, ms, Mz, mz 

à up 

hment Conte dvanced Search Capabilities 
u can search for attachment files in which the file content matches the text criteria you specify. 
e following table shows an example of an advanced search in Web Client that will find 

ment files that contain the words d “Layout.” (For st s about creating 
advan ea

à if, in, inc à s, says, she, so, some, such 

à be, because, been, but, by à last à th

à for, from à no, not à was, we, were, when, which, who, 
will, with, would 

à had, has, have, he, her, his à of, on, one, only, or, other, out, 
over 

à  

 
 

Using Attac nt A
Yo
Th
attach “PCB” an general in ruction

ced searches, see Advanced S rches (on page 155).) 

            Search for: Items 

            Search Type: Object Search 
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Field h If Pro lue Matc mpt? Va

Attachments.Attached Docume ord PCB Layout nt Text Contains all W s  

To search for attachment fi  attribute ocument Text. 

The following tables describe the attachment content s ilable.  

le content, use the  Attachments.Attached D

earch options ava

Set t ing  F inds Example  

Contains All Words 
  that you 

specify, in any order  may include: 

out 
 

Attachment files that contain 
all the words

Search text: PCB layout 

Search results
  PCB layout 
  PCB design lay
  layout of PCB

Contains Any Word or Attachment files that contain ut 

e: 

ayout 

Words at least one of the words that 
you specify 

Search text: PCB layo

Search results may includ
  PCB layout 
  PCB design l
  layout of PCB 
  PCB design 
  Circuit board layout 

Contains Phrase Attachment files that contain 

 

yout 

e only: all the words that you 
specify, in the order specified

Search text: PCB la

Search results includ
  PCB layout 

Does Not Contain (or  Attachments that do not 
contain the specified text 

Search text: PCB layout 

Search results never include: 
  “PCB” or “layout” 

Contains None Of) 

About (for concept Searches for words that are 

the specified word. 

Search text: sports 
searching) about the same concept as Search results may include “basketball” 

 

nd Stem Search 

 describes setting   and concept searching. 

QL Serve c

 

Concept Search a

This table

Note S

 two specialized search 

r systems do not support con

s, stem searching

ept searching. 

 

Feature  Descr ipt ion Examples  

Concept 
searching 

hes for words that are 
about the same concept as the 
specified word. 

ts 

seball 

Searc Search text: spor

Search results may contain: basketball, ba
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Feature  Descr ipt ion Examples  

Stem searching Searches for the root of the 
specified word and find all 

Search text: index 

attachments that contain the 
root. 

Search results may contain: indexing, indices 

Search text: run 

Search results may contain: running, ran 

 
 

Pre-configured Parametric Searches 
In an advanced search, you can choose from a complete list of the available search attributes. By 
contrast, in a pre-configured parametric search, a list of the most useful or commonly used search 

r search. You can leave the remaining 

 
rch attributes. 

After you or 
reuse. Fo ving a Search

attributes are automatically displayed for you in the search window. For each parametric search 
attribute, you can select a Match If operator and a value for which to search. You define search 
values for only the attributes you wish to use in you
parametric search attributes blank. 

Your Agile administrator defines the parametric search for all Agile PLM users in Agile
Administrator. Each object class or type can have a different set of pre-configured sea
Contact your Agile administrator if you have questions about pre-configured search attributes in 
your Agile system. 

 have defined your parametric search, you can save it in your Personal Searches folder f
r more information about saving a parametric search, see Sa  (on page 152). 

Param
e similar to the quick search. 

Important , you must 

parametric search attributes. Then, select Match If operators and search values for the 
parametric search attributes you want to use, and click Run. 

¾ Each search condition you define is added to the search (creating an AND search), 
including the quick search condition at the top of the page. 

 

Java Client Parametric Search Window 

etric Search Window 
The search features in the parametric search window ar

To display the pre-configured search attributes in the parametric search window
select an object type in the second drop-down list. This displays the pre-configured 
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Base Class drop-
down list 

Use  to select a 
specific base class. 
Agile limits the search 
to any object with that 
base class as its 
“ancestor.” 
Selecting All in this list 
disables the Object 
Type list. Agile 
searches all object 
classes in the 
database. 

Object Type drop-
down list 

Use  to select a 
specific object class or 
a specific object 
subclass (object type) 
to further limit the 
search. 
The available choices 
in this list are defined 
by the Base Class list 
selection. 

Important!   Selecting 
an object type in this 
list automatically 
displays any pre-
configured search 
attributes. 

Search 
Attachment Text 
checkbox 

When you select 
an Object Type, 
this checkbox is 
enabled. 

If you want to 
include the content 
of attachment files 
in your search, 
check the box. 

Search Criteria 
field 

The search criteria 
text is not case-
sensitive. You can 
enter as search 
criteria: 
à a product ID 

number 
à an entire word 
à multiple words 
à partial numbers 

or partial words, 
using the * and ? 
wildcards. 

Run Search 
button 

Runs the search 
you specify and 
displays the 
results in the 
Search Results 
window. 

See Perform a 
Quick Search in 
Java Client (on 
page 142)  for more 
information. 

 See Full Text 
Search for 
Content in 
Attachment 
Files (on page 
145) for more 
information. 

See Quick 
Searches and 
Wildcard 
Characters (on 
page 143) for more 
information. 

See Search 
Results (on 
page 136) for 
more 
information. 

The following search control buttons and menus appear at the bottom of the Java Client parametric 
search window: 

Button  Descr ipt ion 

Run Run the search with the displayed criteria. 

Save Save the displayed search as an Advanced Search. The Save in Folder dialog 
appears. See Saving a Search (on page 152). 

Reset Clears the displayed search criteria in the Search window. 

More... Drop-down list displays additional actions. 

  Customize Output Display The Customize Output Display dialog allows you to select which attribute columns 
appear in the search results table and the order in which you want to appear. See C. 
Define a Custom Output Display (see "C. Define a Custom Output Display, 
Java Client" on page 160). 

  Convert to Advanced 
Search 

Displays the Advanced Search dialog. The parametric search criteria you defined in 
the parametric search are pre-defined in the Advanced Search dialog. See Saving 
a Parametric Search as an Advanced Search (on page 153). 

 
 

 Page - 149

  

 



Getting Started with Agile PLM User Guide  
 
 
 

Running a Pre-configured Parametric Search in Java Client 

To define and run a pre-configured parametric search: 

1. In the main menu Search button  drop-down list, select the object class you want for your 
search. 

2. The parametric search window opens with no pre-configured search attributes displayed. 

See Java Client Parametric Search Window (on page 148). 

Note You can use the collapsed parametric search display to run a quick search. 
(See Quick Search Overview (on page 140).) 

3. To display the pre-configured search attributes, select an object type in the second drop-down 
list. 

The pre-configured search attributes for the selected object type are displayed in the search 
window. 

Use the  -  or  +  to the left of the Search For field to collapse or expand the list of pre-configured 
search attributes. 

4. For each attribute you want to include in your search, select a Match If operator. 

For a complete list of Match If operators. 

5. For each search attribute you want to include in your search, enter a search value. 

If you leave a search value blank, that attribute search criteria will not be used in your search. 

6. Click Run. 

The results are displayed in the search window below the parametric search definition. 

The parametric search is an AND search. Each search condition is included in the search with an 
AND operator. 

Web Client Parametric Search Window 

 

Page - 150 Agile Product Lifecycle Management 

 

 



 Chapter 7  
 
 

Base Class drop-
down list 

Use  to select a 
specific base class. 
Agile limits the search 
to any object with that 
base class as its 
“ancestor.” 
Selecting All in this list 
disables the Object 
Type list. Agile 
searches all object 
classes in the 
database. 

Object Type drop-
down list 

Use  to select a 
specific object class or 
a specific object 
subclass (object type) 
to further limit the 
search. 
The available choices 
in this list are defined 
by the Base Class list 
selection. 

Important!   Selecting 
an object type in this 
list automatically 
displays any pre-
configured search 
attributes. 

Search 
Attachment Text 
checkbox 

When you select 
an Object Type, 
this checkbox is 
enabled. 

If you want to 
include the 
content of 
attachment files in 
your search, 
check the box. 

Search Criteria field 

The search criteria 
text is not case-
sensitive. You can 
enter as search 
criteria: 
à a product ID 

number 
à an entire word 
à multiple words 
à partial numbers or 

partial words, 
using the * and ? 
wildcards. 

Run Search 
button 

Runs the 
search you 
specify and 
displays the 
results in the 
Search 
Results 
window. 

See Perform a 
Quick Search in 
Java Client (on 
page 142) for more 
information. 

 See Full Text 
Search for 
Content in 
Attachment 
Files (on page 
145) for more 
information. 

See Quick 
Searches and 
Wildcard 
Characters (on 
page 143) for more 
information. 

See Search 
Results (on 
page 136) on  
for more 
information. 

The following search control buttons and menus appear at the bottom of the Web Client parametric 
search window: 

Button  Descr ipt ion 

Run Run the search with the displayed criteria. 

Save Save the displayed search as an Advanced Search. The Save in Folder dialog 
appears. See Saving a Search (on page 152). 

Reset Clears the displayed search criteria in the Search window. 

More... Drop-down list displays additional actions. 

Customize Output Display The Customize Output Display dialog allows you to select which attribute columns 
appear in the search results table and the order in which you want to appear. See 
C. Define a Custom Output Display (see "C. Define a Custom Output 
Display, Web Client" on page 163). 

Convert to Advanced Search Displays the Advanced Search dialog. The parametric search criteria you defined 
in the parametric search are pre-defined in the Advanced Search dialog. See 
Saving a Parametric Search as an Advanced Search (on page 153). 
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Running a Pre-configured Parametric Search in Web Client 

To define and run a pre-configured parametric search: 

1. In the main menu, move the mouse pointer over the Search button  drop-down arrow to 
display a list of objects classes. Select the object class you want for your search. 

2. The parametric search window opens with no pre-configured search attributes displayed. 

See Web Client Parametric Search Window (on page 150). 

Note You can use the parametric search display to run a quick search. (See Quick 
Search Overview (on page 140).) 

3. To display the pre-configured search attributes, select an object type in the second drop-down 
list. 

The pre-configured search attributes for the selected object type are displayed in the search 
window. 

Use the  -  or  +  to the left of the Search For: field to collapse or expand the list of pre-configured 
search attributes. 

4. For each attribute you want to include in your search, select a Match If operator. 

5. For each search attribute you want to include in your search, enter a search value. 

If you leave a search value blank, that attribute search criteria will be not be used in your 
search. 

6. Click Run. 

The results are displayed in the search window below the parametric search definition. 

The parametric search is an AND search. Each search condition is included in the search with an 
AND operator. 

Saving a Search 
You can save both parametric searches and advanced searches using a similar save process or 
save as processes. A saved parametric search returns search results in the parametric search 
window, and a saved advanced search returns the search results in the advanced search results 
table. 

à When you run a saved parametric search, the search results are displayed in the parametric 
search window. You can expand the list of pre-configured attributes to modify or refine your 
search. If you want, you can save the search with the modifications you made. 

à When you run a saved advanced search, the search results are displayed in the advanced 
search results window. To modify the advanced search, use the Edit button in the search 
results table. 

To save a parametric or advanced search in Java Client: 

1. Define the search conditions and click Save. 

The Save in Folder dialog box appears. 

2. Enter a name for the search in the Search Name field. 
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3. Select a folder in which to store it. 

If you do not have sufficient privileges to save a search in the selected folder, you can select 
another. You can always save a search in the Personal Searches folder. 

4. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

5. Click OK in the Save in Folder dialog box to save the search. 

To save a parametric or advanced search in Web Client: 

1. Define the search conditions and click Save 

2. The Save Search As dialog box appears. 

3. Enter a name for the search in the Search Name field. 

4. Then select a folder in which to store it. 

If you do not have sufficient privileges to save a search in the selected folder, you can select 
another. You can always save a search in the Personal Searches folder. 

5. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

6. Click OK in the Save Search As dialog box to save the search. 
 

Saving a Parametric Search as an Advanced Search 
When the parametric search window is open, you can convert the parametric search to a new 
advanced search. The advanced search is created with all the parametric search conditions 
predefined in the advanced search. This allows you to define additional search criteria not available 
in a parametric search and save the advanced search for reuse. 

To save a parametric search as an advanced search in Java Client: 

1. With a parametric search window open, in the More button drop-down list, choose Convert to 
Advanced Search... 
You can either define a parametric search and convert it, or you can run a previously saved 
parametric search and convert it. 

2. The Advanced Search dialog appears. Define the advanced search. 

For more information about defining advanced searches, see Creating an Advanced Search in 
Java Client (on page 158). 

3. When you are finished, in the Advanced Search dialog, click Save. 

The Save in Folder dialog box appears. 

4. Enter a name for the search in the Search Name field. 

5. Select a folder in which to store it. 

If you do not have sufficient privileges to save a search in the selected folder, you can select 
another. You can always save a search in the Personal Searches folder. 

6. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

7. Click OK in the Save in Folder dialog box to save the search. 

 Page - 153

  

 



Getting Started with Agile PLM User Guide  
 
 
 

To save a parametric search as an advanced search in Web Client: 

1. With a parametric search window open, in the More button drop-down list, choose Convert to 
Advanced Search... 
You can either define a parametric search and convert it, or you can run a previously saved 
parametric search and convert it. 

2. The Advanced Search window appears. Define the advanced search. 

For more information about defining advanced searches, see Creating an Advanced Search in 
Web Client (on page 161). 

3. When you are finished, in the Advanced Search window, click Save 

4. The Save Search As dialog box appears. 

5. Enter a name for the search in the Search Name field. 

6. Then select a folder in which to store it. 

If you do not have sufficient privileges to save a search in the selected folder, you can select 
another. You can always save a search in the Personal Searches folder. 

7. To create a new folder, click the  New button. In the Create New Folder dialog, enter a folder 
name and click OK. 

8. Click OK in the Save Search As dialog box to save the search. 
 

Using Save As to Save a Search 
You can use More > Save As to: 

à Create a new copy of a previously saved search. 

à Create a shortcut (link) to a predefined system search in a system folder, for example, the 
Global Searches folder, in your personal searches folder. 

If the Agile administrator updates or modifies a global search, when you run the search from 
the shortcut in your personal searches folder, Agile uses runs the most recent updated search. 

à Create a shortcut (link) to a non-editable system search . 

Note When you use Save As and select a non-editable system search, creating a 
shortcut is the default action. 

à Create a shortcut to a saved search in a different personal searches folder. 

To use save as to save a search in Java Client: 

1. Select the search you want to copy or link to, then initiate the save as process: 
In the Search folder, select the search you want, right-click and choose  As. Savey 

y 

y 

. In the advanced search dialog, 

In the Search folder, select the search you want, right-click and choose Edit. In the More 
button drop-down list, choose Save As. 
Run the search, then choose edit from the search results table: 

In a parametric search window, use the More button drop-down list, choose Save As. 

In an advanced search results table, click the Edit button
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use the More button drop-down list and choose Save As. 
The Move to Folder dialog appears. The Create ShortC2. ut checkbox is checked by default. To 

e a c

Note 

creat opy of the search, uncheck the checkbox. 

If you have selected a non-editable predefined system search, the checked 
Create ShortCut checkbox is disabled. You are not allowed to create a co
non-editable system search using Save As. Fo

py of a 
r more information, see 

Predefined System Searches (on page 138). 

3. Select the folder you want for the saved search or shortcut. 

To create a new fold4. er, click the  New button. In the Create New Folder dialog, enter a folder 

ve the search. 

 search you want to edit. 

2. 

name and click OK. 

5. Click OK in the Move to Folder dialog box to sa

To use save as to save a search in Web Client: 

1. In the Searches folde in the navigation pane, navigate to ther 

Click the Edit Search  icon to the right of the search name. 

Alternately, run the search, then choose edit from the search results table: 
y In a parametric search window, use the More button drop- wn list, choose do Save As. 

In an advanced search results table, cli Edit Search y ck the  button. In the advanced 

3. tcut checkbox is checked by default. To 
e a c

Note 

search dialog, use the More button drop-down list and choose Save As. 
The Save Search As dialog appears. The Create Shor
creat opy of the search, uncheck the checkbox. 

If you have selected a non-editable predefined system search, the checked 
Create ShortCut checkbox is disabled. You are not allowed to create a copy of a 
non-editable system search using Save As. For more information, see 
Predefined System Searches (on page 138). 

4. Select the folder you want for the saved search or shortcut. 

To create a new folde5. r, click the  New button. In the Create New Folder dialog, enter a folder 

x to save the search. 

Advanced Searches 

r attachment file content, see Full Text Search for Content in 

name and click OK. 

6. Click OK in the Move to Folder dialog bo
 

This section provides the details on using the advanced search capability. 

For information specific to searching fo
Attachment Files (on page 145). 

For information about where-used searches, see Where-Used Searches for Items (on page 169). 
Where-used searches find assemblies that contain items that match the search criteria. 

For information about relationship searches, see Relationship Searches (on page 179). Relationship 
search criteria. 

earches: 

searches find objects that are related to objects that match the 

These are the topics in this section about advanced s
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à Overview of Advanced Searches (on page 156) 

à Basic Process to Create an Advanced Search (on page 156) 

à Some Caveats about Advanced Searches (on page 157) 

à Creating an Advanced Search in Java Client (on page 158) 

à Creating an Advanced Search in Web Client (on page 161) 

Selecting Search Operatorsà  (on page 164) 

Using And/Or Values in Advanced Searchesà  (see "Using And/Or — An Example" on page 167) 

à Using Parentheses in Search Definitions (on page 
 

168) 

h. The 
e for advanced searches depend on whether you are 

Overview of Advanced Searches 
Advanced searches look for all the objects with fields that match the conditions of the searc
object fields and attributes that you can us
searching for an object base class, class, or subclass. (For information about classes, see 
Introducing Agile Objects (on page 61).) 

Your company may need to examine the benefits of indexing specific columns in your 
database. If the enterprise has an extremely large database, and users discover that 
advanced searches are taking a long time (longer than 2 or 3 minutes), it is likely that the 
searching operation is going through every single column in the database. By indexing 
specific da

Caution 

tabase columns, or setting a “search order” of database columns, the searching 
s a 

s tab 
 Page Two or Page Three fields 

workflow attributes and statuses on changes. 

e. 

ders

capability can run faster for all users. See your Agile administrator if you suspect this i
problem. 

For example, Agile can search for the fields on the Title Block tab of items, the Cover Page tab of 
changes, and the General Info tab of manufacturing objects, as well as fields on the Manufacturer
of items. In both Java and Web Client, if your company uses custom
(which appear on the Title Block or Cover Page tab in Web Client), they may be referred to by a 
different name on your system. Agile can also search those fields. 

When searching for changes, Agile can search for 

Once you create and save a search, you can: 

à Run it by clicking it (Web Client), or double-clicking it (Java Client), in the navigation pan

à Edit it as described in Editing and Managing Searches and Search Fol  (on page 188). 
 

he 
gen dure to creating an advanced search is as follows: 

2. Define : the type of object, the kind of search (for example, an object search, a 
 

r (steps 3–9). 

Basic Process to Create an Advanced Search 
Creating an advanced search is described in detail below for both Java Client and Web Client. T

eral proce

1. Open the Advanced Search dialog from the button in the menu (steps 1 and 2 in the tasks 
below). 

the Search Criteria
where-used search, or a relationship search), field names, conditions, and values you want to
search fo
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3. Define Options: specify the output fields you want displayed in the search results table (steps 
11–13). 

4. Save the search (name and folder), run the search, and print the search results (steps 10, 1
and 15). 

Also see the sections immediately follo

4, 

wing the “create search” tasks: Using And/Or Values in 
Advanced Searches (see "Using And/Or — An Example" on page 167), and Using Parentheses in 
Search Definitions (on page 168). 

Some Caveats about Advanced Searches 
Using Saved Searches to Create your Advanced Search 

Creating a successful advanced search can be challenging. Consider using a saved search that ha
some elements of the search you wish to create. When you start to create an advanced search, 
there is an option to Use a Saved Search; you browse to the search and it “prepopulates” the 
search dialog box or wizard. Or you may pre

s 

fer, with a search selected in Java Client, to click the 
 

 

es Visible property to No), but has not yet logged out on his system, so the 
diately in effect for 

ow the found objects are listed in the search results table. 

 

 see 

 
t only affected items with quantity > 5 will appear on the search 

results table; however, all the affected items of the found PSRs will be listed, resulting in the PSR 
itself being listed multiple times. 

View/Edit button, save the opened search with another name (and directory as needed), and develop
your new search by modifying the old one. 

Difference in Caching Search Attributes in Java Client and Web Client

You may encounter a situation where a field on Page Three of a business object is available for 
search in Web Client, but is not available in Java Client. This can happen when the administrator 
hides a field (chang
change has not gone into effect for Java Client users, while the change is imme
Web Client users. 

Complexity between Search Criteria and Output Display 

There is potential for ambiguity between the search criteria and the search results output display 
settings. The search criteria that you define – including the object type (step 3 below) coupled with 
the object attributes (step 6 below) –determine which objects the search finds. The output display 
attributes (step 11 below) determine h
The output display attributes do not alter the results of the search, they determine only the manner 
in which those results are displayed. 

When you search for objects by defining criteria that uses data found on related tables, and select
similar criteria to display in the output, you may find unexpected results. It is recommended that, 
whenever possible, you set up your search against the parent object and not its associated data. 

More specifically, if you search an object using an attribute of a related object – data that is pulled 
from other objects, such as BOM, Affected Items, Related PSRs, Changes, and so forth – as a 
search criteria, and for your output you choose to display attributes of the related object in your 
output, all the related objects will be listed, not just those that meet the search criteria. You will
the searched-for objects listed multiple times in the search results, once for each related object. 

For example, if you choose “PSR” for object type and search against Affected Items (which is 
associated data) for some criteria such as “quantity > 5,” and you display the affected item number
and quantity, you may expect tha
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Searching for Space Characters in Text Fields 

A space character by itself is not a valid search value. Agile PLM will return an error if one or more 
space characters are the only characters specified in the search condition Value field. 

However, you can specify a search value that includes a space character in conjunction with other 
characters. For example, you can search for “blue box” to find the text string “blue<space>box”. 

Note To search for text strings that begin with a space, you can use the Like search operator in 
the Match If field and include a wildcard character in the Value field. 

When you use a wildcard in the search Value field, you must use the Like operator. The only 
advanced search operator that allows wildcard characters is the Like operator. 

For more information about wildcard characters, see Using Wildcard Characters (on page 144). 

Creating an Advanced Search in Java Client 
To create an advanced search in Java Client:     

A. Select the Search Type, Java Client 

1. Click the Advanced Search button  in the toolbar. 

The Advanced Search dialog appears, ready for you to define the search criteria. The name 
Advanced Search appears in the title bar at the upper left of the dialog box. 

2. To create a completely new search, select Create New. 

You can also start with a saved search: select Use a Saved Search, click the ... button, and select 
the search you want to start with. 

3. In the Object Type drop-down list, select the type of object to find. You can specify a base class, 
class, or subclass object. 

4. In the Search Type drop-down list, make sure Object Search is selected. 

Note If you select a search type other than Object Search, you must also select an 
object type in the With Related Content drop-down list. For more information, see 
Where-Used Searches for Items (on page 169), Where-used Searches for File 
Folders (on page 179), and Relationship Searches (on page 179). 

 

B. Define the Search Criteria, Java Client 
1. By default, the search condition table contains one row. (You can add as many rows as you 

need by clicking Add in the search builder window.) 

Click the row to enable the search criteria selection lists. 

2. Define a set of search criteria, or conditions: 
a. Click the first drop-down list  to select a target Field from the list. For example, Title 

Block.Number represents the Number field on the Title Block tab of a part or document. 

The Field list varies depending on the object selected in the Object Type field. For example, 
if you search for assembly drawings—a part—the Field list includes Title Block.Lifecycle 
Phase. If you search for ECOs—a change—the Field list includes Cover Page.Status. 
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b. Click the second drop-down list to select a Match If search operator from the list. For more 
information, see Selecting Search Operators (on page 164). 

c. The Prompt? field is enabled if appropriate, and the checkbox is unchecked by default. If 
you leave the checkbox unchecked, the Value field is enabled (see next step). If you check 
the checkbox, you are not going to fill in the Value field, and, when you run the saved 
search, you will be prompted to enter a value. 

d. In the Value field, select a value from the drop-down list and click OK. The value you 
selected populates the field. 

The Value field specifies the content or setting of the field selected from the field list. 
Depending on the selection in the field list, the value field may contain a list that is relevant 
to the selection, a calendar button, or a field where you can enter text or numbers. For 
example, if Field is set to Title Block.Lifecycle Phase, then the Value field lists the different 
lifecycle phases; if Field is set to Title Block.Description, then you can type text or numbers 
in the Value field. 

If you select Like as a Match If search operator, or if you are searching for attachment file 
content, you can use wildcard characters when entering a value. For information about 
using wildcards to search for objects, see Using Wildcard Characters (on page 144). For 
information about searching for attachment file content, see Full Text Search for Content 
in Attachment Files (on page 145). 

e. To add an operator setting of “AND” or “OR,” click the And/... field and select AND or OR 
from the list. 

Use AND if both conditions must be met. 

Use OR if either or both conditions can be met. 

If you have selected AND or OR but wish to remove the operator, click the And/... field and 
select the empty space, which will de-populate the field of either operator. 

If you do not use parentheses when defining your search, the search is processed giving 
precedence to AND values, that is, it processes all rows that end with AND before 
processing rows that end with OR. In other words, the first line is combined with the 
second and process order is based on the first line’s AND/OR value. 

For more information, see Using And/Or Values in Advanced Searches (see "Using And/Or 
— An Example" on page 167). 

f. To add parentheses, select two adjacent rows using Shift-click. This enables the ( ) button. 
Click it and the proper parenthesis appears to the left of the first row and right of the 
second row. 

To remove parentheses, select two rows grouped by parentheses, and click the enabled 
Remove ( ) button. 

For more information about using parentheses, see Using Parentheses in Search 
Definitions (on page 168). 

3. To add another row of search conditions, click Add. A new row is added at the end of the table. 
The AND/OR field at the end of the previous row is set to [blank] by default. 

4. To insert a search condition row, select a row and click the Insert button. The new row is 
inserted above the selected row. If you want to delete a search condition row, select one or 
more rows and click Delete. The selected rows are deleted. 

5. To perform a case-sensitive search where text capitalization matters, click the Match Case 
checkbox. 

If you want to perform a search where text capitalization does not matter, click to deselect 
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Match Case. 

Selecting the Match Case checkbox can help your search run more quickly. If you enter text in 
the Value field, the search looks for text that is an exact match (uppercase and lowercase 
letters). If you select a value from a list (such as for Product Line), checking Match Case allows 
the system to use internal database settings to find objects more quickly. 

6. When you have finished adding search conditions, you can Save the search, or click Run to run 
the search without saving it. 

If you click Save, skip to D. Save and Run the Search, Java Client (on page 160) and follow 
step a through step d to save the search. Saving the search now, before you define the Custom 
Output Display (see C. Define a Custom Output Display, Java Client (on page 160)), gives you 
the opportunity to name the Search Criteria you have defined, and to use that search with 
different output displays later. 

If you click Run without saving the search, the results are displayed in the search results 
window. To further edit the search or to save the search, click the View/Edit button . 

C. Define a Custom Output Display, Java Client 
1. When you have finished adding search conditions, select Custom Output Display... in the More.. 

button drop-down list. The Custom Output Display dialog appears for you to specify which 
fields to include in the search results. The Available Fields and Selected Fields tables are 
displayed. 

2. In the Custom Output Display dialog, in the Available Fields table, select the field names you 
want and use the right and left arrows to move field names to and from the Available Fields and 
Selected Fields lists. Double-clicking a field name also moves it from one list to the other list. 

The Selected Fields list specifies the field names that will appear in the search results table. 
Select one or more rows and use the up and down arrows to change the order of field names in 
the list, which reflects the order of the columns in the search results. 

3. To sort the search results, in the Selected Fields list, click in the Sort column for the field name 
by which you want to sort, and select a number from the drop-down list (for example, 1 means 
sort by this field name first). You can sort by multiple field names; select a number in the Sort 
column for the each of the field names you want to use to sort. Click in the Direction column and 
select Ascending or Descending order. 

Note List and Multilist fields, such as Product Lines, cannot be sorted alphabetically. 

4. When you have finished specifying output display fields and sort order, click OK in the dialog 
box. 

 

D. Save and Run the Search, Java Client 
1. You may choose to click Save to save the search, or click Run to run the search without saving it 

first. 
a. If you click Save, the Save in Folder dialog box appears. 
b. Enter a name for the search. 
c. Then select a folder in which to store it. If you do not have sufficient privileges to save a 

search in the selected folder, you can select another. You can always save a search in the 
Personal Searches folder. 

d. Click OK in the dialog box to save the search. 
e. When you are ready to run the search, click Run in the search dialog box. 
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The Search Results window shows all the objects that match the search criteria. 

2. To print the list of search results, click the Print button . 
 

Edit the Search After Running It, Java Client 

To edit the search after running it, do one of the following: 

à If the search results window is open, click the View/Edit button . 

à If you saved the search and closed it, in the Searches tab of the navigation pane, select the 
search and run it. Then click the View/Edit Search button  in the search results window, and 
edit the search. 

 

Creating an Advanced Search in Web Client 
To create an advanced search in Web Client:     

A. Select the Search Type, Web Client 

1. Click the Advanced Search button  in the toolbar. 

The Advanced Search dialog appears with the Search Criteria tab displayed. 

2. To create a completely new search, select Create New. 

You can also start with a saved search: select Use Saved Search, click , and select the 
search you want to start with. 

3. In the Search For drop-down list, select the type of object to find. You can specify a base class, 
class, or subclass object. 

4. In the Search Type drop-down list, make sure Object Search is selected. 

Note If you select a search type other than Object Search, you must also select an 
object type in the With Related Content drop-down list. For more information, see 
Where-Used Searches for Items (on page 169), Where-used Searches for File 
Folders (on page 179), and Relationship Searches (on page 179). 

 

B. Define the Search Criteria, Web Client 
1. By default, the search condition table contains one row. (In Web Client, you can add as many 

rows as you need by clicking the And/Or field and selecting AND or OR from the list. See step 
2e below.) 

Click the row to enable the search criteria selection lists. 

2. Define a set of search criteria, or conditions: 
a. Click the first drop-down list  to select a target Field from the list. For example, Title 

Block.Number represents the Number field on the Title Block tab of a part or document. 

The Field list varies depending on the object selected in the Object Type field. For example, 
if you search for assembly drawings—a part—the Field list includes Title Block.Lifecycle 
Phase. If you search for ECOs—a change—the Field list includes Cover Page.Status. 

b. Click the second drop-down list to select a Match If search operator from the list. For more 
information, see Selecting Search Operators (on page 164). 
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c. The Prompt? field is enabled if appropriate, and the checkbox is unchecked by default. If 
you leave the checkbox unchecked, the Value field is enabled (see next step). If you check 
the checkbox, you are not going to fill in the Value field, and, when you run the saved 
search, you will be prompted to enter a value. 

d. Click the Value field, one or more value from the drop-down list and click Close. The value 
you selected populates the field. 

The Value field specifies the content or setting of the field selected from the field list. 
Depending on the selection in the field list, the value field may contain a list that is relevant 
to the selection, a calendar button, or a field where you can enter text or numbers. For 
example, if Field is set to Title Block.Lifecycle Phase, then the Value field lists the different 
lifecycle phases; if Field is set to Title Block.Description, then you can type text or numbers 
in the Value field. 

If you select Like as a Match If search operator, or if you are searching for attachment file 
content, you can use wildcard characters when entering a value. For information about 
using wildcards to search for objects, see Using Wildcard Characters (on page 144). For 
information about searching for attachment file content, see Full Text Search for Content 
in Attachment Files (on page 145). 

e. To add an operator setting of “AND” or “OR,” click the And/Or field and select AND or OR 
from the list. 

Use AND if both conditions must be met. 

Use OR if either or both conditions can be met. 

Note that a second line for your search is added as soon as you select AND or OR. 

If you have selected AND or OR but wish to remove the operator, click the And/... field and 
select the empty space, which will de-populate the field of either operator. 

Note that the added line does not disappear. You can still set values for that row, and re-
select AND or OR. You can also delete the row using the button to the right. 

If you do not use parentheses when defining your search, the search is processed giving 
precedence to AND values, that is, it processes all rows that end with AND before 
processing rows that end with OR. In other words, the first line is combined with the 
second and process order is based on the first line’s AND/OR value. 

For more information, see Using And/Or Values in Advanced Searches (see "Using And/Or 
— An Example" on page 167). 

f. To add parentheses, click the appropriate radio buttons to locate both an open and close 
parenthesis. Then click the Add ( ) button. The proper parenthesis appears to the left of the 
first row and right of the second row. 

To remove parentheses, click the appropriate radio buttons for the two rows grouped by 
parentheses, and click the Remove ( ) button. 

For more information about using parentheses, see Using Parentheses in Search 
Definitions (on page 168). 

3. To add another row of search conditions, click the And/Or field and select AND or OR. A new 
row is added at the end of the table. You can add as many rows as you like before populating 
them with criteria. 

4. To insert a search condition row, click the Insert Row in Search Criteria  button. The new row is 
inserted above the row where you clicked the button. If you want to delete a search condition 
row, click the Delete button for that row. 
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5. To perform a case-sensitive search where text capitalization matters, click the Match Case 
checkbox. 

If you want to perform a search where text capitalization does not matter, click to deselect 
Match Case. 

Selecting the Match Case checkbox can help your search run more quickly. If you enter text in 
the Value field, the search looks for text that is an exact match (uppercase and lowercase 
letters). If you select a value from a list (such as for Product Line), checking Match Case allows 
the system to use internal database settings to find objects more quickly. 

6. When you have finished adding search conditions, you can use the buttons at the bottom of the 
dialog to Run, Save, or Cancel the search. 

If you click Save, skip to D. Save and Run the Search, Web Client (on page 163) to save the 
search. Saving the search now, before you define the Custom Output Display (see C. Define a 
Custom Output Display, Web Client (on page 163)), gives you the opportunity to name the 
Search Criteria you have defined, and to use that search with different output displays later. 

C. Define a Custom Output Display, Web Client 
1. When you have finished adding search conditions, select Custom Output Display... in the More 

button drop-down list. The Custom Output Display dialog appears for you to specify which 
fields to include in the search results. The Available Fields and Selected Fields tables are 
displayed. 

2. Under Output Fields, in the Available Fields table, select field names you want and use the 
right and left arrows to move field names to and from the Available Fields and Selected Fields 
lists. Double-clicking a field name also moves it from one list to the other list. 

The Selected Fields list specifies the field names that will appear in the search results table. 
Use the up and down arrows to change the order of field names in the list, which reflects the 
order of the columns in the search results. 

3. To sort the search results, in the Sort By field, use the drop-down list to select the field name by 
which you want to sort first, and click a radio button for Ascending or Descending. If you want, 
do the same in one or both “Then By” fields. 

Note List and Multilist fields, such as Product Lines, cannot be sorted alphabetically. 

4. When you have finished specifying output fields and sort order, click OK in the dialog box. 
 

D. Save and Run the Search, Web Client 
1. You may choose to click Save to save the search, or click Run to run the search. 

a. If you click Save, the Save Search As dialog box appears. 
b. Enter a name for the search. 
c. Then select a folder in which to store it. If you don’t have sufficient privileges to save a 

search in the selected folder, you can select another. You can always save a search in the 
Personal Searches folder. 

d. Click OK in the dialog box to save the search. 
e. When you are ready to run the search, click Run in the search dialog box. 

The Search Results window shows all the objects that match the search criteria. 

2. To print the list of search results, click the Print button . 
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Edit the Search After Running It, Web Client 

To edit the search after running it, do one of the following: 

à If the search results window is open, click the Edit Search button . 

à If you saved the search and closed it, in the Searches tab of the navigation pane, click the 
search, click the Edit Search button , and edit the search. 

 

Selecting Search Operators 
Search operators are specified in the Match If field. Available operators vary depending on the Field 
list selection. For example, if the Field setting is Title Block.Description, the Match If field includes the 
Contains operator along with several others; if the Field is set to Title Block.Lifecycle Phase, the only 
operators are In, Not In, Is Null, and Is Not Null. 

Operator  Descr ipt ion 

Contains Finds any value that includes the contents of the Value field. For example, if you 
are searching for objects that contain the value “cap” in their description, the search 
would find objects described as capacitor, High Capacity Drive, CAP plug, and so 
on. 

Equal To Finds only an exact match with the contents of the Value field. 

Like Allows wildcard searches that match any single character. 

Not Like Allows wildcard searches that exclude any single character. 

Starts With Finds values that begin with the characters in the Value field. 

Does Not Contain Finds any value that does not include the contents of the Value field. 

Not Equal To Finds any value other than an exact match with the contents of the Value field. 

Does Not Start With Finds values that do not begin with the characters in the Value field. 

Is Null Finds objects where the field selected from the Field list contains no value. 

Is Not Null Finds objects where the field selected from the Field list contains any value. 

Greater Than Finds dates later than, or duration (in hours) longer than, the contents of the Value 
field. 

Finds numbers larger than the contents of the Value field. 

Finds currency amounts larger than the contents of the Value field. 

Greater Than Or 
Equal To 

Finds dates that match or are later than, or duration (in hours) that matches or is 
longer than, the contents of the Value field. 

Finds numbers that match or are larger than the contents of the Value field. 

Finds currency amounts that match or are larger than the contents of the Value 
field. 
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Operator  Descr ipt ion 

Less Than Finds dates earlier than, or duration (in hours) less than, the contents of the Value 
field. 

Finds numbers less than the contents of the Value field. 

Finds currency amounts less than the contents of the Value field. 

Less Than Or Equal 
To 

Finds dates that match or are earlier than, or duration (in hours) that matches or is 
less than, the contents of the Value field. 

Finds numbers that match or are larger than the contents of the Value field. 

Finds currency amounts that match or are larger than the contents of the Value 
field. 

Between Finds dates that match or are between the beginning date and ending date 
specified in the Value field. 

Finds numbers that match or are between the high number and low number 
specified in the Value field. 

Finds currency amounts that match or are between the high amount and low 
amount specified in the Value field. 

Not Between Finds dates that do not match or are not between the beginning date and ending 
date specified in the Value field. 

Finds numbers that do not match or are not between the high number and low 
number specified in the Value field. 

Finds currency amounts that do not match or are not between the high amount and 
low amount specified in the Value field. 

In Finds a list attribute that matches one of the list values specified in the Value field. 

Not In Finds a list attribute that does not match any of the list values specified in the Value 
field. 

Contains Any Finds a multilist attribute that matches any (at lease one) of the multilist values 
specified in the Value field. 

Contains All Finds a multilist attribute that contains all of the multilist values specified in the 
Value field. 

Note: To find an exact match, use the Equal To operator. 

To find a multilist attribute that is not empty, use the Is Not Null operator. 

Contains None Finds a multilist attribute that contains none of the multilist values specified in the 
Value field. 

Note: To find an empty multilist attribute, use the Is Null operator. 

 
 

Search Operators and Attribute Types 

The following table lists the search operators used for each attribute type. The following table 
explains how to recognize different attribute types by the manner in which you enter data into the 
field. 
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Type What  to  Enter  in  the F ie ld  

Date Enter date and time, enter the variable $TODAY to use today's date, or select date and time 
from a pop-up calendar. 

List Select one item from a list. 
Select one item from a cascading list. 

MultiList Select one or more items from a multiple-selection list. The list can be a cascading list. 

Note: here is now no limit to the number of list entries in a multi-list field; in previous service 
packs, multi-lists could only save and populate 31 list entries. 

Text Enter a single line of text; the allowable length varies, but generally it is up to 50 characters. 

MultiText Enter a block of text (up to 4,000 characters) that wraps across multiple lines. 

Numeric Enter a numeric value. 

Money Enter a monetary amount. 

The Agile PLM administrator can set default values (such as the current date, or current user) to automatically 
appear in a field when new objects are created. For more information, see Agile PLM Administrator Guide. 

The following table lists the search operators that apply to each attribute type. 

List  Mul t i l is t  Date,  Number ,  Money Text ,  Mul t i text  

In 

Not In 

Is Null 

Is Not Null 

Equal To 

Not Equal To 

Contains Any 

Contains All 

Contains None 

Is Null 

Is Not Null 

Between 

Equal To 

Less Than 

Less Than or Equal To 

Greater Than 

Greater Than or Equal To 

Not Equal To 

Not Between 

Is Null 

Is Not Null 

Equal To 

Like 

Contains 

Starts With 

Not Equal To 

Not Like 

Does Not Contain 

Does Not Start With 

Is Null 

Is Not Null 

 
 

 

à When the time stamp for the date is 12:00:00 AM, Agile PLM assumes the entire day (12:00:00 
am to 11:59:59 pm) for the search. 

à If you enter a specific time, Agile PLM uses the exact time in the search. For example, Between 
08/20/2007 8:00:00 AM PDT and 08/21/2007 5:00:00 PM. 

à In Advanced Searches, you may also use the search wildcard $TODAY by typing the wildcard 
into the search value field (as opposed to clicking the calendar button to display the calendar 
tool). 

à $TODAY evaluates true for today's date, all times from 12:00:00 am to 11:59:59 pm. Date and 
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time are determined by your Time Zone as defined in your user profile. 

Use $TODAY-<integer> or $TODAY+<integer> to includes a number of days before or after à 
 to 

y Changes with a Date Originated Between $TODAY-10 and $TODAY, that is, all changes 

st 

he and AND, both parts ust be true. For 
xam ro objects found. 

AND  

today. The integers refer to whole days, not hours. For example, use the $TODAY wildcard
search for: 
y Items with a Release Date >= $TODAY-7, that is, all items released in the last week. 

created in the last 10 days. 
 

Using And/Or Values in Advanced Searches 
When you have two or more conditions defined in a search, the relationship between them is 
defined as either AND or OR. 

à AND narrows the search by requiring that both conditions are met. Each item in the results mu
match both conditions. 

à OR broadens the search by including any object that meets either condition. Each item in the 
results table needs to match only one of the conditions, but may match both. 

W
e

n you define a search with “Equal to” 
ple, the following search results in ze

 of the definition m

 Title Block.Product Line(s) Equal to Taurus   

 Title Block.Product Line(s) Equal to Scorpio    

This is because if the first part of the definition is true (that is, the object belongs only to the product 

roduct line, 
ou wing search would find all the o
he T use both sides of the definition  be true: 

AND  

line Taurus), then the second part of the definition cannot also be true (that is, the object cannot 
belong only to the product line Scorpio). 

In the example above, if you wanted to search for objects that belong to more than one p
y
t

could use Contains with And. The follo
aurus and Scorpio product lines beca

bjects that belong to both 
 could

 Title Block.Product Line(s) Contains Taurus   

Title Block.Product Line(s) Contains Scorpio     

 
 

Using And/Or — An Example 

Knowing when you want to use AND versus OR in constructing your search criteria can help you 
get the most accurate results from your search and save you valuable time. For example, the 

llo for parts that have both a part c ry equal to Electrical 
 

AND  

fo
and

wing figure shows a search that looks 
a lifecycle phase equal to Inactive. 

atego

 Title Block.Part Category Equal To Electrical  

 Title Block.Lifecycle Phase Equal To Inactive    

If you replace And with Or, the search locates all parts with either a part category of Electrical or a 
lifecycle phase of Inactive. Depending on your database, this latter search might locate a very large 
number of parts. 
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Using Parentheses in Search Definitions 
If you do not use parentheses when defining your search, the search is processed giving 
precedence to AND values, that is, it processes all rows that end with AND before processing rows 
that end with OR. 

In this case, shown in the following figure, Agile looks for objects with both a lifecycle phase equal 
to Production and a product line equal to Scorpio. Then, Agile searches the rest of the database for 
objects with a Description field that contains “computer.” Found objects must have a lifecycle phase 
equal to Production and a product line equal to Scorpio or the word “computer” in their Description 
field because the rows are processed in order. 

 Title Block.Lifecycle Phase Equal To Production  AND  
 Title Block.Product Line(s) Equal To [Scorpio]  OR  
 Title Block.Description Contains computer    

Parentheses let you group search conditions to determine how the search is performed. 

To place parentheses around search conditions in Java Client: 

1. Select the rows that you want to enclose in parentheses. 
a. Click a row to select it. The row is highlighted. 
b. Use Shift-click or Ctrl-click to select one or more additional rows. 

2. Click the parentheses (  ) button. The parentheses are placed in the first and last rows selected. 

To place parentheses around search conditions in Web Client: 

1. In the row where you want to place an open parenthesis, select the radio button in the open 
parenthesis column. 

2. In the row where you want to place a close parenthesis, select the radio button in the close 
parenthesis column. 

3. Click the Add (  ) button. The parentheses are placed in the first and last rows selected. 

To remove parentheses from search conditions in Java Client: 

1. Select the rows with the open parenthesis and close parenthesis. 
a. Click a row to select it. The row is highlighted. 
b. Use Shift-click or Ctrl-click to select one or more additional rows. 

2. Click the Remove (  ) button. The parentheses are removed. 

To remove parentheses from search conditions in Web Client: 

1. Deselect the open and close parentheses radio buttons in the rows from which you want to 
remove parentheses. 

2. Click the Remove (  ) button. The parentheses are removed. 

For example, in the search conditions shown in the following figure, the second and third conditions 
are enclosed in parentheses. Agile first looks for objects with a lifecycle phase equal to Production, 
then searches that group for objects with either the specified product line or description. All found 
objects must have a lifecycle phase equal to Production, but they can have either a product line 
equal to Scorpio or a Description field that contains “computer.” 
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 Title Block.Lifecycle Phase Equal To Production  AND  

( Title Block.Product Line(s) Equal To [Scorpio]  OR  
 Title Block.Description Contains computer    )   

If the parentheses are placed around different conditions, a different search occurs. For example, in 
the search conditions shown in the following figure, the parentheses are around the first and second 
conditions. Found objects will either have lifecycle phase equal to Production and product line equal 
to Scorpio, or the Description will contain “computer” without regard to lifecycle phase or product 
line. 

( Title Block.Lifecycle Phase Equal To Production  AND  
 Title Block.Product Line(s) Equal To [Scorpio]   ) OR  
 Title Block.Description Contains computer    

 
 

Where-Used Searches for Items 
Where-used searches are specialized searches that find assemblies that include items that meet 
the search criteria. 

In an object search, the search conditions define the objects you want to find; the objects that meet 
those search conditions appear in the search results table. In a where-used search, the search 
conditions specify items that appear on the BOM(s) of the object(s) that you want to find. Therefore, 
a where-used search finds any assembly that uses the specified items. The assemblies that use the 
defined items appear in the search results table. 

For example, the intent of an object search is 

Create a list of items whose Description field contains Computer. 

The intent of a where-used search with the same search condition is 

Create a list of assemblies where the BOM contains items whose Description field contains 
Computer. 

These are the subsections of “Where-Used Searches for Items”: 
y Searching on Rev-Specific Values (on page 169) 
y Where-Used Search Types (on page 170) 
y Where-Used Set Operators (on page 173) 
y Creating a Where-Used Search in Java Client (on page 175) 
y Creating a Where-Used Search in Web Client (on page 177) 

 

Searching on Rev-Specific Values 
When you set up a Where Used search, you may well be seeking information about specific 
revisions of a part or other object. A revision, or “rev”, explicitly means that the part has been 
modified in some way by a change order. (These ideas are covered in Product Collaboration User 
Guide.) 
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You may use or create criteria that includes revision-specific attributes, such as Rev, Lifecycle 
Phase, Rev. Release Date, Rev. Incorporate Date, as well as fields on the Manufacturers tab of the 

be 
n 

he “latest released rev” – 

1. and 

mplemented status types. This is indicated by the revision letter 

2. 
ated 

3. 
t has never been released and it is not on the Affected Items tab of a 

e o

Note 

object. 

In general, Agile reviews only the latest revision of each item object. The “latest rev” is the most 
recent revision of the object. If the object has been released (through a change order), this can 
called a “released rev.” Because an object might be released, unreleased, and released agai
(there can be multiple releases), you may want information about t
presumably the part or assembly that is closest to being finished. 

The latest revision can be any of the following, but only one case at a time (see Note below): 

The latest released revision of the item: the item has been released, it has a revision number, 
there are no change orders or MCOs pending against the item. A released revision occurs 
when the change (Change Order or Manufacturer Order) that created the revision is in its 
workflow at Released or I
showing in parentheses. 

The latest pending revision of the item: the item is on the Affected Items tab of one or more 
unreleased change orders or MCOs. A Pending revision occurs when the change that cre
the revision is in its workflow at one of these status types: Unassigned, Pending, Submit, 
Review, or Hold. This is indicated by the revision letter showing in parentheses. 

An Introductory rev with no pending changes: this Introductory item has no revision number or 
pending revision number. I
chang rder or an MCO. 

These revision types are listed in hierarchical order: if there is an instance of 
case 1, that is the latest rev. If there is no released rev but there is an instance 
of case 2, the system sees that as the latest rev. If there is no released or 
pending rev but there is an instance of case 3, Agile takes the Introductory rev
as the latest rev. Note also that the Introductory rev is considered to be a 
released revision, so i

 

tems at Intro rev are expected to be included in Where 
Used search results. 

 

Where-Used Search Types 
 searches, which are defined and described in the following 

t

 172) 

 Where-Used – One Level – All Released Revisions (on page 173) 

This whe
the nam
y evisions are not included. For items/assemblies with pending change order, the 

There are four types of “where-used”
sec ions. “Level” refers to the BOM. 

à Where-Used – All Levels – Latest Released Revision Only (on page 170) 

à Where-Used – Top Level – Latest Released Revision Only (on page 171) 

à Where-Used – One Level – Latest Released Revision Only (on page

à

 
 

Where-Used – All Levels – Latest Released Revision Only 

re-used search type returns a list of the latest released revision of assemblies that contain 
ed object (that is, assemblies where that object is used). Note that: 
Pending r
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Where Used search result will return the item/assembly labeled Introductory (Intro) 
revision. 

y Introductory revisions are included, and they are treated as if they were released revisions. 

The object described by the search conditions is contained, directly or indirectly (defined below), on 

sembly 

 999 

the BOMs of the returned assemblies. This search returns assemblies that contain the described 
object at any BOM level. 

Refer to the figure below. In Assembly 999, Part 222 is contained directly on the BOM of As
999. Also, Assembly 999 includes Subassemblies 777 and 888. 

Part 333 is on Subassembly 777, therefore, Part 333 is indirectly contained on the BOM of 
Assembly 999. 

A Where-Used–All Levels–Latest Released Revision Only search for Part 333 returns both Assembly
(where it is indirectly contained) and Subassembly 777 (where it is directly contained). 

 

 

This whe
Note tha
y 

ions are included, and they are treated as if they were released revisions. 

 

Where-Used – Top Level – Latest Released Revision Only 

re-used search type returns a list of top-level assemblies, latest released revision only. 
t: 
Pending revisions are not included. For items/assemblies with pending change order, the 
Where Used search result will return the item/assembly labeled Introductory (Intro) 
revision. 

y Introductory revis

The object described by the search conditions is contained, directly or indirectly, on the BOMs of 
the returned assemblies. 
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For example, in the figure below, a Where-Used–Top Level–Latest Released Revision Only search for Part 
333 returns only Assembly 999, the top-level assembly. 

 

Where-Used – One Level – Late eased Revision Only 

ision. 
eased revisions. 

ctly on the BOMs of the returned 

 by Revs A, B, C, D, 

s Assembly 999 
sed revision – Rev E 
n Part 111, but they 
 revision. 

ev (F) also contains Part 111, but it is not included in the search results because it is a pending 

 
 

st Rel

This where-used search type returns a list of latest released revision assemblies that directly 
contain the named object. Note that: 
y Pending revisions are not included. For items/assemblies with pending change order, the 

Where Used search result will return the item/assembly labeled Introductory (Intro) 
rev

y Introductory revisions are included, and they are treated as if they were rel

The object described by the search conditions is contained dire
assemblies. 

Refer to the figure below. Assembly 999 has been released five times, named
and E; there is a pending rev, named by Rev (F). 

A Where-Used–One Level–Latest Released Revision Only search for Part 111 return
Rev E only, since Part 111 is directly contained on the BOM of the latest relea
– of Assembly 999; previously released revisions of Assembly 999 also contai
are not included in the search results because they are not the latest released

R
revision. 

 

 
 

Page - 172 Agile Product Lifecycle Management 

 

 



 Chapter 7  
 
 

Where-Used – One Level – All Released Revisions 

es that directly 

ing change order, the 
ctory (Intro) 

eased revisions. 

 the BOM of the released 

or example, in the figure below, a Where-Used–One Level–All Released Revisions search for Part 222 
ssembly 999 Rev A and Rev C. Assembly 999 Rev B and Rev D are both released 

t 222. Revision (F) does directly contain Part 222, but it 
it is a pending revision. 

This where-used search type returns a list of all the released revision assembli
contain the named object. Note that: 
y Pending revisions are not included. For items/assemblies with pend

Where Used search result will return the item/assembly labeled Introdu
revision. 

y Introductory revisions are included, and they are treated as if they were rel

The object described in the search conditions is contained directly on
revision of the assembly, even if it is not the latest released revision. 

F
returns A
revisions, but they do not directly contain Par
is not included in the search results because 

 

 
 

Where-Used Set Operators 
Where-used set operators allow you to further define relationships between grouped search 
conditions. 
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Union 

This operator is the equivalent of Or. For example, this allows you to find assemblies that contain 
only part 111, assemblies that contain only part 222, and assemblies that contain both parts 111 
and 222. The search results are the union of these two sets of assemblies. 

 
 

Intersection 

 
This operator is the equivalent of And. For example, this allows you to find assemblies that contain 
both part 222 and part 333, but not assemblies with only part 222 or part 333. The search results
are the intersection of these two sets of assemblies. 
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Minus 

This operator is the equivalent of Not. For example, this operator allows you to find assemblie
contain part 333, but not part 444. The search results are the assemblies that contain part 33
exceptin

s that 
3, 

g (that is, not) the assemblies that contain both part 333 and 444, nor the assemblies that 
contain only part 444. 

 

 following table illustrates how theThe  set operators can be used. This search locates all assemblies 
333, but not part 444. 

 

that contain (part 111, part 222, or both) and part 

Title Block.Number Equal To 111   Union 
 Title Block.Number Equal To 222   Intersection 
 eTitl  Block.Number Equal To 333   Minus 
 Title Block.Number Equal To 444    

This whe
Nex  
In that re

Cr t earch in Java Client 
The proc
search. 

To creat

1. Clic utton 

re-used search first finds assemblies that contain either part 111 or part 222 (or both). 
t, in the resulting list of assemblies, the search then finds assemblies that also contain part 333. 

sulting list of assemblies, the search now subtracts any assemblies that contain part 444. 

ea ing a Where-Used S
ess for creating a where-used search is similar to the process for creating an object 

e a where-used search in Java Client: 

k the Advanced Search b  in the toolbar. 

The

2. In th ject on which to base the where-used search. 

3. In th

4. 
e

Clic

 Advanced Search dialog box appears with the Search tab displayed. 

e Object Type list, select the type of ob

The object must be an item, a part, or a document. 

e Search Type list, select the type of where-used search to perform. 

By default, the search condition table contains one row. (You can add as many rows as you 
ne d by clicking Add in the Advanced Search dialog box.) 

k the row to display the search criteria selection lists. 

Click each drop-down list button , from left to right, to define the target Field
sea ch operator, and the value. 

, the Match If 
r
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5. Define a set of search criteria, or conditions: 
a. Click the first drop-down list  to select a target Field from the list. For example, Title 

Block.Number represents the Number field on the Title Block tab of a part or document. 

b. r more 
The Field list varies depending on the object selected in the Object Type field. 
Click the second drop-down list to select a Match If search operator from the list. Fo
information, see Selecting Search Operator (see "Selecting Search Operators" on pa
164). 

ge 

c. 

The last search condition field, the Value field, specifies the content or setting of the field 

 lists 
iption, then you can type text or 

numbers in the field. 

f you card characters when 

If you select the Prompt ? checkbox, the value field is disabled and you do not enter a value 
for which to search. Instead, when you run the saved search, you are prompted to enter a 
value. 

d. In the last field, enter a value. 

selected from the Field list. Depending on the selection in the Field list, the Value field may 
contain a list that is relevant to the selection, a calendar button, or a field where you can 
enter text or numbers. For example, if the first field is set to Title Block.Size, then Value
different sizes; if the first field is set to Title Block.Descr

I  select Like as a Match If search operator, you can use wild
entering a value. For information about using wildcards to search for objects, see Using 
Wildcard Characters (on page 144). 

e. If you want to add another row of search conditions, click Add. 

/Or or Union/Intersection/Minus setting, click the And/Or field to select 

A new row is added at the end of the table. The And/Or field at the end of the row is set to 
[blank] by default. 

f. To modify the And
AND or OR from the list. Use AND if both conditions must be met. Use OR if either or both 
conditions can be met. For more information, see Using And/Or Values in Advanced 
Searches (see "Using And/Or — An Example" on page 167). 

g. If you want to insert a search condition row, select a row and click Insert. 
The new row is inserted above the selected row. 

h. If you want to delete a search condition row, select one or more rows and click Delete. 

The selected rows are deleted. 

If you do not use parentheses when defining your search, the search is processed giving 
precedence to AND values, that is, it processes all rows that end with AND before 
processing rows that end with OR. In other words, the first line is combined with the 
second and process order is based on the first line’s AND/OR value. 

For more information, see Using And/Or Values in Advanced Searches (see "Using And/Or 

6. t Display... in the More.. button drop-down list to specify which fields to 
 Run to run the search without saving 

  

drop-down list, the Display Fields, 

— An Example" on page 167). 

Choose Custom Outpu
include in the search results and save the search, or click
it. 

If you click Run, the search results window shows all the object that match the search criteria.

If you choose Custom Output Display... in the More.. button 
Results Range and Case Sensitive settings are displayed. 

Note In these setup steps, Case Sensitive is selected by default. 
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7. 
om one 

arch results table. Use the up 
ich reflects the order of the columns 

8. To s ted Fields list, click in the Sort column for the field by which 

this  You can sort by multiple fields; select a number in the Sort column for the each of 
the fields you want to use to sort. Click in the Direction column and select Ascending or 

9. If you want to perform a case-sensitive search where text capitalization matters, make sure 

If you want to perform a search where text capitalization does not matter, click to deselect Case 

r text 
 exact match (uppercase and lowercase 
or Product Line), checking Case Sensitive 

y. 

11. 
r. You can 

es folder. 

12. 

13. 

The ws all the objects that match the search criteria. If there is more 

14. If yo

Under Display Fields, select fields and use the right and left arrows to move fields to and from 
the Available Fields and Selected Fields lists. Double-clicking a field name also moves it fr
list to the other list. 

Selected FieldsThe  list specifies the fields that will appear in the se
and down arrows to change the order of fields in the list, wh
in the search results. 

ort the search results, in the S ecel
you want to sort, and select a number from the drop-down list (for example, 1 means sort by 

field first).

Descending order. 

Case Sensitive is selected. 

Sensitive. 

Selecting the Case Sensitive check box can help your search run more quickly. If you ente
in the Value field, the search looks for text that is an
letters). If you selected a value from a list (such as f
allows Agile to use internal database settings to find objects more quickl

10. When you have finished specifying output fields and sort order, click Run to run the search, or 
click Save to save it. 

If you click Save, the Save in Folder dialog box appears. 

Enter a name for the search. Then select a folder in which to store it. If you do not have 
sufficient privileges to save a search in the selected folder, you can select anothe
always save a search in the Personal Search

Click OK in the Save in Folder dialog box to save the search. 

When you are ready to run the search, click Run in the search dialog box. 

 search results window sho
than one page, click the right arrow at the top of the window to display the next page. 

u want to print the list of search results, click the Print button . 

To edit the search after running it, do one of the following: 
y If you saved the search, on the Searches tab of the navigation pane, select the search, 

and click the View/Edit button . 
If the Search Results window is open, click the View/Edit button y  in the Search Results 
window. 

 

Creat
To creat t: 

1. Clic

ing a Where-Used Search in Web Client 
e a where-used search in Web Clien

k Advanced Search . The Define Query page of the Advanced Search wizard app

e Search For list, select the type of object on which to base the where-used search. 

 object must be an item or a part or document. 

ears. 

2. In th

The
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3. In th

4. Select se-sensitive search where capitali

Sele n help your search run more quickly. If you
Value

5. 

k tab of a part or document. 

e Search Type list, select the type of where-used search to perform. 

Match Case if you want to perform a ca zation matters. 

cting the Match Case checkbox ca  enter text in 
the  field, the search looks for text that is an exact match (uppercase and lowercase 
letters). If you selected a value from a list (such as for Product Line), checking Match Case 
allows Web Client to use internal database settings to find objects more quickly. 

Define a set of search criteria, or conditions: 
a. Select a target field from the list. For example, Title Block.Number represents the Number 

field on the Title Bloc
b. Select a Match If search operator from the list. For more information, see Selecting Search 

Operators (on page 164). 
c. If you select the Prompt ? checkbox, the value field is disabled and you do not enter a valu

for which to search. Instead, when you run the saved sea
e 

rch, you are prompted to enter a 

 list. Depending on 
levant to the 

an enter text or numbers. For example, 
izes; if Field is set to Title 

rds to search for objects, see Using 

value. 
d. Enter a value in the Value field. 

Value specifies the content or setting of the field selected from the Field
the selection in the Field list, the Value field may contain a list that is re
selection, a calendar button, or a field where you c
if Field is set to Title Block.Size, then Value lists different s
Block.Description, then you can type text or numbers in the Value field. 

If you select Like as a Match If search operator, you can use wildcard characters when 
caentering a value. For information about using wild

Wildcard Characters (on page 144). 
e. If you want to add another row of search conditions, use the And/Or field or Set field: 

Set the And/Or field to AND, OR, or none (empty field) to show whether the search 
conditions for either or both rows must be met. Use AND if both conditions must be met. 
Use OR if either or both conditions can be met. If you do not use parentheses when 

D values, that is, it 
 with OR. In other 
ased on the first 

defining your search, the search is processed giving precedence to AN
processes all rows that end with AND before processing rows that end
words, the first line is combined with the second and process order is b
line’s AND/OR value. 

For more information, see Using And/Or Values in Advanced Searches (see "Using And/Or 
— An Example" on page 167). 

. 

ch, or click Run to run the search without saving it. 

ize Output 

ize Output Display dialog, use the right and left arrows to move fields to and from 
ble Values and Se sts. The Selected Fields list specifies the fields that appear 

 results list. U he order of fields in the list, 
 the order o

 
y 

9. When you have finished specifying output fields and sort order, click OK. 

6. When you have finished adding search conditions, choose Custom Output Display... in the More.
button drop-down list to specify which fields to include in the search results list and save the 
sear

If you choose Custom Output Display... in the More.. button drop-down list, the Custom
Display dialog appears. 

7. In the Custom
the Availa lected Fields li
in the search
which reflects

se the up and down arrows to change t
f the columns in the search results. 

8. To sort the search results, select the field by which you want to sort from the Sort By drop-down
list, and select Ascending or Descending order. To sort by more than one field, use the Then B
drop-down lists. 
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10. When you are finished defining the search, click Save. 

11. Enter a name for the search. Then select a folder in which to store it. If you do not have 
ileges to sav  in the selected folder, you can select another. You can 

ave a search in t hes folder. 

12. rch, click Run. 

s page shows all a. If there is more 
e, click the r age. 

13. If you want to print the list 

r File Folders 
lized searches (similar to relationship searches, 

rch 

Search fo

sufficient priv e a search
always s he Personal Searc

When you are ready to run the sea

The Search result
than one pag

the objects that match the search criteri
ight arrow next to the page number to display the next p

of search results, click the Print button. 
 

Where-used Searches fo
Where-used searches for file folders are specia
below) that find file folders that appear on the Attachments tabs of the objects defined in the sea
criteria. 

In a file folder object search, the search conditions specify object attributes of the file folders you 
want to find; the file folder objects that match those search conditions are returned in the search 
results. 

For example, the following search return file folders that Mary Smith has checked out: 

r Object: File Folder 

Search Type: Object Search 

Search Condition: Title Block.Checkout User Equal to Mary Smith 

In a file folder where-used search, you select the object where the file folder is used, for example, 
ws you to sp de change object attributes, in 

 criteria that s es. 

For exampl g sear s file folders that Mary Smith has checked out that appear 
 of chang ned to the Virgo product line. 

F

Changes. This allo
addition to search

ecify search conditions that inclu
pecify file folder attribut

e, the followin
on the Attachments tab

ch return
es assig

Search for Object: ile Folder 

Search Type: Where Used Search 

With Related Content: Changes 

Search Condition: Title Block.Checkout User Equal to Mary Smith   And 
Where Used.Changes.Cover Page.Product Line(s) Equal to Virgo 

For detailed information about defining searches, see Advanced Searches (on page 155). 
 

Relationship Searches 
Relationship searches are available for any class that has a Relationships tab, that is, all object 

In a relationship search you select the related object type, for example, Changes. This allows you to 
specify search conditions that include change object attributes, in addition to search criteria that 
specify the attributes of the searched-for object. 

classes except Action Items and Reports. 

 Page - 179

  

 



Getting Started with Agile PLM User Guide  
 
 
 

Not s tab is visible for t le to select this e If the Relationship he searched-for object, you will be ab
search type in the sea g. rch definition dialo

For example, the follow
Severity field on the Cov

ing search returns Non-Conformance Report (NCR) objects where the 
er Page tab of the NCR equals “Minor” and the NCR Relationships tab, 

ffected By table includes change order objects whose Cover Page tab, Change Analyst field lists Larry 
change analyst. 

bject: Non-Conformance Reports 

A
Jones as the 

Search for O

Search Type: Relationships 

With Related Content: Changes 

Search Condition: erity Equal to Minor   And 
Orders.Cover Page.Change Analyst Equal to Larry 

Cover Page. Sev
Relationships.Change 
Jones 

You set up an advanced search to find objects in relationship with each other that fit the criteria you 
specify in the search. See Advanced Searches (on page 155). 

tionship searches allowsRela  you to include attributes from the objects on the Relationships tab in 

à ermine if there is a rule 

à Relationship Type - Affects, Affected By, Reference 

You can select from the following relationship searches: 

your search criteria and to search by Relationship tab attributes including, but not limited to: 

Rule - Null or Not Null - Det

à Criteria Met - Yes or No - Determine if the criteria defined in the rule has been met 

For  object  c lasses:  Avai lable  re la t ionship  searches 

All object classes Relationships Search 

except  
Reports and Action Items. 

 

Programs Content Search 

(Agile PPM) 

File Folders Relationships Search 

Where Used Search     (See Where-used Searches for File Folders 
(on page 179).) 

Transfer Orders Relationships Search 

Selected Content Search 

à Relationships Search allows you to include attributes from the objects on the Relationships tab in 
your search criteria, including search criteria about rules and the relationship type (Affected By, 
Affects, or Reference). 

à Content Search allows you to include Relationships Search attributes and additional Agile PPM 

à Selected Content Search allows you to include attributes from the objects on the Selected Content 
tab in your search criteria. 
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c nt attributes in your search criteria. 

ed information about defining searches, see Advanced Searches

onte

For detail  (on page 155). 

Searching for Users and User Groups 
You can search on Users and User Groups. In Quick Search, you can select Users or User Groups as 
the base class guiding the system per the search-text. You can define a pre-configured parametri
search for users and user groups. In Advanced Search, when you select Users or Use

c 
r Groups in the 

es. 
s 

searches, see Advanced Searches

Search For field, the drop-down list in the Field column is populated with object-specific attribut
As always, your roles and privileges govern what types of objects you can search for as well a
which objects you can open. 

For more information about constructing advanced  (on page 
155). 

Searching for Routable Objects with Workflow 
Attributes 
Workflow Routings (on page 12) introduced and described the workflow-based sample searches.
This section elaborates on this area. 

 

the 

Agile comes with a large array of predefined search samples based on workflow attributes. These 
are designed to complete the majority of tasks for change analysts, observers, and approvers, but 
they can be used by any users if they are assigned the appropriate privileges. 

Note Your ability to use workflow attributes to create searches may be limited depending on 
Agile Server licenses at your site, and which roles and privileges you have been granted. 
For more information, see your Agile administrator. 

T
w

hese predefined workflow searches are also modifiable for use as templates. Building a search 
ith workflow attributes is the same as building standard searches. However, you need to follow 

bui sful search. e informatio
begin with Advanced Se
some special rules to ld a succes

arches
For mor n about building a search, 

 (on page 155). For information about using wor tes in 
searches, see Creating Grouped Conditions for Work

kflow attribu
flow Searches (on page 184). 

ith a new name beforeIt is highly recommended that you save th w  you 
odify them. This wa ays ha mplate to work fro

Creating Workflow Searches 
You can search for ch various attributes relating to the w
You can w attributes flow attr

d con ich further orkf

 general, you can use the workflow attri er non-workflow attributes; however, not all 
w attributes work together in a search with other workflow attributes, or with non-

workflow attributes. If you have selected search attributes that cannot be used together, an error 
message is displayed. For information about creating grouped conditions, see Creating Grouped 

e predefined searches 
m y you will alw ve a te m if you need to start over. 

anges by orkflow in use for those changes. 
combine some of the workflo

create a groupe
with other work

 refines the way the w

butes with oth

ibutes in brackets to 
low attributes work together. dition, wh

In
the workflo

Conditions for Workflow Searches (on page 184). 
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The following table displays each workflow attribute, its operators, and the expected results of using 
it in a search. Use this table to verify that the attributes you wish to search will deliver the 

formation you requir

Note $CurrentStatus limits searches on workflow activities to t flow 

in e. 

he change’s current work
status. $Use earches on  to  
running the search. 

r limits s  users or user actions  the current user, that is, the user

 

Search at t r ibute  Match  I f  
operators  

Value  The change found has these 
at t r ibutes 

Equal To ny 
ssigned 

The specified status matches the current Any workflow status; a
status type; Una status on the Cover Page. 

Not Equal To  tch the 
Page. 

The specified status does not ma
current status on the Cover 

Is Null (None) The Cover Page.Status field is empty. 

Cover 
Page.Status 
 

Is Not Null  y. The Cover Page.Status field is not empt

Equal To Any workflow status; any 
status type 
$CurrentStatus 

The specified status matches the current 
status of the change. 

Signoff.Workflow 
Status 

 
Not Equal To  The specified status does not match the 

current status of the change. 

Equal To Any workflow status; any 
pe status ty

The specified status matches the next 
status of the change. 

Signoff.Next Status 
 

o Not Equal T  The specified status does not match the 
next status of the change. 

Contains One or more users or roup is 
user groups from the 
address book; $User 

The specified user or user g
included in the list of approvers. 

Does Not Contain  Specified user or user group is not 
included in the list of approvers. 

Is Null (None) The approver list is empty. 

Workflow.Approver 

ull mpty; there is at 
 

 

Is Not N  The approver list is not e
least one user, department, or group on
the list. 

Workflow.Observer Contains One or more users or cified user or user group is 
 user groups from the 

address book; $User 

The spe
included in the list of observers. 
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Search at t r ibute  Match  I f  
operators  

Value  The change found has these 
at t r ibutes 

Does Not Contain  The specified user or user group is not 
included in the list of observers. 

Is Null (None) The observer list is empty. 

 

Is Not Null  rver list is not empty; there is at The obse
least one user, department, or group on 
the list. 

Contains One or more users or 
user groups from the 
address book; $User 

 to notify. 
The specified user or user group is 
included in the list of persons

Does Not Contain  The specified user or user group is not 
included in the list of persons to notify. 

Is Null (None) The Notify list is empty. 

Workflow.Notify
Users 

 

 

Is Not Null  The Notify list is not empty; there is at 
least one user, department, or group on 
the list. 

Contains One or more usernames 
from the address book; 
$User 

The specified user performed the signoff 
action. 

Does Not Contain  ser did not perform any The specified u
signoff action. 

Is Null (None) ve performed any signoff No users ha
actions. 

Signoff.Signoff User 
 

Is Not Null  e user has performed a signoff At least on
action. 

Equal To One username from the 
r 

e change to 
address book; $Use

The specified user caused th
be moved out of this status. 

Not Equal To  The specified user did not cause the 
change to be moved out of this status. 

Is Null (None) The change was autopromoted. 

Signoff.Status 
Change

 

d By 

Is Not Null  The change was manually promoted. 

Wo
 

rkflow.Duration 

 

 hours. 

point allowed. 

arison 

<> 
tus 

Must be used in 
conjunction with 
Cover Page.Status.

Number of
Any positive 
number; decimal 

All numerical comp
operators: >, <, >=, <=, =, 

The change was moved to the specified 
status within the number of hours 
specified. 
Cannot be used with Cancel or Hold sta
types. 

Awaiting Approval  
 off. 

One or more approvers/observers have
not signed

Workflow.Approver 
Action 
 

Workflow.Observer 

Contains 
 

Approved One or more approvers/observers have 
approved. 
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Search at t r ibute  Match  I f  
operators  

Value  The change found has these 
at t r ibutes 

Rejected One or more approvers/observers have 
rejected. 

 

Returned One or more approvers’/observers’ signoff 
request has

Action 

 been returned. 

Awaiting Approval All approvers/observers have signed off. 

Approved ers/observers have approved. No approv

Rejected No approvers/observers have rejected. 

Does Not Contain 
 

Returned No approvers’/observers’ signoff request 
has been returned. 

Awaiting Approval All selected approvers/ob
signed off. 

servers have not 

Approved All selected approvers/observers have
approved. 

 

Rejected All selected approvers/observers have 
rejected. 

Equal To 
 

Returned All selected approvers’/observers’ signoff 
request have been returned. 

Awaiting Approval Some s  approvers/observers have 
signed off. 

elected

Approved Not all selected approvers/observers ha
approved. 

ve 

Rejected Not all selected approvers/observers have
rejected. 

 

Note:  When used in 
a grouped condition 
with 
Workflow.Approver 
or with 
Workflow.Observer, 
these attributes 
represent the action 
of the particular user 

y the 
Workflow.Approver 

pr
se

Not all selected approvers’/observers’ 
signoff request have been returned. 

specified b

or 
Workflow.Observer. 

When not used in a 
grouped condition, 
these attributes 
represent the actions 
taken by all the 
ap
ob

overs or 
rvers. 

 Not Equal To 
 

Returned 

 
 

Creating Grouped Conditions for Workflow Searches 
flow search is grouped conditions. This 

opti l sed on certain pairs of workflow attributes. 
Gro

owing grouped condition: 

[  OR  

One of the powerful functions that you can use for a work
on a lows you to build powerful search conditions ba
uped conditions are enclosed in brackets [   ]. 

For example, consider the foll

Signoff.Workflow Status Equal To Status Type.Implemented 
 Signoff.Workflow Status Equal To Status Type.Released ] AND  
 Signoff.Status Changed By Equal To Sharon    

This grouped condition finds all changes where the status type is either Implemented or Rele
and Sharon is the person who changed the status. 

ased 
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Use a grouped condition to refine a search based on workflow attributes. These three rules must be 
follo

à e brackets. 

To g

t to group in brackets. 
he row is highlighted. 

roup. 

laced around the rows selected. 

w attributes in Web Client: 

lect the radio button in the open 
n. 

ou want to place a close bracket, select the radio button in the close 
n. 

laced around the group of workflow attributes. 

To u

1. rows enclosed in brackets. 

2. Click the Remove ( )  button. 

The

à 

à rk

à ign

 Signoff.Next Status 

 

à ame and Workflow.Observer Action is set to 

wed to create a grouped condition: 

à Two workflow attributes are used within a set of brackets. 

à The operator is set to And. 

There are no non-workflow attributes used within th

roup two or more workflow attributes in Java Client: 

1. Select the rows that you wan
a. Click a row to select it. T
b. Use shift-click or Ctrl-click to select the last row of the g

2. Click the [Group] button. 

The brackets are p

To group two or more workflo

1. In the row where you want to place an open bracket, se
parenthesis colum

2. In the row where y
parenthesis colum

3. Click the Add [Group ] button. 

Brackets [   ] are p

ngroup two or more workflow attributes in Java Client: 

Select the 
a. Click a row to select it. The row is highlighted. 
b. Use Shift-click or Ctrl-click to select the second row. 

The brackets are removed. 

To ungroup two or more workflow attributes in Web Client: 

1. Deselect the open and close parenthesis radio buttons in the rows from which you want to 
remove brackets. 

2. Click the Remove ( ) button. 

 following fields qualify for grouped condition searches: 

Cover Page.Status 

Wo flow.Duration 

S off.Workflow Status 

à

à Workflow.Approver when it is set to a valid user’s name, and Workflow.Approver Action is set to 
Equal To or Not Equal To a specific action, and there are no non-workflow attributes within the
brackets. 

Workflow.Observer when it is set to a valid user’s n
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Equ there are no no -wo  attributes within the 
brac

When used in a grouped condition, the workflow attribute that pertains to observers or approvers is 

only that specific status. For example: 

al To or Not Equal To a specific action, and 
kets. 

n rkflow

set to Contains and the operator for the second workflow attribute is set to either Equal To or Not 
Equal To, the grouped condition is evaluated in respect to only that specific approver or observer. 

If one of the workflow attributes in a grouped condition pertains to a status, and specifies a specific 
status, then the remaining workflow attributes in the grouped condition are evaluated in respect to 

à Search 1: Find all changes where Cathy is an approver and she has approved that change. 
The approval action applies specifically to Cathy. Note that the use of brackets makes this a 
grouped condition: 

[ Workflow.Approver Contains [Cathy Agile]  AN
D 

 

 Workflow.Approver Action Equal To [Approved] ]   

 

à Search 2: Find all changes where Cathy is an approver and all approvers have approved that 
change. The approval action applies generally to all the approvers. (Note: this specific search 
does not work, it should be taken as a sample in the context of this discussion.) Note that there 

AND  

are no brackets; this is not a grouped condition: 

 Workflow.Approver Contains [Cathy Agile]  

 Workflow.Approver Action Equal To [Approved]    

In Java Client, grouping is available whenever multiple search conditions a
button is disabled (grayed) the selected search conditions do not make u
condition. Click the Group button to enclose the selected search condition
selected search conditions enclosed in brackets do not make up a va
an error message when you run or save the search. 

In Web Client, grouping is available whenever multiple search conditions a
button to enclose the selected search conditions in brackets [  ]. If the sel
make up a valid grouped condition, Web Client adds brackets. If the sele
not make up a valid grouped condition, you see an error messag
the Add button to enclose in parentheses selected search condition
condition, the selected conditions are enclosed in brackets and become a g

The following figure displays the relationship between the various workflo
a grouped condition. The workflow attributes work only as grouped con

re selected. If the Group 
p a valid grouped 
s in brackets [  ]. If the 

lid grouped condition, you see 

re selected. Click the Add 
ected search conditions 
cted search conditions do 

e. In a similar manner, if you use 
s that make up a valid grouped 

rouped condition. 

w attributes when used in 
itions in pairs within a set of 

brackets. These groupings can be used in conjunction with other search conditions within a single 
d

search. 
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ou can see, not all the attributes function As y together as a grouped condition, while some do not 

Whe flow attributes appear in parentheses along with workflow attributes, parentheses 

( AND  

function without another particular attribute, and others do not work together at all. 

n non-work
are considered precedences rather than a grouped condition. For example: 

Signoff.Signoff User Contains Ann Agile  

 Cover Page.Change Category Equal To Quick Phase-In ) OR  
 Cover Page.Product Line(s) Contains [Scorpio]    

 

Tip  

a  

In W
sub  (  ) for the grouped condition brackets [  ]. 

you r and then save the search again. 

à 

ions.) 

f 
 

 

s and Guidelines for Grouped Conditions

In J va Client, when you attempt to define searches with illegal grouped conditions, Java Client
disables the Group button. 

eb Client, when you attempt to save searches with illegal grouped conditions, Web Client 
stitutes parentheses

In some cases, when you attempt to save a search, you may see an error message. If you do, edit 
r search to correct the erro

Additional restrictions apply to the use of workflow attributes: 

Nested brackets are not supported. You may not include a grouped condition inside the 
brackets of another grouped condition. (You can, however, use a bracketed grouped condition 
inside a set of parentheses with other non-workflow search condit

à Each workflow attribute can be used only once within a grouped condition within a set o
brackets. For instance, you may not useWorkflow.Signoff User twice in the same set of
brackets. 

 Page - 187

  

 



Getting Started with Agile PLM User Guide  
 
 
 

à Workflow.App
used in the s

rover, Workflow.Observer, Workflow.Notify Users and Workflow.Signoff User may not be 
ame grouped condition. 

ntains 

 can be used only along with another workflow attribute within a 

 Status within a grouped 

workflow attributes cannot be used in a grouped h they may be used 
orkflow attributes when enclosed in parenthese

The Match If logical operator Or 

à If Workflow.Approver Action or Wor ition with 
Workflow.Signoff User, then the Ma Workflow.Observer 
Action m l To or Not E  for Workflow.Signoff User 
must be 

Signoff.S er cannot be use n or 
Workflow r Action. 

à When y cific u rkflow.Observer, or Workflow.Notify 
Users, if that user is the member  search also returns changes 

re th or department i mple, if Mary 
 a member of the Libra Project s where Mary is an approver also 

returns changes that list the Libr
 

Editing and Managing Searches and Search 
lder

If you have sufficient privileges, you c hes and the 
folders, even some of the default sys

Buttons and Right-click Menu 
Search 
When you select a search in Java C e left pane 
are enabled; additional functions are

The following table lists and describe rch toolbar in Java Client. 

à Workflow.Approver Action and Workflow.Observer Action may not be used in the same grouped 
condition. 

à Workflow.Duration can be used only in a grouped condition within a set of brackets that co
only Workflow.Workflow Status with an operator of Equal To. 

à Workflow.Workflow Status
grouped condition. 

à Workflow.Status Changed By can be used only with Workflow.Workflow
condition. 

à Non-
with w

condition, althoug
s. 

à cannot be used in a grouped condition. 

kflow.Observer Action is used in a grouped cond
tch If operator for Workflow.Approver Action or 

ust be Equa qual To, and the Match If operator
Contains. 

à ignoff Us
.Observe

d in a grouped condition with Workflow.Approver Actio

ou search for a spe ser for Workflow.Approver, Wo
 of a group or department, the

whe
is

e group s an approver, observer, or user to notify. For exa
 group, searching for change
a Project group as an approver. 

Fo s 
an rename, delete, and rearrange both searc
tem searches. 

Choices in the Java Client 
Toolbar 

lient, most of the buttons on the Search toolbar in th
 enable on the right-click menu.  

s the buttons used in the Sea

Button  Name Descr ipt ion 

 search folder within the current folder (you can 

Available in both Search toolbar and right-click menu. 

New Adds a new 
select another folder in the Save In Folder dialog). 
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Button  Name Descr ipt ion 

 Edit Search 

Right-click menu only 

Opens the selected search in edit mode. 

Available in right-click menu only. 

 
 

og box 
that prompts for a filename and directory. 

Save As
Right-click menu only

Saves the selected search, with standard Save As dial

Available in right-click menu only. 

 
Rename Lets you rename the selected se

se
arch (all searches) or the 

lected user-defined subfolder. 

Available in both Search toolbar and right-click menu. 

 e To Folder Moves the selected search or subfolder to the folder you specify. Mov
Available in both Search toolbar and right-click menu. 

 Delete Removes the selected user-created search or user-created 

enu. 

subfolder. 

Available in both Search toolbar and right-click m

 Organize Sear
Right-click menu only 
when the top Search 

you to 

•Create, rename, or remove folders. 

•Rename or remove searches. 

es depending on your 

nu only. 

ch Opens the Organize Search dialog which allows 

folder is selected. 

•Reorder folders and search
privileges. 

Available in right-click me

 
Expand All When the Searches folder is highlighted, expands all the 

Available only when the subfolders. 

top Search folder is 
selected. 

Available in both Search toolbar and right-click menu 

 
Collapse All When the Searches folder i

Available only when the 
top Search folder is 

subfolders. 

Available in both Search toolbar and right-click menu 
selected. 

s highlighted, collapses all the 

 Refresh Left Panel Refreshes the navigation pane of Java Client’s user interface 
Tree 

Butt

ons on the Searches page in Web Client. 

ons on the Web Client Search Toolbar 

The following table lists and describes the butt

Button  Descr ipt ion 

 Expand All 
Expands all the search folders in the navigation pane to display all available 
searches. 

 Collapse All 
Collapses all the search folders in the navigation pane. 
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Button  Descr ipt ion 

 Organize Searches Opens the Organize Searches window. 

 

Organizing
 can be w. 

rg

1. Select the Se

 

 Searches 
Searches  organized in the Organize Searches windo

To open the O anize Search window in Java Client: 

arches folder  at the top of the Search tab in the left navigation pane. 

ight-click a2. R nd choose  Organize Search in the menu. 

The Organiz

To open the Organi arches window in Web Client: 

In the Search Folders navigation pane, click the 

e Search window opens. 

ze Se

 Organize Searches icon next to the Searches 1. 
folder.  

Or 

In the Web Client main menu, Click Tools  > My Settings > Organize Searches. 

The Organize Searches window opens. 

Searches window to create or remove folders, rename or remove 
nd searches. 

The Organize Searches Window 

Use the features in the Organize 
searches, and sort and move folders a

Button  Descr ipt ion 

Remove Removes the selected searches and search folders. 

See Deleting a Search (on page 192) or Removing a Folder (on page 194). 

Rename Renames the selected search or search folder. 

See Renaming a Search (on page 192) or Renaming a Folder (on page 195). 

Add New Adds a new search folder within
Folder 

 the current folder. 

(drag and drop) Allows you to reorder searches and search folders. 

hes and FoldersSee Moving Searc  (on page 195) below. 

Save Save the modifications you made in the Organize Searches window. 

Cancel Discards the modifications you made in the Organize Searches window and closes the 
window. 
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Editing Searches 
When you edi ination of conditions Agile looks for. You might 

 search to either broaden or narrow the scope of the search or change the output 

able depends on your privileges. 

t a search, you are changing the comb
want to edit a
fields. 

Note Whether a search is edit

Wh n editing a search you can: e

à terior of the search condition table 

à 

à 

à arch results 

 Client 

2. Select the search, right-click and choose Edit Search in the menu. 

nt to edit. To edit the search, follow the steps in 

à Alter the values of se ch criteria ar

à Add conditions to the search condition table 

Insert conditions into the in

à Delete conditions from the search conditions table 

Substitute an And for an Or and vice versa 

Add or remove output columns in search results 

Modify the sort order of se
 

Editing a Search in Java

To edit a search in Java Client: 

1. In the Search folder, navigate to the search you want to edit. 

3. To edit search conditions, click the row you wa
Creating an Advanced Search in Java Client (on page 158), Creating an Advanced Search in 
Web Client (on page ), or Where-Used Searches for Items161  (on page 169). 

ele  delete, and click Delete. 

 button in the search 

To delete a condition, s ct the row you want to

4. When you are finished, click Save. 

Note If the search results window is open, click the View/Edit
results window, and edit the search. 

 

Editing a Search in Web Client 

To edit a sea

1. In the Se e navigation pane, navigate to the search you want to edit. 

rch in Web Client: 

arches folder in th

2. Click the Edit Search  icon to the right of the search name. 

More button drop-down list, choose 
utput Display... 

e steps in Advanced Searches

3. To edit the output columns or the sort order, from the 
Customize O

4. To edit search conditions, follow th  (on page 155) or Where-
Used Searches for Items (on page 169) to edit the search. 

To delete a condition, click the  Remove ch Criteria on at the end of the row. Row from Sear  butt
To insert a condition, click the  Insert Row in Search Criteria at the row below which you want to 

 Page - 191

  

 



Getting Started with Agile PLM User Guide  
 
 
 

insert the new conditions. 

5.  yo
 

Renamin
 better indicate the type of objects the search is designed to 

h tab: 

1. In the Search tab, select the search you want to rename. 

When u are finished, click Save. 

g a Search 
You can rename a saved search to
locate. 

To rename a search in Java Clie t Searcn

2. Right-click and select  Rename in the menu. 

To rename a search in Java Client Organize Searches window: 

1. Select the Searches folder 

3. In the dialog, enter a name for the folder and click OK. 

, right-click and choose   in the menu. 

 search you want to rename and select it. 

h searches and folders you can 

Organize Search
2. In the Organize Search window navigate to the

Note Your assigned roles and privileges control whic
rename. You can always rename searches and folders in your Personal 
Searches folder. 

3. . 

OK

To rename a search in Web Client: 

1. In the Se

Click the Rename button

4. Edit the name of the search in the Enter Name field. 

5. Click . 

6. When you are finished, click Save. 

arch Folders navigation pane, click the  Organize Searches icon. 

2. In the Orga rches window navigate to the search you want to rename and select it. 

privileges control which searches and folders you can 

nize Sea

Note Your assigned roles and 
rename. You can always rename searches and folders in your Personal 
Searches folder. 

3. Click the  Rename button. 

4. In the text field, enter a new name and press the Return key. 

5.  yoWhen u are finished, click  Save. 

 a Sear
 

Deleting ch 
earch on the Searches tab if you have the appropriate privileges 

rches page. 

In Java Client, you can delete a s
for that search. 

In Web Client, you can delete a search from the Organize Sea
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To remove a search in Java Client Search tab: 

1. In the Search tab, select the search you want to delete. 

2. Right-click and select  Delete in the menu. 

3. When the confirmation p rs, click Yes. rompt appea

The search is deleted. 

To remove a search in Java Client Organize Search window: 

1. Select the Searches folder , right-click and choose   Organize Search in the menu. 

2. In the Organize Search window navigate to the search you want to remove and select it. 

Note Your assigned roles and privileges control which searches and folders you can 
remove. You can always remove searches and folders in your Personal 
Searches folder. 

3. Click the Remove button. 

4. When you are finished, click Save. 

click the 

To remove a search in Web Client: 

1. In the Search Folders navigation pane,  Organize Searches icon. 

e and select it. 2. In the Organize Searches window navigate to the search you want to remov

Note Your assigned roles and privileges control which searches you can remove. 
You can always remove searches and folders in your Personal Searches 
folder. 

 Remove button. 3. Click the 
 

Using Folders to Organize Searches 
You can organize your searches in folders to make them easier to locate and manage. You can use 

es. 

Creating a Folder 

tab: 

ate a new folder. 

the existing folders or create new on

To create a search folder in Java Client Search 

1. In the Search tab, select the folder in which you want to cre

2. Right-click and choose  New Folder in the menu. 

3. In the Folder Name field, enter a name for the folder and click OK. 

To c the Organize Search window: reate a search folder in Java Client in 

1. Select the Searches folder , right-click and choose  Organize Search in the menu. 

er. 2. In the Organize Search window navigate to the folder in which you want to create a new fold

Note Your assigned roles and privileges control the folders in which you can create 
new subfolders. You can always add folders in your Personal Searches folder. 

3. In the Folder Name field, enter a new name. 
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4. Click OK. 

5. When yo

Web Client: 

1. In the Search Folders navigation pane, click the 

u are finished, click Save. 

To create a search folder in 

 Organize Searches icon. 

to the folder in which you want to create a new 2. In the Organize Searches window navigate 
folder. 

Note Your assigned roles and privileges control the folders in which you can create 
new subfolders. You can always add folders in your Personal Searches folder. 

 New button. 3. Click the 

4. In the text field, enter a new name and press the Return key. 

5. When you are finished, click  Save. 
 

Removing a Folder 

You can remove or delete a folder, even if it is not empty. 

e. 

To remove a folder in Java Client Search tab: 

1. In the Search tab, select the folder you want to delet

 Delete in the menu. 2. Right-click and choose 

3. When the confirmation prompt appears, click Yes. 

The folder and its contents are deleted. 

To remove a folder in Java Client Organize Search wind w: o

, right-click and choose  Organize Search in the menu. 1. Select the Searches folder 

2. nize Search window, navigate to the folder you want to remove and select it. 

Note . You 

In the Orga

Your assigned roles and privileges control which folders you can remove
can always remove searches and folders in your Personal Searches folder. 

3. Click the Remove button. 

4. When you are finished, click Save. 

To remove a search or folder in Web Client: 

ne, click the 1. In the Search Folders navigation pa  Organize Searches icon. 

 navigate to the folder you want to remove and select it. 

emove. You 

2. In the Organize Searches window

Note Your assigned roles and privileges control which folders you can r
can always remove searches and folders in your Personal Searches folder. 

3. Click the  Remove button. 

u are finished, click 4. When yo  Save. 
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Renaming a Folder 

To rename a folder in Java Client Search tab: 

 want to rename. 1. In the Search tab, select the folder you

2. Right-click and select  Rename in the menu. 

3. In the Enter Name field, enter a name for the folder. 

nize Searches window: 

4. Click OK. 

To rename a search in Java Client Orga

1. Select the Searches folder , right-click and choose  Organize Search in the menu. 

2. In the Organize Search window navigate to the search you want to rename and select it. 

Note Your assigned roles and privileges control which searches and folders you can 
rename. You can always rename searches and folders in your Personal 
Searches folder. 

3. Click the Rename button. 

4. In the Enter Name field, enter a name for the folder. 

5. Click OK. 

6. When you are finished, click Save. 

To rename a search in Web Client: 

1. In the Search Folders navigation pane, click the  Organize Searches icon. 

2. 

Note trol which folders you can rename. You 

In the Organize Searches window navigate to the folder you want to rename and select it. 

 Your assigned roles and privileges con
can always rename searches and folders in your Personal Searches folder. 

3. Click the  Rename button. 

4. In the text field, enter a new name and press the Return key. 

5. When you are finished, click  Save. 
 

Moving Searches and Folders 

To use the Search window buttons to move a search or a search folder into another folder in 
Java Client: 

1. Select the Searches folder , right-click and choose  Organize Search in the menu. 

2. In the Organize Search window, navigate to the folder or search you want to move. 

3. Click the folder or search to select it. 

4. Drag the folder or search to its new location and drop it onto: 
y Highlighted folder – the dropped folder or search is moved into the highlighted folder. 
y Grey line between two names in the list of searches and folders – the dropped folder or 

search is moved to that location in the list. 
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5. When you are finished, click Save. 

To move a search or a search folder into another folder in Web Client: 

1. In the Search Folders navigation pane, click the  Organize Searches icon. 

2. In the Organize Searches window, navigate to the search or folder that you want to move. To 
expand a folder, click its folder icon. 

3. Click the folder or search to select it. 

4. Drag the folder or search to its new location and drop it onto: 
y Highlighted folder – the dropped folder or search is moved into the highlighted folder. 
y Grey line between two names in the list of searches and folders – the dropped folder or 

search is moved to that location in the list. 

5. When you are finished, click Save. 
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Routing Objects with Workflows 
This chapter includes the following: 

� About Workflows.................................................................................................................................................. 197 
� Status List ............................................................................................................................................................ 198 
� Default Workflows................................................................................................................................................ 200 
� Example of a Customized Workflow .................................................................................................................... 202 
� Using Workflows in the Change Control Process ................................................................................................ 203 
� Working with Workflows....................................................................................................................................... 205 
� After a Routable Object is Released.................................................................................................................... 236 
� Switching Routable Objects to Their Final Status................................................................................................ 236 
� Redlining through ECOs, MCOs, PCOs and SCOs............................................................................................. 237 
� Deleting Routable Objects ................................................................................................................................... 238 
� Printing Routable Object’s Data........................................................................................................................... 240 

 
 

About Workflows 
Workflows automate the change control process by performing or completing tasks that you 
previously performed manually. For example: 

à When you create a routable object, you can select the appropriate workflow from the list of 
available workflows for that routable object. 

à When the routable object moves into a Review or Released status type, the lists of approvers 
and observers can be automatically selected. 

à When all the approvers have signed off for a Review or Released status type, and all the 
required fields have been completed, the routable object can be automatically promoted to the 
next status with the AutoPromote feature. 

à By defining a workflow with multiple Review or Released status types, you can sequentially 
route an object to different lists of approvers and observers. 

à When all required fields have been filled in on a routable object, it can be autopromoted to the 
next status. 

à 

à 
e 

ion person can then approve or reject the routable object in place of the 

à 
f time. If you have the appropriate privileges, you can transfer signoff authority for other 

users. 
 

When an approver does not respond within the specified reminder period set by the Agile 
administrator, a reminder email will be sent automatically. 

If the approver does not respond within the specified escalation period set by the Agile 
administrator, the routable object will be sent to that user’s designated escalation person. Th
designated escalat
original approver. 

You can transfer your authority to approve the routable object to another user for a specified 
period o
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Status List 
At its most basic level, a workflow consists of: 

à A unique name 

à A list of matching criteria 

à A list of statuses 

The status list defines the ordered list of statuses (or steps) that the routable object must go through 
during the change control process. The Agile administrator can define each workflow to have as 
many statuses as required. Each status is of a particular status type. Some status types may be 
used only once in a workflow, while others may be used multiple times. 

The following table lists and defines the different status types. 

Status type  Constra ints  Def in i t ion  

Before a workflow is selected for a routable object 

Unassigned “Placeholder” Unassigned is the default initial status name before a 
routable object has been matched with a workflow. 

Basic Status Types (Active) 

Pending Required. 
 
Used once. 

à An originator is developing the routable object. 
à A workflow must begin with a Pending status type; 

it is the first status in every workflow. 
Submit Not required 

Unlimited use. 
The Submit status type sends the routable object to 
the specified routing manager, who determines 
whether or not to promote the routable object to the 
next status. 

Review Not required. 
 
Unlimited use. 

The Review status type routes the routable object to 
CCB members (approvers and observers). When all 
approvers have signed off, and required fields have 
been completed, the routable object is automatically 
promoted to next status in the status list if 
AutoPromote is on. If the AutoPromote is off or it is 
manually moved by the routing manager.  
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Status type  Constra ints  Def in i t ion  

Released Not required. 
 
Unlimited use. 

à When a routable object enters the first Released 
type status, the software performs a series of 
checks; it also creates new revisions of the affected 
items (ECOs) with the new BOM, incorporates 
redlines into a new “rev,” or updates the 
manufacturer part information (MCOs). 

à Like the Review status type, the Released status 
type may have approvers and observers and be 
routed for signoff and may be autopromoted. 

à Only the first Released status actually releases the 
routable object. Subsequent Released status 
types—given distinguishing status names—provide 
additional review/approval cycles for the released 
routable object. 

à Returning a released routable object to any of the 
first three status types unreleases  the routable 
object—removes approvals that were gathered. 

Complete Not required. 
Used once. 

à If Complete status type is used, it must be the last 
active status in the workflow, and it may be used 
only once. 

Cancel 
 

Hold 

Not required. 
They are a means to 
inactivate a routable object. 
They always follow the final 
active status (e.g., Complete) 
in the status list. 
Note: List Cancel before Hold 
in the status list if both are 
present (although a routable 
object might well be held 
before it is canceled). 

à The Cancel and Hold status types provide two 
ways to remove a routable object from the 
workflow. They are added to the end of the status 
list as they are never part of the active sequence of 
statuses. 

à Hold temporarily removes a routable object from 
the workflow and allows you to reinsert it later. 

à Cancel permanently removes a routable object 
from the workflow. If the routable object includes 
affected items with redline changes, the redlines 
are discarded. 

à If a routable object has been released, moving to 
the Hold or Cancel type status unreleases the 
routable object. 

à You manually move a routable object to Cancel or 
Hold from any other status in the workflow 
(assuming it is listed as a valid next status under 
the Manual Valid Next Status property). 

à When moved to Hold, it stays there until you 
manually move it back into the workflow. These 
moves require proper Change Status privileges. 

 
 

Viewing Workflows 
You can view all the workflows used at your company from any open routable object. In Java Client, 
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click the View Workflows button  on the toolbar of the object window. In Web Client, choose the 
View Workflows command on the Actions menu. This feature allows you to browse through the 
available workflows and their status lists at any time. You can examine the various workflows before 
you select one for a routable object. You can also view workflows if you have already specified one 
for the object. 

To view all workflows and their status lists in Java Client: 

1. Open the routable object you want to work with. 

2. Click the View Workflows button. The View Workflows dialog box appears, displaying a flowchart 
of the statuses in the default workflow for that object type. 

3. To see the statuses for a different workflow, select it from the Select Workflow drop-down list. 

4. When you have finished viewing the workflows, click Close. 

5. If you want to select a workflow for the object, on the Cover Page tab, select a workflow from the 
Workflow drop-down list, and click Save. The Workflow tab now displays the flowchart for the 
workflow you selected. 

To view all workflows and their status lists in Web Client: 

1. Open the routable object you want to work with. 

2. Choose Actions > View Workflows. The View Workflow page appears, displaying a flowchart of 
the statuses in the default workflow for that object type. 

3. To see the statuses for a different workflow, select it from the Please select a Workflow drop-down 
list. 

4. When you have finished viewing the workflows, click Cancel. 
5. If you want to select a workflow for the object, on the Cover Page tab, click Edit, select a workflow 

from the Workflow drop-down list, and click Save. The Workflow tab now displays the flowchart for 
the workflow you selected. 

 

Show/Hide Workflows within a Class 

When you open the Workflow tab of a routable object, a second  button is called Hide/View 
workflow chart in Java Client and Show/Hide Workflow Overview in Web Client. Here this button is a 
toggle: in an ECO, if the workflow is not visible and you click the button, the ECO’s workflow 
appears — and the same is true for the workflow of any ECO you open at this point. If you click the 
Show/Hide Workflow button again, the workflows are hidden in all ECOs. The switch controls the 
View/Hide mode for all objects in that Agile class (for example, ECOs, PCOs, or Problem Reports). 
This is on a “per machine” basis, that is, it is not dependent on which user is logged on or other 
factors. 

Default Workflows 
Agile PLM includes default workflows for each routable object type. Default workflows provide the 
same change control process as previous Agile releases. 
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Sequence Defaul t   
Change  
Orders ,  
Defaul t  

S i te  
Change 
Orders  

Defaul t  
Change 

Requests  

Defaul t  
Deviat ions 

Defau l t  
Stop 

Ships 

Defaul t  
Manufacturer  

Orders  

1st Pending Pending Pending Pending Pending 

2nd Submitted Submitted Submitted Submitted Submitted 

3rd CCB CCB CCB CCB CCB 

4th Released Released Released Released Released 

Final Implemented Closed Expired Resumed First Article Completed 

The Hold and Canceled statuses are optional and are not part of the sequential status list: 

Optional Canceled Canceled Canceled Canceled Canceled 
 Hold Hold Hold Hold Hold 

 

Sequence Defau l t  ATOs Defau l t  CTOs 

1st Pending Pending 

2nd Released Review 

3rd  Released 

Final Complete Complete 

 

Sequence Defaul t   
Problem 

Reports  and 
NCRs 

Defaul t  CAPAs Defau l t  Audi ts  

1st Pending Identified Preparation 

2nd Submitted Acknowledged Initiation 

3rd Review Investigated Analysis 

4th Released Implemented Issued 

5th  Validated Correction 

6th   Validation 

Final Closed Closed Closed 

The Hold and Canceled statuses are optional statuses that are not part of the sequential status list: 

Optional Canceled Canceled Canceled 
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Sequence Defaul t   
Problem 

Reports  and 
NCRs 

Defaul t  CAPAs Defau l t  Audi ts  

 Hold Hold Hold 

 

Sequence Defaul t   
Act iv i t ies  

Defau l t  Gates  

1st Not Started Closed 

2nd In Process In Review 

Final Complete Open 

The Canceled status is an optional status that is not part of the sequential status list: 

Optional Canceled Canceled 

 

Sequence Defaul t  Packages 

1st Pending 

2nd Submitted 

3rd Review 

4th Accepted 

Final Closed 

The Hold and Canceled statuses are optional statuses that are not part of the sequential status list: 

Optional Canceled 
 Hold 

The Default File Folders workflow has one status, Review. This workflow and the Default ATOs 
workflow are read-only. 

Example of a Customized Workflow 
The following figure shows an example of a customized workflow. Notice that this workflow has 
three different Review status types and two different Released status types. A routable object using 
this workflow is: 

à Routed through an approval cycle (Review status type) before it is submitted to the change 
analyst. 

à Routed through two approval cycles (Review status type) before it is released, with a different 
group of approvers for each approval cycle. 

à Released when it moves into the first Released status type. 

à Moved into the second Released status type after the required fields have been filled in and, at 
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this status, routed for approval a final time before moving into the Complete status type. 

Customized Agile workflows allow great flexibility in defining change control processes to meet your 
company’s needs. 

 
 

Using Workflows in the Change Control Proce
When a routable object is first created, it has no workflow assigned to it; therefore, it h
workflow status. Until you select a workflow for the routable object, it remains unassign

ss 
as no 
ed, and the 

Unassigned status stamp is displayed in the upper right corner of the Cover Page tab. 

You can edit an unassigned routable object the same way you edit a routable object in a Pending 
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status type: fill in fields, add items to the Affected Items tab, add files to the Attachments tab, and so 
on. 

When you have finished editing an Unassigned routable object, or a routable object in the Pending 
art the routable object moving through the change control 

unassigned, and the 

2. se methods to 
sele

orkflow drop-down list. 

y  above the tabs. 

 Select Required 
og drop-down list. 

lick

Note able object are shown in the drop-down 

status type, and you are ready to st
process, use the Next Status button. 

Selecting a Workflow 
Until you select a workflow for a routable object, the routable object remains 
Unassigned status stamp is displayed in the upper right corner. 

To select a workflow for an unassigned routable object in Java Client: 

1. Open the routable object that you want to assign a workflow to. 

When working with an unassigned routable object, you can use either of the
ct a workflow: 

y On the Cover Page tab, select a workflow from W
Click Save in the object window. 
Or, click the Next Status button

If there is no workflow assigned, you are prompted to select one in the
Fields dial

Complete any required fields, for example, select a Change Analyst. 

C  OK. 

All the workflows that match the rout
list. The drop-down list may vary depending on whether the Agile administrator 
has created any custom workflows. 

The s s of the routable object switches to the first status in the selected workflow, which is 
alway Pending status type. 

tatu
s a 

Note As long as the routable object is in the Pending status type, you can select a different 
workflow. 

¾ assigned 
 Pending status type 

To select a different workflow for a routable object that is not in either the Un
status or the Pending status type, you must switch the status to the
first. (See Returning a Routable Object to the Originator (on page 228).) 

3. bject to which you want to assign a workflow. 

4. ct, you can use either of these methods to 
sele
y r Page tab, click the Edit button. 

 

y  above the tabs. 

 Select Required 

To select a workflow for an unassigned routable object in Web Client: 

Open the routable o

When working with an unassigned routable obje
ct a workflow: 
On the Cove
Select a workflow from Workflow drop-down list.

Click Save. 
Or, click the Next Status button

If there is no workflow assigned, you are prompted to select one in the
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Fields wizard drop-down list. 

om

Click

Note All the workflows that match the routable object are shown in the drop-down 

C plete any required fields, for example, select a Change Analyst. 

 OK. 

list. The drop-down list may vary depending on whether the Agile administrator 
has created any custom workflows. 

The s s of the routable object switches to the first status in the selected workflow, which is 
Pending status type. 

As long as the routabl

tatu
always a 

Note e object is in the Pending status type, you can select a different 
workflow. You can also select the blank field in the Workflow drop-down list, which 

ow switches the routable object to the Unassigned status and cancels the previous workfl
selection.  

To select a different workflow for a routable object that is not in either the Unassigned 
t switch the status to the Pending status type 
he Originator

status or the Pending status type, you mus
first. (See Returning a Routable Object to t  (on page 228)). 

Working with Workflows 
This section includes the following topics: 

à Auditing Routable Objects (on page 207) 

à Switching a Routable Object from One Status to Another Status (on page 206) 

à Demoting a Routable Object (on page 211) 

eà Completing the Status Chang  (on page 212) 

à Handling Routed Changes (on page 214) 

Approving Routable Objects 

à 

à 

Rejecting Routable Objects 

à Reminder Period and Review Escalation Period (on page 223) 

à Designated Escalation Person (on page 223) 

à Transferring Signoff Authority (on page 224) 

à Defining Personal Criteria for Authority Transfers (on page 227) 

à Returning a Routable Object to the Originator (on page 228) 

à Canceling a Routable Object (on page 229) 

à Uncanceling a Routable Object (on page 230) 

à Putting a Routable Object on Hold (on page 230) 

à Releasing Routable Objects (on page 231) 

à Unreleasing Routable Objects (on page 232) 
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à Multiple Released Status Types (on page 233) 

à Adding Comments to the History Tab (on page 234) 

ng a Routable Object’s Subclassà Changi  (on page 234) 

Rou s move through the change control process by moving through the statuses in the 
n two 

e object is autopromoted from its current status to the next status in the workflow 
status list. 

For 

 

Switching a Routable Object from One Status to Another 
Status 

table object
workflow status list. Routable objects make the transition from one status to another status i
ways: 

à The routabl

à An Agile use s the routable object from one status to another status manually. r switche

details about switching a routable object from the Unassigned status, see Selecting a Workflow 
page 204). (on 

à 
t. Click this button, and the appropriate change status 

dialog box (Java Client) o Client) i layed. 

st. For example, you might switch a routable object from a 

out your privileges. 

ny 
id

 valid next status in Java Client: 

1.  the

2. Audit the r 
status. If 

A routable object is manually switched from one status to another in one of the following ways: 

The Next Status button switches the routable object from the current status to the next 
sequential status in the workflow status lis

r page (Web s disp

à The Workflow tab allows you to switch the routable object from the current status to any status 
allowed by the settings in the workflow (manual valid next status). The status need not be the 
next status in the workflow status li
Submit status type to a Hold status type. 

Whether you use the Next Status button or the Workflow tab, you must have the appropriate privileges 
to switch a routable object from one status to another status. See your Agile administrator if you 
have questions ab

Switching the Status of a Routable Object 

You can use the Workflow tab or the Next Status button to switch the status of a routable object to a
val  next status. 

To switch a routable object to any

Open  routable object. 

 routable object to ensure that there are no errors that prevent switching to anothe
any errors are found, fix them. (See Auditing Routable Objects (on page 207).)

Workflow tab. 

 

3. Click the 

Note The valid next statuses (underlined statuses) that appear on the Workflow tab 
are determined by workflow property settings and your privileges. To review the 

entire status list, click the View Workflows button  in the toolbar. Click Close 
to close the View Workflows dialog box. 

4. e of the valid next statuses from the chart on the Workflow tab, or click the default next Click on
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status (underlined). Or click the Next Status button above the tabs to accept the default next 
status in the sequence. 

When5.  the Change Status dialog box appears, add the appropriate approvers, observers, users 
to notify, and comments. (See Adding and Removing Approvers and Observers (on page 

 completes the status change, for example, Submit, Route, or Release. 

 valid next status in Web Client: 

1.  the

2. Audit the ther 
status. If any errors are found, fix them. (See Auditing Routable Objects

215).) 

6. Click the dialog button that

The routable object moves to the selected status, which is the yellow status on the Workflow 
tab. 

To switch a routable object to any

Open  routable object. 

 routable object to ensure that there are no errors that prevent switching to ano
 (on page 207).) 

ge Status page are determined 

3. Click the Workflow tab. 

Note The valid next statuses that appear on the Chan
by workflow property settings and your privileges. To review the entire status 
list, choose Actions > View Workflows. Click Cancel to close the View Workflow 
page. 

4. 

servers, users to 

Select one of the valid next statuses from the chart on the Workflow tab, or click the Next Status 
button to accept the default next status in the sequence. 

5.  When the Change Status page appears, add the appropriate approvers, ob
notify, and comments. (See Auditing Routable Objects (on page 207).) 

The routable object moves to the selected status, as which is the orange status on the Workflow 

pears to be filled in. 
d comments, and you may spend several 

 Route, Agile performs an automatic workflow status 
lem is found. You are asked if you want to continue: 

 

With app

The omatically when you use the Change Status function or the 
workflow attempts to autopromote to the next status. You can perform a status audit at any time by 

6. Click OK. 

tab. 

You can use the Next Status button to switch the status of a routable object. 

Save Routing Slip Content when Advancing Change 

When you manually advance a workflow to the next status, the routing slip ap
This contains approvers, observers, “notify” users, an
minutes completing the slip. When you click
audit and presents you with a dialog if a prob
previously, if No was selected, you were returned to the routable object and lost all the work. As of 
Agile 9.2.1, if you select No, you are returned to the routing slip, allowing you to copy the routing 
slip data and paste it to a temporary location, such as a word processor file. 

Auditing Routable Objects 
You can audit a routable object at any status in the workflow. Before switching the routable object to
a different status, always audit the object to detect any errors that may prevent switching to a 
different status.  

ropriate privileges, you can perform two types of audits—a status audit and a release audit. 

status audit is performed aut
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using the Audit Status button or menu selections. It performs the following checks: 

Makes sure the Exit Required Fields for the current status are filled in. à 

 If the current status is a Review status type or a Released status type, makes sure that all 

ss 
rning, Agile PLM also performs a release audit. 

 

ically when the routable object is promoted to the first 
e

The it for both the current status and the release status. 

à Affected Items

à are manufacturer redlines that will be lost 

à ct 

à er ECO, SCO, or 

à 

l 

à 

à t on an item. 

 an item has multiple 
 

à tiple 
ing or Disallow.) 

à
approvers have approved. 

à Checks the workflow settings of the Pass Release Audit property for the current status. If Pa
Release Audit is set to either Yes or Wa

 

Agile PLM performs a release audit automat
Rel ased type status in the workflow. You can perform a release audit at any time by using the 
Audit Release button or menu selections. 

 release audit performs the status aud

It performs the following additional checks: 

For ECOs, checks if the proposed new revision number on the  tab already exists. 

For ECOs, SCOs, PCOs and MCOs, checks if there 
after the routable object is released. 

For ECOs and SCOs, checks if there are BOM redlines that will be lost after the routable obje
is released. 

For ECOs, SCOs, PCOs and MCOs, checks if there are conflicts due to anoth
MCO being released first. 

For ECOs, SCOs, and MCOs, if the BOM Multi-level Recursive SmartRule is set to Disallow, 
checks for recursive BOM structures, that is, when a subassembly includes one of its parent 
items from an upper level of the BOM tree structure on its own BOM. (A recursive BOM 
structure, if carried to its logical conclusion, would repeat indefinitely). 

The BOM tree is evaluated from top to bottom. The Audit Release error message indicates, for 
each affected item with a recursive BOM, the first item found in the BOM tree whose first-leve
BOM table includes an item that appears at a higher level in the BOM tree, thus causing a 
recursive BOM structure. Although there may be multiple instances of recursive BOM structure 
in an affected item BOM tree, only the first found instance is displayed in the audit results. 

For ECOs, SCOs, and PCOs, depending on SmartRule settings, checks for duplicate items, 
duplicate find numbers and duplicate reference designators caused by a change rebase. 
(When there are multiple pending changes for the same item, when one change is released, 
the remaining pending changes are rebased on the latest released change.) 

For ECOs, SCOs, and MCOs, checks for duplication of the same manufacturer par
(MultipleItemsPerManufPart is set to Warning or Disallow.) 

(Duplication of the same manufacturer part on an item occurs when
pending changes which associate the same manufacturer part to that item and one change is
released. The remaining pending changes are rebased on the latest released change. The 
remaining pending changes now include manufacturer part redline modifications to add a 
manufacturer part that already exists on the released item's Manufacturers table.) 

For ECOs, SCOs, and MCOs, checks for the use of the same manufacturer part on mul
items. (MultipleItemsPerManufPart is set to Warn

(Duplication of the same manufacturer part on multiple items occurs when multiple changes 
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add the same manufacturer part to two or more item's Manufacturers tables, either by redline 
anufacturer part's 
ing pending 

 single 

 or Warning, 
sed. 

remain checked out. 

à Checks the Effectivity Date Order and Effectivity Gap SmartRul

uct Collaboration User Guide. 

Mod

If yo
table, even if the item has fic. 

e The 
follo

à rder, the release audit 
validates the site's  and  settings with the item Sites tab 

ake
auto

à Beca
chan  violations caused by a modification to Make/Buy remain on the 

e, 

addition or redline replacement. When one of the changes is released, the m
Where Used table is rebased to refer to the newly released item. The remain
changes now include manufacturer part redline modifications that would allow a
manufacturer part to be used by multiple items.) 

à For ECOs, SCOs, and PCOs, if the Item Release First SmartRule is set to Disallow
then the routable object is checked to see if the child components have been relea

à Checks if any of the attachments of the routable object remain checked out. 

à For every affected item, checks if any of the attachments 

e settings. 

à Checks if items on the Affected Items tab have any other pending routable objects. 

à For ECOs, validates the affected item's Sites tab Make/Buy setting with the site's Site AML Allowed 
and AML Required on Buy settings. For more information, see Prod

 

ifying the Make/Buy Field on the Item Sites Tab 

u have the appropriate modify privileges, you can modify the Make/Buy field in an item's Sites 
been released. However, the Make/Buy setting is not revision-speci

Wh n you modify the Make/Buy setting on any item revision, it is also modified for all revisions. 
wing restrictions apply when modifying the Make/Buy setting: 

When the item is included on the affected items table of a change o
Site AML Allowed AML Required on Buy

M /Buy setting for that revision.  Past revisions are not audited. (A release audit is performed 
matically when the change order is released.) 

use the Make/Buy setting is not revision-specific and can be changed without using a 
ge order, any validation

latest released revision of the item and may not be detected until the next time the item is 
added to a change order and the change order is release audited. 

 

Note When a routable object moves from the current status (including the Pending status typ
the first status in the workflow) to the next status in the workflow, the system automatically 
performs a release audit depending on the workflow Pass Release Audit property settings 
for the current status. 

In Java Client, the audit results box remains open until you close it. This allows you to refer to the 

e termine which objects and which fields you can 

audit results as you modify the routable object. 

Not  Your Discovery and Read privileges de
see in the audit results box. If you do not have the appro
words “No Privilege” displayed. 

priate privileges, you may see the 

 

See also Switching a Routable Object from One Status to Another Status (on page 206). 

To a lient: 

1. 

udit the current status of a routable object in Java C

Open the routable object you want to audit. 

You may audit a routable object from any tab. 
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2. Click the Audit Status   button above the tabs. Or right-click in the Agile Java Client window; 
. 

ppears. 

 and audit again. 

3. ialog box, click OK. 

To a eb Client: 

2. 

 

To a

1. ease. 

in the menu that appears, choose Audit Status
The Audit Results for Audit Status dialog box a

If there are errors, correct them

To close the Audit Results d

udit the current status of a routable object in W

1. Open the routable object you want to audit. 

You may audit a routable object from any tab. 

Choose Actions > Audit Status. 

A note appears on the tab. 

If there are errors, correct them and audit again. 

udit the routable object for release in Java Client: 

Open the routable object you want to audit for rel

You may audit a change from any tab. 

2. Click the Audit Release button  above the tabs. Or right-click in the Agile Java Client window; 
in the menu that appears, choose Audit Release . 

The Audit Results for Audit Release dialog box appears. 

 and audit again. 

3. ialog box, click OK. 

To a nt: 

t to audit for release. 

 

 Failure 
 status type, and all the required 

s 
with

If autopr
investiga n to move the routable object 

Auto

à An a a change order, remains checked out. 
y Either checkin the attachment or cancel the checkout, then use Next Status to move the 

If there are errors, correct them

To close the Audit Results d

udit the routable object for release in Web Clie

1. Open the routable object you wan

You may audit a change from any tab. 

2. Choose Actions > Audit Release. 

A note appears on the tab.

If there are errors, correct them and audit again. 
 

Autopromotion
When all the approvers have signed off for a Review or Released
fields have been completed, the routable object can be automatically promoted to the next statu

 the AutoPromote feature. 

omotion fails, the routing manager receives a notification. The routing manager should 
te why autopromotion failed and take the necessary actio

forward in the workflow. 

promotion may fail for one or more of the following reasons: 

ttachment on the routable object, for example, 

Page - 210 Agile Product Lifecycle Management 

 

 



 Chapter 8  
 
 

routable object to the next status in the workflow. See Switching a Routable Object from 
One Status to Another Status (on page 206). 

status in the workflow. See Switching a Routable Object from 

à For one or more affected items of the routable object, an attachment remains checked out. 
y Either checkin the attachment or cancel the checkout, then use Next Status to move the 

routable object to the next 
One Status to Another Status (on page 206). 

 

Redline Conflicts 

If an affected item has two or more unreleased changes and each of those changes includes 

qua

Or an affe ed changes with redlines and there are no redline 

cau  item. 

ange analyst can determine how to resolve the conflict: 

an remove 

at 
hange to lose redlines. Ignore the warning and 

ed from the remaining change. 

Ability to Fail Autopromote More than Once within same Change Status 

 
 

Demoting a Routable Object 
You prom
as descri
privileges orkflow tab to demote a routable object by moving the routable 
object to a previous status in the workflow status list. From that previous status, the routable object 

redlines to the item. The redlines are in conflict, for example, both ECOs include redlines to the 
ntity of the same BOM item. 

cted item has two or more unreleas
conflicts while both changes are unreleased. However, if the current change is released, it will 

se the other change to have redline conflicts with the most recently released revision of the

The ch

à Examine the pending changes and decide which redlines you want to keep. You c
redlines or you may decide to remove the item from the Affected Items table of one of the 
changes. Advance the status manually. 

à Or, manually advance the status of one of the changes. A warning appears that tells you th
releasing the change will cause another c
release the change; the redlines are remov

 

This feature notifies whomever is specified in the status’s If Autopromote Fails, Notify setting each
time a change order fails to autopromote if new approvers were added since the last autopromote
failure. Additionally, History is updated if Autopromote fails when a new approver is added but 
doesn’t complete all workflow-required fields. 

ote a routable object by moving it through the sequential list of statuses in the workflow, 
bed in the previous section. If the workflow allows it, and if you have the appropriate 
, you can also use the W

then moves through the workflow again. For an example, see Returning a Routable Object to the 
Originator (on page 228). 

Note If the routable object has entered the first Released status type, moving the routable 
object to a previous status in the workflow status list unreleases the routable object, and 
may have undesirable consequences. For more information, see Unreleasing Routable 
Objects (on page 232). 

Agil
a status 
demotion

e: 

e administrative settings determine what happens when a routable object again moves through 
with approvers and observers (Review status type or Released status type) after status 
. Depending on the settings, the following rules apply: 

à Demotion Approvers Removal SmartRul
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y 

Demotion Signoff Removal SmartRule: 
 Review status type or Released status type the 

the first routing cycle are removed, and the 

ing cycle are retained in the 

tatus Change 
Wheneve
Status dia
status typ  Review status type and Released 
status type, additional fields for approvers and observers are included. 

 
ave the appropriate privileges. Typically, the routing manager has the appropriate privileges 

Remove: any ad hoc approvers and observers added during the first time through the 
Review status type or Released status type are removed for the second Review status 
type or Released status cycle. 

y Retain: ad hoc approvers and observers added during the first time through the Review 
status type or Released status type are kept on the approvers and observers lists for the 
second Review status type or Released status type cycle. 

à 
y Remove: When a routable object enters the

second time, all approvals and rejections from 
approvers and observers must sign off again. (The approvals and rejections from the first 
routing cycle are still shown on the Workflow tab.) 

y Retain: When a routable object enters the Review status type or Released status type the 
second time, all the approvals and rejections from the first rout
second routing status cycle and displayed in the signoff summary table. The approvers 
and observers who have already signed off do not need to sign off again. 

 

Completing the S
r you switch a routable object from one status to another, you must complete the Change 
log box (Java Client) or page (Web Client). The Change Status dialog box or page for all 
es includes a Notify field and a Comments field. For the

By default, you can switch a routable object to a Submit status type only if you are the originator, or
if you h
to submit routable objects. 

Note If the routing manager field (for example, the Change Analyst field) on the Cover Page of 
the routable object is left blank, and if the workflow is defined to notify the default routing 
manager, then when you switch to a Submit status type, the routable object is submitted 
to every user on the routing manager drop-down list. 

You must include at least one change analyst in the Notify field of the Change Status dialog box or 

You can ing manager who does not have Discovery and Read 
priv ile PLM Administrator Guide for details.) 

By d
if yo

To c atus dialog box in Java Client: 

1. tton or the Workflow tab. (See Switching 

page. 

Only the originator and users with the appropriate privileges can submit a routable object. 

not submit a routable object to a rout
ileges for that routable object. (See the Ag

efault, you can switch a routable object to a Submit status type only if you are the originator, or 
u have the appropriate privileges. Typically, the change analyst or component engineer has the 

appropriate privileges to submit routable object. 

omplete the Change St

Select a new status by using either the Next Status bu
the Status of a Routable Object (on page 206).) 

The Change Status dialog box appears. 

f names, as specified in the workflow, or the Notify The Notify field may already contain a list o
field may be blank. In either case, you can add names to the Notify field if you choose to do so. 
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2. To add names to the Notify list, type the names of the users to be notified (with semicolons 

. 

r user groups. (See Adding and Removing Approvers 

separating the names). 

Or click the Notify button to open the address book

You may select individual usernames o
and Observers (on page 215).) 

Add any comments in the Comments field. 3. 

se. 

To complete ange Status page in Web Client: 

1. new ext Status button or the Workflow tab. (See Switching 

4. Click the dialog button that completes the status change, for example, Submit, Route, or Relea

 the Ch

Select a  status by using either the N
the Status of a Routable Object (on page 206).) 

The Change Status page appears. 

f names, as specified in the workflow, or the Notify 
e blank. In either case, you can add names to the Notify field if you choose to do so. 

lons 

The Notify field may already contain a list o
field may b

2. To add names to the Notify list, type the names of the users to be notified (with semico
separating the names). 

Or click  to open the address book. 

You may select individual usernames or user groups. (See Adding and Removing Approvers 
and Observers (on page 215).) 

3. Add any comments in the Comments field. 

4. Click OK. 
 

Completing the Status Change for a Review or Released Status 

When you switch a routable object to a Review status type or a Released status type, you are 
routing it for signoff review to a list of approvers and observers. This list of approvers may also be 

e

you utable 
obje e and sent to all the approvers, observers, and 

Obs  
who d to take any action. 

To complete

1. 

called the CCB, or change control board.  

Wh n the Change Status dialog box (Java Client) or page (Web Client) appears, workflow property 
settings may have already assigned a list of users as approvers, observers, and users to notify. If 

 choose, you may add to this list. If these fields are blank, complete them. When the ro
ct is routed, it is attached to an email messag

users to notify. The email message contains an icon representing the change; double-clicking the 
icon opens the routable object. Approvers are required to either accept or reject the routable object. 

ervers may also accept or reject the routable object, but their response is not required. Users
 are notified are not require

 the Change Status to Review or Released dialog box in Java Client: 

Select the Review status type or the Released status type by using either the Next Status button 
outable Objector the Workflow tab (See Switching the Status of a R  (on page 206).) 

s 
s, 

The Change Status dialog box appears. 

2. Complete the Approvers, Observers, and Notify fields. These fields may already contain names a
defined by the workflow; with appropriate privileges, you may add names. Type the name
separated by semicolons. 

Or click the Approvers, Observers, or Notify buttons to open the address book for each field. 
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From the Users or Groups tab, you may select individual usernames or user groups. (See 
Adding and Removing Approvers and Observers (on page 215).) 

5. s the status change, for example, Route or Release. 

 

To c  or Released page in Web Client: 

1. utton 
us of a Routable Object

3. Add any comments in the Comments field. 

4. If appropriate, select the Urgent checkbox. This adds “URGENT” to the subject of the email (if 
users are using Microsoft Outlook). 

Click the dialog button that complete

The routable object is routed to all the approvers and observers, and their names are placed on 
the Workflow tab. All users in the Notify field receive email informing them of the new status of
the routable object. 

omplete  Change Status to Review the

Select the Review status type or the Released status type by using either the Next Status b
or the Workflow tab (See Switching the Stat  (on page 206).) 

s 

 semicolons. 

The Change Status page appears. 

2. Complete the Approvers, Observers, and Notify fields. These fields may already contain names a
defined by the workflow; With appropriate privileges, you may add names. Type the names, 
separated by

Or click  to open the address book. 

You may select individual users, usernames or user groups. (See Adding and Removing 
Approvers and Observers (on page 215).) 

4. If appropriate, select the Urgent checkbox. This adds “URGENT” to the subject of the email (if 

 
 tab. All users in the Notify field receive email informing them of the new status of 

rs, Observers, and Users to Notify 

If any of the users you select as approvers, observers, or users to notify do not have the appropriate 
hen you attempt 

ts the users that do not have the 
 been automatically removed from the 

s, see the Agile PLM Administrator Guide. 

3. Add any comments in the Comments field. 

users are using Microsoft Outlook). 

5. Click OK. 

The routable object is routed to all the approvers and observers, and their names are placed on
the Workflow
the routable object. 

Discovery Privileges of Approve

Discovery or Read privileges for the routable object, an error message appears w
to route or release the routable object. The error message lis
appropriate privileges and informs you that their names have
distribution list. 

For more information about Discovery and Read privilege

Handling Routed Changes 
The following sections describe procedures you perform when routing changes: 

à When to Add Approvers and Observers (on page 215) 

à Adding and Removing Approvers and Observers (on page 215) 
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When to Add Approvers and Observers 

Routing managers may want to monitor routable objects assigned to them to make sure that the l
of approvers and observers is complete. Workflows may assign approvers and observers accordi
to the attributes of the affected items of a routable object; you can add approvers that were n

ist 
ng 

ot 

s 
ed items on an ECO 

e 
ff 

COs include documents to sign off, the Libra Product Line 
 Publications department. 

 
tatus type; the ECO does not need to be in the Review or Released status type to add 

automatically assigned by the workflow. 

For example, at Acme Incorporated, each product line has several projects in development at one 
time. Acme uses a field to identify which project or projects each item (part or document) belong
to. The Libra Product Line workflow looks at the project assigned to the affect
to determine which default approvers and observers to assign. 

Mary Green creates ECO 333. She adds six Orion project objects to the Affected Items tab: three 
parts and three documents. Mary finishes preparing ECO 333 and switches it to the next status, 
where the routable object (ECO 333) is submitted to Bob Smith, the default change analyst. 

To select approvers for the Orion project, the Libra Product Line workflow examines each item on 
the affected items table to determine if the field contains Orion. If all the items on the affected items 
table belong to the Orion project, then the list of Orion approvers, as defined in the workflow, is 
automatically added to the Workflow tab when ECO 333 is submitted to Bob. 

However, in the case where some of the objects on the affected items table are documents, Acm
requires that Orion team members in the Publications department (a user group) must also sign o
the routable object. Since not all E
workflow does not automatically add to every ECO approvers from the

Bob Smith, the change analyst, examines the ECO 333 and notices that some of the affected items 
are documents. Bob clicks Add Approvers/Observers on the ECO 333 page and adds all the members 
of the Orion Publications group as approvers. Bob can add approvers to any future Review or
Released s
approvers or observers. 

See Adding and Removing Approvers and Observers (on page 215) for detailed instructions for 
adding approvers and observers. 

Adding bservers 

 
may be n
following:

à The Ad Hoc Approvers/Observers property in the workflow is set to Yes. 

server if that user does not have Discovery 

 and Removing Approvers and O

After a routable object has been routed for approval and enters a Review or Released status type, it
ecessary to either add or remove approvers or observers. This requires both of the 
 

à You have the appropriate privilege granted to you by your Agile administrator. 

Note You cannot add a user as an approver or ob
and Read privileges for that routable object. 

¾ Ad hoc approvers or observers can be added to or removed from the routable object only 
 or 

observers cannot be added to or rem ved from the routable object when it is in the 

 Observers list. If you attempt to add 
 

when it is in a Submitted, Review, or Released type status. Ad hoc approvers
o

Pending type status. 

You cannot add the same user to both the Approvers and the
the same names to both lists, Agile PLM warns you and prompts you to delete the duplicate names
from the list you select (approvers or observers). 
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To a

1. 

2. 

3. 

dd an approver or observer in Java Client: 

Select and open the routable object. 

On the Workflow tab, select the status you want the additional people to approve. 

Click the Add Approver/Observer button . 

4. ears. 

5. m elds. Type the names of the approvers or observers to 
g the names). 

Or c ch field. 

6. If you want to add an entire roup itself or 
 of the 

grou
a.  the address book. 

re group names. 

lect user names, expand a group by clicking the plus sign +.) 

t, click the 

The Add Approvers and Observers dialog box app

Co plete the Approvers and Observers fi
add to the list (with semicolons separatin

lick the Approvers or Observers button to open the address book for ea

From the Users or Groups tab, you may select individual us mes or user groups 

 user group as an approver, you can either add the g

erna

the members of the group. This determines whether only one memb r all members
p must sign off. 
Click the Group tab in

er o

b. Select one or mo

(To se

c. To add the group name to the recipient lis  button. The group name is 
eeds to sign off. 

the recipient list, click the 

added to the recipients list. Only one user in the group n

d. To add the members of the group to  button. The 
ded to the recipient list. Each user in the 

To add an a er or observer in Web Client: 

1. Workflow tab. 

2. 

3. Sele pprove. 

4.  
add

Or c

usernames of the members of the group are ad
group must sign off. 

7. Add any comments. 

8. Click OK. 

pprov

Select and open the routable object. Click the 

Click the Add Approvers/Observers button. 

The Add Approvers or Observers page appears. 

ct the status you want the additional people to a

Complete the Approvers and Observers fields. Type the names of the approvers or observers to
 to the list (with semicolons separating the names). 

lick  to open the address book. 

You may select individual usernames or user groups. 

r group as an approver: 
 Select Group drop-down list, select All Groups, and click Find. All the groups in the 

address book appear in the Available Values list. 
b. In the Available Values list, select either UserGroupName - All or UserGroupName - Any, 

where UserGroupName is the name of the user group you want to select. This determines 
whether all users in the group need to sign off (All) or only one member of a group needs 
to sign off (Any). Click the right arrow to move the group to the Selected Values list, and click 

To add an entire use
a. In the
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OK. 

any comments. 

 OK. 

When you add a user group as an approver such that only one member of the group 

5. Add 

6. Click

Note 
needs to signoff (UserGroupName - Any), escalation behavior is determined by the user 
group's profile settings for Allow Escalation Designation Approval (After Escalation or A
and the user group's assigned escalation pe

lways) 
rsons. However, when you add a user group 

ust signoff (UserGroupName - All), 
f the group as an individual approver and, 

pends on the user profile settings and assigned 

as an approver such that all members of the group m
Agile PLM automatically adds each member o
therefore, escalation behavior de
escalation persons of each individual user. 

To r observer in Java Client: 

he approvers or observers you want 

3. Click the n. 

emove an approver or 

1. Select and open the routable object. 

2. On the Workflow tab, under the appropriate status, select t
to remove from the list. 

Remove Approver/Observer butto  

k Yes. 

r only if that approver has not yet approved or 

4. When prompted to confirm the removal action, clic

Note You can remove an approve
rejected the routable object. 

To r

s page appears. 

3. 

4. 

emove an approver or observer in Web Client: 

1. Select and open the routable object. 

2. Click the Remove Approvers/Observers button. 

The Remove Approvers or Observer

Select the status for which you want to remove approvers or observers. 

Enter the names of approvers or observers to be removed from the list. Type the names (with 
semicolons separating the names). 

Or click  to open the address book. The approvers or observers appear in the Available 
 Select the usernames or groups you want to move, and click the right arrow to move 

5. Enter any

You can remove an approver only if that approver has not yet approved or 

Values list.
them to the Selected Values list, and click OK. 

 comments. 

6. Click OK. 

Note 
rejected the routable object. 

 

Approving Routable Objects 
Wh n you approve a routable oe bject, the approval and any comments are shown on the Workflow 
tab. 
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To approve a routable object in Java Client: 

1. Open the routable object. 

2. Click the Approve button  to open the Approve dialog box. 

Enter any comments in the Comments field. 3. 

4. e checkboxes if you want to notify these people: Notify Change Analyst, Notify 

cho

5. Dep nitions, and the conditions 
und hat 
you mus
y Esca

Des

r or group in the st or the Selected list and click the 
ne list to the other. If you if you 

� 

y Tran
the 

g box that 
cted list and click the 

ot 

� 

y ember.  

� 

ntification: Depending on system settings, you may be required to enter dual types 
f ide
� ord 

rd field. 
cond identification type depends on Agile PLM settings and may be either your 

Completing the Comments field may be either required or optional, depending on workflow 
settings. 

Click any of thes
Originator, Notify Reviewers. If you select Notify Reviewers, you can use the drop-down list to 

ose a different workflow status. 

ending on the Agile PLM system settings and workflow defi
er which you are signing off, the Approval dialog may include the following fields or lists t

t fill in: 
lated From: A list of escalations for approver users or groups for which you are the 
ignated Escalation Person.  

� Click the down arrow next to the Escalated From field.  
� To select the users or groups for which you wish to approve, in the dialog box that 

appears, select a use Choices li
right or left arrows to move the your selections from o
do not wish to approve for any escalations, leave the Selected list blank. 
Click OK. 
sferred From: A list of transfer authorities for approver users or groups for which you are 
Transfer To person.  

� Click the down arrow next to the Transfer From field.  
� To select the users or groups for prove, in the dialo which you wish to ap

appears, select a user or group in the Choices list or the Sele
right or left arrows to move the your selections from one list to the other. If you do n
wish to approve for any transfers, leave the Selected list blank.  
Click OK. 
oval G p(s): A list of the approver groups of which you are a mAppr rou

� Click the down arrow next to the Approving for Group(s) field.  
� To select the users or groups for which you wish to approve, in the dialog box that 

appears, select a user or group in the Choices list or the Selected list and click the 
right or left arrows to move the your selections from one list to the other. If you do not 
wish to approve for any groups, leave the Selected list blank. 

OK� Click  
y Signoff for Self: When you are also an individual approver, a checkbox is displayed next to 

ryou  name.  
Check the checkbox to indicate that your are approving for yourself, in addition to any 
group, escalation, or transfer approvals. If you do not wish to approve for yourself, 
uncheck the checkbox. 

y Dual Ide
o ntification.  

The first identification type is your approval password. Enter your approval passw
in the Passwo

� The se
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userID (username) or your login password. 

with multiple signoff possibilities (escalations, transfers, Note When presented 
groups, or self) you must select at least one group or person for whom you are 
approving. 

6. 

1. 

ter 
e 

atus. 

mments field may be either required or optional, depending on workflow 

4. Clic ant to notify these people: Notify Change Analyst, Notify 
Origi

5. Dep
under wh
you mus
y Esca

Des Escalation Person.  

Click Approve. 

To approve a routable object in Web Client: 

Open the routable object. 

2. Click the Approve button to open the Approve page. The Approve and Reject buttons appear af
the routable object is moved to a certain status, for example, a problem report moves from th
Submitted to the Review st

3. Enter any comments in the Comments field. 

Completing the Co
settings. 

k any of these checkboxes if you w
nator, Notify Reviewers. 

ending on the Agile PLM system settings and workflow definitions, and the conditions 
ich you are signing off, the Approval page may include the following fields or lists that 

t fill in: 
lated From: A list of escalations for approver users or groups for which you are the 
ignated 

� Click the  button next to the Escalated From field.  
� To select the users or groups for which you wish to approve, in the dialog box that 

appe ct a user or group in the Available Values list or the Selected Values list 
lections from one list to the other. 

ist 

� 

y Tran re 
the n.  

ars, sele
and click the right or left arrows to move the your se
If you if you do not wish to approve for any escalations, leave the Selected Values l
blank. 
Click OK.  
sferred From: A list of transfer authorities for approver users or groups for which you a
Transfer To perso

� Click the  button next to the Transfer From field.  
� To sele users or groups for prove, in the dialog box that 

ele r the Selected Values list 
r. 

� 

y Appr  list of the approver groups of which you are a member.  

ct the which you wish to ap
appears, s ct a user or group in the Available Values list o
and click the right or left arrows to move the your selections from one list to the othe
If you if you do not wish to approve for any transfers, leave the Selected Values list 
blank. 
Click OK. 
oving f Group(s): Aor 

� Click the  button next to the Approving for Group(s) field.  
� To select the users or groups for which you wish to approve, in the dialog box that 

o not wish to approve for any groups, leave the Selected 

appears, select a user or group in the in the Available Values list or the Selected 
Values list and click the right or left arrows to move the your selections from one list to 
the other.  If you if you d
Values list blank. 

� Click OK 
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y  
your

u do not wish to approve for yourself, 

y Dual types 
of ide

st identification type is your approval password. Enter your approval password 
Password field. 

userID (username) or your login password. 

Signoff for Self: When you are also an individual approver, a checkbox is displayed next to
 name.  

� Check the checkbox to indicate that your are approving for yourself, in addition to any 
group, escalation, or transfer approvals. If yo
uncheck the checkbox. 
 Identification: Depending on system settings, you may be required to enter dual 
ntification.  

� The fir
in the 

� The second identification type depends on Agile PLM settings and may be either your 

Note When presented with multiple signoff possibilities (escalations, transfers, 
groups, or self) you must select at least one group or person for whom you are 
approving. 

6. 

When all the approvers have approved, the routable object is ready to move to the next status in the 

à If the AutoPromote property for the status is set to Yes, and the required fields are filled in, then 

vers have 

e ct, the rejection and any comments appear on the Workflow tab, and 
the specified users receive an email message. Usually, this is the change analyst or component 

 routable object. 

approved, the Workflow tab shows only the approval 
and

To r utable object in Java Client: 

2. 

Click Approve. 

status list. 

the routable object is automatically promoted to the next status in the status list. 

à If the AutoPromote property for the status is set to No, then an email message notifies the 
change analyst, component engineer, or other routing manager that all the appro
approved the routable object. 

 

Rejecting Routable Objects 
Wh n you reject a routable obje

engineer. The email message states that you have rejected the

If a routable object is first rejected but then later 
 not the rejection. However, the History tab shows both actions. 

eject a ro

1. Open the routable object. 

Click the Reject button  to open the Reject dialog box. 

r any comments in the Comments 3. Ente field. 

Com al, depending on workflow 
sett

4. Dependi
under wh
you 

 
� ect, in the dialog box that 

pleting the Comments field may be either required or option
ings. 

ng on the Agile PLM system settings and workflow definitions, and the conditions 
ich you are signing off, the Reject dialog may include the following fields or lists that 

t fill inmus : 
y Escalated From: A list of escalations for approver users or groups for which you are the 

Designated Escalation Person.  
� Click the down arrow next to the Escalated From field. 

To select the users or groups for which you wish to rej
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appears, select a user or group in the Choices list or the Selected list and click th
right or left arrows to move the your selections from one list to the other. If you if you
do not wish to reject for any escalations, leave the Selected list blank. 
Click OK. 

e 
 

� 

y : t of transfer authorities for approver users or groups for which you are 

. 

Approving for Group(s)

e 

y  
r

u do not wish to reject  for yourself, 

y Dual types 
of ide   

ssword. Enter your approval password 

 second identification type depends on Agile PLM settings and may be either your 
 password. 

with multiple signoff possibilities (escalations, transfers, 

Transferred From  A lis
the Transfer To person.  
� Click the down arrow next to the Transfer From field.  
� To select the users or groups for which you wish to reject, in the dialog box that 

appears, select a user or group in the Choices list or the Selected list and click the 
right or left arrows to move the your selections from one list to the other.  If you if you 
do not wish to reject for any transfers, leave the Selected list blank

� Click OK. 
y Approval Group(s): A list of the approver groups of which you are a member.  
� Click the down arrow next to the  field.  
� To select the users or groups for which you wish to reject, in the dialog box that 

appears, select a user or group in the Choices list or the Selected list and click th
right or left arrows to move the your selections from one list to the other. If you if you 
do not wish to reject for any groups, leave the Selected list blank. 

� Click OK 
Signoff for Self: When you are also an individual approver, a checkbox is displayed next to

 name.  you
� Check the checkbox to indicate that your are rejecting for yourself, in addition to any 

group, escalation, or transfer rejections. If yo
uncheck the checkbox. 
 Identification: Depending on system settings, you may be required to enter dual 
ntification.

� The first identification type is your approval pa
Password field. in the 

� The
userID (username) or your login

Note When presented 
groups, or self) you must select at leas
rejecting. 

t one group or person for whom you are 

5. Click the Notify button to add any users to be notified. 

6. 

1. 

2. 

3. Ente field. 

Com al, depending on workflow 
sett

4. Dependi
under wh
you mus
y Esca  A list of escalations for approver users or groups for which you are the 

Click Reject. 

To reject a routable object in Web Client: 

Open the routable object. 

Click the Reject button to open the Reject page. 

r any comments in the Comments 
pleting the Com nts field may be either required or optionme

ings. 

ng on the Agile PLM system settings and workflow definitions, and the conditions 
ich you are signing off, the Reject page may include the following fields or lists that 

t fill in: 
lated From:
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Designated Escalation Person.  

� Click the  button next to the Escalated From field.  
� To select the users or groups for which you wish to reject, in the dialog box that 

es list or the Selected Values list 
ther. 

� 

y Tran rom: A list of transfer authorities for approver users or groups for which you are 
 person.  

appears, s ct a user or group in the Available Valuele
and click the right or left arrows to move the your selections from one list to the o
If you if you do not wish to reject for any escalations, leave the Selected Values list 
blank. 
Click OK. 
sferred F

the Transfer To

� Click the  button next to the Transfer From field.  
� To select  users or groups for which you wish to reject, inthe  the dialog box that 

s list appears, select a user or group in the Available Values list or the Selected Value
and click the right or left arrows to move the your selections from one list to the other. 
If you if you do not wish to reject for any transfers, leave the Selected Values list 
blank. 

� Click OK. 
y Reject for Group(s): A list of the approver groups of which you are a member.  

� Click the  button next to the Approving for Group(s) field.  
To select the users or groups for which you wish to reject, in the dialog box that 
appears, select a user or group in the Available Values list or the Selected Values li

� 
st 

y Signoff for Self: When you are al

�  rejecting for yourself, in addition to any 
grou

y Dual types 
of ide   

pproval password 

 second identification type depends on Agile PLM settings and may be either your 

h multiple signoff possibilities (escalations, transfers, 

and click the right or left arrows to move the your selections from one list to the other. 
If you if you do not wish to reject for any groups, leave the Selected Values list blank. 

� Click OK 
so an individual approver, a checkbox is displayed next to 

your name.  
Check the checkbox to indicate that your are

p, escalation, or transfer rejections. If you do not wish to reject  for yourself, 
uncheck the checkbox. 
 Identification: Depending on system settings, you may be required to enter dual 
ntification.

� The first identification type is your approval password. Enter your a
Password field. in the 

� The
userID (username) or your login password. 

Note When presented wit
groups, or self) you must select at least one group or person for whom you are 
rejecting. 

5. Click the  button next to the Notify field to add any users to be notified. 

Reject6. Click 

Whe r has rejected a routable object, the following actions occur, as specified 
in the workflow property settings: 

e object has been 
rejected. 

. 

n at least one approve

à The users specified in the workflow properties are notified that the routabl
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à If the AutoPromote property is set to Yes, then the routable object is not promoted to the next 
status in the status list. 

à Depending on the workflow property settings, the object may switch to a specified status when 
it has been rejected. 

 

Reminder Period and Review Escalation Period 
The reminder period and the review escalation period are periods of time defined for each Review 

us type. The reminder period is shorter than the escalation period so the approvers 

t, 

When the escalation period elapses, if an approver has not approved or rejected the routable 

outable object has been escalated to the specified 

 History tab. 

gn 
or only after the escalation period has elapsed. See your 

For inform

or Released status type in each workflow. For example, the reminder period for the CCB status in 
the Default Change Orders workflow is 48 hours, and the review escalation period is 96 hours. The 
reminder period and the review escalation period begin when the routable object enters a Review or 
Released stat
have time to respond before the escalation period elapses. 

Each Review or Released status type has its own reminder period and review escalation period. If a 
workflow has several Review or Released status types, each one may have a different length of 
time for both its reminder period and review escalation period. 

When the reminder period elapses, if an approver has not approved or rejected the routable objec
a reminder email is sent to the approver. The change analyst or component engineer receives a 
similar email. 

object, an email is sent to the appropriate designated escalation person. A similar email notifies the 
change analyst or component engineer that the r
designated escalation person. The designated escalation person may approve or reject the routable 
object in the place of the original approver. 

When reminder and escalation notifications are sent, the actions are recorded on the

Designated Escalation Person 
Each user or user group may have multiple designated escalation persons. A designated escalation 
person can be an individual user or user group. 

Your Agile administrator determines whether your designated escalation persons are able to si
off a routable object for you at any time, 
Agile administrator if you have questions about your designated escalation persons. 

ation about defining escalations, see Navigating in Agile Java Client (on page 5). 

If the review escalation period elapses, the approver’s designated escalation persons are notified by 
he designated escalation persons may approve or 
al approver. If the designated escalation person 

email that the approver has not responded. Now t
reject the routable object in the place of the origin
approves or rejects the routable object, then the name is recorded on the Workflow tab and the 
History tab as the Signoff user. 

Note If the designated escalation person is a user group, only one member of the group needs 
to sign off the routable object. When the routable object has been signed off, the routable 
object no longer appears in the Inbox of the other members of the group. 
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Tra ferring Signoff Authority ns
noff authority for the 

u will be on vacation for a 
ne. 

You

off authority for other 

e

Note Sign  object. 

If you have the appropriate privileges, you can temporarily transfer your sig
routable object to one or more Agile users. For example, if you know yo
week, you can give other users the authority to sign off routable objects for you while you are go

 can specify which routable objects to transfer to which user. 

In addition, if you have the appropriate privileges, you can also transfer sign
users. For example, if Mary will be on vacation, you can give Bob the authority to sign off routable 
obj cts for Mary while she is gone. 

 off authority is transferred for users who are assigned approvers on a routable
Signoff authority is not transferred for observers. 

To transfer signoff authority for yourself or others in Java Client: 

 Settings > Transfer Authority1. Cho

2. 

3.  to transfer authority from, then select the user who is receiving 

Note 

ose  in the main menu bar. The Transfer Authority dialog box 
appears, which lists the transfer authority definitions you have the ability to modify or delete. 

Click the New button. The New Transfer Authority dialog box appears. 

Select yourself or another user
signoff authority. 

Users who are receiving the authority must have the appropriate privileges to 
sign off the routable objects transferred to them. If you have questions about 
privileges, see your Agile administrator. 

4. In the Select Criteria list, click to select the type of information to transfer. 

 verify 
Click 

ose the dialog box. 

 extensive. If you have questions about which criteria 

To view the filter conditions for the selected criteria, click the View button in the Criteria pane. 
The criteria is displayed, much like a search definition, in a read-only dialog box. You can
whether the selected transfer criteria will find the routable objects you want to transfer. 
Cancel to cl

Note The list of criteria is quite
would best suit your needs, contact your Agile administrator, who manages all 

bal criteria. Alternatively, consider defining a personal criteria that you can 
n use for transferring authority. See Defining Personal Criteria for Authority 

glo
the
Transfers (on page 227) for information about creating personal criteria. 

5. Specify a start date and an end date. 

6. Under Affected Changes, specify whether you want all routable objects in your Inbox to be 

7. Click  to complete the transfer. 

ew 

8. Click Clos

1. Click Tools > My Settings > Transfer Authority. The Transfer Authority page appears. 

2. Click the Create button. The Create Transfer Authority page appears. 

transferred, or only routable objects that arrive in your Inbox within the date range you 
specified. 

OK
The n transfer authority definition appears in the Transfer Authority dialog box. 

e. 

To transfer signoff authority for yourself or others in Web Client: 
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3. iving 
signoff au

Note 

Select yourself or another user to transfer authority from, then select the user who is rece
thority. 

Users who are receiving the authority must have the appropriate privileges to 
sign off the routable objects transferred to them. If you have questions about 
privileges, see your Agile administrator. 

4. In the Criteria list, click to select the type of information to transfer. 

Note The list of criteria is quite extensive. If you have questions about which criteria 
would best suit your needs, contact your Agile administrator, who manages all 
global criteria. Alternatively, consider defining a personal criteria that you can 
then use for tran
See Defining Personal Criteria for 

sferring authority—click Tools > My Settings > Personal Criteria. 
Authority Transfers (on page 227) for 

information about creating personal criteria. 

5. Specify a start date and an end date. 

6. In the Affected Changes list, specify whether you want all routable objects in your Inbox to
transferred, or only routable objects that arrive in your Inbox

 be 
 within the date range you 

7. 
 

Ro  Period 

follo

y 
sed-type status) during the time period defined in the Transfer Authority. 

à 
 routable objects are transferred: 

t the time the Transfer Authority was created (in a Review-type status or a Released-type 

Routable objects that are created during the Transfer Authority time period that do not also 

me 
ith the current date 

and time. 

With the app ges, you can modify or delete signoff authority transfers at any time. For 

date r routable objects already in the Transfer To user’s Inbox. 

You can also modify and reuse any expired authority transfer at a future date. 

specified. 

Click Finish to complete the transfer. 

utable Objects Affected During the Transfer

If the Transfer Authority Affected Changes property is set to All Changes During Time Period, the 
wing conditions define the routable objects are transferred: 
y The routable object meets the criteria defined in the transfer authority.  

The routable object enters a workflow status that has a list of approvers (a Review-type 
status or a Relea

y The From user is an approver for that workflow status. 

If the Transfer Authority Affected Changes property is set to All Changes, the following conditions 
define the
y The conditions listed above for All Changes During Time Period. 
y In addition, all criteria-defined routable objects that were awaiting signoff by the From user 

a
status).  

à 
enter a Review-type or Released-type status during the time period are not transferred to the 
To user. 

The Start and End dates are time specific. If you enter today's date as the start date, and the ti
component of the date is in the past, Agile PLM creates the Transfer Authority w

Modifying Signoff Authority Transfers 

ropriate privile
each authority transfer, you can modify the person who receives signoff authority, the start and end 

s, and whether or not to transfe
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Your Transfer Authority privileges determine which authority transfers you can modify: 

wn 

 Client: 

1. se S ox 
appears, lete. 

2. Click to select the transfer authority definition you want to change, then click the Modify button. 
g box appears. 

3. 

ers who are receiving the authority must have the appropriate privileges to 

à If you have privileges to create only your own authority transfers, you can modify only your o
authority transfers. 

à If you have privileges to create authority transfers for other users, you can modify any authority 
transfers created by any user. 

To modify signoff authority in Java

Choo ettings > Transfer Authority in the main menu bar. The Transfer Authority dialog b
which lists the transfer authority definitions you have the ability to modify or de

The Modify Transfer Authority dialo

Change the settings as needed. 

Note Us
sign off the routable objects tran
privileges, see your Agile admin

sferred to them. If you have questions about 
istrator. 

4. Click OK to complete the transfer. 

The modified transfer authority definition appe

5. Click Close. 

ars in the Transfer Authority dialog box. 

To modify sig

1. Click Too nsfer Authority page appears. 

ws you want to modify, then click the Edit button. 

Note Users who are receiving the authority must have the appropriate privileges to 

noff authority in Web Client: 

ls > My Settings > Transfer Authority. The Tra

2. Select the ro

3. Change the settings as needed. 

sign off the routable objects transferred to them. If you have questions about 
privileges, see your Agile administrator. 

4. 

rity Transfers 

Java Client: 

er Authority dialog box 

 button. 

Click Save. 
 

Deleting Signoff Autho

To delete one or more transfers of signoff authority in 

1. Choose Settings > Transfer Authority in the main menu bar. The Transf
appears, which lists the transfer authority definitions you have the ability to modify or delete. 

2. Click to select the transfer authority definition you wa e, then click the Deletent to chang

When prompted, click Yes. 3. 

4. Click Close to close the Transfer Authority dialog box. 

To delete one or more transfers of signoff authority in Web Client: 

1. Click Tools > My Settings > Transfer Authority. The Transfer Authority page appears. 

2. Select the rows you want to delete, then click the Delete button. 
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Defining Personal Criteria for Authority Transfers 
A cr

g 
ated 

or tr

al criteria for all ECOs that affect a specified product line. 

To c  a p

1. Choose S  box 
appears, lete. 

2. Either clic Modify button. The New or Modify 
rs. 

3. 

iteria is similar to an advanced search. The attributes used to create criteria are similar to the 
fields used to create advanced searches. Criteria can also be thought of as “filters” or “qualifyin
descriptions” of, in the case of escalations or authority transfers, the changes that will be escal

ansferred. 

For example, you could create a person

reate ersonal criteria in Java Client: 

ettings > Transfer Authority in the main menu bar. The Transfer Authority dialog
which lists the transfer authority definitions you have the ability to modify or de

k the New button or select a row and click the 
Transfer Authority dialog box appea

In the Criteria pane, click the New button to display the New Personal Criteria dialog box. 

4. Enter a name for the criteria. 

Note The personal criteria that you create appear in the Transfer Authority criteria list 
preceded by your name, making them easier to locate. For example, if Bob 

es enters “All Leo Projects,” the criteria appears in the Transfer Authority Jon
criteria list as “Bob Jones.All Leo Projects.” 

5. 

tion might be “All changes in the Leo product line.” 

iteria dialog box the same way that you define search 
ced Search wizard. Fill in the fields. For more information about 

gile Data with Searches

Enter a description for the criteria. 

Using the sample name above, the descrip

6. You define criteria in the New Personal Cr
conditions in the Advan
searching, see Finding A  (on page 135). 

ew n now 
select thi

To create a p

iteria. 

2. 

7. Click OK. 

The n criteria appears in the Criteria pane in the Transfer Authority dialog box. You ca
s criteria when defining or modifying a transfer authority. 

ersonal criteria in Web Client: 

1. Click Tools > My Settings > Personal Cr
Click the Create button. 

3. Enter a name for the criteria. The Create Personal Criteria window appears. 

Note The personal criteria that you create appears in the Transfer Authority criteria 
list preceded by your name, making it easier to locate. For example, if Bob 

es enters “All Leo Projects,” the criteria appears in the transfer authority Jon
Criteria list as “Bob Jones.All Leo Projects.” 

4. 

n the Leo product line.” 

 

Enter a description for the criteria. 

Using the sample name above, the description might be “All changes i

5. You define criteria in the Create Personal Criteria wizard the same way that you define search
conditions in the Advanced Search wizard. Fill in the fields. For more information about 
searching, see Finding Agile Data with Searches (on page 135). 

6. Click Finish. 
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The new criteria appears in the Criteria drop-down list. You can now select this criteria when 
defining a transfer authority (Tools > My Settings > Transfer Authority). 

Returning a Routable Object to the Originator 

ble object from a workflow status 
 first status in the workflow status 

he originator is now able to edit the routable object, including editing 

Whe he next 
status in the and 
ente at 

 the routable object enters the Review status type or Released status type cycle 
ng a Routable Object

You return a routable object to the originator by switching the status to the Pending status type. 
Before you can switch a routable object back to the Pending status type, you need the appropriate 
privileges. Usually, the change analyst and component engineer have these privileges. If you need 
them and do not have them, see your Agile administrator. 

When a change analyst or component engineer switches a routa
(not from the Unassigned status) to the Pending status type (the
list), the originator is notified. T
items on the Affected Items tab and selecting a different workflow. 

n the originator completes edits to the returned routable object and then switches it to t
workflow status list, the routable object moves through the workflow status list 

rs the Review status type or Released status type cycle a second time. For details about wh
happens when
again, see Demoti  (on page 211). 

To return a routable object to the originator in Java Client: 

1. 

2. On the W w tab. 

See Swit om One Status to Another Status

Open the routable object. 

orkflow tab, click Pending (or a status of type Pending) in the chart on the Workflo
ching a Routable Object fr  (on page 206). 

OK
s type. 

When the Change Status dialog box appears, complete the Notify field and add comments. 

3. Click . 

bject switches to the Pending statuThe status of the routable o

Note Approvals and rejections from previous routing cycles appear on the Workflow 
tab, but they are not active. Only approvals and rejections for the latest routing 
cycle on the Workflow tab are allowed. The History tab also shows the actions of 

r routing cycles. the earlie

You cannot return a routable object to an originator who does not have
privileges for that object. (See the Agile PLM Administrator Guide for d

 Discovery and Read 
etails.) 

To r  a ro

1. Open the 

2. On the W  status of type Pending) in the chart on the Workflow tab. 

o the Pending status type. 

eturn utable object to the originator in Web Client: 

routable object. 

orkflow tab, click Pending (or a

When the Change Status page appears, complete the Notify field and add comments. 

3. Click OK. 

The status of the routable object switches t

Note Approvals and rejections from previous routing cycles appear on the Workflow 
tab, but they are not active. Only approvals and rejections for the latest routing 
cycle on the Workflow tab are allowed. The History tab also shows the actions of 
the earlier routing cycles. 
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You cannot return a routable object to an originator who does not have Discovery and Read 

cel a routable object by switching the status to the Cancel 

à The 

à You t 
your

For exam gh workflow, but later 
decided not to modify it. So you can cancel the routable object itself. The reasons the ECO is 

m the item revision list 

privileges for that object. (See the Agile PLM Administrator Guide for details.) 

Canceling a Routable Object 
You can use the Workflow tab to can
status type if both of the following are true: 

Cancel status type has been defined in the workflow as one of the valid next statuses. 

have the appropriate privileges. (See your Agile administrator if you have questions abou
 privileges.) 

ple, you create an ECO to modify an assembly and route it throu

canceled would be recorded in the comments of the canceled ECO. But still you can keep the 
canceled ECO in Agile database. 

Note If you cancel a released routable object, the revision is removed fro
of the affected items. A routable object with affected items that has been canceled cannot 
be uncanceled (moved to a different status in the workflow). The canceled routable obj
appears on the Change History table of the item’s Changes tab. If there are redline edits 
asso

ect 

ciated with the routable object, redlines are dropped (discarded) and you cannot 
utable object. This differs from a routable object 

ct on Hold
access the redline table of a canceled ro
on hold; see Putting a Routable Obje  (on page 230). 

Canceling a routable object is not the same as deletin
a fundamental flaw or rejection by several approver

g it. A routable object can be canceled due to 
s, but it remains in the database. (See also 

Deleting Routable Objects (see "Deleting a Bookmark" on page 50).) 

When a routable object is canceled, it no longer has the current status, and the remaining statuses 
on the statu w the name of the 
pers ged By column on the 

 Java Client: 

2. 

tus dialog box appears, complete the Notify field, and add comments. 

1. 

e Cancel status type. 

lick Cancel in the chart. 

ments. 

3. 

. 

s list are skipped. All the remaining statuses on the status list sho
on who moved the routable object to Canceled under the Status Chan

Workflow tab. 

To cancel a routable object in

1. Open the routable object. 

On the Workflow tab, click Cancel in the chart. 

When the Change Sta

Click OK. 

The status of the routable object switches to th

To cancel a routable object in Web Client: 

1. Open the routable object. 

2. On the Workflow tab, c

When the Change Status page appears, complete the Notify field, and add com

Click OK. 

The status of the routable object switches to the Cancel status type
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Uncanceling a Routable Object 
ncel a routable object by using the Workflow tab to switch the status. You can switch to an
vided that: 

You unca y 
status pro

as one of the valid next statuses. 

rivileges. (See your Agile administrator if you have questions about 

à 

 cancel a released routable object, the revision is removed from the item revision list 

à The status has been defined in the workflow 

à You have the appropriate p
your privileges.) 

There are no items on the Affected Items tab of the routable object. 

Note If you
of the affected items. A routable object with affected items that has been canceled cannot 

This differs from a routable 
object on hold; see also Putting a Routable Object on Hold
be uncanceled (moved to a different status in the workflow). 

 (on page 230). 

To uncancel a routable object in Java Client: 

2. 

pears, complete the Notify field, add approvers and 
if appropriate, and add comments. 

3. 

cted status. 

Client: 

ers 
appropriate, and add comments. 

 the selected status. 

The proc s type is similar to the process of 
canceling an object. See Canceling a Routable Object

1. Open the routable object. 

On the Workflow tab, select a status in the chart. 

When the Change Status dialog box ap
observers 

Click OK. 

The status of the routable object switches to the sele

To uncancel a routable object status change in Web 

1. Open the routable object. 

2. On the Workflow tab, select a status in the chart. 

When the Change Status page appears, complete the Notify field, add approvers and observ
if 

3. Click OK. 

The status of the routable object switches to

Putting a Routable Object on Hold 
ess of switching a routable object to the Hold statu

 (on page 229) for detailed instructions. 

s 

off hold, follow the directions described in 

When you put a routable object on hold, select the Hold status type instead of the Cancel statu
type. 

For information about taking a routable object 
Uncanceling a Routable Object (on page 230). 

en put on hold can Note A routable object with affected items that has be be switched from a 
Hold status type to another status in the workflow. If you put a released routable object on 
hold, the revision remains on the item revision list of the affected items. This is a 
substantial difference between Cancel and Hold. 
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The routable object on hold appears in the Pending Changes table on the item’s Changes tab. 

Status button on the Workflow tab. (See Switching 

Releasing Routable Objects 
You can release routable objects by using the Next 
a Routable Object from One Status to Another Status (on page 206).) 

If the AutoPromote property of the preceding Review status type is set to Yes, the routable object is
automatically released

 
 when all required fields are filled in and all approvers have approved the 

Before a ro

à 
red in the workflow property settings.) 

 
n the Affected Items tab of the routable object. The system then 

s th

à The e if any of the sites are 
specified as Buy. A warning is displayed when an AML is required for a Buy item. 

termine if any of the sites are required or allowed to 

nu 
(We fy that the routable object passes the release audit and that all required fields 

uditing 

change. 

eased, the system checks for the following: utable object can be rel

The Category field and all other required fields are filled in. (Your Agile administrator 
determines which fields are requi

à The routable object passes the release audit. 

In addition, when a routable object releases an item, the system checks to see which sites the item
is being released for, as indicated o
check e following: 

value in the Make/Buy field on the items’ Sites tabs, to determin

à The Site-Specific AML field of the sites, to de
have a site-specific AML. 

You can use the Audit Release button (Java Client) or the Audit Release command on the Actions me
b Client) to veri

have been completed. (For details, including the conditions a release audit checks, see A
Routable Objects (on page 207).) 

Affected Items tab of Note If you do not have Discovery and Read privileges for an item on the 
the routable object, you cannot release that routable object. 

To r

1. 

dit the routable object (click the Audit Release button, or right-click and choose 

 the Released status type from the workflow status chart. 

elease a routable object in Java Client: 

Open the routable object. 

2. If you want, au
Audit Release). 

3. On the Workflow tab, select

Or click the Next Status button . 

4. Complete the Notify field, and enter any comments in the Comments field. 

Complete the Approvers and Observers fields if you want an additional sign
routable object has been released. Otherwise, leave these fields blank. 

off cycle after the 

(See Completing the Status Change (on page 212).) 

5. 

outable object in Web Client: 

1. 

Click Release. 

To release a r

Open the routable object. 
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2. If you want, audit the routable object (choose Actions > Audit Release). 

3. On the Workflow tab, select the Released status type from the workflow status chart. 

ents in the Comments field. 

Complete the  and  fields if you want an additional signoff cycle after the 

4. Complete the Notify field and enter any comm

Approvers Observers
routable object has been released. Otherwise, leave these fields blank. 

(See Completing the Status Change (on page 212).) 

5. Click OK. 

If not all the required fields have been completed, you are prompted to complete them. 
Otherwise, the status of the routable object switches to Released. 

rmFor info ation about multiple Released status types, see Multiple Released Status Types (on page 

asing Routable Objects 
use the Workflow tab to unrelease a

233). 

Unrele
You can  routable object by switching the routable object from a 
Released or Complete status type to a Pending, Submit, Review, Cancel, or Hold status type. 

Routa

rout

t not a recommended practice. Use extreme caution when 
u are using Agile Content Service (ACS) or 

 passed to your 

 
cies 

has been configured by the Agile administrator to 
outable object to another status type. (The default 

 procedure.) 

à r changes have been made and released against the same items. 

For example, f other changes have been created 

If yo m on the Affected Items tab of the routable 
obje

ble object in Java Client: 

 a status from the chart. Do not select a Released or Complete 

ble objects can be interrelated in complex ways, for example, by their release order or by 
being listed on the Relationships tab one or more additional routable objects. Unreleasing any 

able object can have unforeseen consequences. 

Cau ion Unreleasing a routable object is 
unreleasing routable objects if yo
ChangeCAST. After you have released a routable object and it’s been
ERP system, unreleasing the routable object has no effect on the information in the ERP 
system. ACS and ChangeCAST do not pass the updated information about unreleasing a
routable object to the ERP system, and any audit trails, records of tasks, or dependen
between objects are not restored. 

You can unrelease a routable object, provided that: 

à The workflow assigned to the routable object 
allow you to switch a Released or Complete r
workflows do not allow this

à You have the appropriate privileges. 

No othe

when you are working with items and changes, i
and released against the same items, you must first unrelease those later changes. Unrelease 
those changes in the reverse order in which they were created. 

u do not have Discovery and Read privileges for an ite
ct, you cannot unrelease that routable object. 

To unrelease a routa

1. Open the routable object. 

2. On the Workflow tab, select
status type. 
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Note Selecting the Pending status type allows you to edit the unreleased routable 
object, including selecting a different workflow. 

3. Complete Comments field. If appropriate, add 

s Change

 the Notify field, and enter any comments in the 
approvers and observers. 

(See Completing the Statu  (on page 212).) 

ype allows you to edit the unreleased routable 

4. Click OK. 

To unrelease a routable object in Web Client: 

1. Open the routable object. 

2. On the Workflow tab, select a status from the chart. Do not select a Released or Complete 
status type. 

Note Selecting the Pending status t
object, including selecting a different workflow. 

3. Complete the Notify field, and enter any comments in the Comments field. If appropriate, 
approvers and observers. 

4. Click OK. 
 

Multiple Released S

add 

tatus Types 
A workflo routable object enters the first 
Released status type, all the release checks are performed (described in Auditing Routable Objects

w can have multiple Released status types. When the 
 

ta redlines data goes into effect in the affected 

 

l approval cycles after release but before the 

(on page 207)), and any BOM or manufacturer da
items. The routable object is now released. 

For subsequent Released status types, no additional checks or release actions are performed; the
routable object remains released. However, the released routable object may be routed for 
additional approval cycles. This allows for individua
routable object moves to the Complete status type. The routable object remains released as long as 
it moves from a Released status type to either another Released status type or to a Complete 
status type. 

Note Moving a routable object from a Released status type to a Pending, Submit, Review, Hold, 
or Cancel status type unreleases the routable object. 

 

Use Case of First Released Status 

This use case explains how the system refers to multiple Released statuses. The “first Released 
status” does release the workflow. The other Released statuses provide for additional review 
signoffs; they can also have Entry Required fields. 

Let there be a workflow with multiple Released statuses – call the
Entry Required fields set for each Release status. Also, a “no
R2 or R3 – has been permitted to be a Valid Manual Next Sta

m R1, R2, and R3 – and there are 
n-first Released status” – in this case, 
tus from one of the pre-Released 

). 

hecking the first Released 
changed in the database because 

statuses (that is, you can skip the first Released status, the one that actually releases the workflow
Then, when you select that workflow and it moves from Pending status to R3 status, the system 
checks the Entry Required fields of the first Released status, R1. 

It works this way because the workflow should not be released without c
status’s Entry Required fields, because that’s where objects are 
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of the released Change. For example, when an item’s lifecycle is changed, its revision (rev) should 

 
item

 
object has a Comment button, you can add a 

ct. 

To add a History tab comment in eith nt or Web Client: 

 
nt to only the current review or 

sed  
 revi

(Java Client  “Notify Reviewers 
tuses for selection. 

You
privilege le object is still in the Pending status type, you can change the subclass of 
a routabl
crea
obje

Note e of its data fields may change, 

be incremented, and even if you are attempting to leapfrog over R1, R1’s requirements are still 
important; if R1’s Entry Required fields were ignored, you could end up with an improperly released

. 

Adding Comments to the History Tab
If you have the appropriate privilege and the routable 
comment to the routable object's History tab and send that comment to the users you sele

er Java Clie

1. Open the routable object and click its Comment button. 

2. In the displayed dialog or wizard, enter your comments in the Comment field. 

3. Use the checkboxes to select default users to notify, such as the change analyst or the list of 
reviewers. Each type of routable object includes a selection of default users appropriate for that 
type of object. 

4. Use the Notify field to specify additional users to notify. 

5. When you are finished, click Comment. 
 

Sending Comments to all Previous and Current CCB Members 

When sending comments (by using the Comment button) from a Review or Released type status in a
change, you can specify whether the comments are to be se
relea status reviewers – that is, for the workflow’s current status – or if comments are to be sent
to all ewers in both current and previous Review and Released statuses. In the Comment dialog 

) and the Comment wizard (Web Client), a drop-down box (after the
for” checkbox) contains Current Status and Current and Previous Sta

Changing a Routable Object’s Subclass 
r Agile administrator can create new subclasses of routable objects. If you have the appropriate 

s, and the routab
e object to another subclass in the same class. For example, if your administrator has 

ted the ECN (engineering change notice) subclass, you can change the subclass of a routable 
ct in the Change Orders class from ECO to ECN. 

 When you change the subclass of a routable object, som
and all previous information about the Page Three section is cleared. 

To c

1. On ge tab of the routable object, select a new subclass from the Object Type drop-

e 
ed. 

Yes red. 
lick  

2. If the new r, Agile 
asks if you want to continue using the same object number. 

hange the subclass of a routable object in Java Client: 

the Cover Pa
down list. For example, for Change Type, you can select ECO or ECN. 
y If the Page Three tab is visible, a warning message appears, alerting you that all Page Thre

data is clear
y Click to continue changing the subclass and to allow Page Three data to be clea
y C  No to cancel the change subclass process. No changes are made to the object.

 subclass has an autonumbering scheme assigned by your Agile administrato
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y Click Yes to change the subclass but retain the existing number. 
y Click No to change the subclass and assign a new autonumber. If more than one 

lect the autonumbering scheme 

nged. 

autonumbering scheme applies, you are prompted to se
you want. 

If the new subclass does not have an autonumbering scheme assigned by your Agile 
administrator, the process is completed with the subclass being changed but the number not 
being cha

Note When you click the AutoNumber button , the number changes automatically. 
The autonumbering scheme assigned to the subclass you selected is used, or 
you are prompted to select one (if multiple schemes have been designated). 

3. Agile PLM automatically numbers the routable object and displays the new number in the 
Number field, and the event is entered on the History tab of the routable object. 

hange the subclass of a routable object in Web Client: To c

1.  subclass from the Object Type 

notice

2. 

red. 
es are made to the object. 

3. igned by your Agile administrator, Agile 
mber for the new subclass (unless 

autonumbering is required by your system, in case you see a different warning 
age

y Click
y Click  number. 

umber source is 

y Click Yes to select a different autonumber source. 

 AutoNumber button 

On the Cover Page tab of the change, click Edit, and select a new
drop-down list. For example, for Change Type, you can select ECO or ECN (engineering change 

). 
If the Page Three section (on the Cover Page tab) is visible and has data, a warning message 
appears, alerting you that all Page Three data is cleared. 
y Click OK to continue changing the subclass and to allow Page Three data to be clea
y Click Cancel to cancel the change subclass process. No chang

If the new subclass has an autonumbering scheme ass
Web Client asks if you want to select a new autonu

 which 
mess ). 

 OK to continue the process of changing the number. 
 Cancel to change the subclass and use the AutoNumber button to change the

If the new subclass does not have an autonumbering scheme assigned by your Agile 
administrator, the process is completed with the subclass being changed but the number not 
being changed. 

If autonumbering is required in your system, and more than one auton
designated for the new subclass, a different warning is displayed. 

y Click No to use the same autonumber source. 

Note When you click the , the number changes 
automatically. The autonumber

ed to sele
 scheme assigned to the subclass you selected 

ct one (if multiple schemes have been is used, or you are prompt
designated). 

 the change and displays the new number in the Number field, 4. Agile PLM automatically numbers
and the event is entered on the History tab of the routable object. 
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After
Releasing a routable object affects the appearance and behavior of the routable object’s tabs, as 

On the Af the Add and Delete buttons 

nd behavior of 

 a Routable Object is Released 

well as the BOM of any items affected by the routable object that were included on the affected 
items list of that routable object. 

On the Cover Page tab of the routable object: 

à The stamp reflects the new status. 

à The Status field reads Released. 

fected Items tab, the Add and Remove buttons (Java Client) or 
(Web Client) are disabled. 

Note If the workflow has more than one Released status type, the appearance a
the rout  object are altered only when the routable object enters the firsable t Released 
status type. For more information, see Multiple Released Status Types (on page 233). 

 

Switching Routable Objects to Their Final Status 
 it 

 
A routable object’s workflow defines its final status. If the workflow has a status of type Complete,
is always the last status in the status list, before any Hold or Cancel status types.

Note Depending on the assigned workflow, a routable object may not have a Complete status 
type. A Complete status type is not re ired in a workflow. qu

To examine the status lists of the workflows in use at your company, in Java Client, click the View 

Workflows button  in the toolbar. In Web Client, choose Actions > View Workflows. 

tus 
type  the Complete status type when all the required 
fields for the ny approvers have approved the routable 

ch a routable object to its Complete status type. 
 administrator if you have questions about your privileges. 

Afte atus, you cannot delete it unless you 

If the Released status type is set to autopromote and it immediately precedes the Complete sta
, the routable object automatically switches to

Released status type are filled in and a
object. 

You must have the appropriate privileges to swit
See your Agile

r a routable object has been switched to its final st
unrelease it first. See Deleting Routable Objects (on page 238). 

To witch a routable object tos  its final status in Java Client: 

3. Workflow tab. 

 box appears. 

5. Enter any comments in the Comments field. 

1. Open the routable object. 

2. If you want, audit the routable object. 

Select the Complete status type by using either the Next Status button or the 

The Change Status dialog

4. Complete the Notify field. 

Page - 236 Agile Product Lifecycle Management 

 

 



 Chapter 8  
 
 

6. Click OK. 

The routable object is switched to its final status. 

To switch a routable object to its final status in Web Client: 

1. Open the routable object. 

2. If you want, audit the routable object. 

Next Status Workflow 

, PCOs and 

icy, when you redline manufacturing data, use an ECO when you 
an MCO when you do not want to advance the 

ents, see Concepts and Terms in Agile 

3. Select the Complete status type by using either the  button or the tab. 

The Change Status to Complete status type name page appears. 

4. Complete the Notify field. 

5. Enter any comments in the Comments field. 

6. Click OK. 

The routable object is switched to its final status. 

Redlining through ECOs, MCOs
SCOs 
Redlining highlights, in red, changes made to an object. Only ECOs, MCOs, PCOs, and SCOs have 
redlining functions. Use these changes when you need to modify a released item. For information 
about the functions of these types of changes, see the Product Collaboration User Guide. 

Depending on your company pol
want to advance the revision of an item, or use 
revision of an item. 

For information about redlining a BOM, AML, and attachm
PLM Solutions (on page 61). 

Redlining through ECOs 
You can redline BOM and AML data and attachments using an ECO. 

ECO changes let you release new items and modify previously released items. When you create an 
modified by the change (the ones listed on the 
eliminary revision is converted to a released 

O. 

er, MCOs do not change the 

MCO 

ECO, a preliminary revision is created for any items 
Affected Items tab). When the ECO is released, the pr
revision for each modified item. 

Redlining through MCOs 
You can redline AML data using an MC

MCOs are similar in appearance and function to an ECO. Howev
revision of an item, unlike an ECO. Instead, the MCO number is displayed alongside the 
corresponding n number in the Rev drop-down list. For example, if there is a pending  revisio
#M12345 against Rev B of an item, then, on the Rev drop-down list, that revision is listed as (B) 
M12345. 
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Re gh PCOs 
o your 

and  redline the price and route it through a PCO. 

es you want to redline. 

rice List Redline appears. 

ired: 
y Ship To 

6. The price is added to the  tab. The added price is displayed in red. 

 

Redlining through SCOs 

SCO
of a ad, the SCO number is displayed next to the corresponding revision 

5 against revision B 

dlining Prices throu
You can redline prices using a PCO. Using the redlining feature, you can publish the price t
customers. For example, if you have renegotiated the price of a particular item with your supplier 

 you want to publish the new price, you can

To redline the price through a PCO: 

1. Open the PCO that contains the pric

2. Click the Affected Prices tab. Click the Do Redlining icon. The P

3. Click the Add button to add one or more prices. The Add Affected Prices Wizard appears. 

4. Search for the prices you want to redline, or create a new price. 

5. Enter the required information, and click Finish. The following fields are requ

y Price Effective From Date 

Price List Redline
7. Click the Back to PCOnumber button. The PCO page appears, with the Has been redlined icon in

the rows for the prices you have redlined. 
 

You can redline site-specific BOM and AML data using an SCO. 

s are similar in appearance and function to ECOs. However, SCOs do not change the revision 
n item, unlike ECOs. Inste

number in the Rev drop-down list. For example, if there is a pending SCO S1234
of an item, then, on the Rev drop-down list, that revision is listed as (B) S12345. 

Deleting Routable Objects 
Agile Java Client and Web Client support “soft” and “hard” deletes. For general information about 
soft and hard deletes, see Working with Business Objects (on page 81). 

Note You can undelete a soft-deleted object. You cannot undelete a hard-deleted object. 

You can delete routable obj ts that meet the following criteria: ec

à 
to 

signed status. 

the Affected Items table, you 

To d
obje utable object using the Workflow tab to 
switch it to a different status. (See Unreleasing Routable Objects

You created it; or you are the change analyst or component engineer, and your Agile 
administrator has given change analysts or component engineers the appropriate privileges 
delete a routable object. 

à The routable object is at the Pending status type or the Unas

If you do not y and Read privileges for any items on have Discover
cannot delete the routable object. 

elete a routable object that has already been released, you must first unrelease the routable 
ct. You need the appropriate privileges to unrelease a ro

 (on page 232).) 
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To soft-delete an unreleased routable object in Java Client: 

1. Open the routable object that you want to delete. 

2. Click the Delete button , and respond Yes to the confirmation prompt. 

The routable object is soft-deleted. It is no longer available for use. However, until it is hard-

d respond OK to the confirmation prompt. 

ever, until it is hard-

ed Items tab before you delete it. You can undelete only routable object with no entries on 

rout opy it under another routable object number before 

riate privileges) in Java 

 Deleted Objects search to locate the soft-deleted 

Delete

deleted, its number is reserved and cannot be reused. 

To soft-delete an unreleased routable object in Web Client: 

1. Open the routable object that you want to delete. 

2. Choose Actions > Delete, an

The routable object is soft-deleted. It is no longer available for use. How
deleted, its number is r erved and cannot be reused. es

If you think you might want to undelete a soft-deleted routable object in the future, be sure to clear 
its Affect
the Affected Items tab. If you want to keep the record of affected items but still want to delete the 

able object, use the Save As command to c
deleting it. 

To hard-delete a soft-deleted routable object (if you have the approp
Client: 

1. From the Recycle Bin Searches folder, run the
routable object  you want to hard-delete. 

2. Open the routable object. 

3. Click the  button , and respond  to the confirmYes ation prompt. 

 

bjects search to locate the soft-deleted 

he confirmation prompt. 

Undeleting Routable Objects 
an undelete them if you have the 

 the Affected Items tab. 

bjects search in the Recycle Bin 
Searches folder. 

1. Find the soft-deleted routable object by running the Deleted Objects search in the Recycle Bin 
Searches folder. 

To hard-delete a soft-deleted routable object (if you have the appropriate privileges) in Web
Client: 

1. From the Recycle Bin Searches folder, run the Deleted O
routable object you want to hard-delete. 

2. Open the routable object. 

3. Choose Actions > Delete, and respond OK to t
 

Since soft-deleted routable objects still exist in the database, you c
necessary privileges, and if the routable objects has no items on

To undelete a routable object in Java Client: 

1. Find the soft-deleted routable object by running the Deleted O

2. Open the deleted routable object you want to restore. 

o undelete the routable object, choose the Undelete button. 3. T

To undelete a routable object in Web Client: 
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2. Open the deleted routable object you want to restore. 

3. To undelete the routable object, choose Actions > Undelete. 
 

Printing Routable Object’s Data 
You can print routable objects and other data. With the routable object open, click the Print button 

 (Java Client), or choose Actions > Print (Web Client). You can print the current tab or all tabs. 

Attachments are printed from their native applications or the Viewer. 
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Working with Attachments 
This chapter includes the following: 

� What are Attachments? ....................................................................................................................................... 241 
� Working with the Attachments Tab of Business Objects ..................................................................................... 244 
� Basic Procedures on the Attachments Tab ......................................................................................................... 251 
� Adding and Removing Files via the Attachments Tab ......................................................................................... 255 
� Revising Attachment Files ................................................................................................................................... 263 
� About Item Revisions and File Folder Versions................................................................................................... 267 
� Viewing and Redlining Attachment Files in the Viewer........................................................................................ 272 
� Generating Attachment Quick Access URLs ....................................................................................................... 275 
� Scan Utility........................................................................................................................................................... 280 

 
 

What are Attachments? 
Attachments to Agile business objects contain pertinent information about the object in addition to 
the information recorded on the object tabs. Examples of attachment files are: 
y Drawing files such as CAD drawings or scanned image files in viewable formats 
y Web-based information in the form of URLs 
y Specifications and other documents 
y Non-viewable files, compressed files, and so on 

Use the business object’s Attachments tab to manage and access attachments. Attachments tab 
actions allow you to add, remove, open, view (in the Viewer), or get a copy of an attachment file. 
You can also check out and check in an attachment file in order to modify or update it. For more 
information about Attachments tab actions, see Working with the Attachments Tab of Business 
Objects (on page 244). 

Attachment file storage and retrieval is managed automatically by your Agile PLM system. 
Attachment files are stored in the Agile File Vault and each attachment file in the vault is associated 
with a numbered Agile file folder object. The concept is similar to the way in which you would file 
and store paper documents: sort the documents into file folders, label or number the file folders, and 
store them in a filing cabinet. 

Attachment Files and Agile File Folders: an Analogy to 
Papers, Desks, and Vaults 
Using numbered file folder objects and a locked Agile File Vault to store attachment files is similar in 
concept to the way you might manage paper documents that you must work with every day. The 
scenario that follows describes a typical office system, which will make the rules that govern Agile 
attachment files and file folders easier to follow. 

Bob is an engineering manager, and managers at his company have to coordinate the designs of 
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their products. Bob has a file cabinet, but he is afraid of losing track of his drawings so he keeps 
stacks of paper drawings on his desk and they never get filed. The drawings are associated with 
various projects that Bob manages. When Carl wants to see a particular drawing, he must ask Bob, 
and Bob searches through the piles on his desk. Bob often has several versions of a drawing, and it 
is difficult for him to locate the specific version that Carl remembers seeing. Of course, this sorting 
process is time-consuming and inefficient. 

Bob decides to get organized, so he sorts the drawings and puts them into manila file folders, and 
he even puts a label on each folder with an identifying name or number. Bob puts all the versions of 
the same drawing in one file folder, newest version in front, oldest version in back. He then files the 
manila folders into his filing cabinet. He can lock the cabinet in order to keep the drawings secure. 
Now when Carl asks for a drawing by project name, folder number, and version—for example, the 
Acme project—Bob locates the Acme drawing that Carl needs. 

However, six months later, Bob’s archive of drawings has continued to grow. His naming of folders 
is somewhat inconsistent, and occasionally he cannot find what he wants. He spends too much time 
fielding requests from his staff, and he hands out various versions of drawings but then forgets who 
has what. When changes are made to a product, there is no control over what version of drawing 
plan should be used. Bob needs someone to help him manage the drawings, and other engineers in 
the company have the same problem. 

Doris is tasked to create and manage the company’s document control vault. Bob and his 
colleagues give all their drawings and file folders to Doris, who files them in a locked vault. Doris 
uses a document system that ensures she will always locate the correct file folder and correct 
version of a drawing. Now when Carl needs a drawing, he requests it from Doris, she locates it in 
the vault and makes a copy of it. She gives the copy to Carl, but the original drawing stays locked in 
the vault. Doris also marks the file folder as Checked Out. When a file folder is checked out, Doris 
does not allow any other person to update the drawings in that file folder. 

When Carl brings Doris the updated drawing, she puts it in the file folder, records the new version 
number on the file folder and marks the file folder as Checked In. Now when Bob asks Doris for the 
Acme folder, he can see the progress of work done on the product by Carl and the other engineers. 

If Bob happens to know the file folder number of the Acme drawing he wants to update, he can ask 
Doris to check out that file folder by its number. But he does not have to know the file folder number 
because Doris keeps track of the relationships between each project, the names and version 
numbers of the drawings for that project, and the file folder numbers where the drawings are stored. 

Agile Document Management: Even More Efficient than Doris 
The scenario above illustrates some problems that companies have as designs, data, and 
information accumulate on projects, as well as solutions that have been developed to manage and 
control the information. Agile PLM manages and controls the product record in electronic form, and 
Agile users have to become familiar with an arena in which design drawings or data are attachment 
files, manila folders are file folder objects, and the venerable file cabinet is accessed through the 
Attachments tab of any Agile business object, or from the Files tab of a file folder object. There is 
nobody named Doris controlling the file vault in Agile PLM, but you should recognize the same kind 
of business rules that have been incorporated into Agile’s system of file security and management. 

Files and URLs that are attached to—associated with—parts or other business objects have always 
been called attachments in Agile. A file folder is simply a numbered container or “wrapper” for 
attachment content. By referencing the same file folder number and version on their Attachments 
tabs, multiple business objects can use the same file attachment (for example, a single datasheet 
attached to multiple manufacturer parts). This ensures that the attachment content is always in sync 
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with the business objects. Re-use of attachment files prevents the proliferation of multiple copies of 
the same file in the file vault. 

The diagram below illustrates the relationships between business object Attachments tabs, file 
folders, and the file vault. Note that one file in a file folder can be attached to one business object, 
and another file in the same file folder can be attached to another business object. 

Attachments to business objects are managed through the Attachments tab; use the Attachments tab 
features to add, remove, get, view, and update attachments. In addition, if your company’s business 
processes require it, file folders can be managed and updated independently of other objects in the 
database. All attachment files are stored in the file vault, part of Agile File Manager (AFM). For more 
information about file folders, see Working with File Folders (on page 284). 

It is generally a best practice to limit each file folder to a single, attachable file or URL; however, file 
folders can contain any number of files and URLs. For example, a file folder might contain the same 
file under different formats, such as a CAD drawing that is saved in its native CAD format as well as 
in PDF format. Also, items or other Agile objects can have any number of file folders attached. In 
this way, every file, drawing, or URL that contributes to describing any part, product, or process at 
the enterprise can be referenced by multiple objects in Agile PLM. 

The following diagram illustrates the relationship between business objects with file folders 
attached, file folder objects, and attachment file content. Once files are added to a file folder, other 
Agile objects can have any combination of those files attached by referencing the file folder. The 
following diagram illustrates a few cases. 
 

What are Attachment Versions? 
The version of a file folder is important to understand when you work with attachments. This is a 
brief introduction to versions. For more information about versions (of attachments) as well as 
revisions (of items), see About Item Revisions and File Folder Versions (on page 267). 

à On the Attachments tab of business objects, the Folder Version field in each row reports the 
version of the file folder that is attached to the object. The file folder version represent the 
version of the attached file. 

à When you use the Add | Files feature of the Attachments tab to add business object attachment 
files from your local disk or network, Agile automatically creates a new file folder container for 
each of the added files and sets the version of each file folder to 1. 

à Each time you modify the attachment file (by checking out the file, editing the file, and then 
checking in the file), the file folder version number is incremented by one. 

à A business object can attach (that is, point to) only one version of a file folder; you select this 
version when you add the attachment. 

à By editing the attachment row, you can select a different version of the file you want to attach 
or reference from the Attachments tab. For example, if an attachment has file folder versions 1, 
2, and 3, you can select any one of those versions in the attachment row, or you can select 
LATEST. 

à “Latest-x” represents the dynamic “latest version of a file folder,” where x is the highest 
numbered version up to this point. For example, Latest-x is seen as Latest-3 on the business 
object’s Attachments tab. When you select LATEST as the version number, the attachment row 
always refers to the latest version of the file, no matter how many times it has been updated 
(checked out and checked in). 
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à 

sion 
 refers to a non-latest version (in this 

à 
ities you can perform 

When you point to the latest version (that is, either Latest-x or x), you can check out and check 
in attachment files from the object’s Attachments tab. You can checkout only the most recent 
version of the attachment. In this example, the version number must be either Folder Ver
Latest-3 or Folder Version 3. If the attachment row
example, 1 or 2), the checkout button is disabled. 

If you have the appropriate privileges, you can open the file folder object by clicking its number 
on the Attachments tab. For more information about file management activ
from the file folder object, see Working with File Folders (on page 284). 

If you want to access earlier versions of the attachment files, use the Show Versions feature 

 with the Attachments Tab of Business 
Objects 

ents. This section describes operations performed from the Attachments tab of any business 

rmation about items and manufacturer parts, see the Product Collaboration User 

lace it in a location of your choice 

n 

ions of an attachment file 

 folders in 

. 
achments tab are enabled or disabled, depending on your privileges and 

Attachments tab to display and select a previous version of the file, as described below. 

Working

All business objects in Agile have an Attachments tab. Items—parts or documents—and 
manufacturer parts may reference attachment files more often than the other classes in Agile 
because those classes represent physical entities that often require supportive information; 
however, users will likely encounter objects from classes across Agile PLM solutions that have 
attachm
object. 

For more info
Guide. 

You can use the Attachments tab to: 

à Get a copy of an attachment file and p

à View an attachment file in the Viewer 

à Open an attachment file in its native applicatio

à Show previous vers

à Print attached files 

à Add and remove attachments 

à Check file folders out, modify them, and check file
 

Buttons on the Attachments Tab 
You need the appropriate privileges to perform any attachment file operation on the Attachments tab
The buttons on the Att
administrative settings. File Validation (Handle File Checksum) (on page 308) addresses some of 
these dependencies. 

The buttons in the following table are available to users with the required privileges. To view a file 
using Viewer, double-click its File Name (Java Client) or click its File Name link (Web Client). If the 
file format is included on the list of valid viewer file types in Agile Administrator, the file opens in the 
Agile viewer. Otherwise, the file opens in its native application, provided the application is installed 
on your computer. 
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Note You cannot make changes to the Attachments tab of incorporated items. Once an item rev 
is incorporated, its attachments cannot be checked out from the item rev without a 
change. However, you can still check out or check in the associated file folder, and the 
folder version still increments upon checkin. 

Attachment tab buttons, Java Client 

Button  Name Descr ipt ion 

   Get Files Select the rows you want, then click the Get Files from Selected 
Attachments button to place a copy of the selected files in the folder or 
location of your choice. These copies are in native application formats. 

Or 

Click the button and select Batch Get All Files from this Object to place a 
copy of all the object’s attached files in the folder or location of your choice. 
These copies are in native application formats. 

If you selected a row with multiple files (indicated by a file folder icon in the 
row), the Select Files dialog appears, allowing you to select which files you 
want to get. 

   Open Files Click the Open Files button to open the files in file folders on the 
Attachments tab as a unit. In the case of multi-file file folders, you can 
choose an individual referenced file to open. 

 Show Versions Click the Show Versions button to open a table of all versions of selected 
attachment file. From this dialog you can view, get, open, and print a 
selected version. 

   View Files Click the View Files button to view the selected files in the Viewer. 

Or, click the View Files button’s drop-down arrow and select from the 
menu: 

View – view the files in the Viewer.  

 Cross Probe – crossprobe between PCB and schematic files in two 
windows.  

 Compare – compares the selected files and presents a comparison 
summary.  

 Overlay  – lets you lay the selected files over each other.  

 Digital Mockup – loads multiple selected models into the same 
workspace, where they can be analyzed together. For example, you can 
check them for proper fit. 

 By Search – find other files in the system, which you may want to 
(select from menu) cross probe, compare, overlay, or digital mockup (see 
above), without having to select two files from the same Attachments tab; 
that is, you could search and select one attached file from Part 234 and 
another attached file from Part 765. 

(For more information about Cross Probe, Compare, Overlay and Digital 
Mockup, see Viewer Supplement.) 
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View Redline For item objects, the View Redline button shows whether a file has been 
redlined by the Viewer. Click the button to view the file and its redlines in 
the Viewer. 

   Print Files Click the Print Files button to print the corresponding attachment file. The 
Viewer is started in a separate browser window and begins the printing 
process. 

   Edit Click the Edit button to edit the Version, File Description, and Folder 
Description of the selected file that you want to attach, as well as any other 
editable, custom fields that your administrator has defined. 

The Add button is disabled if the item is incorporated 

  
 

  
 

  

  

Add Files Click the Add button to open the File Uploader.  

Or, click the Add button’s drop-down arrow and select from the menu: 

 Files – displays the File Uploader dialog, which allows you to drag and 
drop the files you want to attach. You can also click Browse for Files 
button to browse your computer or network for the files you want. To add 
multiple files as a single file folder, click the Add all files to a single file 
folder button. If you select the UnZip all zipped files upon upload 
checkbox, the ZIP file is unzipped and the contents are added as individual 
files. 

Note Selecting the UnZip checkbox is not recommended for very large files. 

 URLs – brings up the Add URLs dialog 

 By Search – brings up the Add Files by Search dialog  

 By Scan – permit direct access to a file you want to scan. See Scan 
Utility (on page 280). 

The Add button is disabled if the item is incorporated. 

   Remove Files The Remove Files button removes the selected attachment references 
from the Attachments tab. The file remains linked to the file folder object, 
and is not removed from the Agile File Management Server. 

The Remove Files button is disabled if the item is incorporated. 

   Check Out The Check Out button checks a single attachment file or multiple 
attachment files out of the file vault. From the business object, the checkout 
prompts you to get the file or files. You can download and edit the file. If you 
cancel the procedure, the attachment is checked out, but the file is not 
downloaded. When a folder is checked out, a  appears in front of it on the 
Attachments tab.  

Check Out is disabled when the item is incorporated. 

   Check In Click the Check In button to return file(s) to the file vault. The file folder 
version number is advanced. Previous versions are accessible by using the 
Show Versions feature.  

Check In is disabled when the item is incorporated. 
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   Cancel 
Checkout 

Click the Cancel Checkout button to cancel a checkout. It re-locks the 
selected file folder, so it is available to be checked out again. A user who 
has Cancel Checkout privilege can cancel the checkout. 

Cancel Checkout is disabled when the item is incorporated. 

(no icon) Incorporate or 
Un-incorporated 

The information as to whether the part is Incorporated or Unincorporated is 
automatically filled. 

   Has Checksum 
Error 

The Has Checksum Error field is checked if the file has been modified 
directly in the file server vault. For more information, see Checksum File 
Validation. 

 

 

Attachment tab buttons, Web Client 

Button  Name Descr ipt ion 

   Edit Click the Edit button to modify the Version, File Description, and Folder 
Description of the selected file that you want to attach, as well as any other 
editable, custom fields that your administrator has defined. 

The Edit button is disabled if the item is incorporated. 
 Action: 

Open file in its 
native application 

Click the File Name link. 

If the file format is included on the list of valid viewer file types in Agile 
Administrator, the file opens in the Agile viewer. Otherwise, the file opens in 
its native application, provided the application is installed on your computer. 

   Remove Removes all selected files from the Attachments tab.  

The Remove button is disabled if the item is incorporated. 
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Add Click the Add button to open the File Uploader.  

Or, click the Add button’s drop-down arrow and select from the menu: 

  Files – if you are using File Productivity tools, displays the File 
Uploader dialog, which allows you to drag and drop the files you want to 
attach. You can also click Browse for Files button to browse your computer 
or network for the files you want. To add multiple files as a single file folder, 
click the Add all files to a single file folder button. If you select the UnZip 
all zipped files upon upload checkbox, the ZIP file is unzipped and the 
contents are added as individual files. 

  Files – (no File Productivity tools) displays the Add File dialog, which 
allows you to browse for up to five files, add the files to a single file folder, 
and unzip zipped files. 

Note Selecting the UnZip checkbox is not recommended for very large files. 

For more information about File Productivity tools, see Using the Advanced 
File Uploader. 

  URLs – brings up the Add URLs dialog 

  By Search – brings up the Add Files by Search dialog  

The Add button is disabled if the item is incorporated. 

Note: Either Advanced File Uploader or Standard File Uploader will be used 
depending on your user profile File Productivity Preference setting. For 
more information see Adding Attachment Files from your Local Disk or 
Network. 

   Get Shortcut Copies a URL to your clipboard, which you can paste into another sofware 
application, such as an email, document, or spreadsheet. The URL provides 
easy access to Agile attachments. For more information, see Accessing Files 
using URLs.  
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   View Click the View Files button to view the selected files in the Viewer. 

Or, click the View Files button’s drop-down arrow and select from the menu: 

View – view the files in the Viewer.  

 Cross Probe – crossprobe between PCB and schematic files in two 
windows.  

 Compare – compares the selected files and presents a comparison 
summary.  

 Overlay lets you lay the selected files over each other.  

 Digital Mockup – loads multiple selected models into the same 
workspace, where they can be analyzed together. For example, you can 
check them for proper fit. 

 By Search – find other files in the system, which you may want to (select 
from menu) cross probe, compare, overlay, or digital mockup (see above), 
without having to select two files from the same Attachments tab; that is, 
you could search and select one attached file from Part 234 and another 
attached file from Part 765. 

(For more information about Cross Probe, Compare, Overlay and Digital 
Mockup, see Viewer Supplement.) 

   Get File Click the Get Files button to place a copy of the selected files in the folder or 
location of your choice. These copies are in native application formats. 

If you selected a row with multiple files (indicated by a file folder icon in the 
row), the Select Files dialog appears, allowing you to select which files you 
want to get. 

   Check Out The Check Out button checks a single attachment file or multiple attachment 
files out of the file vault. From the business object, the checkout prompts you 
to get the file or files. You can download and edit the file. If you cancel the 
procedure, the attachment is checked out, but the file is not downloaded. 
When a folder is checked out, a  appears in front of it on the Attachments 
tab.  
Check Out is disabled when the item is incorporated. 

   Check In Click the Check In button to return file(s) to the file vault. The file folder 
version number is advanced. Previous versions are accessible by using the 
Show Versions feature. 

Check In is disabled when the item is incorporate 

   Cancel Checkout Click the Cancel Checkout button to cancel a checkout. It re-locks the 
selected file folder, so it is available to be checked out again. A user who has 
Cancel Checkout privilege can cancel the checkout. 

Cancel Checkout is disabled when the item is incorporated 

   Print Files Click the Print Files button to print the corresponding attachment file. The 
Viewer is started in a separate browser window and begins the printing 
process. 
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 Show Versions Click the Show Versions button to open a table of all versions of selected 
attachment file. From this dialog you can view, get, open, and print a 
selected version. 

 
 

Fields on the Attachments Tab 
The following table lists fields on the Attachments tab. These apply to both Java and Web Clients, 
although the order of the fields may vary in each client. 

Field  Descr ipt ion 

   If a file has been modified directly in the file server vault, this icon appears in the field 
to indicate that the file Has checksum error. Click the icon to get information about 
the checksum error. See Checksum File Validation (on page 266). 

   

 

   

This icon appears in the field if the file Has been redlined. 

The Do Redlining icon will appear here from the file folder level for any file type that 
is listed in the Supported File Types and Valid Model File Type settings in 
Administrator. Both of these cases allow ad-hoc viewing and redlining. 

   This icon appears in the field if the file Has been checked out. 

Filename 

Java Client     

Web Client    
 

The name of the file. This field begins with an icon just before naming the file or files: 
a “single document” icon is present in rows containing single attachment files; a “file 
folder” icon is present in rows containing multiple attachment files (that is, a file 
folder that contains multiple files). 
à In Java Client, the attachment row must be selected in order to print, open, get, or 

view the file using buttons on the menu. 
à In Web Client, click the filename to view the file in the Viewer. 

File Description Description of the referenced attachment files. To change File Description field, see 
Basic Procedures on the Attachments Tab (on page 251). 

File Size Size of the file, in Bytes 

File Type The kind of file, for instance, document, graphic, drawing 

Folder Number The ID number assigned to the file folder 

Folder Description The description of the file folder 

Folder Version Reflects which version of the file folder that is being referenced by the business 
object. By default, the most recent version is shown, but you can select an earlier 
version. 

Checkout User Name of the person who checked out the file folder; appears only when file folder is 
checked out 

Checkout Date Date when the file folder was checked out; appears only when file folder is checked 
out 

Modified Date Indicates when the file folder was checked back in after modifications 
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Field  Descr ipt ion 

Last View Date Date when the file was last viewed. (The History tab records detailed information 
about file viewing.) 

 

Checkout Location When you check out an attachment file and save a copy of the checked out file, 
Agile stores the checkout location (computer name and directory path name) in this 
field. When you check in, Agile uses the Checkout Location information to 
automatically locate the modified file to check in. 

Note In Web Client, this field is completed automatically 
only when using Advanced Productivity 
Components. See also Checking In Revised 
Attachment Files (on page 265). 

Attachment Type File or Image 

 
 

Basic Procedures on the Attachments Tab 
On the Attachments tab of any business object, you can perform all the actions needed to add, view, 
manage, and update your attachment files. 

Note Your ability to use Attachments tab features is determined by your assigned roles and 
privileges. Contact your Agile administrator if you have questions about your Attachments 
tab privileges. 

 

Getting Attachment Files 
You can copy attachment files to the directory of your choice. This is called getting a file. You can 
get as many copies as you like. If you want to revise an attachment file and make the version 
public, you must check the file out, make changes, and check it back in. This is covered in Checking 
Out Attachment Files (on page 264). 

Several users can get the same attachment files simultaneously. You can get files that are checked 
out. Also, you can get a file even though the application used to create that file is not loaded on your 
computer. 

You must have the appropriate privileges to get a copy of the file. If you have questions about your 
privileges, contact your Agile administrator. 

Note When you get an attachment file, the date and time stamps on your copy of the file 
reflects the date and time that you got the file, not the date that the file was attached or 
saved. 

 

Java Client, Getting Attachment Files 

To get copies of one or more attachment files from a business object in Java Client: 

1. Display the Attachments tab of an object. 
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2. Select the rows of the files that you want to get. 

3. Click the Get Files button  . 
y If you selected a row with multiple files (indicated by a file folder icon in the row), the Select 

Files dialog opens. 

Select the files you want and click OK. The Select Directory dialog opens. Continue with 
the next step. 

y If you selected one or more rows that consist of a single attached file, the Select Directory 
dialog opens. Continue with the next step. 

4. In the Select Directory dialog, specify the directory where you want to store the copies. 

If you want to get the files together in one ZIP file, click Download the files in one ZIP file. Specify a 
ZIP filename. 

5. Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be prompted whether you want to open the file or files. 

Java Client, Batch Get 

To batch get copies of all the attachment files of a business object in Java Client: 

1. Display the Attachments tab of an object. 

2. Click the button drop-down menu for Get Files   and select Batch Get All Files from this Object. 
y If the attachments table includes a row with multiple files (indicated by a file folder icon in 

the row), the Select Files dialog opens. 

Select the files you want and click OK. The Select Directory dialog opens. Continue with 
the next step. 

3. In the Select Directory dialog, specify the directory where you want to store the copies. 

If you want to get the files together in one ZIP file, click Download the files in one ZIP file. Specify a 
ZIP filename. 

4. Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be prompted whether you want to open the file or files. 

Web Client, Standard File Productivity, Getting Files 

To get copies of attachment files from a business object in Web Client, using Standard File 
Productivity method: 

1.  Display the Attachments tab of an object. 

2.  Click the Get button  in the row of a file you want. 
y If you selected a row with multiple files (indicated by a file folder icon in the row), the Select 

Files dialog opens. 

Select the files you want and click Finish. The Select Directory dialog opens. Continue with 
the next step. 

y If you selected one or more rows that consist of a single attached file, the Select Directory 
dialog opens. Continue with the next step. 

3.  The Save As dialog appears. Save the files to disk, specifying the directory where you want to 
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place the files. Web Client copies the files to the selected directory. If you get copies of multiple 
files, they are placed in a ZIP file. 

4.  Click OK. The files (or ZIP file) are copied to the specified directory. 
 

Web Client, Advanced File Productivity, Getting Files 

To get copies of attachment files from a business object in Web Client, using Advanced File 
Productivity method: 

1. Display the Attachments tab of an object. 

2. Click the Get button  in the row of a file you want. 
y If you selected a row with multiple files (indicated by a file folder icon in the row), the Select 

Files dialog opens. 

Select the files you want and click Finish. The Select Directory dialog opens. Continue with 
the next step. 

y If you selected one or more rows that consist of a single attached file, the Select Directory 
dialog opens. Continue with the next step. 

3. The Save As dialog appears. Save the files to disk, specifying the directory where you want to 
place the files. 

Note When using the Advanced File Productivity method to get multiple files, Web 
Client gives you the choice of downloading individual files or downloading a 
ZIP. 

4. If you want multiple files in a single ZIP file, check Download the files in one ZIP file and enter a ZIP 
file name. 

Note If you did not select multiple files, the ZIP file option and name field do not 
appear in the Select Directory dialog. 

5. Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be prompted whether you want to open the file or files. 

Opening Attachment Files in their Native Applications 
To open an attachment file from a business object in Java Client: 

1. Display the Attachments tab of an object. 

2. Select the rows of the files that you want to open. 

3. Click the Open Files button . The files will open in their native application. 
y If you selected a row with a URL attachment, the URL is launched in a web browser. 
y If you selected a row with multiple files (indicated by a file folder icon in the row), the Select 

Files dialog opens. 

Select the files you want and click Finish. 

If a file’s native application is not on your machine, the Viewer will open and display the file. 

You can also select a file and click the View button ; in this case, the Viewer opens the files 
for viewing. 
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To open an attachment file from a business object in Web Client: 

1. Display the Attachments tab of an object. 

2. Click the Filename link. 

The file opens in its native application providing the following conditions are both true: 
y The file is not in a format that is listed as a valid Viewer file type. (Viewer valid file types 

are set by your Agile administrator.) 
y The native application installed on your computer. 

Note If the attachment is a URL, clicking the Filename link launches the URL in a 
web browser. 

 

Printing Attachment Files 
agile_homeYou must have the appropriate privileges to print an attachment file. If you have 
questions about your privileges, contact your Agile administrator. 

Note A “batch print” is simply printing the contents of a file folder that has multiple files. You still 
click the Print button and follow the sequence in Viewer. 

To print a file on the Attachments tab using the Viewer in Java Client: 

1. With the Attachments tab displayed, select one or more attachment rows to print. 

2. Click the Print button . 

You can also select a file and click the View button ; in this case you would start the viewer 
print functions manually. 

3. If the file type is supported by the Viewer, the viewer opens and begins the printing process. 
Follow the instructions in the displayed dialog boxes to complete the printing process. When 
the printing process is complete, the Viewer automatically closes. 

Note When you print from within the Viewer, watermarks and banners can appear in 
addition to the contents of the attached file. For more information, see About 
Banners and Watermarks on the Printed Image (on page 255). 

To print a file on the Attachments tab using the Viewer in Web Client: 

1. With the Attachments tab displayed, click the Print button  in the row you want. 

You can also click the Filename link to open the file in the Viewer. In this case you would start 
the viewer print functions manually. 

2. If the file type is supported by the Viewer, the viewer opens and begins the printing process. 
Follow the instructions in the displayed dialog boxes to complete the printing process. When 
the printing process is complete, the Viewer automatically closes. 

Otherwise, Web Client starts the file’s native application and opens the file so you can print it 
using that application’s printing commands. Choose the Print command for that application. 

Note When you print from within the Viewer, watermarks and banners can appear in addition to 
the contents of the attached file. For more information, see About Banners and 
Watermarks on the Printed Image (on page 255). 
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It is also possible to get a copy of the file, open it in its native application, and use the native 
application’s print functions to print the file. The native application must be installed on your 
computer before you can print the file. Follow the usual printing procedures according to the 
application’s documentation. 

About Banners and Watermarks on the Printed Image 

When printed through the Viewer, the printed image has a banner above and below the image. The 
banner has six fields: top left, top center, top right, bottom left, bottom center, and bottom right. 

The banner labels and contents for each object class are set by the Agile administrator. 

In addition, the Agile administrator can choose to include a printed watermark on the printed image. 

Accessing Different Versions of Attachments 
You can get, open, view, and print any version of an attachment file from the Attachments tab of the 
business object. 

You can easily access history without clicking through to the File Folder object. This is useful when 
a single file is being modified and accessed by multiple people/different functions. For instance, 
user can easily trace and identify which versions another user made their edits in - this is identified 
from version create date and checkout user. 

The Versions dialog displays, for each version, the Version Creation Date (date the version was 
created), whether that version has redlines (indicated by the Has Been Redlined  icon), and the 
Checkout User (user who created that version). This allows you to easily see the history of an 
attachment from the Attachments tab, including who modified the file, and when it was modified. 

To switch between versions of file folders from an object's Attachments tab in Java Client: 

1. On the Attachments tab, select one or more attachment row that you want to access. 

2. Click the Show Versions button . The Versions dialog appears. 

3. Select the version row or rows that you want to access. 

4. Click the appropriate action button (Get, Open, View, or Print). 

5. Optionally, click the Has Been Redlined  icon to open the viewer and display the redlines. 

To switch between versions of file folders from an object’s Attachments tab in Web Client: 

1. On the Attachments tab, click the Show Versions button  in the attachment row you want and 
the Versions dialog appears. 

2. In the version row that you want to access, click the appropriate action button (Get, View, or 
Print). 

 

Adding and Removing Files via the Attachments 
Tab 
This section includes the following topics: 

à Adding Attachment Files from your Local Disk or Network (on page 256) 
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à Add Files by Search Options (on page 259) 

à Adding a URL (on page 260) 

à Adding Files by using SaveAs to Create a New Business Object (on page 261) 

à Removing Attachments from the Attachments Tab (on page 261) 

à Editing the Attachments Table (on page 262) 
 

Adding Attachment Files from your Local Disk or Network 
When adding files to a business object Attachments tab, Agile provides a simple and easy-to-use file 
uploader. The File Uploader allows you to drag and drop the files you want from your desktop or 
from an open directory window to the file uploader window. The uploader also has a Browse button 
so you can find the files you want in that manner. 

Note For Web Client only: Depending on your company’s policies, your Agile administrator may 
set a systemwide preference that prevents the use of the Advanced File Uploader. In that 
case, Add >  File operations in Web Client are completed using the Add File dialog, as 
described in Using Web Client’s Standard Add File Dialog (on page 298). 

 

Using the Advanced File Uploader 

You can add as many files at one time as you like. There are two checkboxes; when checked, one 
will Unzip all zipped files upon upload, and the other will Add all files to a single File Folder. When you are 
ready, click Upload. 

When the upload is completed, depending on Agile PLM system settings, you may be prompted 
“Would you like to delete the uploaded files from your local disk?” which is useful if you have loaded 
a file onto your machine only to attach it to an Agile object. When you uploaded the file, Agile File 
Manager created a copy of the file that is always stored in the file vault. 

At any time before clicking Upload, you can Cancel the upload. Click Close to close the uploader 
dialog. 

To add attachment files using Advanced File Loader in both Java Client and Web Client: 

1. Click Add | Files. 

The blank File Uploader window is displayed. The instruction “Drag Files Here” appears in the 
window. 

2. Open a directory window (for example, Microsoft Explorer) and size the window so that you can 
see both the File Uploader window and the directory window on your screen. 

3. Navigate to the directory you want. 

4. Select the file you want and drag it to the File Uploader window and drop it. The file name 
appears in the File Uploader window. 
y If you drag and drop a folder, all the files in the folder are added to the list in the File 

Uploader. 
You can also click the Browse button in the Fy ile Uploader window and browse for the file 

Double-clicking on folder will open the folder's contents. 

you want. When using the browse function: 
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Single clicking on folder and then clicking Open will add all contents of that folder (files as 
well as contents of subfolders within that folder) 

5. Continue locating and dragging as many files as you want to want. You can open additional 
directory windows if you choose. 

Note To remove any file from the download dialogue box (for example, if you made a 
mistake and selected a file erroneously), simply click on the file and press the 
Delete key on your keyboard. 

6. When you have selected the files you want, if desired, click the Options button to make 
additional choices: 
y Type — select the file folder type (subclass) you want to create. 
y Unzip all zipped files upon upload — unzips ZIP files so that they are stored in their native 

format. 

If this option is unchecked, a ZIP file is stored in its ZIP format. 
y Add all files to a single File Folder — adds all the selected files to a single file folder. You may 

enter a Folder Description. 

If this option is unchecked, each file in the list is assigned its own unique file folder, one 
attachment file to one file folder. By default, Agile assigns attachments to the File Folder 
type (subclass). 

y Edit rows after adding — presents an edit dialog which allows you to edit the newly added 
attachment table rows. 

7. When you are done, click Upload. 

The files are added to the business object Attachment stab. The File Uploader window displays 
progress messages for each file as it is uploaded. 

Note Agile automatically creates a new file folder container for each of the uploaded 
files and sets the version of each file folder to 1. If you selected Add all files to a 
single File Folder, only one file folder container is created and the version is set 
to 1. 

8. When the files are uploaded, you are asked if you want to delete the uploaded file from your 
local disk. 
y Yes (default) — removes the copy of the file from the directory from which you selected it. 

This ensures that the correct version of the file is maintained in the Agile file vault and you 
do not have any out-of-date copies on your local disk. To view or update the file, use the 
Agile Attachments tab. 

Note The copy of the file on your local disk is removed; it is not moved to your 
desktop recycle bin. 

y 

à ce 

à Your company does allow Web Client use of the Advanced File Loader, however, your 

No — the copy of the file that you selected to add to the Attachments tab remains on your 
local disk. 

 

Adding Files in Web Client without Advanced File Loader 

If Advanced File Loader is not available to you in Web Client, there are two possible reasons: 

Due to your company's policies, your Agile administrator has set the system-wide preferen
such that Web Client users are not allowed to use the Advanced File Loader Java applet. 
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personal user profile preference attribute for File Productivity Preference is set to Standard. If 
this is the case, you can change your user profile preference to Advanced, which will allow you 
to use the Advanced File Loader. 

Note By default, your user profile is set to the Prompt preference. By responding to the prompt, 
you can select which file productivity method you prefer without editing your user profile. 
See the description of Prompt responses in Setting your File Productivity Preference (on 
page 297). 

 

Setting your File Productivity Preference 

To modify your File Productivity Preference: 

1. In Web Client, select Tools > My Settings to display the My Settings page. 

2. On the My Settings page, click User Profile. Your tabbed user profile appears. 

3. Click the Preferences tab. 

4. Click Edit. 
5. In the File Productivity Preference drop-down list, select one of the following: 
y Advanced — allows you to use the Advanced File Loader and other File Productivity 

components (providing the Agile system-wide preference is set to allow it). The next time 
you add a file or check in files on the Attachments tab, if it has not been previously installed, 
a Java applet will be installed. See Using the Advanced File Uploader (on page 295). 

Note File Productivity components include both Advanced File Loader and 
Automated Checkin. In Web Client, File Productivity also allows you to get 
(download) a multi-file attachment row as individual files instead of a ZIP file, 
and enables the opening of an attachment in its native application when you 
click its Filename link. 

y Standard — Web Client standard Add File dialog is used when you add a file or check in 
files on the Attachments tab. See Using Web Client’s Standard Add File Dialog (on page 
298). 

y Prompt — the next time you add a file to an Attachments tab, the Please Choose File Update 
Mode dialog is displayed to prompt you to choose whether to use the advanced 
productivity components (Advanced File Loader) or not. (By default, your File Productivity 
Preference is initially set to Prompt.) 
Your possible choices in the Please Choose File Update Mode dialog are as follows: 

Yes (and check Do not show this dialog box again) — if it has not been previously installed, a 
Java applet will be installed. The File Productivity Preference attribute in your user profile is 
set to Advanced. Every time you use Add > Files or check-in attachments on the Attachments 
tab, the Advanced File Loader is displayed. 

No (and check Do not show this dialog box again) — The File Productivity Preference attribute in 
your user profile is set to Standard. Every time you use Add > Files or check-in attachments 
on the Attachments tab, the standard Add Files dialog is displayed. 

Yes or No (and do not check Do not show this dialog box again) — The File Productivity 
Preference attribute in your user profile is remains set to Prompt. Every time you use 
Add > Files or check-in attachments on the Attachments tab, the Please Choose File Update 
Mode dialog is displayed and you can select the method you want to use. 

Once you respond to the prompts and you also check Do not show this dialog box again, your 
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preferred file productivity method will always be used. The Please Choose File Update 
Mode dialog will no longer appear and the File Productivity Preference attribute in your user 
profile is set as described above for the Yes or No choice. 

Note At any time, you can use the above process (beginning with step 1) to edit the 
File Productivity Preference attribute in your user profile to change your 
preference and select the file upload method you prefer. 

 

Using Web Client’s Standard Add File Dialog 

If you want to use the standard Add File dialog, make sure that the File Productivity Preference 
attribute in your user profile is set to Standard. See the Setting your File Productivity Preference 
(on page 297) for instructions. 

To use the standard Add File dialog: 

1. In Web Client, on the Attachments tab, click Add > Files. 

The Add File window appears with rows for up to five attachments. 

2. Use the Browse button to locate and select files to add. You can select electronic files on a local 
drive or on your network. 

3. Add descriptions for the files. You do not have to add a description now. You can add or edit a 
description at any time. 

4. If desired, check the optional checkboxes: 
y Unzip — unzips ZIP files so that they are stored in their native format. 

If this option is unchecked, a ZIP file is stored in its ZIP format. 
y Add All Files to a Single File Folder — adds all the selected files to a single file folder. You may 

enter a Folder Description. 

If this option is unchecked, each file in the list is assigned its own unique file folder, one 
attachment file to one file folder. 

5. Click Finish. The files are added to the Files tab and placed in the file server vault. 
 

Add Files by Search Options 
To reuse existing attachments and file folders, use the Add > By Search function. This option allows 
you to reuse existing attachments when needed. 

To Add attachments by search: 

1. Open the object to which you want to add an attachment, and click the Attachments tab. 

2. Select Add > By Search. The Add Files by Search dialog appears. 

Add > By Search (button or menu choice) opens a dialog with three Search tabs. 

This dialog allows you to search for any business object (for example, items or manufacturer 
parts) and select the attachments of those objects to add to the current object. 
y Search tab lets you create a simple search or an advanced search. You can check to 

search attachment contents, too. 
y Saved Searches tab opens to your navigation pane where you can browse in search folders, 

select a search, and run it. Again, returned results may be moved to the Selected Items 
table, and click OK. 

 Page - 259

  

 



Getting Started with Agile PLM User Guide  
 
 
 

y Shortcuts tab opens to your navigation pane where you can select objects from My 
Bookmarks or Recently Visited. The system displays shortcuts to only those objects that are 
appropriate to the operation you are performing. 

Note Only business objects with attached files appear in the search results table. For 
example, a business object that you viewed recently will not appear on the 
Recently Visited list of the Shortcuts tab if it has no attachments. 

3. When the results of your search are returned, select a row in the Results table, and the related 
files for that object appear in the Related Files table. 

4. In the Related Files table, select and move attachments to the Selected Files table. 
y If the object is an item, the Related Files table displays only the attachments on the latest 

Released Revision of the item (not pending or older revisions). 
y For any other (non-item) object, the Related Files table displays only attachments currently 

on that Attachments tab (not previously associated files). 

5. You can continue to run multiple searches or shortcuts until you are finished selecting the 
attachments you want. 

6. If you want to edit the attachment table rows after you add the attachments, check Edit rows 
after adding. 

7. Click OK. 

The current business object now references (or points to) the existing attachments and file folders 
you selected. 

Add by Search for Existing File Folder 

If you have the appropriate privileges, you can use the Add by Search feature described above and 
select File Folders as the object type for your search. 

To add by searching for existing file folders: 

1. Select File Folders as the object type. 

2. Use one of the available search methods: simple search, advanced search, saved search or 
shortcuts. 

3. In the results table, select the file folder you want. 

4. In the Related Files table, select the file folder version number you want to use. By default, the 
latest version is selected. 

5. Move your file selections to the Selected Files table. 

6. You can continue to run searches and select files to add by repeating the above steps. 

7. When you are finished, if desired, check Edit rows after adding, then Click OK. 
 

Adding a URL 
To add a URL to the Attachments tab in both Java Client and Web Client: 

1. Open the object to which you want to add a URL, and click the Attachments tab. 

2. Select Add > URL. The add URL dialog appears. 

3. Enter a URL and description. URLs must include the http syntax. 
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Note The URL field is prepopulated with the text string http:// to streamline this 
process. 

4. To verify that you have typed the correct URL, click Preview. A new browser window opens 
using the URL you have entered. 

If desired, check the option Add All URLs to a Single File Folder. You can enter a Folder 
Description. 

If you leave this option unchecked, a separate file folder will be created for each URL. 

5. Click OK. The URL is added to the Attachments tab. 

Note If a URL is added to a single file folder (there are no other files or URLs in that 
file folder) and the file folder version remains at Version 1, you can select the 
URL row on the Attachments tab, click Edit, then edit (modify) the URL. All the 
business objects that include the URL on their Attachments tab will display the 
newly edited URL. 

 

Adding Files by using SaveAs to Create a New Business 
Object 
When you use Save As to create a new business object (object B), if the object from which you are 
performing the Save As function (object A) has one or more attachments, an Agile system 
preference determines how object B’s attachments are created. 

If your Agile administrator has selected Prompt for this system preference, you will be prompted to 
choose between the following two options. If you are not prompted, the new object is automatically 
created using the specified system preference setting. 

à Create new copy of file(s) means that as object A is being replicated to create new object B, the 
system creates a new copy of the attachment file and also a new (referenced) file folder. Object 
A references FF-1, ver. 5, now version 5 of the file has been copied but, in new file folder FF-2 
referenced by object B, the file is at version 1. 

à Reference existing file(s) means that as the object is being replicated to create a new object, the 
system will use the existing file folder and create a new reference to it. In this case, object A 
references FF-1, ver. 5, and object B also references FF-1, ver. 5; the object was replicated but 
no file folder nor copy of attachment file was created. 

à Do not copy file(s) means that as object A is being replicated to create new object B, the system 
creates object B with no attachment files. Object B's attachment table is empty. 

à Prompt means that the system will always prompt the user who performs a Save As whether 
they want to create a new copy of the attachment, simply reference existing file and folder, or 
create the new object with no attachments. This prompt does not display if object A does not 
have an attachment. 

 

Removing Attachments from the Attachments Tab 
You can modify the Attachments tab by removing attachment table rows. 

Note Removing an attachment table row removes only the reference to the attached file’s file 
folder object. The file folder object and its contents are not deleted. 
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To remove attachments from the Attachments tab: 

1. Open the object and click the Attachments tab. 

2. Select the rows you want to remove. 

3. Click the Remove button. 

Note You cannot remove an incorporated item’s attachments. For more information about 
incorporated items and attachments, see About Item Revisions and File Folder Versions 
(on page 267). 

 

Editing the Attachments Table 
Select the rows you want and use the Edit button to edit the File Description and Version of the 
selected attached file as well as any other editable fields and custom fields that your administrator 
has defined. 

Note Your ability to use Attachments tab features is determined by your assigned roles and 
privileges. Contact your Agile administrator if you have questions about your Attachments 
tab privileges. 

The following attachment row fields can be edited as described below: 

Field  Edi t  method 

Filename If the selected row refers to a file folder that contains multiple files, you can use 
the drop-down list to select a different file. You can select All Files. 

File Description Edit the description for this version of the attached file. 
à File Description is Folder Version specific. For example, if you modify the File 

Description for version 3, the File Description for version 1 remains 
unchanged. Each attachment version can have a different File Description, if 
needed. 

à If the selected row refers to a file folder that contains multiple files and one 
specific file is selected in the Filename field, you can edit the File Description 
field. The File Description field on the file folder object Files tab is updated 
with the new file description. 

à If the select row refers to a file folder that contains multiple files and All Files 
is selected in the Filename field, the File Description field is editable 
depending on your roles and privileges pertaining to the referenced file 
folder. 

à If the selected version is incorporated to an item (which may not be the 
current business object that you are editing), the File Description field is not 
editable. 

Folder Description Edit the description of the file folder which contains the referenced file. 
à If the file folder is referenced by multiple business objects, you must have the 

appropriate modify privileges to edit this field. 
à If the file folder is referenced by multiple business objects and you have the 

appropriate privileges to modify this field, the new Folder Description appears 
on all the business object Attachments tabs that reference this file folder. 
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Field  Edi t  method 

Folder Version Select the attachment version (file folder version) you want. 
à If the selected row refers to a file folder that contains multiple files, if you 

select Latest-x as the version, the Filename field is automatically set to All 
Files. 

à You can select any version in the list. Note that if you select a non-latest 
version, you will not be able to checkout this attachment row. For more 
information about latest and non-latest versions, see What are 
Attachment Versions? (on page 243). 

Other editable fields Your Agile administrator may have defined other custom fields. If you have the 
appropriate privileges, you can modify these additional fields. Contact your Agile 
administrator if you have questions about your Attachments tab privileges 

To edit attachment table rows: 

1. Open the object and click the Attachments tab. 

2. Select the rows you want to edit. 

3. Click the Edit button. 

4. Make the modifications you want. 

5. Click OK (Java Client) or Save (Web Client). 
 

Revising Attachment Files 
When you need to update or revise the attached file, Agile PLM uses Check Out and Check In 
functions to ensure that only one user at a time can revise the file. 

This section includes the topics: 

à Checking Out Attachment Files (on page 264) 

à Checking In Revised Attachment Files (on page 265) 

à Canceling Checkouts (on page 266) 

à Checksum File Validation (on page 266) 

Using the examples of Bob and Carl, engineers, and Doris, the document control manager (see 
Attachment Files and Agile File Folders: an Analogy to Papers, Desks, and Vaults (on page 241)), 
the following story illustrates the concepts of the Check Out and Check In features. 

Doris keeps all the company’s documents locked in a document vault. Each document is filed in a 
labeled file folder. When Bob or Carl need a copy of a document, Doris makes a copy and gives it to 
them (see Getting Attachment Files (on page 251).) 

However, when Carl wants to revise a document, Doris gives him a copy of the latest version, and 
she marks the file folder as Checked Out. When a file folder is checked out, Doris does not allow any 
other person to update the drawings in that file folder, although anyone can still request a copy of 
the drawings. 

When Carl brings Doris the updated drawing, she puts it in the file folder, records the new version 
number on the file folder and marks the file folder as Checked In. 
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In Agile PLM, Check Out and Check In features provide the following safeguards: 

à When an attachment is Checked In, no one is allowed to revise the attachment. The attachment 
file is locked in the vault, however, any user with the appropriate privileges can check it out. 
The attachment is locked for all users. 

à When an attachment is Checked Out only the checkout user can revise the attachment. The 
attachment file remains locked in the vault, and it is not available for checkout by any other 
user. The attachment is unlocked for revision only by the checkout user. 

 

Checking Out Attachment Files 
Note To checkout an attachment file on a business object Attachments tab, the Folder Version 

for that row must specify the latest revision, either the latest revision number (for example, 
3) or the dynamic Latest-x revision (for example, Latest-3). If the Folder Version is a non-
latest version, the Check Out feature is not available. For more information see What are 
Attachment Versions? (on page 243). 

Note Checkout is disabled for URL attachments. 

To check out an attachment row of an object for revision, Java Client: 

1. Display the Attachments tab of the object. 

2. Select one or more attachment rows. 

3. Click the Check Out button.  

If you have selected a row that cannot be checked out, an error message is displayed telling 
you which rows cannot be checked out and why (for example, non-latest version or already 
checked out). 

4. If you have selected an attachment row that includes multiple files (a folder icon appears in the 
Filename field), the Select Files dialog appears. By default, all files are selected. Select the files 
you want, and click OK. 

5. The Select directory dialog appears. Navigate to the directory where you want to save copies of 
the checked out files. 

To save the files in a ZIP file, check Download the files in one ZIP file and enter a ZIP file name. 

The checkout location is recorded on the Attachments tab Checkout Location field; it is also 
logged on the History tab. 

6. Click OK. 

7. The Open Files dialog appears. If you want to open the checked out files, click Yes. 

To check out an attachment row of an object for revision, Web Client: 

1. Display the Attachments tab of the object. 

2. In the row you want to checkout, click the Check Out button . 

If a Check Out button does not appear in that row, the row cannot be checked out (for example, 
non-latest version). 

3. In the Save As dialog, navigate to the directory where you want to save copies of the checked 
out files. 
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Click . 

In Web Client, if you are not using the Advanced Productivity Tools, the

Save

Note  
Checkout Location field is not populated. See also Checking In Revised 
Attachment Files (on page 265). 

 

Checking In Revised Attachment Files 
When you check in attachment files, Agile PLM verifies that the file has been modified. 

The check in process retrieves the revised file from the Checkout Location recorded on the 
Attachments tab, and replaces the checked out version of the file. The Folder Version is advanced b
1. For example, If you checked out version 6, when you checkin, the version will be 7. Note that 
version 6 is still stored in the Agile file vault. If you wish to view it, us

y 

e the Show Versions feature 
(see Accessing Different Versions of Attachments (on page 255)). 

If the revised file has been moved from the checkout location, or you have changed its name, you 

heckin process is finished, you are prompted to delete the checked-in files from your 

ck in. 

are prompted to browse for the replacement file. 

When the c
local disk. 

To check in attachment files, Java Client: 

1. Select the checked out rows that you want to che

2. Click the Check In button.  

Agile PLM automatically checks in the revised file3. s from the Checkout Location recorded on the 

4. eckout Location where they 
orig

Note heck In Files 

Attachments tab when the files were checked out. 

If any of the revised replacement files are not in the recorded Ch
were inally checked out, the Check In Files dialog appears. 

If you have moved the checked out file or changed its name, the C
dialog appears so you can specify the check in replacement files. 

Use the Browse button to locate each replacement file. 

6. cked-

on. 
cked-in files in the checkout location. 

5. When you are done, click OK. 

When the check in process is complete, you are asked if you would like to delete the che
in files from your local disk. The default response is Yes. 
y Click Yes to delete the copy of the checked-in files from the checkout locati
y Click No to leave the copy of the che

To check in attachment files, Web Client: 

1. In the row you want to check in, click the Check In button.  

2. ing on your File Productivity Preferences. 

y ty 
m 

y orded Checkout Location where 

The checkin process differs depend

Advanced File Productivity Preference: 
If your Agile system is set to use File Productivity tools and your user profile File Productivi
Preference is set to Advanced, then Agile PLM automatically checks in the revised files fro
the Checkout Location recorded on the Attachments tab when the files were checked out. 
If any of the revised replacement files are not in the rec
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they were originally checked out, the Check In Files dialog appears. 

rowse button to locate each replacement file. Use the B

e checked out file or changed its name, the Check In Files Note If you have moved th
dialog appears so you can specify the check in replacement files. 

Stan tivity Preference: 
y 

revised fi

tion about File Productivity tools see Using the Advanced File 

dard File Produc
If you not using File Productivity tools, then you are prompted to browse to locate the 

les. 

Note For more informa
Uploader (on page 295). 

3. 

4. cked-

 of the checked-in files from the checkout location. 
cked-in files in the checkout location. 

ing Checkouts 

ent files remain in the checkout location you 
Attachments tab. 

ublic versions of the 
ult). 

ct. 

ut. 

When you are done, click OK. 

When the check in process is complete, you are asked if you would like to dele
in files from your local disk. The default response is Yes. 

te the che

y Click Yes to delete the copy
y Click No to leave the copy of the che

 

Cancel
When you wish to discard edits to attachment files that you checked out, you can cancel the 
checkout. 

A checkout can be canceled only by the user who checked out the attachment, or by a user with 
necessary privileges. If you have questions about your privileges, contact your Agile administrator. 

When you cancel a checkout, copies of the attachm
selected, but the original files are once more available to be checked out from the 
Any edits you make to the remaining copies of the files do not appear in the p
file (the versions of the file stored in the file va

To cancel a checkout from an object’s Attachments tab in Java Client: 

1. Display the Attachments tab of an je ob

2. Select the checked-out row or rows for which you want to cancel the checko

3. Click the Cancel Checkout button . 

To cancel a checkout from an object’s Attachments tab in Web Client: 

1. Display the Attachments tab on an object page. 

2. Locate the checked-out row for which 

3. Click the Cancel Check Out button 

you want to cancel the checkout. 

 in the row for which you want to cancel the checkout. 

tion reveals when a file in the file server vault has 

 

Checksum File Validation 
To enhance the security of file access and to inform the end-user or administrator of any illegal 
modification or corruption of a file, the Agile system performs file validation on attachment files with 
a utility called Handle File Checksum. The valida
been modified directly, that is, bypassing the Agile system. So when you try to view, get, check out, 
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check in, or add a file that has been im operly modified, an error message appears and access to 
the file is prevented until the error is resolved. 

In both Java and Web Clients, the Attachments tab of business objects and the Files tab of file folder
have a field called Has Checksum Error. 

pr

s 
  When a file on an attachment row has a checksum error, 

the Has Checksum Error field displays the same symbol. (If the administrator has disabled the 
. If 
gile 

; however, the system sends notification to the 

Checksum Computation systemwide preference, however, this field will not display any errors
you suspect there are security problems with files and this field is never populated, see your A
administrator.) 

You can resolve a checksum error only if you have been assigned the Reset File Checksum 
privilege mask. If you click the Checksum icon that appears on an attachment row and get a 
warning, you cannot resolve the problem
administrator and other designated users. The History tab of the file folder (with the offending 
attachment file) identifies u ers who have been notified, either during the validation process or 
during the “handle checksum” process. 

Assuming you have been assigned the Reset File Checksum privilege (along with appropriate file 
folder privileges), clicking 

s

 in the row of the offending file brings up a dialog that offers several 
or 

s well as other background information about the Introductory 
ard to items, and pending 
out items, revisions, and 

for Agile PLM 

ean in Agile PLM: 

an attachment file’s state as it is attached to an 
ion was the only use in Agile 8.5 and earlier. With the 
 primarily refers to how a file folder changes through 

cement. 

e
To v  dif

1. If you wa anufacturing site, select that site from 

options to resolve the problem. Because this privilege is usually assigned to Agile administrators 
user administrators, more information about resolving checksum errors is found in Agile PLM 
Administrator Guide. See “Administering Attachments and Files.” 

About Item Revisions and File Folder Versions 
This section distinguishes revisions to items (or other business objects) and versions of file folders 
(referencing attachment files), a
revision, the “Rev” list on items, change orders (ECO, MCO, SCO) in reg
revisions. See Product Collaboration User Guide for more information ab
the change control process. 

Revision and Version Defined 
The words “revision” and “version” can be similar or synonymous in a variety of manufacturing 
contexts; here is what they m

Revision — an item’s state at a point in time; also, a BOM’s structure at a point in time. Revisions 
are advanced in the change control process. (Items and change control are documented in Product 
Collaboration User Guide.) 

Version — A file folder’s state at a point in time; also, 
item or other business object. This latter definit
introduction of file folders in Agile PLM, version
file addition, deletion, and repla

Vi wing a Different Revision 
iew a ferent revision: 

nt to see a revision that pertains to a specific m
the Site drop-down list. 
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Note When you select ALL from the Site drop-down list, the default value in the Rev 
list is the latest released change for that item. 

2. Select a revision from the Rev drop-down list above the tabs. When you select a revision, the 
spon

When yo n. 
For exampl sion C to revision B, the other 

ecific; for example, the Where Used tab and the 

corre ding effectivity date is displayed. 

u select a different revision, all the tabs display information from the selected revisio
e, if the BOM tab is displayed, and you switch from revi

tabs also show revision B. 

Note Not all tabs are revision-sp
History tab are not revision-specific. When you view tabs that are not revision-
specific, the Rev drop-down list is disabled. 

 

Introductory Revisions 
The initial revision of an item—that is, the revision of a newly created, unreleased item—is called 
Introductory. Introductory revisions have no changes against them, the only rev on the list that is not 
associated with a change. It is never assigned a revision letter, for when an item is in the 
Introductory stage, it is not under change control and can therefore be modified directly. 

s 

p-down list because it is the earliest revision. The 
all the attributes seen on every tab of the object 

(including Attachments tab). Even after pending revisions and released revisions are created, the 
nges 

revi

g 
emember, an item can be revised only by an ECO.) For example, for a part, if ECO 

E54 e release of revision C, then revision C in the Rev drop-down list reads 

dicates that the revision is pending, not yet 

hese are referred to as blank revisions. 

Introductory revisions are treated the same as released revisions; they are considered to be the 
base revision by Where-used and Object searches, the Where Used tab, changes, and the Save A
feature. All revision-specific rules that apply to ECO-created revisions also apply to the Introductory 
revision of an item. 

Introductory appears at the bottom of the Rev dro
user can select the Introductory rev and control 

Introductory rev remains a “baseline” with a single record of data about the item before any cha
took effect. 

How the Revision List Works 
As stated above, a revision labeled Introductory in the Rev list indicates the initial revision of the 
object, with no pending changes. Once the object is listed on a change, a letter sequence of 

sions is started. 

For released revisions, the number of the releasing ECO is displayed next to its correspondin
revision. (R

321 resulted in th
 C   E54321 

A revision number or letter inside parentheses in
released: 

(A)  C00004 

You may see revisions in the list that are not Introductory and that do not have an assigned revision 
letter. T

Blank revisions occur when an MCO is released against an item before an ECO releases the item. 
That releasing MCO creates a blank revision, as do any subsequent changes that occur before a 
new ECO revision is created. The Rev list displays the number of the MCO instead of a revision 
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letter: 
     M00001 

MCOs and SCOs are based on item revisions, but neither can create a new revision of a part, and, 
therefore, neither has attachment capabilities. MCO and SCO modifications, which you can select in 

O-created revision or the Introductory 

t. 
ev drop-down 

 site access. However, when 
Rev

rent site 
fro own list, the default revisio  from your default site. 

of Rev L

owing list o sed 
e second n.  

the Rev drop-down list, inherit the attachments of the EC
revision upon which they are based. 

The MCO or SCO number is displayed next to the corresponding revision on the Rev drop-down lis
For example, if there is a pending MCO M12345 against Rev B of a part, then on the R
list, that revision is listed as “(B) M12345.” 

How Rev and Site Lists are Determined 

All revisions are shown to all users regardless of their default site or
you open an item, the  drop-down list is set to the last change for your default site. 

An item’s default revision shown is based on your default site. Even if you select a diffe
m the Site drop-d n still reflects what you see

Samples ists with ECO, MCO, and SCO 

Given the foll f revisions on the Rev drop-down  list of an item that was initially relea
as an ECO, th  column describes the attachment capability of each revisio

Rev l is t  ent ry  At tachment  capabi l i t ies  

(c) ECO -356 Yes, has attachment capabilities, because it is a pending ECO-created Rev. 

B     SCO-444 No attachment capabilities; it is based on Rev B and inherits Rev B’s attachments. 

B     ECO-233 Rev. Yes, has attachment capabilities, because it is an ECO-created 

A     MCO-888 No attachment capabilities; it is based on Rev A and inherits Rev A’s attachments. 

A Yes, has attachment capa ed Rev.     ECO-222 bilities, because it is an ECO-creat

INTRODUCTORY ory 
 the same features as an ECO-created revision. 

Yes, has attachment capabilities, because it is an introductory revision. Introduct
revisions have

In the case of an item initially released by an MCO to create a blank revision: 

Rev l is t  ent ry  At tachment  capabi l i t ies  

(B)  MCO-934 No attachment capabilities; pending MCO based on Rev B and inherits Rev B’s 
attachments. 

B     ECO-572 Has attachment capabilities, because it is an ECO-created Rev. 

A     SCO-444 d on Rev A and inherits Rev A’s attachments. No attachment capabilities; it is base

A     MCO-788 No attachment capabilities; it is based on Rev A and inherits Rev A’s attachments. 

A     ECO-333  Has attachment capabilities, because it is an ECO-created Rev.

       MCO-766 No attachment capabilities; it is based on the Introductory revision and inherits the 
ments. Introductory revision’s attach

 Page - 269

  

 



Getting Started with Agile PLM User Guide  
 
 
 

INTRODUCTORY Has attachment capabilities, because it is an introductory revision. Introductory 
revisions have the same features as an ECO-created revision. 

 
 

CO 
 

 released revision of the item. If there is an 
Affected Items

n 
CO-2 pending 

By default, when a pe nherits whatever files are attached to the current 
, 

 to either allow or disallow attachments to be copied to a new 
pending revision. 

atta e Agile PLM system to either 

e te a pending revision 
of an item. Depen

à new 

à s new 
pen

à 

nts 

Working with Pending Revisions 

You can create a pending revision of an item. When you create an ECO against an item, the E
creates a pending revision of that item. Pending revisions let you incorporate  (lock) attached files
into the item. When the preliminary ECO affecting the item is released, the attached files stay with 
the new revision of the item and are incorporated (unless your Agile administrator has opted to alter 
this behavior). 

A pending revision is identified by parentheses around the revision number in the Rev field, for 
example, (A). 

The pending revision is always based on the latest
existing pending revision —the item is already on the  tab of an unreleased change 
order—and you choose to add the item anyway, the pending revision associated with your change 
order is based on the latest released revision, not the existing pending revision. So, if ECO-1 has a
existing pending rev on Part 123, and ECO2 is created by SaveAs of ECO-1, then E
rev does not reflect any ECO-1 pending rev BOM redlines, manufacturer redlines, attachment 
redlines, or attachment additions/deletions made to ECO-1 pending rev. 

Attachments on Pending Revisions 

nding revision is created, it i
default revision. If any files are then either added to or removed from the current default revision
those modifications are not reflected on the Attachments tab of the pending revision. 

The administrator sets your system

Effects of CopyFilesToRev SmartRule 
The CopyFilesToRev (Copy Files to Rev) SmartRule setting determines how pending revision item 

chments are created or referenced. The Agile administrator sets th
copy, copy with warning, reference, reference with warning or disallow the list of attachments to be 
copied to a new pending revision. 

Wh n you add an item to the Affected Items table of a pending ECO, you crea
ding on the Agile PLM Copy Files to Rev SmartRule setting, pending revision 

attachments are processed as followed: 

Copy - For the item's new pending revision, Agile creates a new file folder and creates a 
copy of the attachment file, which is placed in the new file folder. 

Reference - Agile uses the existing file folder and creates a new reference to it on the item'
ding revision Attachments tab. 

Disallow - The new item pending revision is created with no attachments. 

à Copy with Warning - The same as the Copy setting, with the option of choosing no attachme
for the new pending revision. 
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When you add items to the pending ECO, you are presented with a warning dialog that 

y  attachments, check both the Add checkbox and the 

r the new pending revision. 

ttac
pending r

For exam t Part 456, Rev C (thus creating a pending Rev D), all the 
nt files that are attached to Rev C are also attached to pending Rev D. (The file and file 

 duplicated on the Attachments tab of 
tachments tab of Rev C, or any other 

d 

includes a row for each item you are adding.  
To add the item and to copy the
Attachments checkbox.  

y To add the item with no attachments, check only the Add checkbox. 

à Reference with Warning - The same as the Reference setting, with the option of choosing no 
attachments fo

When you add items to the pending ECO, you are presented with a warning dialog that 
includes a row for each item you are adding.  
y To add the item and to reference the existing attachments, check both the Add checkbox 

and the Attachments checkbox.  
y To add the item with no attachments, check only the Add checkbox. 

When this SmartRule is set to Reference or Reference with Warning, if there are multiple versions of 
any a hment file, only the reference to the latest version is used for the new reference on the 

evision. 

ple, if you create an ECO agains
attachme
folder references on the Attachments tab of released Rev C are
pending Rev D.) Any attachment files that are added to the At
Rev C Attachments tab modifications (for example, modifying the file folder version numbers) after 
the creation of the ECO are not copied to pending Rev D. 

Note Attachment files that are added to the Introductory revision after the object is associate
with a change (that will result in released Rev A) will not be copied to subsequent revs. 
This SmartRule does not affect MCO or SCO revisions because MCOs and SCOs do not 
create separate new revisions.  

 

Availability of 
Certai tions. If operations are disabled, check for the 

à 
n you may 

à 

Attachment Operations 
n situations affect access to attachment opera

following: 

Are you looking at the desired version of the attachment? Always check the number in the 
Version column to ensure you are looking at the latest version, or other specific versio
want to revise. 

Are you viewing an item MCO revision? Attachment operations are not available on MCO 
revisions. 

For more information about item revisions and attachment capabilities, see Samples of Rev 
Lists with ECO, MCO, and SCO (on page 269). 

Have you been granted sufficient privileges? Check with your Agile administrator. You may be
granted certain privileges for some files but not for others. 

Is the item released? Your privileges may allow you to modify the attachments of an 
unreleased item, however, you may not have sufficient privileges to modify the attachments of
a released item. Check with your Agile administrator. 

à  

à 
 

à Is the item revision incorporated? You cannot modify the attachments of an incorporated 
revision. 
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More specifically, once an item revision is incorporated, that revision’s attachments cannot be 
the item, 
r, you 

to 
d 
 

evision is incorporated; while modifications to the file folder will bring about a new 
ber upon checkin. 

ee 

checked out from the item Attachments tab. (If you select an unincorporated revision of 
including pending revisions, you can check out from the item Attachments tab.) Howeve
can still check out or check in the associated attachment files in the file folder. Modifications 
the file folder (adding, removing, or editing the attachment file) will not affect the incorporate
item revision’s attachment, since the version of folder (holding the attachment) is fixed when
the item’s r
version num

For more information about items, incorporation, and changes (for example, ECOs and MCOs), s
the Product Collaboration User Guide. 

See also: Adding Files by using SaveAs to Create a New Business Object (on page 261). 

Attachment Files in the 

s, you can view attach r, redline them, and print 
ner and watermark information. 

iewer, see Viewer Supplement. 

v er, starting from Java Client: 

1. 

2. Sele

3. 

Viewing and Redlining 
Viewer 
With appropriate privilege ment files in the Viewe
them with datestamps, timestamps, and other ban

For more information about working with the V

To iew a file using the View

Display the Attachments tab of the object. 

ct one or more rows in the files or attachments table. 

Click the View button . The attachment file opens in Viewer. 

 a file using the Viewer in Web Client: 

lay the Attachments tab of 

To view

1. Disp

2. Clic

Whe
le 

ith Viewer, the attachment 
puter, provided you are 

using Advanced File Productivity tools. For more information, see Using the Advanced File 

the object. 

k the name of a file. 

n you click the filename link, the results are as follows: 
y If the file folder holds a single file, and the file is viewable with Viewer, the attachment fi

opens in the viewer. 
y If the file folder holds a single file, and the file is not viewable w

file opens in the native application, if it is installed on your com

Uploader (on page 256). 
y If the file folder holds multiple files, and at least one of the files is viewable with Viewer, the 

viewable file opens in the viewer. If multiple files are viewable, they are all opened in o
Viewer window; use Viewer menu selection View | 

ne 
Multicontent to select another file to view. 

Get button 
y If the file folder holds multiple files, and none of the files are viewable with Viewer, the 

filename is not a link. Click the  to get a copy of the file. 
 

 in the Viewer 
With the Viewer, you can add redline layers or “markup files” to attachment files that are referenced 
by Agile items. To redline or mark up attachment files associated with an item, that item must be on 

Redlining or Marking Up Files
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the b, open the 

Note

Affected Items tab of an ECO. From the ECO, you click the Redline Attachments ta
attachment files, and mark up or redline using the Viewer. 

 For more information about ECO redlining and ad hoc file folder redlining, see Viewer 
Supplement. 

Attachment files can be redlined in two ways: 

r routable objects to redline à Use an engineering change order (ECO). You cannot use the othe
files. 

See Marking Up or Redlining Attachment Files from an ECO (on page 273). 

“Ad hoc redlining” can be done from the Files tab of a file folder that holds the object. à 

tachment Files from the File Folder.See Ad Hoc Redlining or Marking Up of At  (see "Ad Hoc 
s from the File Folder" on page 306) 

Atta

à 

à ferenced by parts and documents can be ECO-redlined. 

ves the redlines 
e their redlines, they 

or a  
are s  
the a
file fo
the file folder object. 

 

ion attachment Folder 

Redlining or Marking Up of Attachment File

chment-file redlines follow these rules: 

You must have appropriate privileges to redline attachment files. 

Only the file folders re

à Multiple users may redline a file at the same time. If that happens, Agile sa
from the first user and closes the file. When the other users attempt to sav
see a warning message and can save the redlines to a different location. 

à Each user can redline in a different color. 

à F  specific file, for example, FILEA.txt, ECO-created redlines and ad hoc file folder redlines
eparate from each other. To view ECO-created redlines, you must open the ECO object or
ffected item object; ad hoc file folder redlines are not visible via the ECO. To view ad hoc 
lder redlines, you must open the file folder object; ECO-created redlines are not visible via 

 

Marking Up or Redlining Attachment Files from an ECO 

One method to mark up or redline an attachment file is to create a change order for an item with an
attachment, and approach the attachment via the Redline Folders tab of the change. 

Note When redlining an attachment through an ECO, the pending revis
Version must be set to a specific version number; if the Folder Version is set to LATEST-x, 
you will not be able to create redline markups. However, you can edit the Folder Version 
on the Attachments tab of the pending revision so that it refers to a specific Folder Version. 

For example, if the pending revision of the item refers to Folder Version LATEST-7 of the fi
select that row on the Attachments tab, click the Edit 

le folder, 
 button and use the Folder Version drop-down 

 select 7. Click OK to complete the edit process. You will now be able to 
a

1. with an attachment to the Affected Items tab of an 
ease ECO. 

2. Select the m on the Affected Items tab of the ECO. 

list in the Edit dialog box to
cre te redline markups for that attachment.Select the added item on the Affected Items tab of the 
ECO. 

To mark up or redline an attachment file from an ECO in Java Client: 

If you have not already done so, add an item 
unrel d ECO. The item now has a pending revision associated with the unreleased 

 added ite
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3. On the Redline Attachments tab, select the row containing the file you want to redline. 

5. 

6.  tools described in the viewer online Help to redline the attachment. To view online 

ng revision of 

4. Click the View button. 

When the Viewer appears, click the Markup button. (This button is available only when markups 
are allowed.) 

Use the
Help, choose Help > Content in the menu bar. 

Note ECO marku  are aved against and associated with the pendips  s
the item. 

To m

n 
g revision associated with the unreleased ECO. 

2. On e Af

ark up or redline an attachment file from an ECO in Web Client: 

1. If you have not already done so, add an item with an attachment to the Affected Items tab of a
unreleased ECO. The item now has a pendin

th fected Items tab, click the Do Redlines button  next to the item to open the Redlines 
page. 

3. If the item has already been redlined, the Has Redlines button  will be displayed in the sam
column. Click either 

e 
 or  to access the redlines page. 

4. On the Redline Folders tab, click the Do Redlines button (or Has Redlines button) on the row of the 
file you want to redline. (This button is available only when markups are allowed.) 

5. Use the tools described in the viewer online Help to redline the attachment. To view online 
Help, choose Help > Content in the menu bar. 

Note ECO markups are saved against and associated with the pending revision of 
the item. 

For information about redlining 3D files from a change order, and about viewing change order 
redlines on the Pending revision of the item’s Attachments tab, please see Viewer Supplement. 

Configuring File Associations for Opening Files in Web Client 
Whe b Client, you can open atta rowser. This feature works 

r which you have the co installed, and when the file 
 up for your browser between e formats. Web Client relies 
association ich are set up , to open the appropriate 

ith which to ope

 administrator ca lp you determ at associations that need to be set 
our system to handle ats you ith. 

 examples of common file formats and th wn in the following table: 

n you are using We
for those file formats fo

chment files in your b
rresponding applications 

association is set
on the file format 

those applications and fil
 in your operating systems, wh

application w n a file. 

Your system n he ine the file form
up in y the file form  are working w

Some eir associations are sho

Fi le  format  F i le  extension   Appl icat ion of ten  associated  

Microsoft Word document DOC Microsoft Word for Windows 

Microsoft Excel file XLS Microsoft Excel for Windows 

JPEG graphic JPEG, JPG Default browser 

GIF graphic GIF Default browser 
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Fi le  format  F i le  extension   Appl icat ion of ten  associated  

HTML HTML, HTM Default browser 

PDF PDF Adobe Acrobat Reader 

For UNIX users, Web Client attempts to display the f
win ow. The file types that can be displayed depend

 ile within a new instance of the browser 
d  on a number of factors, including the UNIX 

alled. If you have questions, 
see you

ng the Get button), and view it in the file’s 
o

cess URLs 

à 

à 

ds:  

cess URLs

vendor and the version of Netscape Communicator that has been inst
r system administrator for assistance. 

If you cannot view the file, you can get a copy instead (usi
ass ciated application. 

Generating Attachment Quick Ac
Attachment URLs allow you to do the following: 

Generate a URL for an attachment on item objects. 

Generate a URL for a file on file folder objects. 

à Generate a URL for a file on the Content tab of Program objects. 

à Paste URLs from Agile to another application 

à Externally open files outside of the Agile application. 

You can generate attachment URLs from Items, Activities, and File Folders by two metho

à Using Agile PLM commands to copy a URL to your clipboard: 

Agile-Generated Attachment Quick Ac  (on page 275) 

URLs Formats

à Manually typing an Attachment Smart URL in an easy-to-understand format: 

User-Generated Attachment Quick Access Smart  ("User-Generated Attachment 

The URL format enable bject and files are being referenced. Because of the 
to-u

without logging into the Agile system, if you know where the files are located. 

Agile-Generated Attachment Quick Access URLs 

ile Folders by clicking Get Shortcut after 

hat points 
r corresponding to the file on that row. 

s to 

You must have Read privileges for an object in order to generate a URL for the object. 

Quick Access Smart URL Formats" on page 276) 

s you to identify which o
easy- nderstand format, you can generate your own URLs to point to specific file attachments 

From Web Client, you can only generate Attachment Quick Access URLs from the Attachments tab 
of any object, the Content tab of Activities, and Files tab F
performing one of the following scenarios: 

à Selecting only one row from the Attachments, Content, or Files tab to generate a URL t
to the folde

à Selecting all the rows on the Attachments, Content, or Files tab to generate a URL that point
the collection of files on the tab. 

Note 
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Caution If you select more than one row on the Attachments, Content, or Files tab, the Get Shortcut 

 
o

wn URLs to point to 
ere the files are 

located.  

The form to 
three mai

Item

link is disabled. 

The URL is copied to your clip board. You can then paste it into another application or file, such as
a w rd processing file, a spreadsheet file, or an email. 

User-Generated Attachment Quick Access Smart URL 
ts Forma

With the easy-to-understand Smart URL format, you can generate your o
specific file attachments without logging into the Agile system, if you know wh

ats of user-generated attachment Smart URLs depend on the object type, and fall in
n categories: 

à  Attachment Quick Access URL Formats ("Item Attachment Quick Access Smart U
ats" on page 276) 

lders Qui

RL 
Form

à File Fo ck Access URL Formats ("File Folders Quick Access Smart URL Formats" on 
e 278) 

à Program Content Quick Access URL For

pag

mats ("Program Content Quick Access Smart URL 
Forma  page 279) 

 

Item Attachment Quick Access Smart URL Formats 

You can generate Smart URLs for item
tp://<server jec
umber>[/Revi ber
<FileAction

http://<server
tNumber>[/Revision/ChangeNumber]/files/<FileName>[/<FileAct

] 

where 

ts" on

 attachments in the following format: 
ht
tN

:port>/<VirtualPath>/link/<ObjectType>/<Ob
sion/ChangeNumber]/files/Folder/<FolderNum

>[/ >] 

or 
:port>/<VirtualPath>/link/<ObjectType>/<Objec

ion>

Server  
Port  

 Path  

Ident i f ies the  Agi le  instance 

Vi r tua l

link The text "link" identifies the URL as a special attachment URL to the Agile 
server. 

ObjectType Refers to the subclass of the Item, File Folder, or Program/Activity. 

ObjectNumber Refers to the actual object number for the object type. 

Revision Identifies an item revision by specifying the change number corresponding to 
that revision. 
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ChangeNumber 
 the number is not 

tory 

Identifies a unique revision (Released or Pending) of the item. If the number 
is not specified, the latest released revision is attached. If
specified and the item does not have a released change, the Introduc
revision is attached. 

Folder Indicates that the object is a file folder, not the actual file. 

FolderNumber w. The version of the file Identifies the file folder related to the selected ro
retrieved is the most current version, based on the specific revision of the 
item.  

FileName Refers to the name of the specific file attached to the specified revision of the 
item. 

FileAction Determines the action performed with the retrieved files. Values are G
VIEW. If FileAction is not specified, a GET is performed. 

ET or 

retrieved in its native format.  If the parameters specified in the URL point to 
If the parameters specified in the URL point to a single file, the file is 

a collection of files, then all the files are returned as a zipped file called 
"Download.zip".  

If th n of an item has multiple files contained in the same folder on the Attachments e specific revisio
tab, but is referenced from different versions of the folder, then a Folder-based URL may not reflect 
the actual set of attachments from the item revision’s Attachments tab. 

Examples of user-generated URLs for item attachments: 

à http://myappserver/mycompany/Link/Document/DOC0001/files/Folder/Folder001 

Returns a zipped file containing all files from Folder001 that are attached to the latest released 
revisions of DOC0001. 

http://myappserver/mycompany/Link/Document/DOC0001/files/Folder/Folder001/VIEWà  

Opens all files from FOLDER001 that are attached to the latest released revision of DOC0001 
in th

 

Lim

The etrieving the attached files of item objects: 

à In th ents tab that 
belo er, a folder-

's Attachments tab. 

model.dwg and P0001_specs.pdf, both in Folder1. Assume that the DWG file is from 

lPath>/link/Part/P0001/Revision/C0001/files/Folder/Folder1

e Viewer. 

itations for Item Object Attachment Quick Access Smart URLs 

 following limitations apply to r

e case where a specific revision of an item has multiple files on its Attachm
ng to the same folder, but are referenced from different versions of the fold

based URL may not reflect the true set of attachments from that item+revision
For example, consider an item P0001, whose revision A has two attachments: 
P0001_3d
version 2 of the file  folder, and the PDF  file is from version 5 of the file folder. In this case, the 
following URL: 

http://server:port/<Virtua

returns all the files contained in either version 5 or version 2 (results are not predictable) of 
Fold

How

er1.  

ever, the following URL: 

http://server:port/<VirtualPath>/link/Part/P0001/Revision/C0001/files/ALL

returns the complete set of files belonging to revision A of the item, including 

 Page - 277

  

 



Getting Started with Agile PLM User Guide  
 
 
 

P0001_3dmodel.dwg from version 2 of Folder1 and P0001_specs.pdf from version 5 of 
Folder1. 

You cannot generate an item-based URL that will return a file from a historical version of a file 
folder referenced on an item

à 
's attachments tab. The user can, however, generate a folder-

à 

Number]/files/

based URL to achieve this. 

In case of the following format example, 

http://server:port/<VirtualPath>/link/ObjectType/ObjectNumber[/Rev/Change
FileName[/FileAction] 

If two files of the same name (filename + file extension) exist on t
user gen

he attachments table, and a 

optio ple files 
by the same ll the files of a 

 folder where there are more than one file with the same name, an error is displayed 
indicating that there are multiple files  a valid zip archive of 
fi ot be generated.  

à If the ALL option is used to access files from a Program's Content tab where multiple files with 
e exist, an error is displayed indicating that there are multiple files by the same 

name and therefo

olders Qu

enerate Sm
http://<server:port>/<VirtualPath>/link/<ObjectType>/<Objec
tNumber>/files/<FileName>[/</version][/<FileAction>] 

where 

erate a URL using filename, only the first encountered file is retrieved. If the "ALL" 
n is used to access files from the Attachments tab of an item where there are multi

name on the attachments table, or if a URL is generated to return a
file

by the same name and therefore
les cann

the same nam
re a valid zip archive of files cannot be generated. 

 

File F ick Access Smart URL Formats 

You can g art URLs for file folders in the following format: 

Server  
Port  

 Path  

Ident i f ies the  Agi le  instance 

Vi r tua l

link The text "link" identifies the URL as a special attachment URL to the Agile server. 

version Identifies the specific version of the file folder. The value can be a number, or the 
string, LATEST (default). 

FileName Refers to the name of the specific file from the folder or string ALL which attaches all 

ists in a specific version of a folder and a 
y the first version of the file is attached. You 

 one file of the 

the files in the specified version of the folder. 

If more than one file of the same name ex
URL is generated based on filename, onl
cannot use the ALL value to access files from a folder where more than
same name exists. 

FileAction Determines the action performed with the retrieved files. Values 
fileaction is not specified, a GET is performed. 

are GET or VIEW. If 

If the parameters specified in the URL point to a single file, the file is retrieved in its 
native format.  If the parameters specified in the URL point to a collection of files, then 
all the files are returned as a zipped file called "Download.zip".  

Examples of user-generated URLs for file folder attachments: 
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à http://myappserver/mycompany/Link/FileFolder/Folder0001/files/abc.txt/1 

 Gets

://myappserver/mycompany/Link/FileFolder/Folder0001/files/ALL/VIEW

 the abc.txt file from version 1 of Folder0001. 

à http  

 all files from Viewer. 

ontent rmats 

You can generate Smar Content tab of Programs and Activities. The Content 
ws specification the addition of external files, just 

ments tab. ed file 
nt. So, wh

t URL for files
http://<server:port>/<VirtualPath>/link/<ObjectType>/<Objec
tNumber>/content/Folder/<FolderNumber>[/<FileAction>] 

where 

ObjectType 

Opens  the latest version of FOLDER001 in the 

Program C  Quick Access Smart URL Fo

t URLs for files on the 
tab allo of any object as valid content and allows 
like the Attach
as valid conte

 However, the Content tab stores the folder object related to an attach
en retrieving, you must attach the entire folder. 

The Smar  on the Content tab is generated in the following format: 

Represents the subclass of the Program object. 

ObjectNumber Represents the identifier of the Program object. 

Content Indicates the Content tab. 

Folder Indicates that a specific folder is being retrieved. 

FolderNumber Refers to the number of the folder being retrieved from the Content tab. The most 
current version of the folder is always retrieved. 

FileAction Determines the action performed with the retrieved files. Values are GET or VIEW. 
If fileaction is not specified, a GET is performed. 

If the parameters specified in the URL point to a single file, the file is retrieved in its 

then all the files are returned as a zipped file called "Download.zip". 
native format.  If the parameters specified in the URL point to a collection of files, 

 
 

Attachment Files using Quick Access URLs 
After click
log into th
appropria e URL. The attachments are 
viewable in all supported browsers, the Agile Viewer, or the native application. 

1. In an email, the user clicks the Attachment Quick Access URL and an Agile login popup is 

Accessing 
ing or opening an Attachment Quick Access URL, a login popup appears and you must 
e Agile system to view the attachment. Agile PLM then validates that you have the 
te privileges to get or view the file or set of files specified in th

For example: 

displayed. 

2. The user enters her login information. 

Agile PLM verifies that the user has the appropriate privileges to read and view the file. 
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Note If the URL returns a collection of files and the user does not have the appropriate Get or 
View privilege for one or more files, those files are excluded from the returned collection. 
However, a collection of files is returned to the user containing the rest of the files for 
which he does have the appropriate Get or View privileges. 

 

Scan Utility 
The Scan utility lets you scan drawings and documents for use in Agile. After the scanned image file 

e folder, which can be attached to a business object. The name 
image appears on the Attachments tab of any object that points to 

 by choosing File > Scan Files or by selecting Add | By Scan 
 tab or the Files tab of file folders. 

propriate scanner to 
s smoothly with or without a Kofax driver installed. You must 

U/N656U. Agile’s TWAINER reads 

ed images, working with its certified scanners and 
d with such a scanner, like CanoScan 

TWA ata source. 

Scan su n be created in Agile PLM. Scan does not require any roles or 
privilege , and Modify privileges may affect Scan. 

To install a scanner on your machine: 

puter and install the scanner. 

3. Go to Start > Settings > Control Panel > Scanners and Came
ag  wizard. 

5. Click Next
ype as 

is created, it is referenced by a fil
and description that you give the 
that file folder. The Scan utility is accessed
on either the business object’s Attachments

Agile PLM uses the application TWAINER (twainer.exe) installed on an ap
perform its scan function. Scan run
install a Twain-driver–driven scanner, such as CanoScan N650
data from a standard TWAIN data source. 

Kofax VRS is an electronic checkpoint for scann
connection interfaces. If Kofax VRS is associate
N650U/N656U with TWAIN driver installed and USB connection, then it's a candidate for 

INER’s d

pports all objects that ca
s. However, your Discover, Read

Installing a Scanner 

1. Connect the scanner to the com

2. Install Kofax driver. 

ras. 

4. Double-click KSM (32-bit) to start the Kofax Source Man er

. Remove all configured sources. 

6. Create a new source. In Source Properties dialog, define Source Name and Source T
follows: 

Source Name: Canon 

Source Type: TWAIN scanning 

7. In Select TWAIN Source dialog, select Canon CanoScan N650U/N656U. 

8. Click Finish. 
 

Using the Scan Utility 
The following is a general sequence for using the Scan utility. 
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1.  select Add | By Scan From an object’s Attachments tab, . 

ct File > Scan File Note You can also sele  in the Java Client main menu. 

2. Java Client creates the twainer.exe file in %USERPROFILE%\.AgileCM\twainer.exe. 

Java Client is suspended while twainer.exe completes its execution. 

3. Twainer.exe retrieves a list of the TWAIN supporting devices on the client machine and 
displays the Select Source dialog showing available TWAIN devices. 

4. Select one of the devices, and twainer.exe displays the TWAIN user interface for that device. 

5. You can scan your images or documents and exit the user interface. Any scanned files are 
stored by twainer.exe in a temp directory. 

6. Twainer.exe write status and scan information to its standard output stream and terminates. 
Java Client is reactivated and reads the status information. 

7. Java Client converts images from the TWAIN standard BMP format to PNG and adds the 
scanned files as an attachment file to the file folder. If an error occurred, Java Client displays 
an appropriate error message. 

8. Java Client deletes all temporary scanned files and also deletes the twainer.exe program after 
logging off Java Client. 
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Working with File Folders 
This chapter includes the following: 

� What are File Folders? ........................................................................................................................................ 283 
� Working with File Folders .................................................................................................................................... 284 
� File Folder Tabs, Buttons, and Menus................................................................................................................. 285 
� Creating File Folders ........................................................................................................................................... 294 
� Adding Attachment Files and URLs to File Folders ............................................................................................. 295 
� Deleting Attachment Files and URLs from File Folders....................................................................................... 299 
� Purging Unused File Folder Versions .................................................................................................................. 300 
� Getting and Revising Attachment Files and File Folders..................................................................................... 301 
� Other File Folder Operations ............................................................................................................................... 306 

 
 

What are File Folders? 
Attachment file storage and retrieval is managed automatically by your Agile PLM system. 
Attachment files are stored in the Agile File Vault and each attachment file in the vault is associated 
with a numbered Agile file folder object. The concept is similar to the way in which you would file 
and store paper documents: sort the documents into file folders, label or number the file folders, and 
store them in a filing cabinet. 

The relationships between attachments files, file folders, and business objects is explained in detail 
in: 

à Attachment Files and Agile File Folders: an Analogy to Papers, Desks, and Vaults (on page 
241). 

à Agile Document Management: Even More Efficient than Doris (on page 242). 
 

Why Use and Modify File Folders Directly? 
If you have the appropriate privileges, you can perform file maintenance actions on file folder 
objects directly. Updating and maintaining documents from the file folder object is useful when 
those documents are attached to many different business objects. 

For example, you can update and maintain a document that describes a company-wide procedure 
by checking out and checking in the associated file folder object. The procedure document (and its 
associated file folder) may appear on the attachments table on the Attachments tabs of many Agile 
business objects, but you do not need to open each of those business objects in order to update the 
procedure attachment. 

File folders can be managed and updated independently of other objects in the database. All 
attachment files are stored in the file vault, part of Agile File Manager. 

Examples of file folder content are: 
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à Drawing files such as CAD drawings or scanned image files in viewable formats 

 URLs 

chable file or URL; however, file 
 and URLs. 

bject was developed to manage documents and URLs that support your company’s 
n

er object in Agile, you can search for 

à 
the file folders may be attached to. 

nt 

à Web-based information in the form of

à Specifications and other documents 

à Non-viewable files, compressed (ZIP) files, and so on 

It is generally a best practice to limit each file folder to a single, atta
folders can contain any number of files

Advantages of File Folders 

The file folder o
ma ufacturing, production, or specification processes. These are some specific advantages of file 
folder objects: 

à You can create, modify, or delete file folders. Like any oth
file folders and bookmark them. 

à You can view, redline, and print files from the file folder. 

You can search for file folders by file folder attributes, including Filename or File Type, 
regardless of what business objects 

For more information about searching for attachment content, see Full Text Search for Conte
in Attachment Files (on page 145). 

à File folders can be sent to reviewers for approval without using the change control process. 
You can track who has received, reviewed, and accepted or rejected file folder content files. 

Files that are referenced in a file folder are subject to version control. On the Attachmenà ts tab, in 

à 

s Attachments tab. 

à  

e Viewer

the Folder Version field, if you edit the row and select Latest Version, the object always 
references the latest version of the file folder, even when the item’s revision changes. 

File folders can be created by users manually as well as automatically. A file folder is created 
automatically when you attach a file or URL to an object; the file folder is generated, and it is 
already associated with the object. Now that the file folder exists, it can be associated with 
other objects. 

It may be useful to create a file folder object manually, for instance, when specifications and 
related design and drawing files are brought together before the part objects (that they 
describe) have been created in the Agile system. These are later associated with any object in 
Agile on each object’

With appropriate roles and privileges, files (2D and 3D) can be redlined from the Files tab of file
folder object. 

See Viewing and Redlining Attachment Files in th  (on page 272). There is additional 
ment files in the Viewer Supplement. 

enc

information about marking up and redlining attach

Working with File Folders 
The next sections describe tabs, buttons, actions, fields, and other user-interface elements that you 

ounter in your work with file folders. 

à A file folder’s Files tab lists files and URLs, and you can add and remove files and URLs in the 
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file folder. You can check out and check in file folders from here and then get and edit single or 
multiple attachment files. (See Working with the Files Tab of File Folders (on page 290).) 

usiness object that 

 

File lient) with the following elements: 

à 
ibed in 

à A file folder’s Where Used tab is populated automatically with a link to any b
references the file folder on the object’s Attachments tab. 

File Folder Tabs, Buttons, and Menus 
 folders are listed in a window (Java Client) or page (Web C

Tabs on file folder objects include Title Block, Files, Routing Slip, Relationships, Where Used, and 
History. They are defined below. The contents and operations of the Files tab are descr
Working with the Files Tab of File Folders (on page 290). 

The contents and operations of the Attachments tab of objects that reference file folders are 
described in Working with the Attachments Tab of Business Objects (on page 244). 

à ut, CheckIn, Cancel 
heckout are described 

Buttons on the main toolbar of file folder objects in both clients are CheckO
CheckOut, Approve, Reject, and Comment. Checkout, Checkin, and Cancel c
in Getting and Revising Attachment Files and File Folders (on page 301). Approve, Reject, an
Comment are described in Routing and Reviewing File Folders

d 
 (on page 307). 

Additional buttons in Java Client are Send, Print, Delete, and Add Bookmark. 

A final button, More, is a dro
Process Extensions, Mass Upd

p-down menu offering these functions: Subscribe, SaveAs, Sharing, 
ate, and Get All Files. Subscription and sharing are discussed in 

Chapter 5, “Working with Business Objects.” Mass update is covered in Performing a Mass 
Update of a File Folder (on page 306). 

p-down menus include: à Dro
y d back 

ut menu in Java Client opens when you right-click anywhere on the file 
ers these actions to perform on the attachment: Cut, Copy, Paste, Add 
e, Save As, Delete, Print, Send, Sharing, Process Extensions, Mass Update, Get 

File Folder Tabs 
File folders include the following tabs. Some tab isible in your Agile system, 
depe n how your Agi

This table lists th

The Version list shows the number of times a file has been checked out and checke
in, unless it was modified. By default, the most recent version is shown, but you can select 
an earlier version. Each time an attachment file is checked out and modified, a new 
version is created. 

The Actions drop-down menu in Web Client offers these actions to perform on the 
attachment: Bookmark, Subscribe, Save As, Delete, Print, Send, Sharing, Mass Update, or Get All 
Files. Any existing process extensions are also listed. 

The Actions shortc
folder object. It off
Bookmark, Subscrib
All Files, Check Out, Check In, and Cancel Check Out. 

s may not be v
nding o le administrator has configured Agile PLM. 

e tabs found on all file folder objects, with file folder–specific definitions. 
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Tab Descr ipt ion 

Title Block Provides general information about the file folder, such as a description, the object numb
and the date the file folder was last modified. Your administrator may have added Page Tw
and Page Three sections (which may be named differently) th

er, 
o 

at contain additional 
information—class-specific and subclass-specific, respectively. 

Files  
or details about the Files tab, see Working with the Files Tab 

Lists all the contents of the file folder object, and it is where you add and remove files and
URLs in the file folder. F
of File Folders (on page 290). 

Routing Slip s a signoff summary for the file 
ve 

Allows you to route the file folder for approval, and show
folder—a record of which users have viewed and signed off on it. You can add or remo
approvers and observers for the file folder object on this tab. 

Relationships The onships tab allows you to create relationships with other Agile objects and to 

For more information about relationships and relationship rules, see Relationships and 

Relati
create dependencies (relationships with rules) between the current file folder object and 
other routable objects.  

Dependencies Between Objects (on page 103). 

Where Used Populated automatically with 
object’s Attachments tab. To

any business object that references the file folder on the 
 open an object listed on the tab, click its Number or Name 

link. 

History The History tab is a record of actions taken on the file folder and the users who performed 
those actions. The History tab is populated automatically. 

  
 

Buttons on the Files Tab 
You need the appropriate privileges to add or remove file
tab are enabled or disabled, depending on your privilege

s on the Files tab. The buttons on the Files 
s and administrative settings. File 

Validation (Handle File Checksum) (on page 308) addresses some of these dependencies. I
 your privileges, contact your Agile administrator. 

 in the following tables are available to users w

f you 
qu out

The buttons described ith the required privileges on 
Agile object pages. M er in 
this chapter. 

h e av estions ab

any of the operations in this and subsequent tables are elaborated on lat
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B tu to Fins on les tab in Java Client 
    Get Files Places copies of the files in the location of your choice. Click the dro

and select Get files from selected attachments or Batch Get all f
p-down arrow 
iles from this 

ted Attachments 
ur 

cho

 copy of 
all t on of your choice. These copies are in 

à t a 
tion 

  
 

object. These copies are in native application formats. 

Select the rows you want, then click the Get Files from Selec
button to place a copy of the selected files in the directory folder or location of yo

ice. These copies are in native application formats. 

Or 

Click the button and select Batch Get All Files from this Object to place a
he file folder’s files in the folder or locati

native application formats.  
If you selected more than one file, you are prompted to choose whether or no
ZIP file containing the selected files is created and placed in the folder or loca
of your choice.

à If you choose to create a ZIP file, you can fill in a ZIP filename; if you choose no
ZIP file, the individual files are placed in the specified location. 

 Open Files With a file or files selected, opens the file(s) in its native application, if possible.   

 Print Files With a file or files selected, prints the corresponding files. The Viewer is started in a 
separate browser window and begins the printing process.   

  View Files 

 layout ECAD files. (For more 

à 

à ystem, which you may want to (select from 
al mockup (see above), without 

avi r; that is, you could search and 

Click the View Files button to view the selected files in the Viewer. 

Or, click the View Files button’s drop-down arrow and select from the menu: 
à View – view the files in the Viewer.  
à Cross Probe – crossprobe between PCB and

information, see Viewer Supplement.)  
à Compare – visually compare two files in a third compare viewer window.  
à O rlay – lets you lay other files over the current active file. (For more 

information, see Viewer Supplement.) 
Digital Mockup – mockup designs from disparate MCAD and ECAD systems in 
a virtual workspace. Loads the selected files into the same workspace in the 
Viewer, where you can manipulate them. (For more information, see Viewer 
Supplement.) 
By Search – find other files in the s

ve

menu) cross probe, compare, overlay, or digit
h ng to select two files from the same folde
select one file in file-folder A and another file in file-folder B. You can search for 
file folder objects or for any other object type with attachments. 

 

   Edit Mo
cus sabled if the 

dify the File Description field of the selected file or files, and any other editable, 
tom fields that your administrator has defined. The Edit button is di

file folder is checked in. 
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s 

Add Scan 

, 

Click the Add button to open the File Uploader.  

 button’s drop-down arrow and select from the menu: 

à 

Click the Add drop-down menu button to add to the Files tab. It can be a file, URL
or you can scan a document to create an attachment.  

Add File
 

 

Add URL Or, click the Add
 

 Files – displays the File Uploader dialog, which allows you to drag and dr
the files you want to attach. You can also click Browse for Files button to 
browse your c

op 

omputer or network for the files you want. To add multiple files as a 
ct 

P file is unzipped and 
single file folder, click the Add all files to a single file folder button. If you sele
the UnZip all zipped files upon upload checkbox, the ZI
the contents are added as individual files. Selecting the UnZip checkbox is not
recommended for very large files. 

 
 

 

à  URLs – brings up the Add URLs dialog 

à  By Scan – permit direct access to a file you want to scan. (Windows only, 

ed 
ility

Java Client only) Runs a Windows application that scans documents using a 
TWAIN interface. The resulting images are added as file types that are specifi
by the user using Agile Scan (see Scan Ut  (on page 280)). 

 Replace 
Files 

Rep
Cli
folder i

lace  file that has been revised (the file folder object must be checked out). 
ck Replace to remove the file and add a new version of the file, then check the 

n. 

s a  

   Remove Re
out). The 

move ll selected files from the Files tab (the file folder object must be checked s a
Remove button is disabled if the file folder is checked in. 

   Handle 
File 
Checksum 
Error 

Shows tly in the file server vault. For more 
inf

 whether files have been modified direc
ormat , see File Validation (Handle File Checksum)ion  (on page 308).   

Buttons on Files tab in Web

  

 Client 

 Get The
you

The

 Get button places copies of the selected, referenced files in a location of 
r choice.  

 method used depends on your File Productivity Preference (see Setting 
your File Productivity Preference (on page 297).) 

These copies are in native application formats. If you select more than one file, a 
 ZIP file containing the selected files is created and placed in the folder or location

of your choice. 
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nu: 

View Click the View Files button to view the selected files in the Viewer. 

Or, click the View Files button’s drop-down arrow and select from the me

à  View – view the files in the Viewer. 

à  Cross Probe – crossprobe between PCB and layout ECAD files. (Fo
more information, see Viewer Supplement.) 

r 

à  Compare – visually compare two files in a third compare viewer window. 

à  Overlay – lets you lay other files over the current active file. (For more 
information, see Viewer Supplement.) 

à  Digital Mockup – mockup designs from disparate MCAD and ECAD 
systems in a virtual workspace. Loads the selected files into the same 
workspace in the Viewer, where you can manipulate them. (For more 
information, see Viewer Supplement.) 

à  By Search – find other files in the system, which you may want to (sel
 above), 

ect 

ile-folder A and another file in file-folder B 

from menu) cross probe, compare, overlay, or digital mockup (see
without having to select two files from the same folder; that is, you could 
search and select one file in f

 Print  in 
a sep
With a file or files selected, prints the corresponding files. The Viewer is started 

arate browser window and begins the printing process.   

 Edit Click he selected file, and 
Edit 

utton is disabled if the file folder is checked in. 

 the Edit button to modify the File Description field of t
s that your administrator has defined. The any other editable, custom field

b
  

 Remove Removes all selected files from the Files tab (the file folder object must be 
checked out). The Remove button is disabled if the file folder is checked in.   
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 Add  Click the Add drop-down button to add a folder reference to the object. It can be 
checked in. 

uctivity tools, displays the File Uploader 
u 

as individual files. 

you to browse for up to five files, add the files to a single file folder, and unzip 

the UnZip checkbox is not recommended for very large files. 

t File Productivity tools, see Using the Advanced 

a file or a URL. This button is disabled when the file folder is 

Click the Add button to open the File Uploader.  

Or, click the Add button’s drop-down arrow and select from the menu: 
à Files – if you are using File Prod

dialog, which allows you to drag and drop the files you want to attach. Yo
can also click Browse for Files button to browse your computer or network 
for the files you want. To add multiple files as a single file folder, click the Add 
all files to a single file folder button. If you select the UnZip all zipped files 
upon upload checkbox, the ZIP file is unzipped and the contents are added 

à Files – (no File Productivity tools) displays the Add File dialog, which allows 

zipped files. 
Note Selecting 

For more information abou
File Uploader (on page 295). 

Note Either Advanced File Uplo File Uploader will be used ader or Standard 
depending on your user profile File Productivity Preference setting. For 
more information see Setting your File Productivity Preference 
(on page 297).RLs – brings up the Add URLs dialog 

 

 
 

Working with
You can use the Files

à Add files and URLs to the file folder 

à  or URLs

à copy of a

à With the file fold , get a file for revision, then replace the version of the file 

files 

 and redline

itho

To display the Files tab of a file folder: 

 a file folde
e object. 

y In Java Clie der 
object. 

les ta tents of the file folder. 

 the Files Tab of File Folders 
 tab of file folders to: 

Delete files

“Get” a 

 from the file folder 

n attachment file (but not revise it) 

er checked out

à Print 

à View  an attachment file 

à Open a file w ut being prompted to download it (Java Client only). 

1. Open
y In Web Cli

r. (You may wish to use a Quick Search for FOLDER*.) 
nt, click the folder number in the Attachments tab to open the folder 
nt, double-click the folder number on the Attachments tab to open the fol

2. Click the Fi b to display the con
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To open a file or files in a file folder in Java Client: 

s tab 

. Click the Open Files button 

1. On the File of the folder, select the file or files you want to open. 

2 . The attachment file opens in its native application, if possible. 

nt to open. 

rmat (see Agile PLM Administrator Guide for a list of supported 
ropriate privileges, you can use all 

ng Attachment Files in the Viewer

To open a file or files in a file folder in Web Client: 

1. On the Files tab of the folder, click the filename of the file or files you wa

2. If the file is a supported file fo
file formats), the file opens in the Viewer. With the app
Viewer features, as described in Viewing and Redlini  (on 

 its native application, if 
possible. 

page 272). 

If the file is not a supported file format, the attachment file opens in

Fields on the Files Tab 
The following table lists fields on the Files tab. 

Field  Descr ipt ion 

   If a file has been modified directly in the
indicate that the file Has checksum err

 file server vault, this icon appears in the field to 
or. Click the icon to get information about the 

. See File Validation (Handle File Checksum)checksum e orrr  (on page 308). 

 field if the file Has been redlined.   This icon appears in the  
The Do Redlining icon will appear here from the file folder level for any file type that is 
listed in the Supported File Types and Valid Model File Type settings in Administrator. 
Both of these cases allow ad-hoc viewing and redlining. 

File Name The name of the file. 
à In Java Client, the files table row must be selected in order to prin

the file. 
t, open, get, or view 

ent, click the filename to view the file in the Viewer. à In Web Cli
File Path Can be manually set; the field is automatically filled if a user compresses a file using 

cts multi-file “Unzip” when .ZIP, with Options set to “Store full path info” and the user sele
adding the path. 

File Type The format of the file 

File Size The size of the file, in bytes 

Last Viewed Date Date when the file was last viewed (The History tab records detailed information about 
file viewing.) 

 

Che
Loc

heck out procedure. 

ut Location is used to automatically locate 
and checkin the checked-out files. 

ckout 
ation 

Records where checked out files were placed during the c

If you are using the Java Client or you are using Web Client with Advanced File 
Productivity preference selected, Checko

File Description Description of the file 

Document Text If needed, this field will be filled in automatically by the Agile system. 
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Ope s of File Folders 

à 

ning and Viewing Content
This section includes the topics: 

Java Client, Getting File Folder Files (on page 292) 

à Java Client, Batch Get (on page 292) 

à Web Client, Standard File Productivity (on page 29

à 

2) 

Web Client, Advanced File Productivity (on page 293) 

ient, Getting File Folder Files 

va Client: 

s that you want to get. 

3. Click 

 

Java Cl

To get copies of files from a file folder in Ja

1. Display the Files tab of the file folder. 

2. Select the rows of th lee fi

the Get Files button  . 

The Select Directory dialog opens. 

4. 

If you sel , click 
Download s in one ZIP file. Specify a ZIP filename. 

 prompted whether you want to open the file or files. 

Jav ien

1. 

es 

In the Select Directory dialog, specify the directory where you want to store the copies. 

ected more than one row, and you want to get the files together in one ZIP file
 the file

5. Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be

a Cl t, Batch Get 

To batch get copies of all the files from a file folder in Java Client: 

Display the Files tab of the file folder. 

2. Click the button drop-down menu for Get Fil  and select Batch Get All Files from this Object. 
ctory where you want to store the copies. 

Specify a 

4. Click . The files (or ZIP file) are copied to the specified directory. 

We

nt, using Standard File Productivity 

et. 

3. In the Select Directory dialog, specify the dire

If you want to get the files together in one ZIP file, click Download the files in one ZIP file. 
ZIP filename. 

OK
You will be prompted whether you want to open the file or files. 

b Client, Standard File Productivity 

To get copies of files from a file folder in Web Clie
method: 

1. Display the Files tab of the file folder. 

2. Select the rows of the files that you want to g
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3. Click the Get button . 

Select Directory dialog opens. The 

isk, specifying the directory where you want to 
cted directory. If you get copies of multiple 

file) are copied to the specified directory. 

We

met

1. 

2. 

4. The Save As dialog appears. Save the files to d
place the files. Web Client copies the files to the sele
files, they are placed in a ZIP file. 

5. Click OK. The files (or P 
 

 ZI

b Client, Advanced File Productivity 

To get copies of files from a file folder in Web Client, using Advanced File Productivity 
hod: 

Display the Files tab of the file folder. 

Select the rows of the files that you want to get. 

3. Click the Get button . 

Select Directory dialog opens. The 

4. The Save As dialog appears. Save the files to disk, specifying the directory where you want to 
place the files. 

Note When using the Advanced File Productivity method to get multiple files, Web 
Client gives you
ZIP. 

 the choice of downloading individual files or downloading a 

5. If you want multiple files in a single ZIP file, check Download the files in one ZIP file and enter a ZIP 
file name. 

Note If you did not select multiple files, the ZIP file option and name field do not 
appear in the Select Directory dialog. 

6. Click OK. The files (or ZIP file) are copied to the specified directory. 

 

file folder from within the file folder in Web Client: 

 

leges to print an attachment file. If you have questions about 
dministrator. 

You will be prompted whether you want to open the file or files. 

Switching Between Versions
To switch between versions of a file folder from within the file folder in Java Client: 

From the Version drop-down list at the top of the folder object, select the version you want to 
view. 

To switch between versions of a 

From the Version drop-down list at the top of the folder object, select the version you want to
view. 

Printing Contents of File Folders 
You must have the appropriate privi
your privileges, contact your Agile a

Note A “batch print” is simply printing the contents of a file folder that has multiple files. You still 
click the Print button and follow the sequence in Viewer. 
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To print a file on the Files tab using the Viewer: 

 With the Files tab displayed, select the rows you want to print. 

1. Click the Print button . 

You can also select a row and click the View button ; in this case you 
print functions manually. 

would start the viewer 

nting process. 

an print it 

nt from within the Viewer, watermarks and banners can appear in addition to 

2. If the file type is supported by the Viewer, the viewer opens and begins the pri
Follow the instructions in the displayed dialog boxes to complete the printing process. 

Otherwise, Web Client starts the file’s native application and opens the file so you c
using that application’s printing commands. Choose the Print command for that application. 

Note When you pri
the contents of the attached file. For more information, see About Banners and 
Watermarks on the Printed Image (on page 255). 

It is also possible to get a copy of the file, open it in its native application, and use the native 
application’s print functions to print the file. The native application must be installed on your 

When pri
banner h

The bann

. 

ct, and manually, using the create object functions 

To create

1. Crea eb Client. 

2. The file folder that you have created is an empty container, that is, it has no files in it. To add 
nd URLs to File Folders

computer before you can print the file. Follow the usual printing procedures according to the 
application’s documentation. 

About Banners and Watermarks on the Printed Image 

nted through the Viewer, the printed image has a banner above and below the image. The 
as six fields: top left, top center, top right, bottom left, bottom center, and bottom right. 

er labels and contents for each object class are set by the Agile administrator. 

In addition, the Agile administrator can choose to include a printed watermark on the printed image

Creating File Folders 
There are two ways to create a file folder: automatically, when you attach a file or URL to a 
business object in the Attachments tab of the obje
of Java Client and Web Client. 

 a file folder manually: 

te the file folder using the New button in Java Client or the Create button in W

files to the file folder, see Adding Attachment Files a  (on page 295). 

For more information on creating business objects, see Creating Objects (on page 88). 

Revising File Folders 
Revising or editing a file folder object requires the appropriate modify privileges, just as editing an
Agile object requires the appropriate modify privileges. In addition, you must also have privileges 
that allow you to check out and check in a file folder. 

To revise the Files tab, or the content of the file folder, you must check o

y 

ut the file folder, modify 
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files, add files or remove files, then check in the file folder. For details, see: 

à Adding Attachment Files and URLs to File Folders (on page 295). 

à Deleting Attachment Files and URLs from File Folders (on page 299). 

à Getting and Revising Attachment Files and File Folders (on page 301). 
 

Ad
Folders 
You ou have 

our Agile administrator. 

 
inde lt filename. 

You t 
sites; they are not, themse

Note  field increments by 1, however, other users 

ding Attachment Files and URLs to File 

 must have the appropriate privileges to add attachment files to file folders. If y
questions about your privileges, contact y

Each time you add a file to the Agile system, it is copied into the Agile File Manager vault as an
pendent file with a unique numeric vau

can also include a URL (Internet address) in a file folder. URL attachments point to Interne
lves, documents on the Agile File Manager file server. 

When you check out a file folder, the Version
are still able to view the current version. When you check the file folder in, and it has been 

be 
changed, the new version number holds. The system will not let an unchanged file folder 

checked in. If you did not make a change to the file folder, complete the action by 
clicking Cancel Checkout, and the version number reverts to the previous numeral. 

Dele  Deleting Attachment Files and URLs from File Foldersting attachment files is covered in  (on 
pag

When adding er. 
The File Uplo p the files you want from your desktop or from an open 

u can find 
 

Note s, your Agile administrator may 

e 299). 

files to a file folder Files tab, Agile provides a simple and easy-to-use file upload
ader allows you to drag and dro

directory window to the file uploader window. The uploader also has a Browse button so yo
the files you want in that manner. 

 For Web Client only: Depending on your company’s policie
set a systemwide preference that
case, Add >  File operations in

 prevents the use of the Advanced File Uploader. In that 
 Web Client are completed using the Add File dialog, as 

described in Using Web Client’s Standard Add File Dialog (on page 298). 
 

You  
Loader i
ready, cli

Whe
“Wo ed 
a file onto your machine only to attach it to an Agile object. When you uploaded the file, Agile File 

At any time before clicking Upload, you can Cancel the upload. Click Close to close the uploader 
dialog. 

Using the Advanced File Uploader 
 can add as many files at one time as you like. When adding to the Files tab, the Advanced File

ncludes one checkbox; when checked, it will Unzip all zipped files upon upload. When you are 
ck Upload. 

n the upload is completed, depending on Agile PLM system settings, you may be prompted 
uld you like to delete the uploaded files from your local disk?” which is useful if you have load

Manager created a copy of the file that is always stored in the file vault. 
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To add attachment files to the file folder Files tab using Advanced File Load
Client and Web Client: 

er in both Java 

. 

3. 

5. Sele
appe
y d drop a folder, all the files in the folder are added to the list in the File 

Uploader. 
loader window and browse for the file 

you want. When using the browse function: 
he folder's contents. 

nts of that folder (files 

ging as many files as you want to want. You can open additional 
hoose. 

o remove any file from the download dialogue box (for example, if you made a 

1. Open the file folder you want and, if it is not already checked out, click the Check Out button

2. On the Files tab, select Add > Files. 

The blank File Uploader window is displayed. The instruction “Drag Files Here” appears in the 
window. 

Open a directory window (for example, Microsoft Explorer) and size the window so that you can 
see both the File Uploader window and the directory window on your screen. 

4.  Navigate to the directory you want. 

ct the file you want and drag it to the File Uploader window and drop it. The file name 
ars in the File Uploader window. 
If you drag an

y You can also click the Browse button in the File Up

� Double-clicking on folder will open t
� Single clicking on folder and then clicking Open will add all conte

as well as contents of subfolders within that folder) 
6. Continue locating and drag

directory windows if you c

Note T
mistake and selected a file erroneously), simply click on the file and press the 
Delete key on your keyboard. 

7. Whe

8. Unzi ive format. 

9. When yo

The files ress 
message

10. 
loca

you 

y Files tab remains on your local 

11.  Wh
 

Addin ut Advanced File Loader 

If Advan

n you have selected the files you want, if desired, check the optional checkbox. 

p all zipped files upon upload — unzips ZIP files so that they are stored in their nat

If this option is unchecked, a ZIP file is stored in its ZIP format. 

u are done, click Upload. 

are added to the file folder’s Files tab. The File Uploader window displays prog
s for each file as it is uploaded. 

When the files are uploaded, you are asked if you want to delete the uploaded file from your 
l disk. 

y Yes (default) — removes the copy of the file from the directory from which you selected it. 
This ensures that the correct version of the file is maintained in the Agile file vault and 
do not have any out-of-date copies on your local disk. To view or update the file, use the 
Agile Files tab. 
No — the copy of the file that you selected to add to the 
disk. 

en you are finished, remember to check in the file folder by clicking the Check In button. 

g Files in Web Client witho

ced File Loader is not available to you in Web Client, there are two possible reasons: 
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à Due  the system-wide preference 
such . 

à You
pers
this d, which will allow you 
to u

Note  

 to your companies policies, your Agile administrator has set
 that Web Client users are not allowed to use the Advanced File Loader Java applet

r company does allow Web Client use of the Advanced File Loader, however, your 
onal user profile preference attribute for File Productivity Preference is set to Standard. If 
is the case, you can change your user profile preference to Advance
se the Advanced File Loader. 

By default, your user profile is set to the Prompt preference. By responding to the prompt,
you can select which file productivity method you prefer without editing your user profile. 
See the description of Prompt responses in Setting your File Productivity Preference (on 
page 297). 

 

Setting yo

ced File Loader and other File Productive 
le system-wide preference is set to allow it). The next time 

 previously installed, a Java 

ur File Productivity Preference 

To modify your File Productivity Preference: 

1. In Web Client, select Tools > My Settings to display the My Settings page. 

2. On the My Settings page, click User Profile. Your tabbed user profile appears. 

3. Click the Preferences tab. 

4. Click Edit. 
5. In the File Productivity Preference drop-down list, select one of the following: 
y Advanced — allows you to use the Advan

components (providing the Agi
you add a file or check in files on the Files tab, if it has not been
applet will be installed. See Using the Advanced File Uploader (on page 295). 

Note File Productivity components include both Advanced File Loader and 
Automated Checkin. In Web Client, File Productivity also allows you to get 
(download) a multi-file attachment row as individual files instead of a ZIP file, 
and enables the opening of an attachment in its native application when you 
click its Filename link. 

y Standard — Web Client standard Add File dialog is used when you add a file or check in 
 Dialogfiles on the Files tab. See Using Web Client’s Standard Add File  (on page 298). 

pdate Mode 
uctivity 

) or not. (By default, your File Productivity Preference is 
initially set to Prompt.) 

ble choices are as follows: 

 attribute in 
ck-in attachments 

how this dialog box again) — The File Productivity 
s set to Prompt. Every time you use 

les tab, the Please Choose File Update Mode 

y Prompt — the next time you add a file to an Files tab, the Please Choose File U
dialog is displayed to prompt you to choose whether to use the advanced prod
components (Advanced File Loader

Your possi

* Yes (and check Do not show this dialog box again) — if it has not been previously installed, a 
Java applet will be installed. The File Productivity Preference attribute in your user profile is 
set to Advanced. Every time you use Add > Files or check-in attachments on the Files tab, the 
Advanced File Loader is displayed. 

* No (and check Do not show this dialog box again) — The File Productivity Preference
your user profile is set to Standard. Every time you use Add > Files or che
on the Files tab, the standard Add Files dialog is displayed. 

* Yes or No (and do not check Do not s
Preference user profile is remain attribute in your 
Add > Files or check-in attachments on the Fi
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dialog is displayed and you can select the method you want to use. 

nce  again, your 
Update 

Mod ill no longer appear and the File Productivity Preference attribute in your user 

 the above process (step 1 through step 5) to edit the 

O  you respond to the prompts and you also check Do not show this dialog box
preferred file productivity method will always be used. The Please Choose File 

e dialog w
profile is set as described above for the Yes or No choice. 

Note At any time, you can use
File Productivity Preference attribute in your user profile to change your 

 upload method you prefer. preference and select a the file
 

Using Web Client’s Standard Add File Dialog 

 
ference

If you want to use the standard Add File dialog, make sure that the File Productivity Preference
attribute in your user profile is set to Standard. See Setting your File Productivity Pre  (on 

er you want and, if it is not already checked out, click the Check 

2. 

The ndow appears with rows for up to five attachments. 

3.  local 
rive

4. Add  
desc

5. If de

r vault. 

s 

r) 

page 297) for instructions. 

To use the standard Add File dialog: 

1. In Web Client, open the file fold
Out button. 

On the Files tab, select Add > Files. 

 Add File wi

Use the Browse button to locate and select files to add. You can select electronic files on a
d  or on your network. 

descriptions for the files. You do not have to add a description now. You can add or edit a
ription at any time. 

sired, check the optional checkboxes: 
y Unzip — unzips ZIP files so that they are stored in their native format. 

If this option is unchecked, a ZIP file is stored in its ZIP format. 

6. Click Finish. The files are added to the Files tab and placed in the file serve

7. Click Check In to check in the file folder. 
 

Adding URL

Note If a URL is added to a single file folder (there are no other files or URLs in that file folde
and the file folder version remains at Version 1, you can select the URL row on the Files 
tab, click Edit, then edit (modify) the URL. All the business objects that include the URL on 
their Attachments tab will display the newly edited URL. 

To add a URL to the Attachments tab in both Java Client and Web Client: 

1. Open a file folder, and click the Check Out icon  to check out the file folder. 

nte

Note 

2. Click the Files tab to display its contents. 

3. Select Add > URL. The add URL dialog appears. 

4. E r a URL and description. URLs must include the http syntax. 

The URL field is prepopulated with the text string http:// to streamline this 
process. 
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5. To verify that you have typed the correct URL, click Preview. A new browser window opens 

Files tab. 

7. Click  to check in the file folder. 

Editin
When a file folder is checked out, you can modify the editable fields on the Files tab. 

 want and, if it is not already checked out, click the  button. 

play it. 

ele
y Web Client — the Files tab is displayed in edit mode. Make the desired modifications and 

click Save. 
s and click OK. 

using the URL you have entered. 

6. Click OK. The URL is added to the 

Check In
 

g the Files Table 

To edit the files table in either Java Client or Web Client: 

Check Out1. Open the file folder you

2. Click the Files tab to dis

3. S ct the rows you want to edit, and click the Edit button. 

y Java Client — the Edit dialog appears. Make the desired modification

Note If a URL is added to a single file folder (there are no other files or URLs in that file folder) 
and the file folder version remains at Version 1, you can select the URL row on the Files
tab, click Edit, then edit (modify) the URL. All the business objects that include the URL on 
their Attachments tab will display the newly edited URL. 

 

If there are multiple files or URLs on the Files tab, or the file folder has been advanced from Version 
1, you will not be able to edit the URL. However, if the file folder is checked out, you can delete the 
URL ro Add > URLw from the table and use  to add a new URL row. 

leting Attachment Files and URLs from File 
lders 

De
Fo
Whe
vau

Each chment file, it is copied into the File 
nt file with a unique numeric vault filename. This is true even if 

n you delete a referenced attachment file, Agile removes the file from the File Management 
lt. The outside file at its original location is untouched; only the Agile copy in the vault is deleted. 

 time you use an outside file to create a referenced atta
Management vault as an independe
you add the same outside file to several different file folders. You can delete the file from one file 
folder without affecting any of the copies. 

You must have the appropriate privileges to delete files and URLs from the Files tab. If you have 
questions about your privileges, contact your Agile administrator. 

Note If the file you want to delete has been checked out from the Attachments tab of the 
business object that references it, (unless you have sufficient privileges) you cannot 

as been checked back in on the Attachments tab. delete it from the file folder until it h

To delete files and URLs from a file folder in Java Client: 

 Files1. RLs that you want to delete. 

2. 

On the  tab of the checked-out file folder, select the files and U

Click the Delete button . 
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Be sure to use the Delete Attachments button  on the Files tab. Do not use the Delete Note 
command on the File menu and do not use the Delete Object button  in the object window 
toolbar. This deletes the entire object you are working with, not just the attachment. 

To delet

1. On the F te. 

2. Click the

e

e files and URLs from a file folder in Web Client: 

iles tab of the checked-out file folder, select the files and URLs that you want to dele

 Delete button. 

Not  Be sure to use the Delete button on the Files tab. Do not use the Delete command on the 
Actions menu. This deletes the entire object you are working with, not just the attachment. 

 

Purging Unused File Folder Versions 
If yo ropriate privileges, you can purge checked-in file folder versions that are not 
refe
vault all 
drop-dow

Purg ons 
remove the following ways: 

à 
folder is or replace files and URLs in that checked-out 

 

u have the app
renced by any Agile object. Purging a file folder version removes from the File Management 

the files checked in for that version. The version number is also removed from the file folder 
n list. 

ing a file folder version and deleting attachment files have similar results because both acti
files from the Agile file vault. These actions differ in 

When deleting files or URLs from a file folder, the file folder must be checked out. While the file 
checked out you can selectively delete 

file folder version. When you check in the file folder version, any files or URLs you deleted are 
removed from the File Management vault. For more information, see Deleting Attachment Files
and URLs from File Folders (on page 299). 

rmed only to a checked-in file folder 
ed by any Agile object and it 

oves all the files and URLs in 
ult.  

Why Purge Unused File Folder Versions? 
s 

cked in, Mary realizes that the file she checked in is incorrect. She checks out the 
aces it with the correct file and checks in Version 7. The incorrect file in file 

 

ced 

b. 

à Purging an unused file folder version action can be perfo
version. The checked-in file folder version cannot be referenc
cannot contain any redlined files. Purging a file folder version rem
that version from the Agile File Management va

Mary has checked out the Version 5 file attachment from an Item object Attachments tab. Mary work
on her local copy of the file, and then checks in the Version 6 file attachment for the Item object. 
After she has che
attachment again, repl
folder Version 6 remains in the file vault. Even though Version 6 can be considered only an 
historical document, and the Item attachment table no longer points to Version 6, Mary would like to
remove Version 6 completely because it is incorrect. 

To remove an unused file folder version: 

1. Before you begin, you can verify that the file folder version you want to purge is not referen
by any other Agile object, on an Attachments tab or a Content tab.  
a. Navigate to the file folder object and click the Where Used tab. 

In the Version drop-down list, select the version you want to purge. 

If the Where Used table for the selected version is empty, the file folder version is not in 
use. 

c. If the Where Used table for the selected version lists one or more objects, if you have the 
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appropriate privileges, you can modify those objects so they use a different file 
version: 
� Navigate to each object and edit the Attachments tab or

folder 

 the Content tab of the object to 
on you wish to purge. You can 
the latest version (providing the 

. 

urged: 

s not purged. 

y lected file folder version is checked out, Agile PLM displays a warning message 
file folder version is not purged. 

RLs are removed 
 from the file folder's 

 if: 

der Version privilege. 

à 
 

Getting and Revising Att
Fo

an attachment file that you are interested in, you may want to read 
possibilities. To print the file, see Printing Attachment Files

select a version of the file folder other than the versi
choose an earlier version, a more recent version, or 
version you want to purge is not the latest version). 

2. With the file folder object open, from the Version drop-down list, select the version you wish to 
purge. 

3. From the Web Client Actions menu or the Java Client More... menu, select Purge Folder Version
4. Confirm the prompt. 

Agile PLM checks whether the selected file folder version meets the requirements that allow it 
to be p
y If the selected file folder version is in use (on an Agile object Attachments tab or Content tab) 

or if the file folder version has been incorporated to an item object, Agile PLM displays a 
warning message  and the file folder version i

y If the selected file folder version contains redlined files, Agile PLM displays a warning 
message and the file folder version is not purged. 
If the se
and the 

If the file folder version meets the requirements, it is purged. All files and U
from the Agile File Management vault and the version number is removed
Version drop-down list. 

The Purge Folder Version menu selection is disabled

à The user does not have t e Purge Folh

The latest version of the file folder is zero (0). 

achment Files and File 
lders 

If you have searched and found 
it, revise it, or print it, among other  (on 

 it (or, revise the file as you wish without other people 

e

page 254). 

If you want to read the file without revising
being able to access your revised version through A ile), or review the contents of a file folder 
without revising it, you will just perform a “Get” proc dure, as described below. 

g

Note In Web Client, the Get procedure differs depending on your File Productivity Preference 
user profile setting. See Setting your File Productivity Preference (on page 297). 

You must have the appropriate privileges to check out and check in a file folder and to cancel a 
che itself or from the Attachments 
tab  contact your Agile 
administrator. If you are going to work with file folders often, it may be appropriate that you be 
assigned the File Folder Administrator or File Folder Manager role. 

ckout, whether you are performing the operation at the file folder 
of a business object. If you have questions about your privileges,
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Getting Attachment Files or File Folders 

ou like. If you want to revise an attachment file and make the revision 
hanges, and check it back in. This is covered in 

e Folders

You can copy attachment files to the directory of your choice. This is called getting a file. You can 
get as many copies as y
public, you must check the file out, make c
Checkout and Checkin to Revise Attachment Files or Fil  (on page 303). 

ously. You can get files that are checked 
ed to create that file is not loaded on your 

You must hav stions about your 
priv , con

of the file reflects the date 

Several users can get the same attachment files simultane
out. Also, you can get a f even though the application usile 
computer. 

e the appropriate privileges to get a copy of the file. If you have que
ileges tact your Agile administrator. 

Note When you get an attachment file, the date stamp on your copy 
that you got the file, not the date that the file was attached or saved. 

 

Java Client 

pies of attachment files from a file folTo get co der object in Java Client: 

he files that you want to get. 

1. Display the Files tab of the file folder. 

2. Select the rows of t

3. Click the Get Files button . 

In the Select Directory dialog, specify the directory where you want to store the copies. 

t the files together in one ZIP file, click 
fy a ZIP filename. 

4. Click OK.

You will b

To b pies of all the attachment files of a file folder object in Java Client: 

1. ay th

If you selected more than one file, and you want to ge
Download the files in one ZIP file. Speci

 The files (or ZIP file) are copied to the specified directory. 

e prompted whether you want to open the file or files. 

Java Client, Batch Get 

atch get co

Displ e Files tab of the file folder. 

2. Click the button drop-down menu for Get Files   and select Batch Get All Files from this Object. 
3. t to store the copies. 

If there is more than one file on the  tab, and you want to get the files together in one ZIP 

The files (or ZIP file) are copied to the specified directory. 

rompted whether you want to open the file or files. 

In the Select Directory dialog, specify the directory where you wan

Files
file, click Download the files in one ZIP file. Specify a ZIP filename. 

4. Click OK. 

You will be p
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Web Client, Standard File Productivity 

To get copies of attachment files from a file folder object in Web Client, using Standard File 

2. Select the rows of the files that you want to get. 

Productivity method: 

1. Display the Files tab of the file folder. 

3. Click the Get button  in the row of a file you want. 

4. The Save As dialog appears. Save the files to disk, specifying the directory where you want to
place the files. Web Client copie

 
s the files to the selected directory. 

Note If you get copies of multiple files, they are automatically placed in a ZIP file. 

5. Click
 

Web C

Note For more information about the Advanced File Productivity preference, see Setting your File 

 OK. The files (or ZIP file) are copied to the specified directory. 

lient, Advanced File Productivity 

Productivity Preference (on page 297). 

To get copies of attachment files from a business object in Web Client, using Advanced File 
Productivity method: 

1. Display the Files tab of the file folder. 

2. Select the rows of the files that you want to get. 

3. Click the Get button  in the row of a file you want. 

The Select Directory dialog opens. 

Note When using the Advanced File Productivity method to get multiple files, Web 
Client giv
ZIP. 

es you the choice of downloading individual files or downloading a 

If you want multiple files in a single ZIP file, check Download the files in one ZIP file and enter a ZIP
file name. 

4.  

Note If you did not select multiple files, the ZIP file option and name field do not 
appear in the Select Directory dialog. 

5. 

Checkout and Checkin to Revise Attachment Files or File 

The
che nd check it back in. To revise an 
atta
mak
repl e Description. 

Click OK. The files (or ZIP file) are copied to the specified directory. 

You will be prompted whether you want to open the file or files. 

Folders 
re are several factors that determine how you check an attachment file out for modification and 
ck it back in, and how you check out a file folder for revision a
chment file means, of course, to alter the contents of the file itself. To revise a file folder means 
ing structural changes to the file folder’s contents, such as adding a file, deleting a file, 
acing one file with another, or editing th File 
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Not  When you download a file for revision, you simply get a copy of the file, make your e
revisions, and replace the original file when you are checking it back in. 

A fil ile 
File ust 
first

lder, the s s the attachment files available for modification 
by t der inaccessible for modification 
by o  which no one else can do until you either check 
the 

Important  “check 
e checked out file is automatically 

rs, think of CheckOut as 
nlocking a file, making it available to only the file folder Checkout User 

CheckIn is 

Onc y user who 
view
mod ser accesses the Latest Version of the folder object. 

By d , on r that 
you checked o ever, your Agile administrator can alter the privilege 
mas opriate privileges, you can edit the 
filenames when you check in the attachment. 

The following procedure works from a file folder’s Files tab. For information about checking out from 

e folder can contain one file or multiple files. All the files are stored in the file vault, part of Ag
 Manager, each file identified with its file folder. In order to modify a file in the file vault, you m
 check out its file folder. 

When you check out a file fo ystem make
he Checkout User only—unlocks them—and renders the file fol
thers. You can download and edit the file(s),

efold r in or cancel the checkout. 

To many people in manufacturing industries and from Agile business objects, to
out a file” means a one-step operation in which th
downloaded to the user’s computer. In Agile PLM File Folde
synonymous with u
for modification. After modifying and replacing the referenced file(s), 
synonymous with locking the file in the file vault. 

e you have modified an attachment file and checked a containing folder back in, ever
b the same or another file folder object, will see the s o jects that reference that file, from 

ified version of the file—provided the u

efault ly you or a user with “file folder administration” privileges can check in a file folde
ut, or cancel a checkout. How

ks so that anyone can check in any file folder. Also, with appr

a business object Attachments tab, see Checking Out Attachment Files (on page 264). 

To check out a file folder and get attachment files for modification: 

1. Open a file folder. 

2. Click the Check Out button . 
y In Java Client, “[Checked out]” appears in red type at the upper-right portion of the object. 

ut file folder icon y In Web Client, a checked o  appears in the upper-left portion of the 

e files in the file folder are listed (URLs are listed too). 

. 

), having checked the folder out, now select the files 
you want and click the Get Files button 

object page. 

The Version number of the folder is advanced, from the latest previous version to the next 
number. If the checkout is canceled, the version number will revert. 

On the Title Block tab of the file folder, the checkout information is filled in, for example, 
Checkout User and Checkout Date. 

3. Click the Files tab. Th

4. To change the file folder itself, click the Edit, Add > Files, or Add > URLs button. Note that Edit 
button gives you the control information about the folder, and you are not editing the file itself
You can edit the File Description field or the File Path field. 

To change the contents of attachment file(s
 . 

5. Revise and save the files. 
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6. Return to the checked-out file folder from which you got the attachment file you have modified. 

b with the file you modified, using the appropriate instructions 
below for either Java Client or Web Client. 

odifications (Replace, Add, Delete, and Edit) click the 

7. Replace the file on the Files ta

When you have completed all yo  mur
Check In button . The file folder is checked in, and the version increments. 

Java Client, replace files: 
Replace Filea. Select the row to enable the  button. 

b. Click the Replace File button . 
c. The Select File dialog appears. 

 

d. Select the modified file or navigate to the directory you want and select the file. 
e. Click Open to complete the replacement process. 

Web Client, replace files:

a. In the file row you want to replace, click the Replace File button . 
b. The Replace File dialog appears. 
c. Click the Browse button to navigate to the directory you want and select the file. 
d. Whe

From the Files tab of the file folder, you can 

n you are done, click Finish. 

Note choose to replace a file at any time 
the file folder is checked out. 

The modified file writes over the previous version of the file. 

Checking in a file folder increases the version number of the attachment. 

n you checWhe k out a file folder and get an attachment file, a copy of the attachment file is stored in 

dele

If you placed n), you 
can check in t y computer that provides access to that drive or directory. If you place 
the file into a directory that is not a shared directory, it must be checked in from that same 

 about shared directories. 

When you wish to discard edits to files on a file folder that you checked out, you can cancel the 

e  

 file 

To cancel a file folder object checkout: 

1. Display the file folder object. 

a specified directory. When you check the file folder in, the files remain in the directory until you 
te them manually. 

the file on the network or in a shared drive or directory (during the Get operatio
he file from an

computer. See your Microsoft documentation for more information

Canceling Checkouts 

checkout. 

A checkout can be canceled only by the user who checked out the attachment, or by a user with 
necessary “file folder administration” privileges. If you have questions about your privileges, contact 
your Agile administrator. 

Wh n you cancel a checkout, copies of the attachment files remain in the checkout directory you
selected, but the original files are once more available to be checked out from the Files tab. Any 
edits you make to the remaining copies of the files do not appear in the public versions of the
(the versions of the file stored in the file vault). 
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2. Click the Cancel Checkout button . 
 

Ad Hoc Redlining or Marking Up of Attachment Files from the File 
l

” in which the 

To a  an attachment file from a file folder object in the Java Client: 

2. 

ewer appears, click the Markup button. (This button is available only when markups 
 

dline the attachment. To view online 

saved against and associated with the version of the file 

Fo der 

The other method to mark up or redline an attachment file is called “ad hoc redlining
attachment is approached via the Files tab of the file folder. 

d hoc redline or mark up

1. On the Files tab of the file folder object, select a file you want to redline. 

Click the View button. 

3. When the Vi
are allowed.)

4. Use the tools described in the viewer online Help to re
Help, choose Help > Content in the menu bar. 

Note Ad hoc markups are 
folder object. 

To ad hoc redline or mark up an attachment file from a File Folder object in the Web Client: 

1. On the Files tab of a file folder object, click the Do Redlines button  (or Has Redlines button  ) 

 described in the viewer online Help to redline the attachment. To view online 
 Help > Content in the menu bar. 

iated with the version of the file 

on the row of the file you want to redline. (This button is available only when markups are 
allowed.) 

2. Use the tools
Help, choose

Note Ad hoc markups are saved against and assoc
folder object. 

For more information about the Viewer, see Viewer Supplement. 

Other File Folder Operations 

ile 
Fold is created, and File Folder 1 becomes obsolete, you can replace the attachment of File 

move a file folder reference from all or some of the objects that reference the file folder. 

r. 

t to remove, replace, or add. 

Performing a Mass Update of a File Folder 
You can remove or replace a file-folder attached to multiple objects at one time. For example, if F

er 2 
Folder 1 with File Folder 2 on all of the objects that include a reference to File Folder 1. 

à Re

à Replace a file folder reference in all or some of the objects that reference the file folde

à Add a file folder to the Attachments tab of multiple specified objects. 

To perform a bulk file folder operatio n Java Client: 

1. Open the file folder that you wan

n i

2. Right-click and choose Mass Update. 
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3. Select the version of the file folder on which you want to perform the bulk operation. 

4. Select the attachment files you want to include in the operation, and click Next. 
e 

 wizard search tools to find 
 affected by this bulk operation or, select the objects you 
d list. 

Finish

d. 

. Specify whether you want to add file, remove file, replace file, or replace version, and click Next. 
4. Select the version of the file folder on which you want to perform the bulk operation. 

5. Select the attachment files you want to include in the operation, and click Next. 
6. Using the wizard search tools, find and select the objects you want to be affected by this bulk 

operation. 

7. Click Finish. 
 

Routing and Reviewing File Folders 
The Default File Folders Workflow applies to all file folder objects that users create in the File 
Folders class. This workflow is “read only” and, with only a single Review status, is a simple review-
and-signoff system—although the signoff can still be an approval or a rejection. 

To add approvers or observers: 

1. Open the file folder object, and select the Routing Slip tab. 

2. Click the Add Approvers/Observers button. The Add Approvers and Observers dialog box opens. 

3. Select the approvers and observers you want to add, and enter a comment, if desired. Click 
OK. 

Similarly, you can use the Remove Approvers or Observers page to remove reviewers for a file 
folder. 

On the Approve Folder page, you can approve a file folder. Enter your password and any 
comments, then click Approve. On the Reject Folder page, you can reject a file folder. Enter your 
password and any comments, then click Reject. If you are the group member who is approving or 

rejecting the change for a group, click 

5. Specify whether you want to add, remove, replace the file folder or replace the version of th
file folder, and click Next. 

6. Depending on which function you selected in step 5 above, use the
and select the objects you want to be
want to be affected from the displaye

7. Click . 

To perform a bulk file folder operation in Web Client: 

1. Open the file folder that you want to remove, replace, or ad

2. Choose Actions > Mass Update. 

3

 to select the group or groups for which you are 
approving or rejecting the file folder. 

In the Comment dialog box, you can make comments about the file folder and notify users. Type the 
text in the Comment field. To notify users of the comment via email, select the users. Comments also 
appear on the History tab of the file folder. 
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File Folders and the Effects of CopyFilesToRev SmartRule 
See Effects of CopyFilesToRev SmartRule (on page X270X). 

File Folders and Viewing 
For information about Viewer, see Viewer Supplement. 

File Validation (Handle File Checksum) 
See Checksum File Validation (on page X266X). 
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